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INTRODUCTION 
 
This Data Acquisition and Processing Report outlines the acquisition and processing procedures used for 
Hydrographic projects surveyed in 2008 by the NOAA Ship Fairweather.  

Survey specific details will be listed in Descriptive Reports as needed.  Unless otherwise noted, the acquisition 
and processing procedures used and deliverables produced are in accordance with the NOAA Hydrographic 
Survey Specifications and Deliverables Manual (HSSD) April 2008, the Field Procedures Manual (FPM), May 
2008, and all active Hydrographic Surveys Technical Directives (HTD). 
 
Any additions and changes to the following will be included with the individual Descriptive Reports  

A EQUIPMENT 
 
Detailed descriptions of the equipment and systems, including hardware and software, used for bathymetric data 
acquisition, horizontal and vertical control operations, shoreline acquisition, and processing are listed below. 
 
1.0 Hardware 
 
The hardware listed in this section was used throughout the 2008 field season. 

1.1 Hardware Systems Inventory 
 
Detailed hardware information, including installation dates and serial numbers, is included in Appendix I of this 
report. Manufacturer’s product specifications are included in Appendix II. 

1.2 Echo Sounding Equipment 

1.2.1 Reson 8111ER Multibeam Echosounder (MBES) 
 
Fairweather is equipped with a RESON SeaBat 8111 MBES with the Extended Range (ER) and snippet options.  
The 8111ER is a 100 kHz multibeam system with swath coverage of 150°.  The swath is made up of 101 discrete 
beams with an along-track and across-track beamwidth of 1.5°.  It has a specified depth range of 3 to 1200 meters, 
though the typical operational depth range of the 8111ER on the Fairweather is 20 to 600 meters.  No calibration 
information was provided by the manufacturer for the system. 
 
The 8111ER is hull-mounted within a reinforced projection that extends 27 inches below the keel.  It is located 
39.5” starboard of the centerline at approximately frame 29 (see Figures 1 & 2).   
 

1.2.2 RESON 8160 Multibeam Echosounder (MBES) 
 
Fairweather is equipped with a RESON SeaBat 8160 MBES with the snippet option.  The 8160 is a 50 kHz 
multibeam system with a swath coverage of greater than 4x water depth.  Each swath is made up of 126 discrete 
beams with an along-track and across-track beamwidth of 1.5°.  It has a specified depth range of 10 to 3000 
meters.  No calibration information was provided by the manufacture for the system. 
 
The 8160 is hull-mounted within a reinforced projection that extends 13.6 inches below the keel.  It is located 54 
inches port of the centerline at approximately frame 29 (see Figures 3 & 4).   
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Figure 1: RESON SeaBat 8111ER MBES Figure 2: RESON SeaBat 8111ER MBES on 

Fairweather 
 
 
 

  
Figure 3: RESON SeaBat 8160    Figure 4: RESON SeaBat 8160 on Fairweather 

 

 

1.2.3 RESON 8101ER Multibeam Echosounder (MBES) 
 
Survey Launches 1010 and 1018 are each equipped with a RESON SeaBat 8101 MBES with the Extended Range 
and snippet option.  The 8101ER is a 240 kHz multibeam system with a swath coverage of 150°.  The swath is 
made up of 101 discrete beams with an along-track and across-track beamwidth of 1.5°.  It has a specified depth 
range of up to 500 meters.  The typical operational depth range of the 8101 on launches 1010 and 1018 is 3 to 120 
meters.  Under optimal conditions with a hard bottom, high power and high gain, the depth range of the 8101 ER 
was observed to be as deep as 350 m producing a swath of ±45º from nadir.  No calibration information was 
provided by the manufacturer for the system. 
 
Each system is attached to a launch using a swing mount which is starboard of the keel and approximately 
centered fore and aft (see Figures 5 & 6).   
 

 - A-2 -  



 2008 DAPR NOAA Ship Fairweather 

  
     Figure 5: Launch 1010 with 8101 extended        Figure 6: Launch 1010 with 8101 retracted 
 

1.2.4 Odom Echotrac CVM (VBES) 
 
The Odom Echotrac CVM Vertical Beam Echo Sounder (VBES) is portable, and is intended for use during 
shoreline acquisition or as necessary with vessels 2302 and 1706 (Figure 7). The CVM vertical beam system will 
utilize either a 4 degree or a smaller 9 degree 200 kHz side mounted transducer and has a depth range up to 180 
meters (Figure 8). The eventual goal is to have the transducers hull mounted for improved data quality. The CVM 
links directly into the Trimble Pathfinder® Pro XRS unit and provides a real-time bottom profile. Files are logged 
in Odom format initially and then converted to .XTF format to provide accurate depth records used during the 
Shoreline NALL Buffer, VBES mainscheme, and/or VBES crosslines.  
 

 

               Figure 7: Odom Echotrac CVM                     Figure 8: Four degree (left) & nine degree transducers 
 
 

1.3 Manual Sounding Equipment  

1.3.1 Diver’s Least Depth Gauge 
 
The diver’s least depth gauge (DLDG) is a hand-held device that uses pressure to determine depth of water over a 
discrete point (e.g. mast of a shipwreck).  A raw sounding obtained during a dive is corrected with verified tides 
and Conductivity/Temperature/Depth (CTD) information acquired in the vicinity of the object.  
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The divers least depth gauge  (see Figure 9) was calibrated by PTC Electronics Incorporated on April 2, 2008, 
documentation is included in Appendix V.  Prior to field season use, a raw DLDG sounding with a simultaneous 
lead line reading allowed for a comparison measurement for check purposes to ensure appropriate readings.  
Depths acquired with the DLDG are processed using the same procedures as other shoreline features that require 
tide correction as described in section B.2.2 of this report.  
 
During projects that required DLDG use, periodic quality assurance checks were conducted as outlined in section 
1.5.6 of the FPM.  Daily DQA checks and pre and post dive DQAs were performed.  Documentation and DQA 
files are included with the individual descriptive reports with the Sound Speed DQA data for the particular 
surveys that required the use of the DLDG. 
 
 

 
Figure 9: Diver's least depth gauge 

 
 

1.3.2 Lead Lines 
 
Vessels 1010, 1018, 1706, and 2302 are each equipped with a lead line.  Lead lines are used for depth 
measurements near shore over submerged shoals and for echosounder depth comparisons.   
 
Leadlines were created, measured and calibrated according to Section 1.5.3 of the FPM with the exception that the 
lines were calibrated to the meter instead of decimeter.  Calibration was performed during May and June 2008.  
Calibration reports for the leadlines are included in Appendix V.     

1.4 Positioning, Heading, and Attitude Equipment 

1.4.1 TSS Positioning and Orientation System for Marine Vehicles (POS/MV) 
 
Fairweather and her launches are each equipped with a TSS POS/MV 320 V4, configured with TrueHeave™ and 
Precise Timing.  The POS/MV calculates position, heading, attitude, and vertical displacement (heave) of a vessel.  
It consists of a rack mounted version POS Computer System (PCS) (Hardware Version 2.9-7 on Fairweather and 
version 2.6-7 on both Launches), a strap down IMU-200 Inertial Measurement Unit (IMU), and two GPS antennas 
corresponding to GPS receivers in the PCS.  The port side antenna is designated as the primary receiver, and the 
starboard side antenna is the secondary receiver  (see Figures 10 & 11).  Differential correctors are supplied to the 
POS MV by a CSI wireless MBX-3S Automatic Differential GPS receiver. The POS MV firmware version 3.42 
and the controller software version 3.4.0.0 are currently the installed versions utilized. 
 
For all multibeam systems aboard Fairweather and her launches, timing between the sonar swath, position, 
heading and attitude information was synchronized by utilizing the TSS POS/MV 320 v.4’s.  A timing string was 
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sent from the POS/MV to the RESON topside unit and to the ISIS computer recording the incoming data.  Vessel 
wiring diagrams are included in Appendix III-vssl-5. 
 
POS/MV controller software was used to monitor position accuracy and quality during data acquisition.  This 
ensured that positioning accuracy requirements were met, as outlined in section 3.2.1 of the HSSD, April 2008.  
The POS/MV controller software provides clear visual indications whenever accuracy thresholds are exceeded.   

1.4.2 POS/MV GAMS Calibration 
 
GAMS (GPS Azimuth Measurement Sub-system) calibrations were performed on each of the three POS/MV 
units.  The GAMS calibration procedure was conducted in accordance with instructions in chapter 4 of the 
POSMV V4 Installation and Operation Guide, 2005.  Results are included in the individual vessel reports and 
spreadsheets, with calibration details located in Appendix III. 
  

 
        Figure 10: POS/MV antennas on 1018                           Figure 11: POS/MV antennas on 1010 
 
An additional GAMS calibration was performed on Launch 1018 after a configuration error was detected in 
August 2008.  The primary and secondary GPS antennas were wired incorrectly, with the port antenna, defined as 
the primary, plugged into the secondary antenna port on the PCS, and the starboard antenna, defined as the 
secondary antenna, plugged into the primary port on the PCS.  The configuration error resulted in a horizontal 
position error in data collected by 1018 until the problem was corrected.  Since the offset is a very well-known 
quantity (exactly the separation between the POS/MV GPS antennas), an entry was made in the .hvf to correct the 
output position to the actual reference point of the launch.  Additionally, a new patch test was conducted and is 
addressed in the Patch test section of this report. 

1.4.3 CSI Wireless MBX-3S DGPS Receiver 
 
Fairweather is equipped with commercial grade CSI Wireless MBX-3S DGPS Receivers that are used in 
conjunction with TSS POS/MV to provide vessel positioning during data acquisition.  The DGPS receivers are 
configured in manual mode to allow reception of only one U.S. Coast Guard (USCG) differential GPS beacon 
station.  Vessel wiring diagrams are in Appendix III-vssl-5. 
 
Differential GPS (DGPS) is the primary method of positioning.  The individual descriptive reports list the U.S. 
Coast Guard beacon sites and frequencies used for differential corrections utilized during hydrographic surveying. 

1.4.4 Trimble Backpack 
 
Fairweather uses two GPS Pathfinder® Pro XRS receivers in conjunction with a field computer to acquire 
detached positions during shoreline verification in the field.  Data can also be collected with a handheld TSCe 
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data collector.  Fairweather’s field computers consist of three Panasonic CF-18 Tuffbooks and one CF-29 
Tuffbook. The receivers have integrated beacon/satellite differential antennas which allow access to digital real-
time sub-meter accuracy solutions.  Extensive data quality assurance testing was conducted by Fairweather 
personnel in March 2007.  The Trimble backpack GPS unit testing was combined with the Ashtech testing and the 
results are located in the Horizontal Positioning Equipment Check file in Appendix V.  In April of 2008, a smaller 
scale check of the Trimble units was conducted without a comparison to the Ashtech Z-Xtreme, with comparable 
Trimble results of positions within 2.5meters. 
 

 
Figure 12: Trimble Backpack Unit 

1.4.5 Impulse LR Hand-held Laser 
 
The Impulse Laser Rangefinder and TruPulse 200 Laser Rangefinder are used in conjunction with the Trimble 
Backpack GPS unit to acquire distances and heights during shoreline verification.  These data are entered directly 
into the shoreline acquisition software and annotated on the detached position forms.  The Impulse LR and 
TruPulse 200 Laser Rangefinder do not function properly in low light or in choppy seas when a feature is not 
distinguishable from surroundings.  

   
                  Figure 13: IMPULSE LR laser                    Figure 14: TruPulse 200 Laser Rangefinder 
 
Data quality assurance testing was conducted on the Impulse LR on  February 2006 by Fairweather personnel.  
Comparison testing among the Laser Rangefinder, the TruPulse 200 Laser Rangefinder and the Trimble Backpack 
units was performed on March 2006.  Vertical and horizontal readings were taken with the laser level and 
compared to measurements taken with a fifteen meter steel tape and a graduated metric staff.  Three marks were 
placed on the staff with SOLAS reflective tape in order to get a good fix.  The laser level was set up on a bipod at 
10, 20, 50 and 100 meter intervals from the staff.  Three horizontal and three vertical readings were taken at each 
interval.  The results of the Laser Level Accuracy testing are located in Appendix V. 
 
The laser levels were tested less extensively in April 2008 with steel tape but their accuracy was not verified by 
comparison with the Trimble backpack units.  
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1.5 Sound Velocity Equipment 

1.5.1 SBE 19plus SEACAT Profiler 
 
Fairweather is equipped with three SBE 19plus SEACAT sound velocity profilers used to acquire conductivity, 
temperature, and depth (CTD) data in the water column to determine the speed of sound through water.  Two of 
the SBE 19plus profilers have pressure sensors rated to 1000 meters.  The third has a pressure sensor rated to 
3,500 meters.  
 
The SBE 19plus SEACAT sound velocity profilers were calibrated by the manufacturer and current calibration 
files were returned with the units.  Calibration files are located in Appendix V.   
 
Periodic quality assurance checks include comparison casts between CTD instruments.  Data quality assurance 
(DQA) checks include comparison casts between two instruments as per section 1.5.2.2.2 of the FPM for each 
survey.  Records of the DQA tests performed are kept aboard the ship and are included with the digital Separates 
II – Sound Speed Data for each survey.   
 
To ensure that the CTDs continue to function properly a stringent maintenance schedule is followed using 
guidelines from the manufacturer's recommendations.  This includes a thorough rinsing of the instrument with 
distilled water after each cast and periodically each CTD is flushed with a Triton X-100 solution.   
 

1.5.2 SBE 45 Micro Thermosalinograph (TSG) 
 
Fairweather is equipped with one SBE 45 MicroTSG.  The SBE 45 uses continuously pumped sea water to 
measure conductivity and temperature near the ship’s hull mounted transducers.  The intake is located 9 feet 
below the DWL (13 ft) between frames 11 and 12.   
 
The conductivity and temperature information is converted to sound speed and output to the RESON 8160’s and 
8111’s processing units.  The 8160 requires sound velocity information for beam forming and pitch stabilization 
while the 8111 only requires it for pitch stabilization.  The 8160 cannot be used to acquire data without real time 
sound speed information. 
 
The unit was calibrated during the winter inport in Seattle.  The current calibration report is included in Appendix 
V. 

1.5.3 Moving Vessel Profiler 200 
 
A Brooke Ocean Technology, Ltd. (BOT) Moving Vessel Profiler 200 (MVP200) is mounted in the aft starboard 
corner of the fantail (see Figure 15).  The MVP200 system is a self contained sound velocity profiling system 
capable of sampling water column profiles to 200m depth from a vessel moving up to 12 knots.  The system is 
configured with a Single Sensor Free Fall Fish (SSFFF) outfitted with an Applied Microsystems Ltd. Sound 
Velocity and Pressure Smart Sensor.  Deeper profiles can be obtained by reducing the vessel speed.  When the 
vessel is holding station, the system is capable of recording casts over 400m in depth. 
 
The MVP system consists of a winch, cable, fish (the towed unit with the sound velocity sensor), support 
assembly, and controlling hardware and software. During ship acquisition, the fish is deployed using the on-deck 
controller and towed with enough cable out to keep the fish 3-5 m below the water surface. A “messenger” (a 
short cable-thickening sleeve) is set to allow the system to keep the appropriate amount of cable out and is reset as 
needed when the ship acquisition speed is altered. 
 
During SVP acquisition, the controlling computer application, BOT MVP version 2.26 is used to control the MVP 
system and to acquire SVP data. MVP allows for three acquisition modes: 1) automatic continuous multiple cast 
freefall casting while at speed, 2) single cast freefall casting while at speed, and 3) single cast winch speed casting 
while stationary. The user limits the depth to which the fish will fall by setting 1) the depth-off-bottom and 2) the 
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maximum depth.  Either single, individually initiated casts can be performed at the discretion of the Hydrographer 
or the auto deploy function can be enabled and set with varying intervals (every 10 minutes, for example) for 
deployment. 
 
The Applied Microsystems Ltd. Sound Velocity and Pressure Smart Sensors were calibrated by the manufacturer 
and current calibration files were returned with the units.  Sensor 4986 was the spare sensor on board and not used 
during the 2006 and 2007 field seasons.  An updated calibration was not required for sensor 4986 and the 2006 
calibration file is adequate.  Calibration files are located in Appendix V. 
 
Periodic quality assurance checks include comparison casts between the MVP and one of the SBE 19plus 
SEACATs.  Data quality assurance (DQA) checks include comparison casts among the instruments as per section 
1.5.2.2.2 of the FPM for each survey.  Records of the DQA tests performed are kept aboard the ship and are 
included with the digital Separates II – Sound Speed Data for each survey.   
 
 

 
Figure 15: Fairweather’s MVP200 sound velocity system 

 

1.6 Vertical Control Equipment 

1.6.1 Water Level Gauges 
 
Five Sutron 8210 tide gauges were provided to Fairweather by the Center for Operational Oceanographic 
Products and Services (CO-OPS) at the start of the 2008 field season.  These gauges are equipped with Paros 
Scientific Sensors for pressure measurements.  The tide gauges are checked annually by CO-OPS Field 
Operations Division personnel to ensure that their accuracy standards are being met.  
 
CO-OPS does not provide calibration or quality assurance documentation to the Fairweather.  Installation and 
removal of the water level gauges is the responsibility of Fairweather personnel.  To ensure full functionality of 
the vertical control equipment prior to deployment for field operations, new gauges undergo testing by 
Fairweather personnel.  Five gauges underwent testing in March 2008, the write up and results are included in 
Appendix V. 
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1.6.2 Leveling Equipment 
 
Fairweather is equipped with four universal automatic levels (two Zeiss NI2 333 and two Leica NA2 100) and 
graduated metric staffs to assist in leveling tide gauges.   
 
A Kukkamaki procedure is performed prior to leveling in order to verify the collimation error.  Procedures were 
followed as described in the User’s Guide for the Installation of Bench Marks and Leveling Requirements for 
Water Level Stations, October 1987.  Kukkamaki results for 2008 are located in the Tides folder in Appendix V.     

1.7 Horizontal Control Equipment 
 
Fairweather is equipped with one Ashtech Z-Xtreme and one Magellan Z-Max.Net dual-frequency GPS receivers 
used for the positioning of tidal benchmarks, aids to navigation and portable DGPS reference stations (Fly-Away).  
The Ashtech Z-Xtreme 12 channel, L1/L2 receiver is connected to an Ashtech Geodetic GPS antenna.  The 
Magellan Z-Max.Net 24 channel, L1/L2 receiver is connected to a Thales GPS antenna 
 
The Ashtech antenna can be equipped with an optional ground plane and both receiver antennas can be mounted 
on a fixed height Seco GPS tripod. 
 
Data quality assurance testing of the Ashtech Z-Xtreme GPS receiver equipment was performed in March of 2007 
by Fairweather personnel. The Z-Xtreme receiver was set up over Benchmark No. 37 in Ketchikan, AK using a 
Seco fixed height tripod.  Data was collected for 2 hours 30 minutes. The recorded observations were submitted to 
OPUS, the solution was computed with ultra-rapid orbits.  The OPUS position was less than a centimeter off the 
published NGS Control Point for BM No. 37.   The OPUS solution and a map of the results of the test with the 
Trimble units are located in Appendix V.  Accuracy standards have been met according to NOAA Technical 
Memorandum NOS NGS-58. 
 
Data quality assurance testing of the Magellan Z-Max GPS receiver was performed in July of 2008 by 
Fairweather personnel. The Magellan Z-Max GPS receiver and Ashtech Z-Xtreme GPS receiver were set up over 
Benchmark No. 6 for tide station 945-5517 using a Seco fixed height tripod. Data was collected for 3 hours and 32 
minutes with the Z-Xtreme receiver and 20 hours and 47 minutes with the Z-Max.Net receiver. Both observations 
were submitted to OPUS, the solutions were computed with precise orbits. The two OPUS positions were 3.2 
centimeters apart. The OPUS solutions are located in Appendix V. Accuracy standards have been met according 
to NOAA Technical Memorandum NOS NGS-58. 
 
The Fly-Away DGPS Beacon setup aboard NOAA Ship Fairweather was tested in May 2008 over BM No. 37 in 
Ketchikan, AK.  The testing setup parameters and results are included in Appendix V. 
 
Horizontal control equipment serial numbers and installation dates are located in the hardware section of 
Appendix I, System Tracking.   
 
2.0 Software 

2.1 Software Systems Inventory 
 
An extensive software inventory with documentation, of the software systems used by the NOAA ship 
Fairweather, is maintained as a Survey Software spreadsheet and is included with the Supplemental Survey 
Records for the individual Descriptive Reports.  This spreadsheet includes specifics such as software applications, 
versions, and hot fixes, in addition to dates loaded on specific computers within the survey department. 
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2.2 Data Acquisition Software  

2.2.1 Isis Sonar/ BathyPro/ TritonMap/ 
 
The Fairweather uses the Triton Imaging Inc. software package Sonar Suite to acquire multibeam echo sounder 
and backscatter data on all of its multibeam platforms.  Sonar Suite has two software packages, Isis Sonar and 
TritonMap, which work together along with BathyPro to produce real-time data planning, acquisition, and 
execution.  
 
Triton Imaging BathyPro is an add-on package for Isis Sonar which processes XTF data real-time to produce 
DTMs supported by TritonMap.   TritonMap is a stand-alone GIS program which combines georeferenced 
bathymetric digital terrain models and reference files such as raster charts and vector shoreline files to display 
real-time bathymetric bottom coverage.  

2.2.2 TerraSync/ Pathfinder Office 
 
For GPS positioning and shoreline verification Fairweather uses two Trimble Navigation Limited software 
programs: TerraSync 2.41 and GPS Pathfinder 3.02. 
 
GPS Pathfinder is run on a Microsoft Windows operating system and is used to manage and process Trimble GPS 
data, transfer files to and from GPS receivers and handheld data collectors, and export processed data.   
 
Trimble TerraSync 2.41 supports data dictionaries built with S-57 objects and attributes and georeferenced TIFF 
images. The georeferenced TIFF images are used for reference and navigation purposes as well as for immediate 
S-57 attribution of positions in the field.  TerraSync is installed and configured for data collection on all of the 
Tuffbook field computers, the TuffTab, and the TSCe handheld computer. 
 
GPS precision masks in TerraSync using the following parameters:  

• Horizontal Dilution of Precision (HDOP) ≤ 2.5 
• Signal-to-Noise Ratio (SNR) ≥ 4 
• Elevation Mask ≥ ~8°-15° (varies by location) 

 
Differential GPS correction is applied in real-time, using the unit’s integrated beacon as the first choice corrector, 
and specifying “wait for real-time” as the secondary option.  Positions are filtered so that only those with a 
minimum of 4 satellites (3D position), and HDOP ≤ 2.5, and Positional Dilution of Precision (PDOP) ≤ 6 will be 
recorded.  

2.2.3 CARIS Notebook 

CARIS Notebook™ can be used to directly collect detached shoreline positions and verify shoreline.  The 
software is run on a field computer and receives the Trimble GPS data output from the GPS Pathfinder® Pro XRS 
receivers.   
GPS settings in CARIS Notebook are as follows:  

• Maximum Horizontal Dilution of Precision (HDOP) = 2.5 
• Maximum Positional Dilution of Precision (PDOP) = 6 
• Minimum Signal-to-Noise Ratio (SNR) = 12 
• Minimum Elevation Mask = 8° 
• Minimum # of Satellites = 4 

 
Real-Time settings in CARIS Notebook are as follows:  

• Source Type: Integrated Beacon – Manual Mode 
• Position Mode: Corrected Only 
• Age Limit: 20 seconds 
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Differential GPS correction is applied in real-time, using the unit’s integrated beacon as the primary corrector. 
The unit can be setup to run without using DGPS with position mode set to “Autonomous Only” or with values 
different than those listed above.  These special circumstances of acquisition with altered parameters are recorded 
and documented in the individual Descriptive Report as appropriate.    

2.3 Data Processing Software 

2.3.1 NOAA Hydrographic Systems and Technology Programs (HSTP) Software 
 
Sound velocity data is processed with Velocwin, in-house software produced and maintained by NOAA’s 
Hydrographic Systems and Technology Programs (HSTP) division.  Velocwin creates and archives water column 
profiles, performs quality assurance, and processes pressure based depth data.  Velocwin creates a standard file 
format across NOAA’s hydrographic fleet for sound velocity profiles applied to shallow water multibeam and 
single beam data.  
Pydro, another NOAA program produced and maintained by HSTP, is used to process features such as detached 
positions (DP), geographic positions (GP), and Automated Wreck and Obstruction Information System (AWOIS) 
contacts. PYDRO also converts and attributes features according to S-57 standards for insertion into CARIS 
Notebook.  

2.3.2 CARIS 
 
CARIS HIPS™ (Hydrographic Information Processing System) is used to process all shallow water multibeam 
data including data conversion, filtering, sound velocity, tide correcting, merging and cleaning. CARIS HIPS also 
calculates the Total Propagated Error (TPE) used to produce Bathymetry Associated with Statistical Error (BASE) 
surfaces which assist the Hydrographer in data cleaning and analysis.   
 
CARIS Notebook™ is used to compile and display source shoreline, shoreline updates and S-57 features that are 
either imported from Pydro, digitized, or collected directly in the field.  The .hob files created in Notebook are the 
current shoreline deliverables.    

2.3.3 Fledermaus™ 
 
Fledermaus ™, an Interactive Visualization Systems 3D™ (IVS 3D) program, is used for data visualizations and 
creation of data quality control products, public relations material and reference surface comparisons.   
 
As an additional data quality assurance check, Fledermaus ™ is used to examine the CARIS surfaces prior to 
submission.  The combined BASE surface is exported from CARIS and then converted to a Fledermaus .sd file 
via the Avggrid and Dmagic programs.   

2.3.4 MapInfo™ 
 
MapInfo™ is used to review tables and workspaces associated with assigned projects received from Hydrographic 
Survey Division (HSD).  MapInfo may also be used to produce scaled plots produced for public relation purposes.  
HydroMI, an HSTP produced MapBasic program, is used through MapInfo to convert tide and tidal zoning files 
into a format that is useable in CARIS HIPS, and to obtain latitude/longitude coordinates for pre-survey planning.  
 
3.0 Vessels  

3.1 Vessel Inventory 
 
The NOAA Ship Fairweather (S220) and her survey launches 1010 and 1018 are equipped to acquire multibeam 
echosounder (MBES) and sound velocity profile (SVP) data.  Launch 1018 is also the primary vessel for dive 
operations.  The AMBAR (2302) and Monark (1706) are used during shoreline verification, bottom sampling, and 
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horizontal and vertical control operations.   All vessels may be used in support of tide gauge operations.  See 
Appendix I for the complete vessel inventory. 

3.2 Noise Analysis 
 
The Fairweather sonar systems, RESON 8160 and RESON 8111ER, underwent noise analysis testing on October 
10 and 11, 2004 respectively.  The results are used during acquisition to enhance data quality and are included in 
Appendix III-S220-6.  Standard operating procedures utilizing the RESON 8160 and RESON 8111ER aboard the 
Fairweather have survey speeds set to minimize noise based on these noise analyses.     

 
4.0 Data Acquisition 

4.1 Horizontal Control 
 
A complete description of horizontal control will be included in the project’s Horizontal and Vertical Control 
Report (HVCR), submitted for each project under separate cover when necessary as outlined in FPM section 
5.2.3.2.3. 
 
The horizontal datum for all project is the North American Datum of 1983 (NAD83) unless otherwise noted in the 
individual descriptive reports.   
 
Multibeam and shoreline data were differentially corrected in real time using correctors provided by Coast Guard 
beacons.  The specific beacons used for a given survey will be included in the Horizontal Control section of the 
survey’s descriptive report.  If loss of the differential beacon resulted in any data being recorded with C/A GPS 
positions it will be noted in the descriptive report for the specific survey.   
 

4.2 Multibeam Echosounder Acquisition and Monitoring Procedures 
 
Methods of acquisition took into consideration system performance limitations, the bottom topography, water 
depth, and the ability of the vessel to safely navigate the area.   
 
All multibeam data were acquired in Triton Elic’s extended transfer format (XTF) and monitored in real-time 
using the 2-D and 3-D data display windows and the on-screen displays for the RESON SeaBat 8101ER,  
8111ER, and 8160.  Adjustable parameters that were used to control the RESON from the ISIS software include 
range scale, power, gain, and pulse width.  These parameters were adjusted as necessary to ensure best data 
quality.  Vessel speed was also adjusted as needed to eliminate noise from the data and to ensure the required 
along-track coverage for object detection in accordance with the HSSD.  Survey personnel follow standard 
operating procedures documented aboard the Fairweather while setting and utilizing the RESON systems and Isis 
for acquisition of data. 
 
Mainscheme multibeam sounding acquisition lines using the RESON SeaBat 8101ER,  8111ER, and 8160 are 
generally run parallel to the contours and spaced approximately three to four times the water depth.  For discrete 
item developments, line separation was reduced to 2 times water depth to ensure least-depth determination by 
multibeam near-nadir beams.  Triton Elic’s TritonMap Real Time Bathy was used in lieu of planned line files.  
Real Time Bathy displays the acquired multibeam swath during acquisition and was monitored to ensure overlap 
and full bottom coverage.  If coverage was not adequate, additional lines were run while still in the area. 

4.3 Shoreline Verification 
 
Fairweather personnel conduct field shoreline verification at times near predicted low water, in accordance with 
the Project Instructions and the FPM (May, 2008).   
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The composite source file (CSF) provided with the project instructions is the primary source for shoreline features 
to be verified.  Additionally, AWOIS items and other features to be investigated are provided for a given survey 
and are included in the files utilized during shoreline verification.  Specific details regarding the composite source 
and investigation features are included in the individual descriptive reports. 
 
A Mean High Water (MHW) Buffer line, offset 0.8 mm at the scale of the largest chart in the area, was created 
from the composite source MHW line. This MHW Buffer line was used in the shoreline acquisition software and 
on the boat sheet as a reference, and to determine the Navigable Area Limit Line (NALL).  The NALL was 
determined in the field as the farthest off-shore of either the MHW buffer specified above or the 4-meter depth 
contour.  All shoreline features from the composite source seaward of the Navigable Area Limit Line (NALL) 
were verified (including an update to depth and/or position as necessary) or disproved during shoreline operations.  
Features off-shore of the NALL and not addressed or features of an ambiguous nature were flagged with a marker 
note for further clarification. 
 
Detached positions (DPs) acquired during shoreline verification indicate new features, revisions to source 
features, or source features not found in the field.  They are recorded in the shoreline acquisition software and on 
DP forms.  
 
5.0 

1.0 

Bottom Sample Acquisition 
 
Bottom samples are acquired according to section 7.1 of the HSSD.  Samples were acquired using the current 
shoreline acquisition system and processed similarly to other shoreline features as outlined in the descriptive 
report for the specific survey.  Bottom sample results are included in the Notebook .hob deliverable layer, 
HXXXXX_Field_Verified. 
 
 

B QUALITY CONTROL 
 
The Fairweather has numerous standard operating procedures (SOPs) that are followed by personnel throughout 
the survey to ensure consistent high quality data and products. 
 

Uncertainty Modeling 
 
Error values for the multibeam and positioning systems on Fairweather and her survey launches were compiled 
from manufacturer specification sheets for each sensor (Heave, Pitch, Roll, Position, and Heading) and from 
values set forth in section 4.2.3.6 and Appendix 4 – CARIS HVF Uncertainty Values of the FPM.   
 
Estimates for the error in measuring vessel offsets, multibeam system biases (timing, pitch, roll and yaw), 
dynamic draft, and MRU alignment error are the standard deviations of the values determined by multiple 
personnel processing the data for each of these corrections.   
 
The tidal errors for the gauge and for zoning are determined on a project by project basis and are entered during 
the Compute TPE step in CARIS HIPS.  The values utilized for a given survey are included in the individual 
descriptive report. 
 
The Fairweather TPE Values spreadsheet located in Appendix IV, lists the final uncertainty values for 
Fairweather and her launches, including the default tides and sound velocity values.  Uncertainty values relating 
to vessels and survey systems are entered into the HIPS Vessel File (HVF) for each platform.   
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2.0 Data Processing 

2.1 Multibeam Echosounder Data Processing 
 
Bathymetry processing followed section 4.2 of the FPM unless otherwise noted.  
 
Raw XTF multibeam data were converted to Caris HDCS format using established and internally documented 
settings.  True heave, sound velocity and water level data were then applied to all lines and the lines merged.  
Once lines were merged Total Propagated Error (TPE) was computed.   
 
BASE surfaces were created using the Combined Uncertainty and Bathymetric Estimator (CUBE) algorithm and 
parameters contained in the Cubeparams.xml file which is included with the HIPS Vessel Files with the individual 
survey data.  The file contains parameter values that differ from the traditional default values which are listed in 
Table 1.  The Capture Distance Scalar (CDS) and Capture Distance Minimum (CDM) are set to limit the 
soundings that contribute to the node to those in a set radius surrounding the node.  The grid resolutions utilized 
are based on the beam footprint and expected data density.  The minimum resolution of 2 meters was determined 
based on having a minimum of three soundings per node and to accommodate the beam foot print size at 60 
degrees off-nadir.  In areas where a 1 meter resolution surface is required, data is acquired so that inter-line 
overlap is at 45 degrees.  These would be special circumstances such as developments and will be discussed in the 
individual Descriptive Report.  Additional documentation files on Data Representation and CUBE Results are 
included in Appendix VI, these documents outline the testing conducted, the methodology utilized, and the results 
leading to the determination of the resolutions and CUBE parameters used by Fairweather personnel during the 
2008 field season. 
 
The general resolution, depth ranges, and CUBE parameter settings used by Fairweather are listed in Table 1.  
These values may be adjusted by managers for individual surveys based on bathymetry and conditions in the 
survey area.  A detailed listing of the actual resolutions and depth ranges used during the processing of each 
survey, along with the corresponding fieldsheet(s), is provided in the descriptive report of each survey.   
 

Table 1: Resolutions and Depth Ranges 

Surface Resolutions CUBE Parameters 

Depth Range 
Grid 

Resolution Profile Name EO CDS CDM HES 
  0 to 20 m 2 m 2metergrid 4.0 1.00 1.41 2.95 
15 to 40 m 4 m 4metergrid 4.0 1.00 2.83 2.95 
35 to 80 m 8 m 8metergrid 4.0 1.00 5.67 2.95 
70 m and up 16 m 16metergrid 4.0 10.00 11.31 2.95 

 
Multibeam data were reviewed and edited in HIPS swath editor and in subset mode as necessary.  The BASE 
surfaces are used for directed data editing in subset editor, to demonstrate coverage, and to check for errors 
resulting from tide, sound velocity, attitude and timing. 
 
Vessel heading, attitude, and navigation data were reviewed in HIPS navigation editor and attitude editor if 
deemed necessary upon review of surfaces.  Where necessary, fliers or gaps in heading, attitude, or navigation 
data were manually rejected or interpolated for small periods of time. 
 
The Surface Filtering functionality in HIPS may be used in the processing of survey data to reject errant 
soundings.  If utilized, the individual Descriptive Report shall list the confidence level settings for standard 
deviation used and discuss the particular way the surface filtering was applied.  
 
In areas of navigational significance, depths less than 30 meters, where the BASE surface did not depict the 
desired depth for the given area, a designated sounding was selected.  Designated soundings were selected as 
outlined in section 5.1.1.3 of the HSSD. 
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Layers determining “IHOness” are added to the CUBE surfaces allowing the Hydrographer to see where and  if 
the surfaces  meet IHO Order.  The process is easily performed in HIPS and allows the Hydrographer to identify 
problem areas and determine the severity of the situation.  This is a spatial quality control check rather than just a 
statistical list of nodes and allows for specific areas with problems to be isolated and addressed.   
 
IHOness surfaces are utilized during data collection as an additional child layer of the finalized surfaces to 
indicate problem areas that need attention.  Additionally, IHOness child layer(s) are included with the submitted 
combined surface(s).   
 
A histogram is created in Fledermaus from the combined surface’s IHOness layer exported from CARIS.  This 
allows the Hydrographer to see the full data distribution rather than just the minimum and maximum values in the 
surface.  This data distribution is used to assess the quality of the survey.  The process is setup to highlight 95% of 
the data in the histogram which allows the Hydrographer to show whether 95% of the data for a given survey 
meets the appropriate IHO order as specified in section 2.55.1.1.1 of the HSSD.  An image of the histogram from 
Fledermaus is included with the Descriptive Reports for the specific surveys.    
 
Additionally the submitted combined surfaces are reviewed in Fledermaus to ensure that the data is sufficiently 
cleaned and accurately depicts the seafloor at that resolution. 
 

2.2 Shoreline Data Processing 
 
During shoreline verification, field detached positions (DP) were acquired either with TerraSync 2.41 or CARIS 
Notebook.  Tide application is applied in either Pydro or CARIS Notebook for features requiring tide correction.  
The programs used for shoreline acquisition and tide applications are listed in the individual Descriptive Report. 
 
An original composite source file (H#####_Original_Composite_Source.hob) is saved prior to being edited and is 
submitted with the individual survey.  New features and any updates to the composite source shoreline, such as 
ledges or reefs, are acquired or digitized with S57 attribution and reside in the H#####_Field_Verified.hob.  
Updates to a source shoreline feature primarily include a change in depth/height, position, or S57 classification.  
Notebook’s editing tools are used to modify source feature extents or positions.   
 
The SORIND and SORDAT S57 attribute fields for new features or modified source features are updated to 
reflect the information for the associated survey number and date.  All new or modified features are S57 attributed 
as applicable.  All unmodified source features retain their original SORIND and SORDAT values. 
 
Short descriptive comments taken from the boat sheets or DP forms along with investigation or survey methods 
were listed under the Remarks field.  For significant features that deserve additional discussion or disprovals, the 
Hydrographer included recommendations to the cartographer in the Recommendations field, along with the 
Hydrographer notes and investigation methods provided in the Remarks field.  
 
Features that are disproved or that do not adequately portray the shoreline are moved to the 
H#####_Disprovals.hob layer from the H#####_Field_Verified.hob layer.  Features in the disprovals layer retain 
their original SORIND and SORDAT values.  
 
Photos labeled and associated with a DP number are included with the survey data and stored in the PSS photo 
folder. 
 
AWOIS investigation items were inserted into Pydro for processing if necessary.  Shoreline features correlated to 
the AWOIS item are included in the H#####_Field_Verified.hob layer. 
 
The CARIS Notebook files along with CARIS HIPS BASE surface(s) are viewed to compare soundings and 
features simultaneously.  Standard operating procedures, for processing shoreline features in Pydro and/or CARIS 
Notebook, are followed by survey personnel aboard NOAA Ship Fairweather as outlined in chapter 4 of the FPM.  
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A detailed discussion of the procedures used and any deviations in shoreline processing from standard procedures 
or the FPM are documented in the individual Descriptive Reports. 
 
Final Shoreline Deliverables may include the Pydro PSS, Pydro Feature Reports if necessary, and up to three 
Notebook HOB files: 

HXXXXX_Original_Composite_Source, 
HXXXXX_Field_Verified, 
HXXXXX_Disprovals.  

 
3.0 

1.0 

2.0 

Data Review 
 
Specific procedures were used on Fairweather to ensure quality control of data throughout acquisition, 
processing, and submission.  These procedures are documented and followed by the Hydrographer. A detailed 
Quality Control Check is preformed by the survey manager.  A detailed Review is conducted by qualified survey 
personnel (FOO, CST, SST, or PS) other than the survey manager as an outside review of the survey data and 
deliverables.  Submission checklists are used to ensure that all data and deliverables are complete and included 
upon submission.  Documentation of these tasks is completed for every survey but only the final processing log, 
HXXXXX_Data_Log, is submitted with the individual survey data. 
 
 

C Corrections to Echo Soundings 
 

Vessel HVFs 
 
CARIS HIPS Vessel Files (HVF) were created by Fairweather personnel and used to define a vessel’s offsets and 
equipment uncertainty.  The HVF is used for converting and processing data collected by each survey platform.  
The HVFs used for a given project are included with the digital data submitted with those surveys.   
 

Vessel Offsets  
 
Sensor offsets were measured with respect to each vessel’s reference point.  The reference point for Fairweather 
and survey launches 1010 and 1018 is the IMU.  Specific offset values were input into the POS/MV and the 
CARIS HIPS Vessel File (HVF).   
 
A ship survey was completed for the Fairweather by Westlake Consultants, Inc on September 23, 2003 and a 
POS/MV component spatial relationship survey of the Fairweather was conducted by NGS in February 2007.  
The results of both of these surveys were used to determine the offsets for the ship.  The reports from each survey 
are located in Appendix III-S220-1, and the final values for Fairweather’s offsets and explanations of how they 
were calculated are located in the S220 Offsets & Measurements spreadsheet in the same folder.  
 
Permanent control points were established on launches 1010 and 1018 in July of 2004.  Sensor offsets were 
measured by Fairweather personnel according to documented procedures.  Total stations were utilized for 
positioning the permanent control points (see Figure 16).  The total station specifications are located in Appendix 
II-6, the calibration certificates for the Nikon DTM 310 and the Sokkia SET 5F are included in Appendix V.  A 
steel tape was used to verify and update specific vessel offsets in April 2008 and the results are located in the 
respective vessel’s Minimum Physical Measurements_2008 spreadsheet in Appendix III-101X-1.  The final offsets 
for survey launches 1010 and 1018 were derived from a combination of values from the original full survey and 
the values updated in the verification surveys.  The measurements, derivations, descriptions of methodology used, 
diagrams, and coordinate system references are included in the respective vessel’s Offsets & Measurements 
spreadsheet in Appendix III-101X-1. 
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Figure 16: Permanent Control Point "Benchmark C" on launch 1018 

 
3.0 

4.0 

Static and Dynamic Draft 
  
The static drafts (Waterline Height in the HVF) for launch 1010 and 1018 were calculated based on steel tape 
measurements of the distance from benchmarks on the port and starboard quarter of the vessel to the waterline.   
 
In 2007, the bow and stern draft marks were used to perform a linear interpolation of the static draft at the 
Fairweather’s IMU.  The static draft was measured multiple times with the vessel under different loading 
conditions: with and without launches on board and with different amounts of fuel.  The 2007 final value for the 
static draft was an average of the most likely loading conditions during survey operations.  Less stringent 
measurements were able to be taken at the start of the 2008 field season, while values were obtained, they were 
not used.  The 2007 static draft (Waterline Height in the HVF) and loading values were used as they were deemed 
more robust and appropriate for general surveying conditions.  In October of 2008, Fairweather personnel 
identified offsets apparent in data between the launches and the ship. During the investigation into the cause of 
said offsets divers were deployed to use the DLDG unit and a leadline to verify the static draft measurement for 
the ship.  The static draft value being utilized was confirmed as accurate within the measuring techniques used, 
results of DLDG measurements are included with the ship offset documentation in Appendix III-S220-1. 
 
The values and calculations for static draft are listed in each vessel’s Minimum Physical Measurements and 
Offsets & Measurements spreadsheets located in Appendix III-vssl-1. 
 
Dynamic Draft measurements were conducted for Fairweather in April 2008 and for survey launches 1010 and 
1018 in June 2008.  Additional dynamic draft testing was conducted for Fairweather in Ernest Sound on October 
25, 2008, after noticeable offsets were identified.  Conditions and tide correctors were such that reliable data was 
not obtained.  Fairweather personnel deemed that the 2006 dynamic draft values were more reliable then either 
the 2008 or 2007 values.  Final dynamic draft values were obtained and the processing spreadsheets of dynamic 
draft measurement results for each vessel are located in the respective vessel’s folder in Appendix III-vssl-3.  The 
launches utilized the 2008 dynamic draft values obtained.  The 2006 Fairweather dynamic draft values were used 
and applied for the entirety of the 2008 field season for the RESON SeaBat 8111 and 8160 MBES systems. 
 

Patch Tests 
 
Patch tests were conducted on Fairweather for the Reson 8111 multibeam acquisition system in April 2008, for 
the 8160 system and survey launch 1010 in June 2008.  Survey launch 1018 was fully tested initially and for an 
additional roll calibration in June 2008.  An additional patch test was required after the POS/MV configuration 
error was discovered and corrected in August 2008, as discussed in section 1.4.2.  The results of the patch tests, 
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along with the acquisition and processing logs, are included in the individual MBES Calibration Tables in 
Appendix III-vssl-2. 
 
 
5.0 

6.0 

Attitude  
 
All attitude corrections are generated by the POS/MV using data from the IMU-200 Inertial Measurement Unit 
(IMU).  All attitude data are applied in post-processing in HIPS.  Initially, the Reson 8160 had real-time roll and 
pitch stabilization applied, thus these components of attitude were not applied in post-processing as to not double 
apply the correctors.  It was decided on Day Number 212 (30 July 2008) to make all four systems consistent in 
their processing methods.  As of that date, real-time roll and pitch stabilization was turned off and those correctors 
are applied in post-processing.   
 
IMU values for uncertainty of heave, pitch and roll are included in the manufacturer specification in Appendix II-
2a and are included in the Fairweather TPE Values spreadsheet located in Appendix IV.   

5.1 True Heave 
 
Fairweather and her launches are equipped with the POS/MV TrueHeave™ (TH) option.  True Heave™ is a 
‘delayed’ heave corrector as opposed to ‘real time’ heave corrector and is fully described in Section 6 of the 
POS/MV Version 4 Installation and Operation Manual.  Daily TH files were logged through the Ethernet Logging 
function in the POS/MV controller software.  To ensure proper calculation of TH, files were logged for at least 
three minutes past the end of each day’s survey operations.   
 
During daily processing the occurrence of “corrupted” True Heave files can occur. This is likely due to a 
formatting problem in the True Heave file.  A temporary fix has been provided by CARIS in a tool called 
“fixTrueHeave.exe.”  In cases where this is necessary a new “fixed” file is created with the extension “.fixed” (ex. 
TH_1010_123.000.fixed). The new fixed True Heave file is then applied to the data in the CARIS HIPS program.  
The original corrupted file is retained along with the fixed file with the raw xtf files.  Occurrences of this for 
specific surveys are noted in the individual Descriptive Reports. 
In cases where TrueHeave™ could not be applied, real time heave correctors were used.  Real time heave data 
were recorded in Triton Elic’s Isis software, stored in the .xtf format and applied as the heave corrector for 
multibeam data.  Data that does not have TrueHeave™ applied will be listed in the individual Descriptive Report 
for the survey.  
 

Sound Velocity 
 
Seacat SBE 19plus sound velocity profilers are used regularly to collect sound speed data for the Reson 8101 
multibeam sonars on survey launches 1010 and 1018 and used on an as needed basis for the Fairweather’s Reson 
8111 and 8160 multibeam systems.  The Brooke Ocean Technology Moving Vessel Profiler (MVP) is primarily 
used to collect sound velocity data for sound speed correction of data acquired with Fairweather’s Reson 8111 
and 8160 multibeam systems. 
 
Daily sound speed profiles from the SBE 19plus are processed with Velocwin and concatenated into single .svp 
files for each vessel per survey.  Individual .svp files and the concatenated vessel files for the survey are submitted 
with each survey.    
 
Sound speed profiles acquired using the Brooke Ocean Technology Moving Vessel Profiler 200 (MVP) are stored 
in files labeled .001, .001c, .001d, and .001e (collectively called BOT files) where the number increments by one 
with each subsequent cast. The .00#c file for each cast was opened with Velocwin and converted into CARIS .svp 
file format.  The individual .svp profiles were concatenated into vessel specific .svp files for the entire survey. 
Individual sound velocity profile files taken by the MVP will not be submitted due to the large number of casts 
acquired; however, the daily concatenated files are submitted for backup purposes.   
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The concatenated sound velocity files were applied to multibeam data in CARIS HIPS during data processing.  
CARIS HIPS uses one of four different algorithms to automatically apply a sound velocity profile stored in a 
concatenated sound velocity file.  They are: “previous in time,” “nearest in time,” “nearest in distance” and 
“nearest in distance within time.”  In general, “previous in time” is the method used for applying sound velocity 
information in HIPS for launch data and “nearest in distance within time” is used for ship data, although the other 
methods may be used in certain situations.  The method of applying sound velocity is included in the processing 
logs that are submitted with each survey. 
 
7.0 Water Level 
 
The vertical datum for projects conducted is Mean Lower-Low Water (MLLW).  Predicted, observed, and/or 
verified water level correctors from the primary tide station(s) listed in the project letter instructions may be 
downloaded from the CO-OPS website and used for water level corrections during the course of the project.  
These tide station files are collated to include the appropriate days of acquisition and then converted to CARIS .tid 
file format in MapInfo using HydroMI.   
 
Water level data in the .tid files are applied to data in CARIS HIPS using the zone definition file (.zdf) supplied 
by CO-OPS.   Upon receiving final approved water level data, all data are reduced to MLLW using the final 
approved water levels (smooth tides) as noted in the Descriptive Report included with the survey data. 
 
A complete description of vertical control utilized for a given project can be found in the project specific 
Horizontal and Vertical Control Report (HVCR), submitted for each project under separate cover when necessary 
as outlined in FPM section 5.2.3.2.3. 
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Field Unit: FAIRWEATER
Effective Date: April 23, 2008

Updated Through: October 30, 2008

Vessel Name FAIRWEATHER Launch 1010 Launch 1018 Ambar 700 Skiff FRB

Vessel Image

Hull Number S 220 1010 1018 2302 1706 2301

Call Letters WTEB

Manufacturer Aerojet-General Shipyards
Jacksonville, FL Jensen Jensen Marine Silverships, Inc MonArk Zodiak of North America

Year of Construction 1967 1973 1973 1998 2004

Type of Construction Welded steel hull -
 ice strengthened Aluminum hull Aluminum Hull RHIB Aluminum Hull RHIB

Length Overall 70.4 m (231 ft) 8.8 m (28ft 10in) 8.8 m (28ft 10in) 7.0 m (23 ft) 5.2 m (17 ft) 6.7 m (22 ft)

Beam 12.8 m (42 ft) 3.3 m (10ft 8in) 3.3 m (10ft 8in) 2.9 m (9ft 4in) 2.3 m (7ft 2in) 2.6 m (8ft 6in)

Draft 4.7 m (15ft 6in) 1.2 m (4 ft) 1.2 m (4 ft) 0.4 m (17 in) 0.4 m (1ft 3in) 0.6 m (22 in)

Date of Effective Full Vessel 
Static Offset Survey

Origninal Survey 9/2003    
POS/MV Offsets Surveyed 

2/2007
2004 2004

Organization which Conducted 
the Effective Full Offset Survey

Original Survey -  Westlake 
Consultants              

POS/MV Survey - NGS

NOAA Personnel           
(Wetzler, Sampadian, 

Froelich)

NOAA Personnel           
(Wetzler, Sampadian, 

Froelich)
Date of Last Partial Survey or 
Offset Verification & Methods 
Used

n/a April-2008                
Steel Tape

April-2008                
Steel Tape

Date of Last Static Draft 
Determination & Method Used

April-2007 Draft Marks     
October-2008 DLDG & 

Leadline

April-2007
Waterline to Benchmarks

April-2008
Waterline to Benchmarks

Date of Last Settlement and 
Squat Measurements & Method 
Used

April-2008, October-2008, 
used April-2006

Echosounder (DDSSM)

June-2008
Echosounder Method 

(DDSSM)

June-2008
Echosounder Method 

(DDSSM)

SURVEY VESSELS

Hydrographic Vessel Inventory



Field Unit:

Effective Date:

Updated Through:

Equipment Type Manufacturer Model Serial Number Firmware and/or 
Software Version

Version Install 
Date Location Date of last 

Calibration
Date of last 

Service Additional Information

Processor Odom Hydrographic Echotrac CVM 26034 Version: 4.01 May-08 2302/1706 N/A New unit may 2008

Transducer (2) Odom Hydrographic SMBB200-4A TR5162/TR5159 N/A N/A 2302/1706 N/A N/A Two 4 degree (large)

Transducer (2) Odom Hydrographic SMBB200_9 TR5138/TR5139 N/A N/A 2302/1706 N/A N/A Two 9 degree (small)

Processor Reson 81-P (8111) 35652 N/A May-04 S220 N/A Bar Code : CD0001065312

Processor Reson 81-P (8160) 35385 N/A May-04 S220 N/A Bar Code : CD0001065313

Transducer Reson 8111ER unknown Dry: 8111-E209-6114      
Wet: 8111-E101-AFAA Apr-04 S220 4/20/2006

Transducer Reson 8160 unknown Dry: 8160-2.09-7C6D      
Wet: 8160-1.00-E9E1 Apr-04 S220 incomplete

Processor Reson 81-P 34497 N/A Jul-04 1010 N/A Bar Code : CD0001065351

Transducer Reson 8101 ER 2701011 Dry: 8101-2.09-E34D      
Wet: 8101-1.08-C215 Jul-04 1010 4/10/2006

Processor Reson 81-P 35737 N/A Jul-04 1018 N/A Bar Code : CD0001065349

Transducer Reson 8101 ER 3102026 Dry: 8101-2.09-E34D      
Wet: 8101-1.08-C215 Jul-04 1018 incomplete

Lead Line FA Personnel Traditional 10_01_04 N/A N/A any 6/11/2008

Lead Line FA Personnel Traditional 10_01_05 N/A N/A any 6/11/2008

Lead Line FA Personnel Traditional 10_02_05 N/A N/A any 6/11/2008

Lead Line FA Personnel Traditional 20_01_05 N/A N/A any 6/11/2008

Lead Line FA Personnel Traditional 20_02_05 N/A N/A Ambar 5/30/2008

Lead Line FA Personnel Traditional 20_03_05 N/A N/A any 3/26/2007

Lead Line FA Personnel Traditional 30_01_05 N/A N/A any 4/9/2007

Lead Line FA Personnel V-100/Non-Traditional pending N/A N/A any incomplete work in progress

Lead Line FA Personnel V-100/Non-Traditional pending N/A N/A any incomplete work in progress

Divers Least Depth Gauge PTC MODIII 68322 N/A N/A S220 4/2/2008 4/2/2008

Odom Echotrac CVM Odom Hydrographic ETCVM-A 26034 ET-CVM COM Ver 3.29    
DSPDual Ver 3.28 any Bar Code: CD0001703210, ChartView 

Dongle (100.001.001.098)

Hydrographic Hardware Inventory
FAIRWEATHER

4/23/2008

10/15/2008
SONAR & SOUNDING EQUIPMENT



Equipment Type Manufacturer Model Serial Number Firmware and/or 
Software Version

Version Install 
Date Location Date of last 

Calibration
Date of last 

Service Additional Information

POS/MV PCS Applanix 320 V.4 2411 HW2.9-7, SW03.42        
POS Cntrlr v. 3.4.0.0 Jun-08 S220             

IP:129.100.1.231 4/24/2008 Bar Code : CD0001697462  
Auth. No. 811025-00534537 

POS/MV IMU Applanix LN200 292 N/A Apr-04 S220 Bar Code : CD0001696450

POS/MV Port Ant. Applanix OEM2 3151R BD950 SN:4611A66708 
v.00211 HW1 Apr-04 S220

POS/MV Stbd Ant. Applanix OEM2 3151R BD950 SN:4602A62806 
v.00211 HW1 Apr-04 S220

DGPS Receiver CSI Wireless MBX-3S 0426- 16627- 0001 N/A Jul-04 S220

DGPS Antenna CSI Wireless MGL3 N/A Apr-04 S220

POS/MV PCS Applanix 320 V.4 2564 HW 2.6-7, SW 03.42       
POS Cntrlr v. 3.4.0.0 Jun-08 1010              

IP:129.100.1.231 6/9/2008 1/15/2008 Bar Code : CD0001601275

POS/MV IMU Applanix LN200 294 N/A Jul-04 1010 Bar Code : CD0001696449

POS/MV Port Ant. Applanix OEM2 3151R S/N 60162863 HW1 Mar-07 1010

POS/MV Stbd Ant. Applanix OEM2 3151R S/N 60145247 HW1 Mar-07 1010

DGPS Receiver CSI Wireless MBX-3S 0331-12579-0008 N/A Jul-04 1010

DGPS Antenna CSI Wireless MGL3 0331-12579-0009 N/A Jul-04 1010

POS/MV PCS Applanix 320 V.4 2560 HW 2.6-7, SW 03.42       
POS Cntrlr v. 3.4.0.0 Jun-08 1018              

IP:129.100.1.231 8/13/2008 1/15/2008 Bar Code : CD0001601274

POS/MV IMU Applanix LN200 007 N/A Feb-07 1018 Bar Code : CD0000832907

POS/MV Port Ant. Trimble 39105-00 DC 4618 S/N 60145158 N/A Feb-07 1018

POS/MV Stbd Ant. Trimbe 39105-00 DC 4604 S/N 60130644 N/A Feb-07 1018

DGPS Receiver CSI Wireless MBX-3S 0328-12362-0001 N/A Jul-04 1018

DGPS Antenna CSI Wireless MGL3 0328-12352-0002 N/A Jul-04 1018

StarFire Receiver NavCom SF-2050R Unknown Jul-08 S220 September-08 CD0001697402

Trimble Backpack 1 Trimble Pathfinder Pro XRS 0224078543 Firmware v1.96 RevA 8-Mar S220 Bar Code: CD0001269835

Trimble Backpack 1: Antenna Trimble 33580-50 0220341062 N/A N/A S220 no Bar Code

Trimble Backpack 2 Trimble Pathfinder Pro XRS 0224090101 Firmware v1.96 RevA 8-Mar S220 Bar Code: CD0001269836

Trimble Backpack 2: Antenna Trimble 33580-50 0220321059 N/A N/A S220 no Bar Code

Handheld data collector Trimble TSCe 37318 N/A N/A S220 no Bar Code , PN 45268-50

Laser Laser Tech Inc. Impulse Laser Rangefinder i09290 N/A N/A S220 Bar Code: CD0001269812

Laser Laser Tech Inc. TruPulse 200 Laser 
Rangefinder 001481 N/A N/A S220 no Bar Code

Laser Laser Tech Inc. TruPulse 200 Laser 
Rangefinder 000676 N/A N/A S220 no Bar Code

Antenna cable Trimble P/N22628 S220

Camcorder Batteries Trimble P/N17466 S220

NMEA/RTCM cable Trimble P/N30232-00 S220

data/power cable Trimble P/N30231-00                             S220

dual battery cable Trimble  P/N24333 S220

GPS Pathfinder field device
cable Trimble P/N45052 S220

POSITIONING & ATTITUDE EQUIPMENT



Equipment Type Manufacturer Model Serial Number Firmware and/or 
Software Version

Version Install 
Date Location Date of last 

Calibration
Date of last 

Service Additional Information

Moving Vessel Profiler winch Brooke Ocean Technology 
Inc. MVP-200-5 10328 S220

Moving Vessel Profiler fish Brooke Ocean Technology 
Inc. MVP-FFF-SS-32-1 10478 S220

Moving Vessel Profiler fish Brooke Ocean Technology 
Inc. MVP-FFF-SS-32-1 10329 S220

Moving Vessel Profiler 
sensor

Brooke Ocean Technology 
Inc. Smart SV +P 5229 S220 8/2/2008 8/2/2008

Moving Vessel Profiler 
sensor

Brooke Ocean Technology 
Inc. AML SV +P 4986 S220 1/13/2006 1/13/2006

SEACAT Profiler Sea-Bird SBE 19plus 19P36026-4585 1.4D S220 12/12/2007 12/12/2007 CON files: 4585.con

SEACAT Profiler Sea-Bird SBE 19plus 19P36026-4617 1.4D 1010 or 1018 12/13/2007 12/13/2007 CON files: 4617.con

SEACAT Profiler Sea-Bird SBE 19plus 19P36026-4616 1.4D 1010 or 1018 12/13/2007 12/13/2007 CON files: 4616.con

Micro Thermosalinograph Sea-Bird SBE 45 (TSG) 4536628-0117 N/A N/A S220 1/8/2008 1/9/2008 P/N 4536628

Equipment Type Manufacturer Model Serial Number Firmware and/or 
Software Version

Version Install 
Date Location Date of last 

Calibration
Date of last 

Service Additional Information

Level Carl Zeiss N12 333 100056 N/A N/A S220  March 2008  March 2008

Level Carl Zeiss N12 333 103567 N/A N/A S220  March 2008  March 2008

Level Leica NA2 100 5332739 N/A N/A S220 Spare

Level Lecia NA2 100 5332747 N/A N/A S220 Spare

SOUND SPEED MEASUREMENT EQUIPMENT

TIDES & LEVELING EQUIPMENT



Equipment Type Manufacturer Model Serial Number Firmware and/or 
Software Version

Version Install 
Date Location Date of last 

Calibration
Date of last 

Service Additional Information

Reciever Magellan Z-Max.Net 200709006 MD00 S220 8/19/2008

GPS Antenna Thales Navigation 20071410861 N/A N/A S220 8/19/2008

Receiver Ashtech Z-Xtreme ZE1200339016  ZE21 Mar-08 S220 3/20/2007 obtained April 2004 Bar Code: CD0001062363

GPS Antenna Ashtech Geodetic 4 8365 N/A N/A S220 3/20/2007 obtained April 2004

Position Data Link High
Powered Base Unit Pacific Crest PDL 4135 0424 0171 2.40 Apr-04 S220 5/3/2007 obtained April 2004 Bar Code: CD0001269910

Position Data Link Rover Pacific Crest PDL 4100 04240154 2.4 Apr-04 S220 5/3/2007 obtained April 2004

Position Data Link Rover Pacific Crest PDL 4100 03473047 2.32 Apr-04 S220 5/3/2007 obtained April 2004

Position Data Link Rover Pacific Crest PDL 4100 04240155 2.4 Apr-04 S220 5/3/2007 obtained April 2004

Marine Deep Cycle Battery Magnatron S220 purchased July 2004

Solar Panel Uni-Solar FLX-32 USF-32-14639 N/A N/A S220 no Bar Code

Solar Panel Uni-Solar FLX-32 USF-32-14634 N/A N/A S220 no Bar Code

Solar Panel Uni-Solar FLX-32 USF-32-14633 N/A N/A S220 no Bar Code

Solar Panel Uni-Solar FLX-32 USF-32-14529 N/A N/A S220 no Bar Code

Solar Panel Uni-Solar FLX-32 USF-32-14631 N/A N/A S220 no Bar Code

Solar Panel Uni-Solar FLX-32 USF-32-14625 N/A N/A S220 no Bar Code

Solar Panel Uni-Solar FLX-32 USF-32-14645 N/A N/A S220 no Bar Code

Solutions Dongles Ashtech 600586 (A) KEB2083 N/A N/A S220

Solutions Dongles Ashtech 600586 (A) KEB2077 N/A N/A S220

GPS Receiver Trimble DSM-232 22511661 3.57 Mar-08 S220 Bar Code: CDCD0001697434

GPS Receiver Trimble DSM-232RS 225111655 3.57 Mar-08 S220 Bar Code: CDCD0001697422, 
DGPS Reference Station

DGPS Antenna Trimble 33580-00 220395038 N/A N/A S220

GPS Antenna Trimble Geodetic Reference Station 
Antenna 30325441 N/A N/A S220

Equipment Type Manufacturer Model Serial Number Firmware and/or 
Software Version

Version Install 
Date Location Date of last 

Calibration
Date of last 

Service Additional Information

Penetrometer Brooke Ocean Technology 
Inc. FFCPT-35-2 10416 S220

Penetrometer sensor Brooke Ocean Technology 
Inc. AML SV +P 191-3 S220

HORIZONTAL AND VERTICAL CONTROL EQUIPMENT

OTHER EQUIPMENT
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New DELL deskptop installed week of 12/4/07

Machine Name

FA_Proc_1 Plot Room DELL Precision 490 XP Pro 2002 SP2 Nov-07 2.66 GHz 3GB 2 256 MB 9MP1PD1 CD0001615385

Plot Room DELL Precision 490 XP Pro 2002 SP2 Nov-07 2.66 GHz 3GB 2 256 MB 4NP1PD1 CD0001615382

Plot Room DELL Precision 490 XP Pro 2002 SP2 Nov-07 2.66 GHz 3GB 2 256 MB 6MP1PD1 CD0001615383

Plot Room DELL Precision 490 XP Pro 2002 SP2 Nov-07 2.66 GHz 3GB 2 256 MB 2NP1PD1 CD0001615380

Plot Room DELL Precision 490 XP Pro 2002 SP2 Nov-07 2.66 GHz 3GB 2 256 MB 3MP1PD1 CD0001615381

Plot Room Dell Precision T3400 XP Pro 2002 SP2 Apr-08 3.0GHz 3GB 2 512MB 1JKCZF1 CD0001615471

Plot Room DELL Precision 490 XP Pro 2002 SP2 Nov-07 2.66 GHz 3GB 2 256 MB 8MP1PD1 CD0001615384

Plot Room Dell Precision T3400 XP Pro 2002 SP2 Apr-08 3.0GHz 3GB 2 512MB 5JKCZF1 CD0001615467

Plot Room Dell Precision T3400 XP Pro 2002 SP2 Apr-08 3.0GHz 3GB 2 512MB 3JKCZF1 CD0001615472

DP-2 Dell Precision T3400 XP Pro 2002 SP2 Apr-08 3.0GHz 3GB 2 512MB JHKCZF1 CD0001615468

Field Office Dell Precision T3400 XP Pro 2002 SP2 Apr-08 3.0GHz 3GB 2 512MB 4JKCZF1 CD0001615469

Field Office Dell Precision T3400 XP Pro 2002 SP2 Apr-08 3.0GHz 3GB 2 512MB DHKCZF1 CD0001615470

O-LAB Dell Prcision 360 XP Pro 2002 SP2 3.0GHz 3.5GB 2 128MB GBBG451 CD0001741480

Laptop DELL Inspiron 1100 XP Pro 2002 SP2 ~ March 2004 ~ September 2005 2.4 GHz 2.5 GB 2.5 GB 1 64 MB HGHWM41 CD0001272964

Laptop DELL Inspiron 1101 XP Pro 2002 SP2 ~ March 2004 ~ September 2005 2.4 GHz 2.5 GB 2.5 GB 1 64 MB GGHWM41 CD0001272965

Laptop Panasonic   CF-18 XP Pro 2002 SP2 ~ March 2004 ~ July 2006 1.1 GHz 2.5 GB N/A 1 64 MB 4HKSA59499 CD0001269860

Laptop Panasonic  CF-18 XP Pro 2002 SP2 ~ March 2004 ~ September 2005 1.1 GHz 2.5 GB N/A 1 64 MB 4HKSA59560 CD0001269858

Laptop Panasonic  CF-29 XP Pro 2002 SP2 March 2006 N/A 1.6 GHz 2.5 GB N/A 1 128 MB 6AKSB06863 CD0001698251

Laptop . XP Pro 2002 SP2 ~ March 2004 ~ September 2005 1.1 GHz 2.5 GB N/A 1 64 MB 4GKSA55049 CD0001269589

Launch 1010 ICI XP Pro 2002 SP2 Mar-08 2.66GHz 3GB 3 128MB CD0001615466

Launch 1018 ICI XP Pro 2002 SP2 Mar-08 2.66GHz 3GB 3 128MB CD0001615463

Plot Room Dell Precision T3400 XP Pro 2002 SP2 Mar-08 3.0GHz 3GB 3 512MB CSH8NF1 CD0001615444

Plot Room MVP-C1-2001 2000 SP4 ~ March 2004 ~ September 2005 2.4 GHz 230 MB 230 MB 1 64 MB SN: 10330 CD0001269854

Toughbook 1

Toughbook 2

Toughtab 1

Toughbook 3

*rebuilt after crash July 2006

New DELL deskptop installed week of 04/14/08

New DELL deskptop installed week of 04/06/08

New DELL deskptop installed week of 04/06/08

New DELL deskptop installed week of 04/06/08

New DELL deskptop installed week of 04/06/08

New DELL deskptop installed week of 12/4/07

New DELL deskptop installed week of 12/4/07FA_Proc_5

FA_Proc_6

FA_Proc_7*

FA_Proc_3 New DELL deskptop installed week of 12/4/07

New DELL deskptop installed week of 12/4/07

New DELL deskptop installed week of 04/06/08

FA_Proc_4

FA_O-LAB*

FA_FOO

FA_CST

FA_Proc_8

FA_Proc_9

FA_Proc_10

FA_Mobile1

S220_ACQ

FA_MVP200

FA_Mobile2

1010_ACQ

1018_ACQ

New DELL deskptop installed week of 12/4/07

New DELL deskptop installed week of 12/4/07

FA_Proc_1

FA_Proc_2



Field Unit:  
Effective Date: 

Updated Through: Jan-92

Name and Grade Current Position Years of Hydro Experience 
(calculated) Hydro Experience Since Notes

CDR Doug Baird Commanding Officer 15 year(s) + 9 month(s) January-93
LCDR Richard Brennan Executive Officer 16 year(s) + 6 month(s) April-92
Eric Heiner Third Mate 9 year(s) + 6 month(s) April-99
LT Matt Ringel Field Operations Officer 6 year(s) + 2 month(s) August-02
ENS Llian Breen Junior Officer 1 year(s) + 10 month(s) December-06 departed ship Aug 30, 2008
ENS Nick Morgan Junior Officer 1 year(s) + 10 month(s) December-06
ENS Mark Andrews Junior Officer 1 year(s) + 3 month(s) July-07
ENS Glen Rice Junior Officer 1 year(s) + 3 month(s) July-07
ENS Patricia Raymond Junior Officer 0 year(s) + 4 month(s) June-08
ENS Matt Forney Junior Officer 0 year(s) + 4 month(s) June-08

Name and Rate Current Position Years of Hydro Experience Hydro Experience Since Notes
Lynnette Morgan Chief Survey Technician 8 year(s) + 9 month(s) January-00
Brenna Campbell Survey Technician 2 year(s) + 1 month(s) September-06
Adam Argento Survey Technician 1 year(s) + 7 month(s) March-07
Megan Bucher Survey Technician 1 year(s) + 1 month(s) September-07
Weston Renoud Assistant Survey Tech 0 year(s) + 5 month(s) May-08
Tami Beduhn Assistant Survey Tech 0 year(s) + 2 month(s) August-08

Name and Rate Current Position Years of Hydro Experience Deck Experience Since Notes
Garry Guice Chief Boatswain N/A April-82
Ron Walker BGL N/A June-84
Emily Evans SS N/A January-06 departed ship Sept 25, 2008
Chris Marcum GVA N/A August-07
Clarisse Osegueda AB N/A May-08

DECK DEPARTMENT (involved in survey work)

SURVEY DEPARTMENT

OFFICERS

Hydrographic Personnel Roster
FAIRWEATHER S-220
3/27/2008
10/28/2008

Page 1 of 1



Appendix II 
 
 
Equipment Specifications 
 

1. Sonar Systems 
a. RESON 

i. 8101 Equipment Specs 
ii. 8111 Equipment Specs 
iii. 8160 Equipment Specs 

b. VBES 
i. Odom Echotrac CVM 
ii. SMBB200-9 Transducer Information 
iii. SMSW200-4a Transducer Information 

2. Positioning 
a. POS MV 

i. v320 
b. DGPS 

i. MBX-3S 
ii. SF-2050 

3. Shoreline 
a. Trimble 

i. Accuracy 
ii. Specs 
iii. TSCe 

b. Lasers 
i. TruPulse 200 
ii. Impulse 200 LR 

4. SV 
a. MVP 

i. MVP 200 
b. SBE 

i. SBE 45 
ii. Specs-19p-4585 
iii. Specs-19p-4616 
iv. Specs-19p-4617 

5. Control 
a. Leveling 

i. Leica NA2 level 
ii. Zeiss NI2 level 

b. HorCon 
i. PDL 
ii. Z-Max 
iii. Z-Xtreme Ashtech GPS 

6. Total Stations 
a. Nikon DTM310  
b. Sokkia set5f 



!! Phase and Amplitude
Bottom Detection

!! 150EE Wide Swath
Coverage

!! 240 kHz Frequency

!! Up to 500m Range
Capability

!! Portable
Configuration

!! Meets USACE Class 1
Standards

!! Meets IHO Standards

The SeaBat 8101 Multibeam Echo Sounder measures discrete depths, enabling
complex underwater features to be mapped with precision.  Dense coverage is
achieved utilizing up to 3,000 soundings per second for a swath that can be over
500 meters wide, even as the survey vessel travels at speeds of over 18 knots.

With high accuracy and a measurement rate up to 30 profiles per second, the
SeaBat 8101 enables surveys to be completed faster and in greater detail than
previously realized.  The SeaBat is an integral part of the new, integrated
bathymetry surveying systems.

The SeaBat transducer is available pressurized for depths from 100 to over 3,000
meters.  Small and lightweight, it can be can be mounted on small underwater
vehicles (ROV, AUV or towed) and taken to where accurate measurements are
required.

SeaBat 8101
PRODUCT SPECIFICATION

240kHz MULTIBEAM ECHO SOUNDER



©1999 RESON Inc.
Version 4.0  Due to our policy of continuous product improvement,
032399 specifications are subject to change without notice.

SeaBat 8101 Head
with Optional Fairings

SeaBat 8101 Built-In Test
Environment (“BITE”) Screen

SYSTEM SPECIFICATIONS

Operating Frequency: 240kHz
Range Scales: 5, 10, 15, 20, 25, 35, 50, 75, 100, 125,

150, 175, 200, 250, 300, 350, 400, 450,
500m. 

Range Resolution: 1.25 cm
Number of Beams: 101

Horizontal Beamwidth: 1.5E
Horizontal Coverage: 150E
Vertical Beamwidth: 1.5E

Update Rate: Range-variable up to
30 times per second

SONAR HEAD SPECIFICATIONS

Power Requirement: 24VDC, 2 Amps max.
(Power available from
surface processor.)

Uplink: Digital, 76.8 Mbaud
Down Link Control: RS-232 or RS-422, 19,200 baud

Operating Depth: 100 meters
(300m, 1500m, 3000m & 6000m avbl.)

Dimensions: 266x320mm W/Diam 
(does not include projector)

Temperature: Operating: -5E to +40EC
Storage: -30E to +55EC

Weight (aluminum): Dry: 26.8 kg (59 lbs)
Wet: 4.8 kg (10.6 lbs)

Weight (titanium): Dry: 40 kg (88 lbs)
Wet: 18 kg (39.6 lbs)

DISPLAY SPECIFICATIONS

Screen Size: 14 inch Diagonal 
Input: SVGA (800x600, 72 Hz)

Display: High Resolution Color
Power Consumption: 62 W

PROCESSOR SPECIFICATIONS

Power Requirements: 115/230VAC, 50/60Hz,
100W max.

Data Output: Selectable, 300-155.2 Kbaud
or Ethernet 10 base T
or 10 base 2

Video Output: SVGA (800x600, 72 Hz)
or NTSC or PAL video.

Graphics Colors: 256 colors (8-bit)
Display Mode: Sector Format

Display Arc: 150E
Input Device: 3-Button Trackball
Dimensions: 19" rack, 4U high

(266x483x434mm HWD)
Temperature: Operating: 0E to +40EC

Storage: -30E to +55EC
Weight: 20 kg (44 lbs)

OPTIONS

Option 033: Side Scan Upgrade
Option 034: Mounting Plate Assembly
Option 035: Fairings (pictured above)
Option 036: Spares Kit
Option 037: Titanium Housing
Option 038: 210° Swath
Option 040: Extended-Range Projector
Option 049: Increase Transducer Depth 

Rating



SeaBat 8111
PRODUCT SPECIFICATION

MULTIBEAM ECHOSOUNDER

•• Phase and amplitude
bottom detection

•• 100 kHz frequency

•• 150° swath coverage

•• Real-time quality
control

•• Sidescan upgradeable

•• Modular and portable

•• Pitch stabilization

The SeaBat 8111 is a modular multibeam echosounder system operating at
100 kHz. When installed on a vessel, it produces high-density, high-accuracy
soundings on the seafloor over a 150° swath. Major system components
include a transducer array, a transceiver unit, and a processor unit.

The SeaBat 8111 transducer array is comprised of a cylindrical receive array
and a linear transmitter array, mounted together on a support cradle that
provides mounting points to the vessel. Lightweight and portable, the array
can be installed temporarily over the side of a vessel of opportunity––a first for
a system in this frequency range.

The SeaBat 8111 transceiver features plug-in cards for easy maintenance and
is controlled from the sonar processor.

The Seabat 8111 processor is compatible with other SeaBat sonar heads, can
be updated in minutes to accommodate future requirements, and features a
user-friendly point-and-click interface.



MECHANICAL INTERFACE

Dimensions (in mm):
Transducer Array:

Hydrophone: 636 x 118 (Dia./Length)
Projector: 113 x 650 (Dia./Length)

Processor: 177 x 483 x 417
Transceiver: 267 x 483 x 489

Weight:
Transducer Array: 72 kg (dry) / 59 kg (wet)

with cables
Processor: 20 kg
Transceiver: 13.6 kg

Cable Length: 15m

SEAFLOOR COVERAGE
(with Extended Range option)

SeaBat 8111 SYSTEM SPECIFICATIONS

Version: B006 030205
©1999 RESON Inc.

Due to our policy of continuous product improvement,
RESON reserves the right change specifications without notice.

Transceiver
Processor

Transducer Array

636 OD

650118

113

Hydrophone Projector

SYSTEM PERFORMANCE

Frequency: 100 kHz

Range Resolution: 3.7 cm

Swath Coverage: 150º

Range: 3m to 1200m
(with Option 040)

Number of Beams: 101

Along-Track Beamwidth: 1.5º 3.0º 4.5º 6.0º*
Across-Track Beamwidth: 1.5º

Stabilization: Pitch stabilization 
within +/-15º

Projector Beam Control: External motion
sensor required

Accuracy: IHO Compliant

Operational Speed: Up to 20 knots

Max. Update Rate: 35 Hz

Transducer Pressure Rating: 100m

*operator selectable

INTERFACE

System Supply: 90 to 260VAC, 50/60 Hz,
200W max.

Video Display: SVGA, 800 x 600, 72 Hz

System Control: Trackball or from Ethernet

Data Output: 10 MB Ethernet or
serial RS232C

Data Uplink: High-speed digital coax
with fiber-optic option

Temperature: Operating: 0° to +40° C
Storage: -30° to +55° C

RELATED PRODUCTS
• Option 040 Extended range capabilities
• Option 033 Sidescan upgrade
• Option 051 24DC power supply for SeaBat

81-P Processor

Bottom Depth (meters) Swath Width (meters)
5 to 150 Up to 1110 (7.4 x water depth)

300 960 (3.2 x water depth)
450 810 (1.8 x water depth)
600 600 (1.0 x water depth)
750 450 (0.6 x water depth)
900 360 (0.4 x water depth)



SeaBat 8160
PRODUCT SPECIFICATION
MULTIBEAM ECHOSOUNDER SYSTEM

•• Swath coverage
greater than 4x
water depth

•• Operational depth:
10m to 3000m

•• 50 kHz frequency

•• 126 beams

•• Hull-mount or
portable

•• Meets IHO
accuracy

•• Sidescan
upgradable

The SeaBat 8160 is a new addition to the 8100 series of multibeam
echosounders. Operating at 50 kHz, the system ensonifies the whole
swath in a single ping, generating 126 simultaneous high-resolution
receive beams.

The SeaBat 8160 transducer array is comprised of a linear receive and
transmit array mounted together on a support base. The T-shaped array
geometry provides the basis for a compact, high-resolution sonar which
is easily installed for portable or hull mounts––a first for a high-resolution
system in this frequency range.

The system features a pitch-stabilized transmitter and an active roll-
compensated receiver.

The SeaBat 8160 processor is compatible with other SeaBat sonar heads.
It can be updated in minutes to accommodate future requirements, and
features a user-friendly point-and-click interface.

RESON, INC. • USA
Tel +1 805 964 6260
Fax +1 805 964 7537
Email: sales@reson.com

RESON A/S •  DENMARK
Tel +45 47 38 00 22
Fax +45 47 38 00 66
Email: reson@reson.dk
RESON OFFSHORE •  UK
Tel +44 1224 709 900
Fax +44 1224 709 910
Email: sales@reson.co.uk

w w w. r e s o n . c o m

RESON, GmbH • GERMANY
Tel +49 431 720 7180
Fax +49 431 720 7181
Email: reson@reson-gmbh.de



SYSTEM PERFORMANCE

Frequency: 50 kHz

Depth Resolution: 2.4 cm / 9.6 cm

Swath Coverage: Greater than 4x 
water depth

Max Operational Depth: 3000 m

Number of Beams: 126

Along-Track Beamwidth: 1.5º

Across-Track Beamwidth: 1.5º

Pitch Stabilization: ±10º

Accuracy: IHO Special Order

Operational Speed: Up to 20 knots

Max. Update Rate: 15

Transducer Depth Rating:

100m

INTERFACE

System Supply: 115V/230V 50/60 Hz,
350W

Video Display: SVGA, 800 x 600, 72 Hz

System Control: Trackball or from
Ethernet

Data Output: 10 MB Ethernet or
serial RS232C

Data Uplink: High-speed digital coax
with fiber-optic option

Temperature: Operating: 0° to +40° C
Storage: -30° to +55° C

MECHANICAL INTERFACE

Dimensions (HWD in mm):
Transducer Array: 1474.5 x 1100 x 90.5
Processor: 177 x 483 x 417
Transceiver: 265 x 483 x 492

Weight:

Transducer Array: 50 kg (dry) / 30 kg (wet)
Processor: 20 kg
Transceiver: 13.6 kg

SeaBat 8160 SYSTEM SPECIFICATIONS

Version: B34-PDF-011009
Due to our policy of continuous product improvement,

RESON reserves the right change specifications without notice.

1100mm

1350mm

124.5mm

150mm

90.5mm

Transceiver Processor

Transducer Array

Mounting Frame
Option 034H
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Performance Data 

Frequency 200kHz - BClq 
Beam Width 9° 
Q (transmit) 2.5 

Rated RMS Power 500 W 
Balanced Impedance 60 ohms 
Peak Figure of Merit -16 

Bandwidth  
Acoustic Window Material Urethane 

Threads ½” –14NPS 
Cable Type C33 (2-20 AWG) 
Cable Size 6mm 

Weight 1.3Kg. 

 
Broadband with superlow Q of 2.5.  Small housing with short stem 
used primarily for navigation and survey applications.  This model is 
usually mounted on an extension tube but is adaptable to portable 
survey and navigation systems.  It contains a transformer which can 
be used to match the impedance of the echosounder or allow the use 
of longer cables.  The transducer is available in either a bronze or 
stainless steel housing.  Model SS510 provides good definition in hard 
bottoms with side lobes. 

Odom Hydrographic Systems, Inc.
1450 Seaboard Avenue

Baton Rouge, LA. 70810 –6261
225.769.3051, Facsimile 225.766.5122
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Performance Data 

Frequency 200kHz 
Beam Width 4° 
Q (transmit)  

Rated RMS Power  
Balanced Impedance 60 ohms 
Peak Figure of Merit  

Bandwidth  
Acoustic Window Material Urethane 

Threads    ¾” –14NPS 
Cable Type C37 (2-20 AWG) 
Cable Size 6mm 

Weight 1.3Kg. 

 
The compact stainless steel housing is easily adapted to portable or hull 
mounted applications.  This unit is primarily used for shallow and mid-depth 
survey applications where delineation of steep slopes and sounding in very 
shallow water are important features. It contains a transformer that matches 
the impedance of the transducer to that of the echo sounder and allows for 
the use of longer cables without affecting performance.   
 

Odom Hydrographic Systems, Inc.
1450 Seaboard Avenue

Baton Rouge, LA. 70810 –6261
225.769.3051, Facsimile 225.766.5122



The new POS MV V4 - a tightly-coupled system utilizing 
advanced Inertially-Aided Real-Time Kinematic (IARTK) 
technology designed to increase your operational capability 
and reduce downtime.

Tightly integrated inertial navigation – Continuous positioning 
data can be generated while surveying in areas where GPS reception 
is compromised by multipath effect and signal loss, such as close to 
offshore structures, or in ports, harbors, near-shore coastal waters 
and rivers. Raw GPS data from as few as one satellite can now be 
processed directly within the POS MV reducing position drift and RTK 
re-acquisition time. 

The V4 Advantage 
The Major Benefi ts

• Faster, more robust heading aiding from GPS Azimuth 
Measurement Subsystem (GAMS) when compared to V3

• Proprietary Inertially Aided RTK providing almost 
instantaneous reacquisition of RTK following a GPS outage

• Superior low elevation tracking performance using lighter, 
smaller Trimble Zephyr ™ geodetic antenna technology

• Faster initial system calibration 
• Maintains heading accuracy longer when in a high multipath 

environment 
• Increased component reliability
• Automatic identifi cation and error estimation for lever arm 

distances and angles

The Latest Technology
V4 uses the latest Trimble BD950 receivers with the following 
attributes:

• Extremely fast response time
• Latency of less than 20 milliseconds (at 20 times per second) Latency of less than 20 milliseconds (at 20 times per second) 
• Very low noise L1 and L2 carrier phase Very low noise L1 and L2 carrier phase 

measurements
• Uses the Maxwell 4 Custom Survey 

GPS chip for enhanced tracking 
capability    

Straightforward Installation and Operation 
• All components mounted and installed using a straightforward, 

one-time-only, systematic procedure. 

Faster, More Reliable Networking Potential
• An improved Ethernet raw data logging capability for 

streamlined data acquisition of all motion variables with 
microsecond-accurate time stamping   

Upgradeability*
• Convenient upgrade program for PCS and antennas, to allow 

for maximum interoperability when moving from L1 only to a 
full L1/L2 RTK unit

The Most Accurate Position and Orientation Solution
POS MV V4 maintains positioning accuracy under the most demanding 
conditions regardless of vessel dynamics. With its high data update rate, 
the system delivers a full six degree-of-freedom position and orientation 
solution to provide the following:

• Position (latitude, longitude and elevation)
• Velocity (north, east and vertical)
• Attitude (roll, pitch and true heading)
• Heave (real-time, delayed)
• Acceleration Vectors
• Angular Rate Vectors

* For detailed upgrade information please call your Applanix Marine offi ce 

SYSTEM COMPONENTS
POS Computer System (PCS) – A rugged, compact computer system contains the 
core POS processor and IMU interface electronics, plus two GPS receivers and an optional 
removable PC-card disk drive. The PCS provides system timing, position and velocity aiding, 
together with GPS raw observables for use with GAMS.

POS Inertial Measurement Unit – The system’s primary sensor allows for the 
continuous output of position and orientation data. 

Primary GPS Receiver Antenna – A dual frequency antenna for use with GAMS.

Secondary GPS Receiver Antenna – A dual frequency antenna for use with GAMS.

Latency of less than 20 milliseconds (at 20 times per second) Latency of less than 20 milliseconds (at 20 times per second) 
Very low noise L1 and L2 carrier phase Very low noise L1 and L2 carrier phase 

DATASHEET
The New POS MV - Providing the Marine Industry with robust, reliable, and 
repeatable position and orientation solutions



SPECIFICATIONS
Accuracy

POS MV 320 Main Specifi cations (with Differential Corrections)

Roll, Pitch accuracy: 0.02° (1 sigma with GPS or DGPS)

0.01° (1 sigma with RTK) 

Heave Accuracy: 5 cm or 5% (whichever is greater) for periods of 20 
seconds or less

Heading Accuracy: 0.02° (1 sigma) with 2 m antenna baseline, 0.01 (1 
sigma) with 4 m baseline

Position Accuracy: 0.5 - 2 m (1 sigma) depending on quality of differential 
corrections

0.02 - 0.10 m (RTK) with input from auxiliary RTK or 
optional internal RTK receiver

Velocity Accuracy: 0.03 m/s horizontal

POS MV 320 during GPS Outages

Roll, Pitch accuracy: 0.02° (1 sigma) 

Heave accuracy: 5 cm or 5% (whichever is greater) for wave periods 
of 18s or less

Heading accuracy: Drift less than 1° per hour (negligible for outages < 
60s)

Position accuracy
degradation:

2.5 m (1 sigma) for 30 s outages
<6 m (1 sigma) for 60 s outages

POS MV 220 Main Specifi cations (with Differential Corrections)

Roll, Pitch accuracy: 0.05° (1 sigma with GPS or DGPS)

<0.05° (1 sigma with RTK) 

Heave Accuracy: 5 cm or 5% (whichever is greater) for periods of 20 
seconds or less

Heading Accuracy: 0.1° (1 sigma) with 2 m antenna baseline, 0.05° (1 
sigma) with 4 m baseline

Position Accuracy: 0.5 - 4 m (1 sigma) depending on quality of differential 
corrections

0.02 – 0.10 m (RTK) with input from auxiliary RTK or 
optional internal RTK receiver

Velocity Accuracy: 0.05 m/s horizontal DPGS, .03 m/s horizontal RTK

POS MV 220 during GPS Outages

Roll, Pitch accuracy: 0.05° (1 sigma) 

Heave accuracy: 5 cm or 5% (whichever is greater) for wave periods 
of 18s or less

Heading accuracy: Drift less than 3° per hour (negligible for outages < 
60s)

Position accuracy 
degradation:

2.5 m (1 sigma) for 30 s outages
<6 m (1 sigma) for 60 s outages

Physical Characteristics

Size

IMU: 204 mm X 204 mm 
X 168 mm

7.95 in X 7.95 in 
X 6.55 in

PCS: 432 mm X  89 mm 
X 356 mm 

17.00 in X3.50 in 
X 14.05 in

2.0U 19 in rack 
mount 

GPS Antenna (x2): 187 mm X 53 mm 7.4 in X 2.1 in

Weight

IMU: 3.5 kg 7.7 lb (international)

Processor: 5 kg 11.0 lb (international)

GPS Antenna: <0.5 kg <1.1 lb (international)

Power

Processor: 110/230 Vac, 50/60 Hz, auto-switching 80 Watt

IMU: Power provided by PCS

GPS Antennas: Power provided by PCS

Environmental

Temperature Range (Operating)

IMU: -40 °C to +60 °C -40 °F to +140 °F

Processor:    0 °C to +55 °C +32 °F to +131 °F

GPS Antenna: -40 °C to +70 °C -40 °F to +158 °F

Temperature Range (storage)

IMU: -40 °C to +60 °C -40 °F to +140 °F

Processor: -25 °C to +85 °C -13 °F to +185 °F

GPS Antenna: -50 °C to +70 °C -58 °F to +158 °F

Humidity
IMU: 10 - 80% RH, Ingress Protection of 65
Processor: 10 - 80% RH, non-condensing
GPS Antenna: 0 - 100% RH

Shock & Vibration (IMU)
Operating: 90 g, 6 ms terminal saw tooth

Non-Operating: 220 g, 5 ms half-sine

Applanix Marine Offi ces
Applanix Corporation

85 Leek Crescent
Richmond Hill, Ontario

Canada L4B-3B3 

Tel: +1 905-709-4600
Fax: +1 905-709-6027

Applanix LLC
17461 Village Green Drive

Houston, TX 
USA 77040

Tel: +1 713-896-9900
Fax: +1 713-896-9919

Applanix United Kingdom
Forester’s House, 

Old Racecourse, Oswestry 
SY10 7PW UK

Tel: +44 1691 659359
Fax: +44 1691 659299

 





MBX-3S
The most popular commercial-grade 
Coast Guard Beacon Receiver

www.csi-wireless.com

• Dual-channel Coast Guard beacon receiver

• Supplements GPS systems with free differential corrections,
enhancing accuracy

• Fast signal acquisition

• Wide input voltage range for a variety of power sources

• Low power consumption extends battery life 

• Automatic tuning mode for hands-free operation

• Integrated signal splitter outputs GPS signal from combined 
GPS /differential antennas

• Front-panel interface for easy configuration and status monitoring



Receiver Specifications 
Channels: 2 independent channels
Channel Spacing: 500 Hz
Frequency Range: 283.5 to 325.0 Hz
MSK Bit Rates: 50, 100, 200 bps 
Cold Start Time: <1 min
Warm Start Time: <2 seconds
Demodulation: Minimum shift keying
Sensitivity: 2.5 µV/m for 6 dB SNR
Dynamic Range: 100 dB
Frequency Offset: ±8 Hz (27 ppm)
Adjacent Channel Rejection: 61 dB fo ± 400 Hz
Correction Output Protocol: RTCM SC-104
Input Status Protocol: NMEA 0183

Communications 
Interface: RS-232C or RS-422
Baud Rates: 2400, 4800, 9600

Environmental Specifications
Operating Temperature: -30°C to +70°C
Storage Temperature: -40°C to +80°C
Humidity: 95% non-condensing
EMC: EN 60945

EN 50081-1
EN 50082-1
FCC: Part 15, sub-part J,
class A digital device

Power Specifications
Input Voltage Range: 9 to 40 VDC
Nominal Power: 2.5 W
Nominal Current: 210 mA
Antenna Voltage Output: 10 VDC (5 VDC optional)
Antenna Input Impedance: 50 Ω

Mechanical Specifications
Dimensions: 150 mm L x 125 mm W x 51 mm H

(5.9” L x 4.9” W x 2.0” H)
Weight: 0.64 kg (1.4 lb)
Display: 2-line x 16-character LCD
Keypad: 3-key switch membrane
Power Connector: 2-pin circular locking
Data Connector: DB9-S
Antenna Connector: BNC-S
Optional GPS Output Port: TNC-S

Operating Modes
MBX-3 Mode (Default): RTCM SC-104 correction and

NMEA status message output 
(Default Mode)

MBX-E Mode: RTCM SC-104 correction and 
NMEA status message output 
and GPS NMEA message 
input for position and satellite 
status display

NMEA 0183 I/O
• Receiver Automatic and Manual tune command
• Frequency and data rate query
• Receiver performance and operating status queries
• Automatic search almanac queries (proprietary)
• Baud rate selection command
• Receiver tune command
• Force cold start command (proprietary)
• Software upgrade command (proprietary)
• Configuration up-load command (proprietary)

Accessories
Antenna: Various
Power Cables: Various
Antenna Cables: Various
Data Cables: Various
CSI Beacon 
Command Center: MS Windows 95® beacon 

control software

Pin-out
RS, 232C (DB9 PIN#)

Pin 2 TXD,RTCM SC-104/Status Output
Pin 3 RXD, configuration input
Pin 5 Signal return 

RS-422 (DB9 PIN#)

Pin 1 TXD +, RTCM SC-104 / 
Status Output

Pin 2 TXD -, RTCM SC-104 / 
Status Output

Pin 4 RXD -, configuration input
Pin 5 Signal return
Pin 7 RXD +, configuration input

© Copyright September 2002, CSI Wireless Inc. All rights reserved. Specifications subject to change without notice.

CSI Wireless and the CSI Wireless logo are trademarks of CSI Wireless Inc. Made in Canada.

Warranty: Each CSI Wireless product is covered by a limited one-year warranty on parts and labor.

Avery label #05260 (laser print)
4110 - 9th Street SE • Calgary • AB • Canada • T2G 3C4

Phone (403) 259•3311 • Fax (403) 259•8866
Printed in Canada.

CSI Wireless Dealer  

The most popular commercial-grade DGPS Beacon ReceiverMBX-3S



NavCom’s SF-2050G and SF-2050M 
modular StarFire™ receivers provide instant
position information for decimeter-level 
position accuracy, anywhere in the world, 
anytime. Onboard memory, and a geodetic
quality antenna enable millimeter level 
accuracy from post-processing.

APPLICATIONS
The rugged and reliable SF-2050 series is
designed for productivity with minimal 
setup time. The SF-2050G is designed for
backpack GIS and mapping applications while
the SF-2050M is ideal for vehicle mounting 
to suit a wide variety of machine guidance and
control applications. The primary operating
mode uses the StarFire™ service, and offers
decimeter level accuracy for immediate results
in the field; great for navigation and relocation
of existing assets. The two onboard
WAAS/EGNOS channels provide free 
GPS corrections, which coupled with dual 
frequency measurements and NavCom’s
enhanced SBAS algorithm typically provides
half-meter real-time accuracy. Simply connect
your controller solution to the serial port and
receive NMEA format position information, 
or use a NavCom Partner controller solution
for additional configuration and monitoring
capabilities.

BENEFITS
The SF-2050 receivers use our NCT-2100D
GPS Engine, the fourth generation of the
Touchstone™ ASIC family, of which more 
than 25,000 are in use worldwide. This
incorporates our patented interference 
suppression and multi-path mitigation, up 
to 50Hz raw data rate, geodetic quality 
measurements, and up to 25Hz positioning.

The SF-2050 utilizes a compact tri-band 
antenna capable of receiving GPS and
StarFire signals. This antenna provides 
excellent phase center stability in a small,
robust, lightweight format.

Coupled with NavCom Technology’s StarFire
subscription service, the SF-2050 delivers 
10 cm position fixes without the use of a 
second receiver serving as a base station.
Add the RTK option to your SF-2050, and 
an external radio capable of receiving RTK
corrections from a Base station, and now your
SF-2050 is able to do RTK level surveys for
unsurpassed accuracy.

FLEXIBLE INTERFACE
The SF-2050 receivers are easily configured
by the provided Windows®-based utility 
program. For system integrators needing 
maximum flexibility, the receivers offer a binary
user interface that allows for complete 
command and control of the GPS and L-Band
Module, thus enabling customization of the
interface and receiver operation.  The sensor
can receive GPS corrections in NCT
(NavCom’s ultra compact binary format),
RTCM and CMR thus permitting optimum 
correction source usage with seamless 
position output.

FEATURES

• Fully integrated receiver in robust housing

• “All-in-view” tracking on 26 channels 
(12 L1/L2 GPS + 2 SBAS)

• Global decimeter level accuracy using 
StarFire™ corrections

• Fully automatic acquisition of StarFire 
broadcast corrections

• Two dedicated WAAS/EGNOS channels

• L1 & L2 full wavelength carrier
phase tracking

• C/A, P1 & P2 code tracking

• 64MB internal memory for 
data recording 

• User programmable measurement and 
navigation data rates

• Minimal data latency

• Superior interference suppression

• Patented multipath rejection

• Output format NMEA 0183 or 
NavCom binary format 

• CAN bus interface (SF-2050M Only)

• 1PPS Output (SF-2050M Only)

• Event Marker (SF-2050M Only)

• TruBlu™ Wireless Connectivity,
Bluetooth® compatible

UPGRADES

• Raw measurement data rates 
up to 50Hz 

• Positioning rates up to 25Hz

• RTK positioning rates up to 25Hz 
(external comm-link required)

• RTK Extend™ - RTK positioning  
during comm. outages
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A John Deere Company

Modular GPS 

and StarFire™

receiver provides

worldwide decimeter

level accuracy 

anywhere, anytime

20780 Madrona Avenue, Torrance, CA 90503 • tel: + 1 310.381.2000 • fax: + 1 310.381.2001 • sales@navcomtech.com
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5.67” (144mm)

8.18”
(207.8mm)

3.06”
(77.7mm)

GPS
Antenna
(TNC)

COM 1
(7 pin Lemo)

COM 2
(7 pin Lemo)

DC Power
(4 pin Lemo)

Event Marker/Can
Bus (5 pin Lemo)

1PPS
(BNC)

Back Panel SF-2050M Only

Technical specifications are subject to change at NavCom’s discretion.
NCT-SF-2050/060119-6

PHYSICAL/ENVIRONMENTAL
• Size (L x W x H): ..............................8.18in x 5.67in x 3.06in

(208mm x 144mm x 78mm)

• Weight: ............................................................4lbs (1.81 kg)

• External Power:
Input Voltage: ........................................10 VDC to 30 VDC
Consumption: ..............................................................< 8 W

• Connectors:
I/O: ................................................................2 x 7 pin Lemo 
DC Power: ..........................................................4 pin Lemo 
GPS Antenna: ............................................................TNC-F
CAN bus + Event: ..................5 pin Lemo (SF-2050M Only)
1PPS Output: ....................................BNC (SF-2050M Only)

• Temperature (ambient):
Operating: ............................-40º to +55ºC (-40º to +131ºF)
Storage: ................................-40º to +85ºC (-40º to +185ºF)

• Humidity: ..............................................95% non-condensing

• Tested in accordance with MIL-STD-810F for: 
low pressure, solar radiation, rain, humidity, salt fog, 
sand & dust, and vibration

PERFORMANCE 1

• Measurement Precision (RMS):
Raw C/A code:........................................20 cm @ 42 dB-Hz 
Raw carrier phase noise: ..............L1: 0.95 mm @ 42 dB-Hz

L2: 0.85 mm @ 42 dB-Hz 

• Velocity: ..................................................................0.01 m/s 

• Real-time StarFire Accuracy (RMS):
Position (H):  ............................................................<10 cm
Position (V): ..............................................................<15cm

• Enhanced SBAS (WAAS/EGNOS) Positioning Accuracy:
Horizontal: ....................................................................0.5m 
Vertical: ........................................................................0.7m

• Code Differential GPS Positioning <200kms (RMS):
Horizontal: ......................................................12 cm + 2ppm 
Vertical: ..........................................................25 cm + 2ppm 

• RTK Positioning <10kms (Software option) (RMS):
Horizontal: ......................................................1 cm + 1ppm 
Vertical: ..........................................................2 cm + 1ppm 

• RTK Extend (Software option) (RMS):
Horizontal: ......................................................2 cm + 1ppm 
Vertical: ..........................................................4 cm + 1ppm 

• User programmable output rates:
Position Velocity Time: ..............5 Hz (10Hz, 25Hz Optional) 
Raw measurement data: ..5 Hz (10Hz, 25Hz, 50Hz Optional) 

• Data Latency:
Position Velocity Time: ............................< 20 ms at all rates
Raw measurement data: ........................< 20 ms at all rates

• Time-to-first-fix:
Cold Start, Satellite Acquisition: ........< 60 seconds (typical)
Satellite Reacquisition: ...................................... < 1 second

• Dynamics: (Speed & Altitude restricted by export laws)
Acceleration: ............................................................up to 6g
Speed:............................................< 1,000 knots (515 m/s)
Altitude: ................................................< 60,000 ft (18.3km)

• 1PPS Resolution: ............................12.5ns relative accuracy
(SF-2050M Only)

1 Performance dependent on location, satellite geometry, atmospheric 
conditions and GPS corrections.

COMMUNICATIONS
• Messages:

Data/Control: ....................................NCT Binary Messages
NMEA: ..........................ALM, GGA, GLL, GSA, GST, GSV, 

RMC, VTG, ZDA

• Corrections:..............................RTCM Code (Msg. 1, 3 & 9)
SBAS (WAAS/EGNOS)

StarFire™

• RTK Corrections: ........................................NCT Proprietary
(Optional) RTCM (Msg. 18/19 or 20/21)

CMR (Msg. 0, 1, 2)
CMR+



Key Features

High-performance 
GPS with a world of 
real-time options 
The versatile GPS Pathfinder® Pro XRS receiver is 
the thoroughbred of GPS receivers. Offering a full 
range of accurate real-time correction sources, 
great performance in all GPS conditions, and 
rugged design for the toughest environments, the 
Pro XRS is an essential tool for collecting and 
maintaining GPS data.

Built to meet your demands
With the Pro XRS, you don’t have to worry 
whether your GPS receiver can stand up to harsh 
conditions. All its components are sealed in a 
robust casing. Waterproof, dustproof, and  
shock-resistant, the Pro XRS can work  
anywhere you can. 

Just as tough is the custom-designed ergonomic 
backpack. But it’s light and comfortable, so you 
can wear it all day.

You’re spoiled for real-time choice
If you’re navigating in the field, or finding your way 
back to a previously recorded feature, you’ve got 
all the real-time options covered. Corrections from 
a radiobeacon, a satellite differential service such 
as OmniSTAR, or a satellite-based augmentation 
system (SBAS) like WAAS1 or EGNOS2 are not 
just built in, they’re seamlessly integrated into 
the receiver. Want the freedom to connect to an 
external correction source like a virtual reference 
station (VRS)? You’ve got it. This array of real-time 
sources makes the Pro XRS the most adaptable 
real-time GPS receiver around.

High quality, accurate data for your GIS
With the Pro XRS, you can be sure that the data 
you collect meets your high standards. Offering 
submeter accuracy in real time, and centimeter-
level postprocessed accuracy, it’s the obvious 
choice for collecting the high quality GPS data 

you need in your GIS. And it has advanced  
design features, like EVEREST™ multipath 
rejection technology, to ensure you get only the 
best positions.

Get the results you want
The GPS Pathfinder Pro XRS’s advanced design 
gives you complete control over GPS quality. You 
can focus on productivity, to keep working even in 
adverse GPS conditions. Or you can configure the 
receiver to deliver only the most precise positions. 
It’s up to you. 

Flexible data collection options
Pick the field device and software that fits your 
workflow. The Pro XRS is ready to use with a 
variety of field computers, including Trimble’s own 
range of handheld computers: the GIS TSCe™ 
field device, the Trimble® Recon™ handheld, and 
the GeoExplorer® series.

Choosing software? Try the TerraSync™ software, 
for a complete solution from the field to the  
office and back. Choose off-the-shelf GPS field 
software. Or use the GPS Pathfinder Tools SDK 
to build your own application that’s totally 
customized to your needs.

All you need
You need equipment that’s as 
adaptable and hard-working 
as you are. So when you’re 
choosing GPS equipment, 
don’t compromise. Get a 
GPS Pathfinder Pro XRS receiver 
and have it all. 

Key Features

• Real-time submeter accuracy

• Integrated satellite, beacon, 
and WAAS/EGNOS differential 
receiver

• EVEREST multipath rejection

• Rugged design

• Ergonomic, comfortable 
backpack system

• Choice of field device and field 
software 

GPS Pathfinder Pro XRSGPS Pathfinder Pro XRS











































SPECIFICATIONS FOR LASER TECH TRUPULSE 200 LASER RANGEFINDER 

 

Dimensions 5" x 2" x 3.5" (12cm x 5cm x 9cm) 
Weight 8 ounces (220 g) 
Data Communication Serial, via wired RS232 (standard)  
Power                                 3.0 volts DC nominal 
     Battery Type (2) AA or (1) CRV3  

     Battery Duration AA:  Approximately 7,500 measurements                                                                  
CRV3:  Approximately 15,000 measurements 

Eye Safety  FDA Class 1 (CFR 21) 
Environmental Impact, Water & Dust Resistant. NEMA 3, IP 64 
Temperature -4°F to +140°F (-20°C to +60°C) 
Optics 7X Magnification  (Field-of-view; 330 ft @ 1000 yards) 
Display In-scope LCD 
Units Feet, Yards, Meters, and Degrees 
Monopod/tripod mount ¼ " - 20 female thread 
Measurement Range  
     Distance 0 to 3280 ft (1000 m) typical, 6560 ft (2000m) max to reflective target 
     Inclination ± 90 degrees 
Accuracy  
     Distance ±1 ft (± 30 cm) to high quality targets, ±1 yd (±1 m) to low quality targets 
     Inclination ±0.25 degrees 

Measurement Modes Horizontal Distance, Vertical Distance, Slope Distance and Inclination, and 3-point 
flexible height routine with auto sequencing 

Target Modes Standard, Closest, Farthest, Continuous, and Filter (requires reflector and foliage 
filter) 

 

 

 



Impulse 200 LR Laser 
Our Impulse lasers are specifically designed for optimal performance under whatever conditions you might encounter
in the field. They are lightweight, extremely rugged, completely waterproof and versatile. Use them as a handheld
unit or mount them on a tripod for added stability. 

Impulse Laser w/
1.5 to 4 X Zoom Scope
and Mounting Bracket

Impulse Laser w/
Red-dot Scope
and Hand Strap

Hardware Specifications: 

7070 S. Tucson Way, Centennial, CO  80112 USA 
Toll Free: 1 (800) 280-6113  |  Local: 1 (303) 649-1000

 Web Page: www.lasertech.com  |  E-mail: info@lasertech.com

* All specifications are subject 
to change without notice.  

(Rev. 11/15/03)

Key Features: 

- Custom backlit LCD display
- Audible and visual indicators
- RS232 serial output for
   electronic data storage
- Selective range gating for
  positive target acquisition
- Built-in tilt sensor 
- Filter system to discriminate
  reflective targets
- Cumulative distance capability
- Determines the distance 
   between two in-line objects
- Integrates with GPS

For 3-D data collection,
integrate the Impulse with

a MapStar System.

Package Includes: 

- Impulse laser
- Red-dot scope
- Hand strap
- Tripod / monopod
   mounting bracket
- (2) AA batteries
- Operator's manual
- Padded carrying case

Optional Accessories:

- 1.5 to 4 X zoom scope
- Yoke and staff
- Remote trigger data cable

MapStar
Angle

Encoder

MapStar 
Compass
Module

Typical Target                   IMPULSE 200 LR

Accuracy & Range (Imperial) (Metric)

Accuracy (Typical) 0.1 - 0.2 ft 3 - 5 cm

Accuracy (Max) 0.5 ft 15 cm

Overhead cable / Stake 330 ft 100 m

Phone pole / Stockpile 655 ft 200 m

Tree / Tower 985 ft 300 m

Rock Face / Building 1640 ft 500 m

Max Distance 1885 ft 575 m

Range Resolution .01 ft 0.01 m

Inclination Limits  +/- 90 deg  +/- 90 deg

Inclination Accuracy  +/- 0.1 deg  +/- 0.1 deg

Weight 2.2 lbs. 1 kg

Size  6 x 2.5 x 5 in. 15.2 x 6.4 x 12.7 cm 

Power Supply  (2) AA batteries (20 hours of use)

Environment  Waterproof to IP 67 and NEMA 6

Temperature  - 22 to + 140 F  -30 to + 60 C   

(Max distances are approximate)



















 

 
 

 
Sea-Bird Electronics, Inc. 
1808 136th Place NE 
Bellevue, Washington 98005 USA 
Tel: 425/643-9866 
Fax:425/643-9954 

SBE 19plus
SEACAT PROFILER
Conductivity, Temperature, and Pressure Recorder
with RS-232 Interface

Serial Number: 19P36026-4585



L I M I T E D   L I A B I L I T Y   S T A T E M E N T 

Extreme care should be exercised when using or servicing this equipment.  It should be used or
serviced only by personnel with knowledge of and training in the use and maintenance of
oceanographic electronic equipment.

SEA-BIRD ELECTRONICS, INC. disclaims all product liability risks arising from the use or servicing of
this system.  SEA-BIRD ELECTRONICS, INC. has no way of controlling the use of this equipment or of
choosing the personnel to operate it, and therefore cannot take steps to comply with laws pertaining to
product liability, including laws which impose a duty to warn the user of any dangers involved in
operating this equipment.  Therefore, acceptance of this system by the customer shall be conclusively
deemed to include a covenant by the customer to defend, indemnify, and hold SEA-BIRD
ELECTRONICS, INC. harmless from all product liability claims arising from the use of servicing of this
system.
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WARNING !!
Do not submerge this instrument (S/N 19P36026-4585)

beyond the depth rating of the lowest rated component listed below!

Main Housing (Titanium) 7000 meters

Pressure Sensor (3500 dBar) Druck 3500 meters

Pump (SBE 5M) 10500 meters
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 SYSTEM CONFIGURATION 14 June 2004 
 
   
   
 Model SBE 19plus S/N 19P36026-4585 
 Instrument Type SBE 19plus SeaCaT Profiler 
 Firmware Version 1.4D 
 Communications 9600 baud, 8 data bits, no parity, one stop bit 
 Memory 8192K 
 Housing 7000 meter (3AL-4V Titanium) 
 0 Conductivity Raw Frequency 2630.97 Hz 
 Pressure Sensor Strain Gauge: 3500 dBar, S/N 5433 
   
 Number of Voltages Sampled: 0 
   
 Serial RS-232C Sensor None 
   
 Data Format:  
 Count Temperature 
 Frequency Conductivity 
 Count Pressure, Strain gauge 
   
 
          Pump (SBE 5M) 050647 
 
   
   
 Voltage Delay Setting (standard) (standard) 0 seconds 
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IMPORTANT SOFTWARE & HARDWARE CONFIGURATION INFORMATION 
 
Sea-Bird supplies two versions of our software package for communication, real-time data acquisition, and data 
analysis and display: 
• SEASOFT-Win32 - Windows software for PC running Win 95/98/NT/2000/XP 
• SEASOFT-DOS - DOS software for IBM-PC/AT/386/486 or compatible computer with a hard drive 
Detailed information on the use of the Windows software follows: 
 
SEASOFT-Win32 
SEASOFT-Win32 software was supplied on a CD-ROM with your CTD. This software package is designed to run on a PC running Win 
95/98/NT/2000/XP. The CD-ROM also contains software manuals that describe the appropriate applications for the various programs, the 
procedure for installing the software, and instructions on using the programs. There are three primary programs used with the CTD for 
setup, data collection and retrieval, data display, and data processing: 
• SEATERM - terminal program for setup of the CTD and uploading of data from the CTD memory (Note: If using the CTD with the 

90208 Auto Fire Module or SBE 17plus V2 SEARAM, use SeatermAF instead of SEATERM) 
• SEASAVE - real-time data acquisition program 
• SBE Data Processing - data processing program 
Instructions for using the software are found in their Help files. 
 
To communicate with the CTD to set it up or to upload data from the CTD memory to the computer hard drive, 
SEATERM must have information about the CTD hardware configuration (communication parameters, internal 
firmware, etc.) and about the computer. To communicate with the CTD, double click on Seaterm.exe: 
1. In the Configure menu, select the CTD. The Configuration Options dialog box appears. 

A. On the COM Settings tab, select the firmware version (if applicable), baud rate, data bits, and parity to match the CTD’s 
configuration sheet. If necessary, change the com port to match the computer you are using. 

B. On the Upload Settings tab, enter upload type (all as a single file, etc.) as desired.  
For the SBE 17 and 25 only: enter the serial number for the SBE 3 (temperature) and SBE 4 (conductivity) modular sensors, 
exactly as they appear in the configuration (.con) file. 

C. On the Header Information tab, change the settings as desired. 
Click OK when done. SEATERM saves the settings in a SEATERM.ini file. 

2. On the Toolbar, click Connect to communicate with the CTD. 
3. To set up the CTD prior to deployment: 

On the Toolbar, click Status. SEATERM sends the Status command and displays the response. Verify that the 
CTD setup matches your desired deployment. If not, send commands to modify the setup. 

4. To upload data from the CTD: 
On the Toolbar, click Upload to upload data from the CTD memory to the computer. 

 
Sea-Bird CTDs store and/or transmit data from their primary and auxiliary sensors in the form of binary or 
hexadecimal number equivalents of the sensors’ frequency or voltage outputs. This is referred to as the raw data. 
The calculations required to convert from raw data to engineering units of the measured parameters (temperature, 
conductivity, pressure, dissolved oxygen, pH, etc.) are performed using the software, either in real time, or after 
the data has been stored in a file. SEASAVE creates the file in real time. As noted above, SEATERM uploads the 
recorded data and creates the file on the computer hard drive.  
 
To successfully store data to a file on the computer and subsequently convert it to engineering units, the software 
must know the CTD type, CTD configuration, and calibration coefficients for the sensors installed on the CTD. 
This information is unique to each CTD, and is contained in a configuration file. The configuration file, which has 
a .con extension, was written onto a floppy disk and the CD-ROM shipped with the CTD. The .con file for a given 
CTD is named with the last four digits of the serial number for that CTD (e.g., 1234.con). The configuration file is 
created or modified (e.g., changing coefficients after recalibration, or adding another sensor) by using the 
Configure menu in SEASAVE or  
SBE Data Processing. The configuration file is used by SEASAVE to convert raw data to engineering units  
when it acquires, stores, and displays real-time data. The configuration file is also used by some modules in  
SBE Data Processing (Data Conversion and Derive) that convert raw data to engineering units during data 
processing. 

5



 
The instrument type and instrument configuration settings of the .con file and the required setup for the 
SEATERM.ini file for the CTD as delivered are documented below. The calibration coefficients for the CTD's 
sensors are contained in the calibration coefficient section of the CTD manual. 
 
 NOTE: 
SEATERM will not upload data correctly without a properly configured SEATERM.ini file. SEASAVE and SBE 
Data Processing will not interpret the data correctly without the correct .con file. 

 
 
 
 
 
 

SEASOFT CONFIGURATION: 
 
The correct instrument type for your instrument is SBE 19plus SEACAT Profiler.  The correct settings for the configuration of your 
instrument as delivered are documented below: 

 
  

  

0 
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SEACAT Profiler SBE 19plus

Sea-Bird Electronics, Inc.
1808 136th Place NE, Bellevue, Washington  98005  USA
Website: http://www.seabird.com

Email: seabird@seabird.com
Telephone: (425) 643-9866

Fax: (425) 643-9954

The SBE 19plus is the next generation Personal CTD, bringing numerous improvements in accuracy, resolution (in fresh as
well as salt water), reliability, and ease-of-use to the wide range of research, monitoring, and engineering applications
pioneered by its legendary SEACAT predecessor. The 19plus samples faster (4 Hz vs 2), is more accurate (0.005 vs 0.01 in
T, 0.0005 vs 0.001 in C, and 0.1% vs 0.25% — with seven times the resolution — in D), and has more memory (8 Mbyte vs 1).
There is more power for auxiliary sensors (500 ma vs 50), and they are acquired at higher resolution (14 bit vs 12). Cabling is
simpler and more reliable because there are four differential auxiliary inputs on two separate connectors, and a dedicated
connector for the pump. All exposed metal parts are titanium, instead of aluminum, for long life and minimum maintenance.

The 19plus can be operated without a computer from even the smallest boat, with data recorded in non-volatile FLASH
memory and processed later on your PC. Simultaneous with recording, real-time data can be transmitted over single-core,
armored cable directly to your PC’s serial port (maximum transmission distance dependent on number of auxiliary sensors,
baud rate, and cable properties). The 19plus’ faster sampling and pump-controlled TC-ducted flow configuration significantly
reduces salinity spiking caused by ship heave, and allows slower descent rates for improved resolution of water column features.
Auxiliary sensors for dissolved oxygen, pH, turbidity, fluorescense, PAR, and ORP can be added, and for moored deployments the
19plus can be set to time-series mode using software commands. External power and two-way real-time communication over
10,000 meters of cable can be provided with the SBE 36 CTD Deck Unit and Power and Data Interface Module (PDIM).

The 19plus uses the same temperature and conductivity sensors proven in 5000 SEACAT and MicroCAT instruments, and a
superior new micro-machined silicon strain gauge pressure sensor developed by Druck, Inc. Improvements in design,
materials, and signal acquisition techniques yield a low-cost instrument with superior performance that is also easy to use.
Calibration coefficients, obtained in our computer-controlled high-accuracy calibration baths, are stored in EEPROM memory.
They permit data output in ASCII engineering units (degrees C, Siemens/m, decibars, Salinity [PSU], sound velocity [m/sec],
etc.). The 19plus can be factory-configured to emulate the .hex output format and 2 Hz data rate of old SEACATs for
compatibility with existing software or instrument fleets.

Accuracy, convenience, portability, software, and support; compelling reasons why the 19plus is today’s best low-cost CTD.

CONFIGURATION AND OPTIONS

A standard SBE 19plus is supplied with:
• Plastic housing for depths to 600 meters
• Strain-gauge pressure sensor
• 8 Mbyte FLASH RAM memory
• 9 D-size alkaline batteries
• Impulse glass-reinforced epoxy bulkhead connectors: 4-pin I/O,

2-pin pump, and two 6-pin (two differential auxiliary A/D inputs each)
• SBE 5M miniature pump and T-C Duct

Options include:
• Titanium housing for depths to 7000 meters
• Sensors for oxygen, pH, fluorescence, light (PAR), light transmission,

and turbidity
• SBE 5T pump in place of SBE 5M for use with dissolved oxygen and/or

other pumped sensors
• Stainless steel cage
• MCBH Micro connectors
• Ni-Cad batteries and charger

SOFTWARE

SEASOFT©-Win32, our complete Windows 95/98/NT/2000/XP software package,
is included at no extra charge. Its modular programs include:
• SEATERM© — communication and data retrieval
• SEASAVE© — real-time data acquisition and display
• SBE Data Processing© — filtering, aligning, averaging, and plotting of CTD and

auxiliary sensor data and derived variables

Shown with
optional cage,
SBE 5T pump,

& SBE 43
DO sensor

98



SEACAT Profiler SBE 19plus

Sea-Bird Electronics, Inc.
1808 136th Place NE, Bellevue, Washington  98005  USA
Website: http://www.seabird.com

Email: seabird@seabird.com
Telephone: (425) 643-9866

Fax: (425) 643-9954

Water intake

SBE 5M 
pump

Y-fitting

Air bleed 
valve

Data I/O 
cable

Pump 
inlet port

Pump 
exhaust port

Conductivity cell guard 
(covering temperature 
sensor, TC duct, & 
conductivity sensor)

Dimensions
in millimeters
(inches)

Data I/O

Auxiliary
Differential
Inputs

Pump

Optional
Auxiliary
Input

575 (22.65)

99 (3.90) DIA

 808 (31.80)

136 
(5.37)

103 
(4.05)

SPECIFICATIONS
Measurement Range
Temperature -5 to +35 °C
Conductivity 0 to 9 S/m
Pressure 0 to 20 / 100 / 350 / 1000 / 2000 / 3500 / 7000 meters
Initial Accuracy
Temperature 0.005 °C
Conductivity 0.0005 S/m
Pressure 0.1% of full scale range
Typical Stability (per month)
Temperature 0.0002 °C
Conductivity 0.0003 S/m
Pressure 0.004% of full scale range
Resolution
Temperature 0.0001 °C
Conductivity 0.00005 S/m (most oceanic waters; resolves 0.4 ppm in salinity)

0.00007 S/m (high salinity waters; resolves 0.4 ppm in salinity)
0.00001 S/m (fresh waters; resolves 0.1 ppm in salinity)

Pressure 0.002% of full scale range
Memory 8 Mbyte non-volatile FLASH memory
Data Storage Recorded Parameter Bytes/Sample

T + C 6
pressure 5
each external voltage 2

Real-Time Clock 32,768 Hz TCXO accurate to ±1 minute/year
Internal Batteries 9 alkaline D-cells provide 60 hours continuous CTD operation;

optional 9-cell rechargeable nickel-cadmium battery pack
provides approximately 24 hours operation per charge

External Power Supply 9 - 28 VDC
Power Requirements
Sampling 65 mA
SBE 5M pump 95 mA
Quiescent 30 µA
Auxiliary Voltage Sensors
Auxiliary power out up to 500 mA at 10.5 - 11 VDC
A/D resolution 14 bits
Input range 0 - 5 VDC
Housing Materials — Depth Rating — Weight
Acetal Copolymer Plastic housing — 600 meter (1950 feet) — 7.3 kg (16 lbs)
3AL-2.5V Titanium housing — 7000 meter (22,900 feet) — 13.7 kg (30 lbs)
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Sea-Bird Electronics, Inc. E-mail: seabird@seabird.com 
1808 136th Place NE, Bellevue, Washington  98005  USA Telephone: (425) 643-9866 
Website: http://www.seabird.com Fax: (425) 643-9954 

Mini Submersible Pump  SBE 5M 
 
 
The SBE 5M pump module consists of a centrifugal pump 
head and a long-life, DC ball bearing motor contained in a 
compact, titanium, pressure housing usable to  
10,500 meters deep. The pump impeller and electric drive 
motor are coupled magnetically through the housing, 
providing high reliability by eliminating moving seals. Motor 
speed and pumping rate remain constant over the entire 
input voltage range. The motor drive electronics is 
intrinsically protected against accidental reversed polarity. 
 
 
APPLICATIONS 
 
The SBE 5M is standard on the SBE 19 and 19plus 
SEACAT Profiler CTD. It is optional on the SBE 16, 16plus, 
and 16plus-IM SEACAT C-T Recorder. The pump flushes 
water through the conductivity cell at a constant rate, 
independent of the CTD's motion, improving dynamic 
performance. For applications requiring pumping through 
additional sensors (for example, a dissolved oxygen 
sensor), use the SBE 5T pump instead. 
 
Specify: 
• Option 5M-1 for profiling (continuous duty) applications 

such as the SBE 19plus. 
• Option 5M-2 for moored (pulsed duty) applications such 

as the SBE 16plus or 16plus-IM. 
Contact Sea-Bird for use in other applications. 
 
SPECIFICATIONS 
 
Option 5M-1 (continuous duty):  
Input voltage range 9 - 18 VDC  
 
Flow Rate 25 ml/s supply current 95 ma 
 
Note: Supply current is independent of operating voltage. 
 
 
Option 5M-2 (pulsed duty):  
Input voltage range 6 - 18 VDC  
 
Pulse Duration Flow Volume Electrical Charge 

0.5 seconds 15 ml 0.148 amp-seconds 
1.0 seconds 21 ml 0.283 amp-seconds 
1.5 seconds 31 ml 0.418 amp-seconds 
2.0 seconds 40 ml 0.553 amp-seconds 
 
 
 
 
Weight 
In Air: 0.42 kg (0.91 lbs) 
In Water: 0.28 kg (0.60 lbs) 
 06/03 

Optional  
wet-pluggable 
connector, 
MCBH-2MTI 
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1808 136th Place NE, Bellevue, Washington  98005  USA                 Tel: (425) 643-9866
Website: http://www.seabird.com                                                         Email: seabird@seabird.com

Sea-Bird Electronics, Inc. FAX: (425) 643-9954

SBE 5M MINI SUBMERSIBLE PUMP CONFIGURATION SHEET

Serial Number:

Job Number:

Customer:

Delivery Date:

Single Connector Housing with Titanium screws

Pressure Case:  10,500 meters (titanium)

Maxon Motor Type:

P/N 90337, Motor PN 20130 (Low power 6 VDC, 2000 RPM MAX)

P/N 90335, Motor PN 20130 (Low power 9 VDC, 2000 RPM MAX)

0647

36026

NOAA/PMC

6/14/2004

Vin 15V voltage across C2: VDC      Current mA8.015 7.73

Vin 9V voltage across C2: VDC      Current mA8.014 7.4

Vin 6V voltage across C2: VDC      Current mA5.888 7.61

Pump submerged test, no load, Vin 12VDC Average current draw in water: 121 mA
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Sea-Bird Electronics, Inc. 
1808 136th Place NE 
Bellevue, Washington 98005 USA 
Tel: 425/643-9866 
Fax:425/643-9954 

SBE 19plus
SEACAT PROFILER
Conductivity, Temperature, and Pressure Recorder
with RS-232 Interface

Serial Number: 19P36026-4616



WARNING !!
Do not submerge this instrument (S/N 19P36026-4616)

beyond the depth rating of the lowest rated component listed below!

Main Housing (Plastic) 600 meters

Pressure Sensor (1000 dBar) Druck 1000 meters

Pump (SBE 5M) 10500 meters
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 SYSTEM CONFIGURATION 14 June 2004 
 
   
   
 Model SBE 19plus S/N 19P36026-4616 
 Instrument Type SBE 19plus SeaCaT Profiler 
 Firmware Version 1.4D 
 Communications 9600 baud, 8 data bits, no parity, one stop bit 
 Memory 8192K 
 Housing 600 meter (Celcon plastic) 
 0 Conductivity Raw Frequency 2686.52 Hz 
 Pressure Sensor Strain Gauge: 1000 dBar, S/N 5512 
   
 Number of Voltages Sampled: 0 
   
 Serial RS-232C Sensor None 
   
 Data Format:  
 Count Temperature 
 Frequency Conductivity 
 Count Pressure, Strain gauge 
   
 
          Pump (SBE 5M) 050651 
 
   
   
 Voltage Delay Setting (standard) (standard) 0 seconds 
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IMPORTANT SOFTWARE & HARDWARE CONFIGURATION INFORMATION 
 
Sea-Bird supplies two versions of our software package for communication, real-time data acquisition, and data 
analysis and display: 
• SEASOFT-Win32 - Windows software for PC running Win 95/98/NT/2000/XP 
• SEASOFT-DOS - DOS software for IBM-PC/AT/386/486 or compatible computer with a hard drive 
Detailed information on the use of the Windows software follows: 
 
SEASOFT-Win32 
SEASOFT-Win32 software was supplied on a CD-ROM with your CTD. This software package is designed to run on a PC running Win 
95/98/NT/2000/XP. The CD-ROM also contains software manuals that describe the appropriate applications for the various programs, the 
procedure for installing the software, and instructions on using the programs. There are three primary programs used with the CTD for 
setup, data collection and retrieval, data display, and data processing: 
• SEATERM - terminal program for setup of the CTD and uploading of data from the CTD memory (Note: If using the CTD with the 

90208 Auto Fire Module or SBE 17plus V2 SEARAM, use SeatermAF instead of SEATERM) 
• SEASAVE - real-time data acquisition program 
• SBE Data Processing - data processing program 
Instructions for using the software are found in their Help files. 
 
To communicate with the CTD to set it up or to upload data from the CTD memory to the computer hard drive, 
SEATERM must have information about the CTD hardware configuration (communication parameters, internal 
firmware, etc.) and about the computer. To communicate with the CTD, double click on Seaterm.exe: 
1. In the Configure menu, select the CTD. The Configuration Options dialog box appears. 

A. On the COM Settings tab, select the firmware version (if applicable), baud rate, data bits, and parity to match the CTD’s 
configuration sheet. If necessary, change the com port to match the computer you are using. 

B. On the Upload Settings tab, enter upload type (all as a single file, etc.) as desired.  
For the SBE 17 and 25 only: enter the serial number for the SBE 3 (temperature) and SBE 4 (conductivity) modular sensors, 
exactly as they appear in the configuration (.con) file. 

C. On the Header Information tab, change the settings as desired. 
Click OK when done. SEATERM saves the settings in a SEATERM.ini file. 

2. On the Toolbar, click Connect to communicate with the CTD. 
3. To set up the CTD prior to deployment: 

On the Toolbar, click Status. SEATERM sends the Status command and displays the response. Verify that the 
CTD setup matches your desired deployment. If not, send commands to modify the setup. 

4. To upload data from the CTD: 
On the Toolbar, click Upload to upload data from the CTD memory to the computer. 

 
Sea-Bird CTDs store and/or transmit data from their primary and auxiliary sensors in the form of binary or 
hexadecimal number equivalents of the sensors’ frequency or voltage outputs. This is referred to as the raw data. 
The calculations required to convert from raw data to engineering units of the measured parameters (temperature, 
conductivity, pressure, dissolved oxygen, pH, etc.) are performed using the software, either in real time, or after 
the data has been stored in a file. SEASAVE creates the file in real time. As noted above, SEATERM uploads the 
recorded data and creates the file on the computer hard drive.  
 
To successfully store data to a file on the computer and subsequently convert it to engineering units, the software 
must know the CTD type, CTD configuration, and calibration coefficients for the sensors installed on the CTD. 
This information is unique to each CTD, and is contained in a configuration file. The configuration file, which has 
a .con extension, was written onto a floppy disk and the CD-ROM shipped with the CTD. The .con file for a given 
CTD is named with the last four digits of the serial number for that CTD (e.g., 1234.con). The configuration file is 
created or modified (e.g., changing coefficients after recalibration, or adding another sensor) by using the 
Configure menu in SEASAVE or  
SBE Data Processing. The configuration file is used by SEASAVE to convert raw data to engineering units  
when it acquires, stores, and displays real-time data. The configuration file is also used by some modules in  
SBE Data Processing (Data Conversion and Derive) that convert raw data to engineering units during data 
processing. 
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The instrument type and instrument configuration settings of the .con file and the required setup for the 
SEATERM.ini file for the CTD as delivered are documented below. The calibration coefficients for the CTD's 
sensors are contained in the calibration coefficient section of the CTD manual. 
 
 NOTE: 
SEATERM will not upload data correctly without a properly configured SEATERM.ini file. SEASAVE and SBE 
Data Processing will not interpret the data correctly without the correct .con file. 

 
 
 
 
 
 

SEASOFT CONFIGURATION: 
 
The correct instrument type for your instrument is SBE 19plus SEACAT Profiler.  The correct settings for the configuration of your 
instrument as delivered are documented below: 

 
  

  

0 
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SEACAT Profiler SBE 19plus

Sea-Bird Electronics, Inc.
1808 136th Place NE, Bellevue, Washington  98005  USA
Website: http://www.seabird.com

Email: seabird@seabird.com
Telephone: (425) 643-9866

Fax: (425) 643-9954

The SBE 19plus is the next generation Personal CTD, bringing numerous improvements in accuracy, resolution (in fresh as
well as salt water), reliability, and ease-of-use to the wide range of research, monitoring, and engineering applications
pioneered by its legendary SEACAT predecessor. The 19plus samples faster (4 Hz vs 2), is more accurate (0.005 vs 0.01 in
T, 0.0005 vs 0.001 in C, and 0.1% vs 0.25% — with seven times the resolution — in D), and has more memory (8 Mbyte vs 1).
There is more power for auxiliary sensors (500 ma vs 50), and they are acquired at higher resolution (14 bit vs 12). Cabling is
simpler and more reliable because there are four differential auxiliary inputs on two separate connectors, and a dedicated
connector for the pump. All exposed metal parts are titanium, instead of aluminum, for long life and minimum maintenance.

The 19plus can be operated without a computer from even the smallest boat, with data recorded in non-volatile FLASH
memory and processed later on your PC. Simultaneous with recording, real-time data can be transmitted over single-core,
armored cable directly to your PC’s serial port (maximum transmission distance dependent on number of auxiliary sensors,
baud rate, and cable properties). The 19plus’ faster sampling and pump-controlled TC-ducted flow configuration significantly
reduces salinity spiking caused by ship heave, and allows slower descent rates for improved resolution of water column features.
Auxiliary sensors for dissolved oxygen, pH, turbidity, fluorescense, PAR, and ORP can be added, and for moored deployments the
19plus can be set to time-series mode using software commands. External power and two-way real-time communication over
10,000 meters of cable can be provided with the SBE 36 CTD Deck Unit and Power and Data Interface Module (PDIM).

The 19plus uses the same temperature and conductivity sensors proven in 5000 SEACAT and MicroCAT instruments, and a
superior new micro-machined silicon strain gauge pressure sensor developed by Druck, Inc. Improvements in design,
materials, and signal acquisition techniques yield a low-cost instrument with superior performance that is also easy to use.
Calibration coefficients, obtained in our computer-controlled high-accuracy calibration baths, are stored in EEPROM memory.
They permit data output in ASCII engineering units (degrees C, Siemens/m, decibars, Salinity [PSU], sound velocity [m/sec],
etc.). The 19plus can be factory-configured to emulate the .hex output format and 2 Hz data rate of old SEACATs for
compatibility with existing software or instrument fleets.

Accuracy, convenience, portability, software, and support; compelling reasons why the 19plus is today’s best low-cost CTD.

CONFIGURATION AND OPTIONS

A standard SBE 19plus is supplied with:
• Plastic housing for depths to 600 meters
• Strain-gauge pressure sensor
• 8 Mbyte FLASH RAM memory
• 9 D-size alkaline batteries
• Impulse glass-reinforced epoxy bulkhead connectors: 4-pin I/O,

2-pin pump, and two 6-pin (two differential auxiliary A/D inputs each)
• SBE 5M miniature pump and T-C Duct

Options include:
• Titanium housing for depths to 7000 meters
• Sensors for oxygen, pH, fluorescence, light (PAR), light transmission,

and turbidity
• SBE 5T pump in place of SBE 5M for use with dissolved oxygen and/or

other pumped sensors
• Stainless steel cage
• MCBH Micro connectors
• Ni-Cad batteries and charger

SOFTWARE

SEASOFT©-Win32, our complete Windows 95/98/NT/2000/XP software package,
is included at no extra charge. Its modular programs include:
• SEATERM© — communication and data retrieval
• SEASAVE© — real-time data acquisition and display
• SBE Data Processing© — filtering, aligning, averaging, and plotting of CTD and

auxiliary sensor data and derived variables

Shown with
optional cage,
SBE 5T pump,

& SBE 43
DO sensor
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SEACAT Profiler SBE 19plus

Sea-Bird Electronics, Inc.
1808 136th Place NE, Bellevue, Washington  98005  USA
Website: http://www.seabird.com

Email: seabird@seabird.com
Telephone: (425) 643-9866

Fax: (425) 643-9954

Water intake

SBE 5M 
pump

Y-fitting

Air bleed 
valve

Data I/O 
cable

Pump 
inlet port

Pump 
exhaust port

Conductivity cell guard 
(covering temperature 
sensor, TC duct, & 
conductivity sensor)

Dimensions
in millimeters
(inches)

Data I/O

Auxiliary
Differential
Inputs

Pump

Optional
Auxiliary
Input

575 (22.65)

99 (3.90) DIA

 808 (31.80)

136 
(5.37)

103 
(4.05)

SPECIFICATIONS
Measurement Range
Temperature -5 to +35 °C
Conductivity 0 to 9 S/m
Pressure 0 to 20 / 100 / 350 / 1000 / 2000 / 3500 / 7000 meters
Initial Accuracy
Temperature 0.005 °C
Conductivity 0.0005 S/m
Pressure 0.1% of full scale range
Typical Stability (per month)
Temperature 0.0002 °C
Conductivity 0.0003 S/m
Pressure 0.004% of full scale range
Resolution
Temperature 0.0001 °C
Conductivity 0.00005 S/m (most oceanic waters; resolves 0.4 ppm in salinity)

0.00007 S/m (high salinity waters; resolves 0.4 ppm in salinity)
0.00001 S/m (fresh waters; resolves 0.1 ppm in salinity)

Pressure 0.002% of full scale range
Memory 8 Mbyte non-volatile FLASH memory
Data Storage Recorded Parameter Bytes/Sample

T + C 6
pressure 5
each external voltage 2

Real-Time Clock 32,768 Hz TCXO accurate to ±1 minute/year
Internal Batteries 9 alkaline D-cells provide 60 hours continuous CTD operation;

optional 9-cell rechargeable nickel-cadmium battery pack
provides approximately 24 hours operation per charge

External Power Supply 9 - 28 VDC
Power Requirements
Sampling 65 mA
SBE 5M pump 95 mA
Quiescent 30 µA
Auxiliary Voltage Sensors
Auxiliary power out up to 500 mA at 10.5 - 11 VDC
A/D resolution 14 bits
Input range 0 - 5 VDC
Housing Materials — Depth Rating — Weight
Acetal Copolymer Plastic housing — 600 meter (1950 feet) — 7.3 kg (16 lbs)
3AL-2.5V Titanium housing — 7000 meter (22,900 feet) — 13.7 kg (30 lbs)
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Mini Submersible Pump  SBE 5M 
 
 
The SBE 5M pump module consists of a centrifugal pump 
head and a long-life, DC ball bearing motor contained in a 
compact, titanium, pressure housing usable to  
10,500 meters deep. The pump impeller and electric drive 
motor are coupled magnetically through the housing, 
providing high reliability by eliminating moving seals. Motor 
speed and pumping rate remain constant over the entire 
input voltage range. The motor drive electronics is 
intrinsically protected against accidental reversed polarity. 
 
 
APPLICATIONS 
 
The SBE 5M is standard on the SBE 19 and 19plus 
SEACAT Profiler CTD. It is optional on the SBE 16, 16plus, 
and 16plus-IM SEACAT C-T Recorder. The pump flushes 
water through the conductivity cell at a constant rate, 
independent of the CTD's motion, improving dynamic 
performance. For applications requiring pumping through 
additional sensors (for example, a dissolved oxygen 
sensor), use the SBE 5T pump instead. 
 
Specify: 
• Option 5M-1 for profiling (continuous duty) applications 

such as the SBE 19plus. 
• Option 5M-2 for moored (pulsed duty) applications such 

as the SBE 16plus or 16plus-IM. 
Contact Sea-Bird for use in other applications. 
 
SPECIFICATIONS 
 
Option 5M-1 (continuous duty):  
Input voltage range 9 - 18 VDC  
 
Flow Rate 25 ml/s supply current 95 ma 
 
Note: Supply current is independent of operating voltage. 
 
 
Option 5M-2 (pulsed duty):  
Input voltage range 6 - 18 VDC  
 
Pulse Duration Flow Volume Electrical Charge 

0.5 seconds 15 ml 0.148 amp-seconds 
1.0 seconds 21 ml 0.283 amp-seconds 
1.5 seconds 31 ml 0.418 amp-seconds 
2.0 seconds 40 ml 0.553 amp-seconds 
 
 
 
 
Weight 
In Air: 0.42 kg (0.91 lbs) 
In Water: 0.28 kg (0.60 lbs) 
 06/03 

Optional  
wet-pluggable 
connector, 
MCBH-2MTI 
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SBE 5M MINI SUBMERSIBLE PUMP CONFIGURATION SHEET

Serial Number:

Job Number:

Customer:

Delivery Date:

Single Connector Housing with Titanium screws

Pressure Case:  10,500 meters (titanium)

Maxon Motor Type:

P/N 90337, Motor PN 20130 (Low power 6 VDC, 2000 RPM MAX)

P/N 90335, Motor PN 20130 (Low power 9 VDC, 2000 RPM MAX)

0651

36026

NOAA/PMC

6/14/2004

Vin 15V voltage across C2: VDC      Current mA7.929 9.29

Vin 9V voltage across C2: VDC      Current mA7.928 8.8

Vin 6V voltage across C2: VDC      Current mA5.885 7.99

Pump submerged test, no load, Vin 12VDC Average current draw in water: 120 mA
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Bellevue, Washington 98005 USA 
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SBE 19plus
SEACAT PROFILER
Conductivity, Temperature, and Pressure Recorder
with RS-232 Interface

Serial Number: 19P36026-4617



L I M I T E D   L I A B I L I T Y   S T A T E M E N T 

Extreme care should be exercised when using or servicing this equipment.  It should be used or
serviced only by personnel with knowledge of and training in the use and maintenance of
oceanographic electronic equipment.

SEA-BIRD ELECTRONICS, INC. disclaims all product liability risks arising from the use or servicing of
this system.  SEA-BIRD ELECTRONICS, INC. has no way of controlling the use of this equipment or of
choosing the personnel to operate it, and therefore cannot take steps to comply with laws pertaining to
product liability, including laws which impose a duty to warn the user of any dangers involved in
operating this equipment.  Therefore, acceptance of this system by the customer shall be conclusively
deemed to include a covenant by the customer to defend, indemnify, and hold SEA-BIRD
ELECTRONICS, INC. harmless from all product liability claims arising from the use of servicing of this
system.
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WARNING !!
Do not submerge this instrument (S/N 19P36026-4617)

beyond the depth rating of the lowest rated component listed below!

Main Housing (Plastic) 600 meters

Pressure Sensor (1000 dBar) Druck 1000 meters

Pump (SBE 5M) 10500 meters
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 SYSTEM CONFIGURATION 14 June 2004 
 
   
   
 Model SBE 19plus S/N 19P36026-4617 
 Instrument Type SBE 19plus SeaCaT Profiler 
 Firmware Version 1.4D 
 Communications 9600 baud, 8 data bits, no parity, one stop bit 
 Memory 8192K 
 Housing 600 meter (Celcon plastic) 
 0 Conductivity Raw Frequency 2801.47 Hz 
 Pressure Sensor Strain Gauge: 1000 dBar, S/N 5513 
   
 Number of Voltages Sampled: 0 
   
 Serial RS-232C Sensor None 
   
 Data Format:  
 Count Temperature 
 Frequency Conductivity 
 Count Pressure, Strain gauge 
   
 
          Pump (SBE 5M) 050649 
 
   
   
 Voltage Delay Setting (standard) (standard) 0 seconds 
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IMPORTANT SOFTWARE & HARDWARE CONFIGURATION INFORMATION 
 
Sea-Bird supplies two versions of our software package for communication, real-time data acquisition, and data 
analysis and display: 
• SEASOFT-Win32 - Windows software for PC running Win 95/98/NT/2000/XP 
• SEASOFT-DOS - DOS software for IBM-PC/AT/386/486 or compatible computer with a hard drive 
Detailed information on the use of the Windows software follows: 
 
SEASOFT-Win32 
SEASOFT-Win32 software was supplied on a CD-ROM with your CTD. This software package is designed to run on a PC running Win 
95/98/NT/2000/XP. The CD-ROM also contains software manuals that describe the appropriate applications for the various programs, the 
procedure for installing the software, and instructions on using the programs. There are three primary programs used with the CTD for 
setup, data collection and retrieval, data display, and data processing: 
• SEATERM - terminal program for setup of the CTD and uploading of data from the CTD memory (Note: If using the CTD with the 

90208 Auto Fire Module or SBE 17plus V2 SEARAM, use SeatermAF instead of SEATERM) 
• SEASAVE - real-time data acquisition program 
• SBE Data Processing - data processing program 
Instructions for using the software are found in their Help files. 
 
To communicate with the CTD to set it up or to upload data from the CTD memory to the computer hard drive, 
SEATERM must have information about the CTD hardware configuration (communication parameters, internal 
firmware, etc.) and about the computer. To communicate with the CTD, double click on Seaterm.exe: 
1. In the Configure menu, select the CTD. The Configuration Options dialog box appears. 

A. On the COM Settings tab, select the firmware version (if applicable), baud rate, data bits, and parity to match the CTD’s 
configuration sheet. If necessary, change the com port to match the computer you are using. 

B. On the Upload Settings tab, enter upload type (all as a single file, etc.) as desired.  
For the SBE 17 and 25 only: enter the serial number for the SBE 3 (temperature) and SBE 4 (conductivity) modular sensors, 
exactly as they appear in the configuration (.con) file. 

C. On the Header Information tab, change the settings as desired. 
Click OK when done. SEATERM saves the settings in a SEATERM.ini file. 

2. On the Toolbar, click Connect to communicate with the CTD. 
3. To set up the CTD prior to deployment: 

On the Toolbar, click Status. SEATERM sends the Status command and displays the response. Verify that the 
CTD setup matches your desired deployment. If not, send commands to modify the setup. 

4. To upload data from the CTD: 
On the Toolbar, click Upload to upload data from the CTD memory to the computer. 

 
Sea-Bird CTDs store and/or transmit data from their primary and auxiliary sensors in the form of binary or 
hexadecimal number equivalents of the sensors’ frequency or voltage outputs. This is referred to as the raw data. 
The calculations required to convert from raw data to engineering units of the measured parameters (temperature, 
conductivity, pressure, dissolved oxygen, pH, etc.) are performed using the software, either in real time, or after 
the data has been stored in a file. SEASAVE creates the file in real time. As noted above, SEATERM uploads the 
recorded data and creates the file on the computer hard drive.  
 
To successfully store data to a file on the computer and subsequently convert it to engineering units, the software 
must know the CTD type, CTD configuration, and calibration coefficients for the sensors installed on the CTD. 
This information is unique to each CTD, and is contained in a configuration file. The configuration file, which has 
a .con extension, was written onto a floppy disk and the CD-ROM shipped with the CTD. The .con file for a given 
CTD is named with the last four digits of the serial number for that CTD (e.g., 1234.con). The configuration file is 
created or modified (e.g., changing coefficients after recalibration, or adding another sensor) by using the 
Configure menu in SEASAVE or  
SBE Data Processing. The configuration file is used by SEASAVE to convert raw data to engineering units  
when it acquires, stores, and displays real-time data. The configuration file is also used by some modules in  
SBE Data Processing (Data Conversion and Derive) that convert raw data to engineering units during data 
processing. 
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The instrument type and instrument configuration settings of the .con file and the required setup for the 
SEATERM.ini file for the CTD as delivered are documented below. The calibration coefficients for the CTD's 
sensors are contained in the calibration coefficient section of the CTD manual. 
 
 NOTE: 
SEATERM will not upload data correctly without a properly configured SEATERM.ini file. SEASAVE and SBE 
Data Processing will not interpret the data correctly without the correct .con file. 

 
 
 
 
 
 

SEASOFT CONFIGURATION: 
 
The correct instrument type for your instrument is SBE 19plus SEACAT Profiler.  The correct settings for the configuration of your 
instrument as delivered are documented below: 

 
  

  

0 
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SEACAT Profiler SBE 19plus

Sea-Bird Electronics, Inc.
1808 136th Place NE, Bellevue, Washington  98005  USA
Website: http://www.seabird.com

Email: seabird@seabird.com
Telephone: (425) 643-9866

Fax: (425) 643-9954

The SBE 19plus is the next generation Personal CTD, bringing numerous improvements in accuracy, resolution (in fresh as
well as salt water), reliability, and ease-of-use to the wide range of research, monitoring, and engineering applications
pioneered by its legendary SEACAT predecessor. The 19plus samples faster (4 Hz vs 2), is more accurate (0.005 vs 0.01 in
T, 0.0005 vs 0.001 in C, and 0.1% vs 0.25% — with seven times the resolution — in D), and has more memory (8 Mbyte vs 1).
There is more power for auxiliary sensors (500 ma vs 50), and they are acquired at higher resolution (14 bit vs 12). Cabling is
simpler and more reliable because there are four differential auxiliary inputs on two separate connectors, and a dedicated
connector for the pump. All exposed metal parts are titanium, instead of aluminum, for long life and minimum maintenance.

The 19plus can be operated without a computer from even the smallest boat, with data recorded in non-volatile FLASH
memory and processed later on your PC. Simultaneous with recording, real-time data can be transmitted over single-core,
armored cable directly to your PC’s serial port (maximum transmission distance dependent on number of auxiliary sensors,
baud rate, and cable properties). The 19plus’ faster sampling and pump-controlled TC-ducted flow configuration significantly
reduces salinity spiking caused by ship heave, and allows slower descent rates for improved resolution of water column features.
Auxiliary sensors for dissolved oxygen, pH, turbidity, fluorescense, PAR, and ORP can be added, and for moored deployments the
19plus can be set to time-series mode using software commands. External power and two-way real-time communication over
10,000 meters of cable can be provided with the SBE 36 CTD Deck Unit and Power and Data Interface Module (PDIM).

The 19plus uses the same temperature and conductivity sensors proven in 5000 SEACAT and MicroCAT instruments, and a
superior new micro-machined silicon strain gauge pressure sensor developed by Druck, Inc. Improvements in design,
materials, and signal acquisition techniques yield a low-cost instrument with superior performance that is also easy to use.
Calibration coefficients, obtained in our computer-controlled high-accuracy calibration baths, are stored in EEPROM memory.
They permit data output in ASCII engineering units (degrees C, Siemens/m, decibars, Salinity [PSU], sound velocity [m/sec],
etc.). The 19plus can be factory-configured to emulate the .hex output format and 2 Hz data rate of old SEACATs for
compatibility with existing software or instrument fleets.

Accuracy, convenience, portability, software, and support; compelling reasons why the 19plus is today’s best low-cost CTD.

CONFIGURATION AND OPTIONS

A standard SBE 19plus is supplied with:
• Plastic housing for depths to 600 meters
• Strain-gauge pressure sensor
• 8 Mbyte FLASH RAM memory
• 9 D-size alkaline batteries
• Impulse glass-reinforced epoxy bulkhead connectors: 4-pin I/O,

2-pin pump, and two 6-pin (two differential auxiliary A/D inputs each)
• SBE 5M miniature pump and T-C Duct

Options include:
• Titanium housing for depths to 7000 meters
• Sensors for oxygen, pH, fluorescence, light (PAR), light transmission,

and turbidity
• SBE 5T pump in place of SBE 5M for use with dissolved oxygen and/or

other pumped sensors
• Stainless steel cage
• MCBH Micro connectors
• Ni-Cad batteries and charger

SOFTWARE

SEASOFT©-Win32, our complete Windows 95/98/NT/2000/XP software package,
is included at no extra charge. Its modular programs include:
• SEATERM© — communication and data retrieval
• SEASAVE© — real-time data acquisition and display
• SBE Data Processing© — filtering, aligning, averaging, and plotting of CTD and

auxiliary sensor data and derived variables

Shown with
optional cage,
SBE 5T pump,

& SBE 43
DO sensor

98



SEACAT Profiler SBE 19plus

Sea-Bird Electronics, Inc.
1808 136th Place NE, Bellevue, Washington  98005  USA
Website: http://www.seabird.com

Email: seabird@seabird.com
Telephone: (425) 643-9866

Fax: (425) 643-9954

Water intake

SBE 5M 
pump

Y-fitting

Air bleed 
valve

Data I/O 
cable

Pump 
inlet port

Pump 
exhaust port

Conductivity cell guard 
(covering temperature 
sensor, TC duct, & 
conductivity sensor)

Dimensions
in millimeters
(inches)

Data I/O

Auxiliary
Differential
Inputs

Pump

Optional
Auxiliary
Input

575 (22.65)

99 (3.90) DIA

 808 (31.80)

136 
(5.37)

103 
(4.05)

SPECIFICATIONS
Measurement Range
Temperature -5 to +35 °C
Conductivity 0 to 9 S/m
Pressure 0 to 20 / 100 / 350 / 1000 / 2000 / 3500 / 7000 meters
Initial Accuracy
Temperature 0.005 °C
Conductivity 0.0005 S/m
Pressure 0.1% of full scale range
Typical Stability (per month)
Temperature 0.0002 °C
Conductivity 0.0003 S/m
Pressure 0.004% of full scale range
Resolution
Temperature 0.0001 °C
Conductivity 0.00005 S/m (most oceanic waters; resolves 0.4 ppm in salinity)

0.00007 S/m (high salinity waters; resolves 0.4 ppm in salinity)
0.00001 S/m (fresh waters; resolves 0.1 ppm in salinity)

Pressure 0.002% of full scale range
Memory 8 Mbyte non-volatile FLASH memory
Data Storage Recorded Parameter Bytes/Sample

T + C 6
pressure 5
each external voltage 2

Real-Time Clock 32,768 Hz TCXO accurate to ±1 minute/year
Internal Batteries 9 alkaline D-cells provide 60 hours continuous CTD operation;

optional 9-cell rechargeable nickel-cadmium battery pack
provides approximately 24 hours operation per charge

External Power Supply 9 - 28 VDC
Power Requirements
Sampling 65 mA
SBE 5M pump 95 mA
Quiescent 30 µA
Auxiliary Voltage Sensors
Auxiliary power out up to 500 mA at 10.5 - 11 VDC
A/D resolution 14 bits
Input range 0 - 5 VDC
Housing Materials — Depth Rating — Weight
Acetal Copolymer Plastic housing — 600 meter (1950 feet) — 7.3 kg (16 lbs)
3AL-2.5V Titanium housing — 7000 meter (22,900 feet) — 13.7 kg (30 lbs)
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Mini Submersible Pump  SBE 5M 
 
 
The SBE 5M pump module consists of a centrifugal pump 
head and a long-life, DC ball bearing motor contained in a 
compact, titanium, pressure housing usable to  
10,500 meters deep. The pump impeller and electric drive 
motor are coupled magnetically through the housing, 
providing high reliability by eliminating moving seals. Motor 
speed and pumping rate remain constant over the entire 
input voltage range. The motor drive electronics is 
intrinsically protected against accidental reversed polarity. 
 
 
APPLICATIONS 
 
The SBE 5M is standard on the SBE 19 and 19plus 
SEACAT Profiler CTD. It is optional on the SBE 16, 16plus, 
and 16plus-IM SEACAT C-T Recorder. The pump flushes 
water through the conductivity cell at a constant rate, 
independent of the CTD's motion, improving dynamic 
performance. For applications requiring pumping through 
additional sensors (for example, a dissolved oxygen 
sensor), use the SBE 5T pump instead. 
 
Specify: 
• Option 5M-1 for profiling (continuous duty) applications 

such as the SBE 19plus. 
• Option 5M-2 for moored (pulsed duty) applications such 

as the SBE 16plus or 16plus-IM. 
Contact Sea-Bird for use in other applications. 
 
SPECIFICATIONS 
 
Option 5M-1 (continuous duty):  
Input voltage range 9 - 18 VDC  
 
Flow Rate 25 ml/s supply current 95 ma 
 
Note: Supply current is independent of operating voltage. 
 
 
Option 5M-2 (pulsed duty):  
Input voltage range 6 - 18 VDC  
 
Pulse Duration Flow Volume Electrical Charge 

0.5 seconds 15 ml 0.148 amp-seconds 
1.0 seconds 21 ml 0.283 amp-seconds 
1.5 seconds 31 ml 0.418 amp-seconds 
2.0 seconds 40 ml 0.553 amp-seconds 
 
 
 
 
Weight 
In Air: 0.42 kg (0.91 lbs) 
In Water: 0.28 kg (0.60 lbs) 
 06/03 

Optional  
wet-pluggable 
connector, 
MCBH-2MTI 
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SBE 5M MINI SUBMERSIBLE PUMP CONFIGURATION SHEET

Serial Number:

Job Number:

Customer:

Delivery Date:

Single Connector Housing with Titanium screws

Pressure Case:  10,500 meters (titanium)

Maxon Motor Type:

P/N 90337, Motor PN 20130 (Low power 6 VDC, 2000 RPM MAX)

P/N 90335, Motor PN 20130 (Low power 9 VDC, 2000 RPM MAX)

0649

36026

NOAA/PMC

6/14/2004

Vin 15V voltage across C2: VDC      Current mA7.947 11.8

Vin 9V voltage across C2: VDC      Current mA7.948 11.0

Vin 6V voltage across C2: VDC      Current mA5.868 10.2

Pump submerged test, no load, Vin 12VDC Average current draw in water: 124 mA
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LEICA NA2 • NAK2

Universal automatic level



LEICA NA2 
The classical level from Leica Geosystems

The NA2 universal auto-
matic level meets all
requirements regarding
precision, convenience 
and reliability.

It was designed by sur-
veyors and development
engineers with years of
experience and who know
what a field instrument 
has to be able to do.

The NA2 soon pays for 
itself, because it can be
used for all types of sur-
veying job; on building
sites for routine levelling, 
in engineering projects, 
and for geodetic control at
all levels of accuracy.

Universal application

• Levelling of all types and
all orders of accuracy

• Precise levelling and
settlement determinations
on buildings

• Routine heighting for 
the construction of roads,
railways, pipelines,
tunnels and so forth

• Setting-out work and
control measurements on
the construction site

• Area levelling of high
accuracy

• Tacheometric levelling
with the K-version on flat
terrain by combining 
stadia and angular meas-
urements with height 
readings

• Deformation measure-
ment and monitoring of
bridges



Quickly set up, simple to use

Strong tripods

In principle, the NA2 
can be set up on any Leica
Geosystems tripod. In
practice, for all-round
purposes, we recommend
the heavy-duty GST20
telescopic-leg tripod. 
For precise levelling the
GST40 fixed-leg tripod 
is suitable because of its
extreme rigidity.

The modular relationship
between instrument and
tripod is an advantage
when transport space is
limited.

Centring is easy

The circular level only
needs to be centred
approximately to bring the
compensator well into its
working range of ~30', and
so setting-up goes quicker. 

The bubble is viewed
positively via a pentaprism
and is monitored down 
the eyepiece.

Play-free footscrews

The pitch of the smooth-
running and backlash-free
footscrews is such that 
the bubble can be centred
in a very short time.

Independent of 
temperature

Unlike the tubular level of 
a traditional instrument, the
NA2 universal automatic
level is relatively insensitive
to direct solar radiation 
and an umbrella need only 
be considered for the most
precise levelling. 

Open sight

Rapid / fine focusing knob

Pentaprism for viewing circular level

Endless horizontal drive

Footscrew

Push-button for compensator control

Endless horizontal drive

Footscrew



Adjust the line of sight automatically

Easy to level up

The advantage of this
instrument is that, as soon
as the bubble is centred,
the line of sight is horizontal
for all pointings of the
telescope. The observer is
freed of the time-consuming
centring procedure involved
with the traditional tubular
level, and can concentrate
on the business of staff
readings.

Minimum maintenance

In the unlikely event that
the compensator is
damaged (and this can only
happen as a result of
extremely harsh treatment)
it is replaced easily, being
held only by three screws.

NA2/NAK2 compensator

1 Suspension tapes
2 Prism (fixed)
3 Compensator body
4 Pendulum with prism
5 Line of sight
6 Push-button
7 Spring which taps pendulum
8 Pneumatic damping mechanism

Push-button control –
added security

With most automatics one
taps the tripod or instru-
ment to check if the com-
pensator is functioning.
Leica Geosystems offers a
far more sophisticated
solution.

Pressing the button under
the NA2 eyepiece gives the
compensator a gentle tap,
so that you see the staff
image swing smoothly

away and then float gently
back to give the horizontal
line of sight. This check,
which takes less than 
a second, is technically
perfect, as the pendulum
itself is activated and
swings through its full
range. It is also immediately
apparent if the bubble 
is not centred.

Robust and automatic

The compensator is
essentially a pendulum 
with a prism (4). 

The suspension system
comprises four flexed 
tapes (1) made of a special
alloy to ensure faultless
functioning even at extreme
temperatures. The compen-
sator, which is located
between the focusing lens
and the crosshair reticle, 
is pneumatically damped
against mechanical vibra-
tion and is screened against
magnetic fields.



Top-class optics

Top-class optics

The telescope is of excellent
quality and gives a bright,
high-contrast, erect image,
even in poor light – an
essential for accurate
levelling. With the standard
eyepiece the magnification
is 32×, the optimum for
most applications of the
instrument. Optional
eyepieces are available; the
40× may be preferred for
precise levelling, the 25×
in hot, shimmer conditions.
Eyepiece exchange takes
only a second or so.

The focusing knob has a
coarse/fine movement:
– coarse, for rapid setting

with minimum turning
– fine, for the final delicate

touch to give the perfect
image.

Fatigue-free viewing

The reticle has:
– a single horizontal hair

for reading normal staffs
– a wedge-shaped hair for

use with invar staffs
– stadia hairs for distance

measurement and three-
wire levelling.

The general layout of 
the controls, the smooth
friction-braked rotation 
of the instrument, and the
endless horizontal drive
with bilateral knobs, 
all combine to make the
instrument easy to use.

At an advantage on 
unstable ground

If a tubular level is used 
on unstable ground it tilts
out of range and has to be
continuously reset. By
contrast, the pendulum of
the NA2 “compensates”
and keeps the line of sight
horizontal.

Angle measurement 
with the NAK2

Civil engineers and contrac-
tors often require a circle
for angle measurement 
and setting-out work. Even
simple detail surveys, by
taking angle, distance and
height, and plotting with
the polar method, can be
done with a level.

The model NAK2 has an
internal glass circle which
is read via a scale micro-
scope and which can be set
to any value by turning 
the rim around the base 
of the instrument.

NA2 field of view with metric levelling staff
Reading at horizontal hair: 1.143 m

NAK2 
circle reading (400 gon)

392.66 gon

NAK2 
circle reading (360°) 

314°42'



High-performance accessories for precise levelling

GPM3 
parallel-plate micrometer

This optional accessory
slips over the telescope
objective and blends
perfectly with the smooth
lines of the NA2. With 
a compensator setting
accuracy of ±0.3“ (equiva-
lent to 0.01 mm in 10 m)
and a micrometer reading
to 0.1 mm direct and 
0.01 mm by estimation, the
NA2 with GPM3 is an ideal
combination for precise
levelling, deformation 
studies, and even optical
tooling. The micrometer
drive for raising and lower-
ing the line of sight is con-
veniently located and read-
ings are taken on a glass
scale viewed through an
eyepiece just above the
telescope eyepiece. This
optical reading system,
which is digital apart from
the last and estimated
figure in the metric and
inch versions, is superior 
to the usual metal drum
system.

GPM6 
parallel-plate micrometer

There are tasks for which 
a micrometer is needed, 
yet for which the very high
accuracy of the GPM3 is 
not essential. 

To meet this requirement, 
a simpler micrometer
attachment, the GPM6 
with drum reading, 
is available for the NA2.

The GPM6 fits on to the
telescope objective in the
same manner as the GPM3,
but the graduation is
engraved on a metal drum.

Eyepiece accessories for
specialized tasks

Because of the bayonet
fastening of the inter-
changeable eyepiece, all
theodolite eyepiece acces-
sories can be used with 
the NA2.

• Diagonal eyepiece for
observing from above,
below, and from the side;
useful in cramped spaces

• Eyepiece lamp for con-
verting the NA2 into 
a horizontal collimator 
for laboratory work

• Autocollimation eye-
piece for setting machine 
parts and instrument 
components precisely
vertical



Precise

Reliable, automatic, 
maintenance-free

Easy handling

Quick levelling-up

Superb telescope

Abundant accessories; 
many applications

Effortless focusing

The rugged NA2 is indifferent
to weather conditions and 
is extremely reliable in the
rough world of the building
site. The pendulum compen-
sator is protected against
knocks and shocks. There is
a highly-effective vibration-
damping mechanism.

The high setting accuracy
ensures that the line of
sight stays put. The attach-
able parallel-plate micro-
meter renders the NA2 
ideal for precise fine 
levelling.

The instantaneous check
facility with the push-button
control not only makes 
work easier; it also
promotes confidence.

The convenient, well-
arranged controls are
designed for maximum 
convenience. The bilateral,
endless horizontal 
drive promotes rapid 
fine-pointing.

The instrument is quickly 
set up with the three rapid-
action footscrews. Their 
self-adjusting threads 
make subsequent resetting
unnecessary.

Telescope with excellently-
corrected optics for bright,
high-contrast images. 
All optical components are
coated on both sides.

The erect image seen down
the telescope is quickly 
and accurately brought into
focus with the convenient
rapid and fine focusing
knob.

Additional items such as 
the parallel-plate micro-
meter, the laser eyepiece, 
or theodolite eyepiece
accessories, offer almost
unlimited possibilities.

Compact



LEICA NA2 • NAK2
Proven reliability ensures precise results

Versatile accessories for
demonstrable success

A comprehensive program
of accessories enables you
to expand the performance
and applications range 
of each instrument. 
This way, you can match 
your equipment exactly 
to requirements. 

The possibilities are
described in brochure
“Survey accessories” 
710 883en.

Total Quality Management – 
Our commitment to total 
customer satisfaction

Ask your local Leica
Geosystems agent for 
more information 
about our TQM program.

Illustrations, descriptions, and technical data are not binding and may be changed.
Printed in Switzerland – Copyright Leica Geosystems AG, Heerbrugg, Switzerland, 1999
710 837en – V.03 – RDV

Technical data

Standard deviation for 1 km double-run 
levelling, depending on type of staff and on 
procedure up to 0.7 mm
With parallel-plate micrometer 0.3 mm

Telescope erect image
Standard eyepiece 32×
FOK73 eyepiece (optional) 40×
FOK117 (optional) 25×
Clear objective aperture 45 mm
Field of view at 100 m 2.2 m
Shortest focusing distance 1.6 m
Multiplication factor 100
Additive constant 0

Working range of compensator ~30’
Setting accuracy of compensator (stand. dev.) 0.3“
Sensitivity of circular level 8’/2 mm

Glass circle (K version) 400 gon (360°)
Graduation diameter 70 mm
Graduation interval 1 gon (1°)
Reading by estimation to 10 mgon (1’)

Water- and dust resistance IP53

Temperature range:
Operation –20°C to +50°C (– 4°F to 122°F)
Storage –40°C to +70°C (–40°F to 158°F)

Parallel-plate micrometer Range Interval Estimation
(optional accessory)

GPM3, with glass scale 10 mm 0.1 mm 0.01 mm

GPM6, with metal drum 10 mm 0.2 mm 0.05 mm

Robust container for 
safe transport

The NA2 is supplied in a
foam-padded container
made of high performance
synthetic material. The
foam padding absorbs all
jolts and shocks. The
container provides perfect
protection for the NA2.

ISO 9001 / ISO 14001

Leica Geosystems AG
CH-9435 Heerbrugg

(Switzerland)
Phone +41 71 727 31 31

Fax +41 71 727 46 73
www.leica-geosystems.com
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PDL

Positioning Data Link™

19,200 Baud Rate
Higher Over-the -Air Link Rate

Extends Your Battery Life

Enhanced User Interface
Change Channels in the Field

View Status Information

Compatible with GPS
RTK Equipment

Worldwide
Complete Kit Solutions Available

for Your Application

Reliable
Rugged, All Season Operation

2 Year Warranty
Lower Cost of Ownership

High Performance
Data Link

Designed for Survey Systems

Surveyors utilizing Global Positioning Systems require a rugged radio
modem data link for precise positioning information. The PDL is compact
and lightweight and offers power efficient operation. It is easy to use, and
provides high performance and rugged dependability for the toughest
survey environments.

PDL Products are designed to easily mount on all standard tripods and
range poles. Complete kit solutions are available.

™



RF Power Select	 	 Low/High. 		 			Factory Programmable. 	 	 	N/A.

External
Internal Battery 	 	 N/A 	 	 	 	 	 N/A. 	 	 	 	 	 Lithium Ion Battery Pack.
During TX (nominal) 		 110 Watts.	 	 	 	 11 Watts. 		 	 	 	 N/A.
During RX (nominal) 		 1.9 Watts.		 	 	 	 0.9 Watts. 	 	 	 	 0.3 Watts.
Antenna
External 		 	 50 Ohm, BNC.	 	 	 	 50 Ohm, NMO.	 	 	 	 50 Ohm, NMO.
Modem Specifications
Link Rate/Modulation

Hamming Code (12, 8) with Data Interleaving.

On/Off Button.

Digital Display.
Modem/Power Status Indicators.
RF Power Select  Toggle Switch.

19,200 bps/4 Level FSK.

9600 bps/GMSK.
4800 bps/GMSK.

RoverHigh Power Base

3 Wire, RS-232, 38.4k Baud Maximum.

ANSI/ASAE EP455.

990 Richard Avenue, Suite 110, Santa Clara, CA 95050
1-800-795-1001, Tel: 408-653-2070, Fax: 408-748-9984
Web: www.paccrst.com, E-mail: sales@paccrst.com
©2000 Pacific Crest Corporation.
License required prior to operation of radio communication equipment. Specifications subject to change without prior notice.
TRIMTALK™ is a trademark of Trimble Navigation Limited. M00526-9/02

Positioning Data Link™

Refer to price list for available frequency bands.

Synthesized 12.5k Hertz Resolution.
±2.5 ppm Stability.

-116 dBm (12 dB SINAD).
>-70 dB at 9600 bps/GMSK.
>-60 dB at 19,000 bps/4 Level FSK.

-22     to +140    F (-30   to +60   C).
-67     to +185    F (-55   to +85   C).

IEC 60529 I.P. 66.
Water Tight and Dust Proof.

9 – 16 VDC.

Low Power Base

Transparent, Packet Switched, Digipeater,
TRIMTALK.™

Transparent, Packet Switched, Digipeater,
TRIMTALK.™

Transparent, Packet Switched, TRIMTALK.™

6.23" W x 2.77" H x 6.58" L.
(15.8 cm W x 7.0 cm H x 16.7 cm L).

8.25" L x 2.40" Diameter.
(21.0 cm L x 6.1 cm Diameter).

8.25" L x 2.40" Diameter.
(21.0 cm L x 6.1 cm Diameter).

All models are type accepted and certified for operation in the U.S. and Canada.
For detailed information concerning your country's type certification, please contact your sales representative.

On/Off Button.

Digital Display.
Modem/Power Status Indicators.

On/Off Button.

Digital Display.
Modem/Power Status Indicators.

-4   to +140   F (-20   to +85   C).
-4   to +185   F (-20   to +85   C).

General Specifications
DTE – DCE Interface
User Interface

Power

Link Protocols

Forward Error Correction
Radio Specifications
Frequency Bands
Frequency Control

Sensitivity
Adjacent Channel Selectivity

Type Certification

Environmental Specifications
Operating Temperature
Storage Temperature
Vibration/Shock
Enclosure

Mechanical Specifications
Dimensions

Weight 	 	 	 2.96 lbs. (1.34 Kg).	 					 	 	 	 0.65 lbs. (0.30 Kg). 	  	 	 	 	0.75 lbs. (0.34 Kg).
Data/Power Connector	 5 Pin LEMO #1 Shell. 				 	 	 	 5 Pin LEMO #0 Shell. 				 	 	 	 5 Pin LEMO #0 Shell.
Mount 	 	 	 Tripod Bracket. 	 			 	 	 	 5/8" – 11 Range Pole. 				 	 	 	 5/8" – 11 Range Pole.

Channel Button with AutoBase and AutoRover.™ ™Channel Button with AutoBase and AutoRover.™ ™Channel Button with AutoBase and AutoRover.™ ™

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

O

Antenna

Modem Specifications

RF Transmitter Output 	 3/35 Watts Maximum. 	 	 	 0.5 – 2 Watts. 	 		 	 	  	 	0 Watt (Receive Only).

>-60 dB. >-60 dB.

9600 bps/4 Level FSK.



THALES NAVIGATION

Z-XTREME
The Ashtech® Z-XtremeTM from Thales Navigation professional
products is a rugged, weather-proof, dual-frequency GPS receiver
designed to provide surveyors with cost-effective, centimeter-accurate
positions in a variety of system configurations.

The Z-Xtreme receiver begins with state-of-the-art satellite electronics
coupled with patented Z-Tracking™ to deliver the highest GPS signal
reception level.  A removable battery and flash memory card provide
enough capacity to last all day for maximum utility. Components are
completely integrated inside a weather-proof, high impact plastic
housing, ensuring your investment is safe, rain or shine. Use the easy-
to-operate interface on the front panel for important functions such as
site information entry, survey status, and set-up of RTK base stations
without the additional cost of a handheld controller. The result: 
Z-Xtreme with Instant-RTK® outperforms all other receivers in its class!

ZX-SOLUTIONS
The Z-Xtreme survey system from Thales Navigation provides a range
of solutions designed for the vast array of positioning needs – from
entry level static or kinematic post-processed surveys, all the way up
to real-time functions such as stake out. The entry level ZX-SolutionsTM

system dramatically increases your productivity for control surveys and
other post-processed applications. Add an optional kinematic kit to
make topographic feature collection more cost effective. Use Ashtech
Solutions™ software to easily process the field data, export results and

generate reports. Purchase only what you need for the job at hand
because ZX-Solutions is fully upgradeable.

ZX-SUPERSTATION
Eclipse the productivity of optical instrument stake out with a ZX-
SuperStationTM. The ZX-SuperStation is a field-to-finish GPS surveying
system that combines the Z-Xtreme receiver with a powerful data
collector and wireless modems for centimeter accuracy in real-time.
Instant-RTK gives you the ability to initialize the centimeter solution in
a fraction of the time of conventional RTK systems.  Powerful data
collection software gives you the ability to efficiently perform GPS
surveying techniques and to interface seamlessly with optical total stations.

Z-Xtreme
Survey System

INSTANT-RTK TECHNOLOGY

www.thalesnavigation.com



Z-XTREME

TECHNICAL SPECIFICATIONS

Ashtech Technology

• 12 channel all-in-view operation
• Full-wavelength carrier on L1 and L2
• Z-Tracking
• Multipath mitigation
• Dual-frequency smoothing for improved code   

differential
• Instant-RTK

Performance Figures1

Static, Rapid Static
• Horizontal: 0.005 m + 1 ppm 

(0.016ft+1ppm)
• Vertical: 0.010 m + 1 ppm 

(0.033ft + 1ppm)
Post-Processed Kinematic
• Horizontal: 0.010 m + 1 ppm 

(0.033ft + 1ppm)
• Vertical: 0.020 m + 1 ppm 

(0.065ft+1ppm)
Real-Time Code Differential Position
• <1 m (3.28 ft)
Real-Time Z Kinematic Position (Fine Mode)
• Horizontal: 0.010 m + 2 ppm

(0.033ft + 2 ppm)
• Vertical: 0.020 m + 2 ppm 

(0.065ft + 2 ppm)
• Azimuth (arc sec): 0.4 + 2.0/baseline (km)
RTK Occupation Time
• 2 seconds (typical - sub-centimeter accuracy 

with longer occupation time)
Instant-RTK Initialization
• 99.9% reliability
• Typically <2 seconds with 6 or more satellites, 

PDOP <5, baseline length <7 km (4.35 mi), 
open sky and low multipath conditions

RTK Operating Range
• Recommended: 10 km (6.21 mi)
• Maximum: 40 km (24.85 mi)

Standard Features

• 16 MB PCMCIA removable memory card
• NMEA 0183 output
• Selectable update rate from 999 sec to 10 Hz
• Event marker
• Point positioning
• 1 PPS timing signal
• Session programming

• Wide array of coordinate transformations
• Removable internal battery
• 8-character alphanumeric LED display with 4-    

button interface
• 3 function LED display - Radio,Memory, 

Satellites/Power
• Multi-function audible alarm
• Quick reference card holder
• External mount capabilities
• External power input
• 4 RS-232 ports (115200 baud max, 3   

external, 1 internal)
• 1-year warranty
• Free factory technical support

Standard Accessories

• Communications software
• Padded system bag and hard case
• RS-232 data cable
• Receiver operating manual
• Quick reference field card

Technical Data

Environmental
Z-Xtreme Receiver
• Meets MIL-STD 810E for wind driven rain  

and dust
• Operating temperature: -30° to +55°C 

(-22° to 131°F)
• Storage temperature: -40° to +85°C

(-40° to 185°F)
Geodetic 4 Antenna
• Meets IPX7 specifications for submersion
• Operating temperature: -55 to +75°C

(-40° to 149°F)
• Storage temperature: -55° to +75°C 

(-67° to 167°F)

Physical
Weight
• Receiver: 1.59 kg (3.50 lb)
• Antenna: 0.82 kg (1.81 lb)
• Battery: 0.43 kg (0.95 lb)
Dimensions
• 76.2 H x 196.85 W x 222.25 D mm 
• (0.25 H x 0.646 W x 0.729 D ft)
Power
• 10 - 28 VDC, 6.0 W

Internal battery
• Capacity: 6000 mAh
• >9 hours (typical) @  25°C (77°F)
• Operating temperature: -30° to +55°C 

(-22° to 131°F)
• Storage temperature: -40 to +60°C 

(-40° to + 140°F)

PC card
• ATA Type II PCMCIA memory card (16 MB  

standard)
• Temperature range: -40° to +85°C

(-40° to 185°F)
• Data capacity: 4500 epochs per 2 MB*
* Based on one session, eight satellites' data
and full measurements. This number can vary
significantly depending on the conditions of the
session.

Optional Features

• Real-time kinematic (base and rover modes)  
for cm-accuracy

• RTCM 2.2 (Types 1, 2, 3, 9, 16, 18, 19, 20, 
21, 22)

• Internal UHF or spread spectrum radio for 
RTK rover operations

• External UHF or spread spectrum radio for
RTK base and rover operations

• Geodetic 4 antenna ground plane kit
• Kinematic antenna kit
• Aircraft antenna kit
• AC power cable
• Choke ring antenna
• Long haul backpack kit
• All-on-a-pole kit

Optional Application Software

GPS data processing
• Ashtech Solutions

Land Surveying and Construction
• TDS Survey Pro
• Carlson SurvCE
• Ashtech Survey Control II
• Ashtech GPS Fieldmate

Mining and Land Seismic
• Ashtech Mine Surveyor II
• Ashtech Seismark II 

1 Specifications assume operation follows all the

procedures recommended in the product manual utilizing

Instant-RTK, post processing with Ashtech Solutions or

Ashtech Office Suite for Survey. High-multipath areas,

high PDOP values, low satellite visibility, and periods of

adverse atmospheric conditions and/or other adverse

circumstances will degrade system performance. All

accuracy specifications are RMS values.

Thales Navigation follows a policy of continuous product improvement; specifications and descriptions are thus subject to change without notice.
Please contact Thales Navigation for the latest product information.

© 2003 Thales Navigation, Inc. All rights reserved. Ashtech, Z-Xtreme, Instant-RTK, ZX-SuperStation, ZX-Solutions, Z-Tracking, GPS FieldMate, Survey Control II and Ashtech Solutions are trademarks
of Thales Navigation. All other product and brand names are trademarks or registered trademarks of their respective holders. Ashtech P-code GPS technology has been FGCC tested and is capable
of performing first order surveys (report available upon request).  rev(5.03)  part # 830190

Thales Navigation, Inc.
Corporate Headquarters, Santa Clara, CA, USA 
+1 408 615 5100 * Fax +1 408 615 5200
Toll Free (Sales in USA/Canada) 1 800 922 2401
Email   professionalsales@thalesnavigation.com
In Washington, DC   +1 703 476 2212 * Fax +1 703 476 2214
In South America   +56 2 234 56 43 * Fax +56 2 234 56 47
In China   +86 10 6566 9866 * Fax +86 10 6566 0246

European Headquarters, Carquefou, France  
+33 2 28 09 38 00 * Fax +33 2 28 09 39 39
Email   professionalsalesemea@thalesnavigation.com
In Germany   +49 81 6564 7930 * Fax +49 81 6564 7950
In Russia   +7 095 956 5400 * Fax +7 095 956 5360
In UK   +44 (0) 870 601 0000 * Fax +44 (0) 208 391 1672     
In the Netherlands   +31 78 61 57 988 * Fax +31 78 61 52 027
Web site   www.thalesnavigation.com



Z-Max®.Net
NETWORK GENERATION

Get Free From Operational Constraints



Z-Max.Net:
Liberate Yourself!

Z-Max.Net is the next-generation survey solution from Magellan. 
The .Net generation offers NTRIP, GPRS and RTCM V3.0 net-
work communication. Z-Max.Net delivers high accuracy and 
enhanced performance for all your survey needs.

Z-Max.Net is the most flexible GNSS surveying system  
available, offering multiple operating modes, configurations 
and communication protocols: 

n Survey in NTRIP, VRS or FKP networks.

n Select your communication mode: GSM/GPRS, UHF, unique 
combined UHF+GSM/GPRS module or external source.

n Switch seamlessly from post-processing to RTK.

n Use Z-Max.Net as a base or rover.

You can perform any GPS survey with Z-Max.Net. 

Survey with Added Freedom

The innovative design offers comfort and ease-of-use. 
Detachable modules make configuration changes and  
system upgrades simple.

You can use the intuitive keyboard or Bluetooth® wireless field 
terminal to perform any survey with added freedom. Configure 
your Z-Max.Net “all-on-the-pole” or in the comfortable 
backpack for long-duration missions.

Z-Max.Net fits your needs and frees your mind from 
technology concerns. Simply select the operating mode and 
you’re ready to go!

Get the Max Out of Your GPS

Z-Max.Net delivers the strongest RTK on the market. A com-
bination of unique technologies enables you to optimize your 
time and maximize your profit. Z-Max.Net offers two-second 
initialization, extended operation up to 50 km (30 miles) and 
cuts static data collection time by up to 50%.1 

Powered by state of the art technologies, Z-Max.Net ensures 
exceptional RTK coverage and data confidence even in  
difficult environments.

All-In-One Surveying Solution

Z-Max.Net enhances your surveying capabilities, improves 
your data quality and upgrades your deliverables with a  
comprehensive suite of software tools. FAST Survey™ field  
software simplifies data collection and real-time operation. 
GNSS Solutions™ office software provides powerful support to a 
wide range of applications, handling both real-time and  
post-processing data within the same project.

Z-Max.Net delivers survey-grade positioning on demand, 
boosts your productivity and sets you free from  
operational constraints.

Get Free From Operational Constraints



Survey Your Way
The ultra-flexible Z-Max.Net survey system lets you control 
your survey your way. It operates in a wide range of data 
formats including ultimate standards such as NTRIP  
and RTCM V3.0. 

Z-Max.Net features GSM/GPRS modem and offers a  
unique combined UHF-GSM/GPRS module supporting all  
operational configurations. Z-Max.Net is available with 
the Pacific Crest UHF data link, or the unique Magellan 
Professional UHF for high-performance and superior results 
when surveying on long baselines. 

Z-Max.Net is so flexible that data can even be  
communicated using an external radio modem like CDMA 
or EDGE when necessary. 

Whichever configuration you chose, Z-Max.Net adapts to 
your survey environment and delivers the best performance

 
Strongest RTK on the Market 

n Patented Z-Tracking™ and advanced multipath  
mitigation technologies ensure the strongest centimeter-
level position even in weak signal conditions.

n Instant-RTK® technology enhances survey 
productivity by offering two-second initialization: 
The fastest on the market.

n Magellan Professional unique LRK®, long range kinematic 
technology, combines fast, real-time centimeter-level  
positioning up to 50 km (30 miles).

n State-of-the-art Prism® technology cuts data collection  
time by as much as 50% for post-processed surveys.1 

Plus, Z-Max.Net is ready for tomorrow’s RTK networks with 
features that include GPRS, NTRIP, RTCM V3.0, VRS and FKP.

 
Increased Productivity 

Z-Max.Net is designed to increase your productivity with 
fast initialization, easy modular configuration, superior long-
range capability and reliable accuracy. Surveys are faster 
than ever in both RTK and post-processed mode.

The modular design and flexibility makes upgrades easy 
and cost-efficient, protecting your investment and ensuring 
a high return. 

Key Features and User Benefits

Maximum Simplicity
Every aspect of the Z-Max.Net survey system is designed to 
simplify the job of the surveyor.

Highly sensitive, 
multipath resistant 
antenna for strong 
signal tracking and 
quality data

Unique cable-free 
Vortex UHF 

antenna integrated 
with range pole for 
superior range and 
physical durability

Unique technology 
inside: Z-Tracking, 

Instant-RTK 
and LRK

Field-proven design 
for optimized weight 
distribution and  
effort-less operation

Unique combined 
UHF-GSM/GPRS 
module

Bluetooth wireless 
technology for 

rugged cable-free 
surveying 

Unique clip-on 
module system 
allowing quick 

and easy battery 
replacement in 

the field 

Full-day job 
battery ensuring 

more than 14 
hours work

Front panel 
keyboard interface 
for super-easy 
system set-up and 
control

Large interface 
choice for simple 
and efficient data 
up/download: USB 
port, SD-card or  
serial port 

Unique field 
terminal offer with 
MobileMapper 
CE integrated 
handheld GPS for 
multiple GIS, Nav. 
application needs

Intuitive graphical 
interface with 
FAST Survey field 
software

High technology, 
lightweight terminal 
for comfortable use: 

Large color touch 
screen, keyboard, 

SD-card, USB,
Bluetooth



State of the Art Field Terminals

Z-Max.Net offers two high-quality field terminals: the 
MobileMapper™ CE from Magellan and the classic Allegro 
CX™ from Juniper Systems Inc.® 

Features such as color touch screen, SD-card, USB and 
Bluetooth wireless technology, are included to ensure a 
robust, easy-to-use, cable-free RTK rover.

Combined with MobileMapper CE, Z-Max.Net becomes the 
only survey system on the market to include an additional 
handheld GPS for multiple application needs (GIS,  
navigation, and more). Only Z-Max.Net can offer that kind 
of advantage.

GNSS Solutions - Office Software 

GNSS Solutions is a comprehensive software package 
with all of the tools required to successfully process GPS, 
GLONASS and SBAS survey data.  Focusing on simplicity, 
the software guides you through mission preparation 
planning, processing, quality control, reporting and data 
exporting. 

FAST Survey - Field Software
FAST Survey is a graphical field software for topography  
and construction, designed to optimize the functionality and  
performance of the Z-Max.Net GNSS system. The ability to 
collect single coordinate shots, full RTK vectors, raw GNSS 
data and all data types concurrently, provides a flexible 
solution for your changing needs.

 
Power in the Palm of Your Hand

FAST Survey is both powerful and easy to use. Scaleable 
map-view screen displays points and lines as they are  
surveyed, offering large-print controls for rapid, reliable 
data collection.  Rich attributing, full editing in the field and 
export to industry-standard data formats provides true  
field-to-finish capability, saving time and effort. 

Intuitive Handling of 
Graphical Data

The innovative approach 
to presenting survey data 
in graphical and tabular 
form makes post- 
processing with GNSS 
Solutions a simple and 
enjoyable experience. 

Any collection of data can be viewed in different forms 
through simple drag and drop operations. Importing raster 
or vector map formats enables you to open background 
projects and combine them with land survey projects.

Accuracy and Reliability

GNSS Solutions can handle both real-time and post-pro-
cessing data within the same project. The software includes 
advanced blunder detection and quality analysis tools to 
ensure extremely accurate and reliable results. Loop  
closures, automatic repeat, observation analysis, automatic 
control analysis, and least-squares adjustments are integral 
components of GNSS Solutions. 

Complete Solution in the Field and at the Office



As a Z-Max.Net surveyor you are prepared for any job  
condition and ready to meet your customers’ needs. Quality, 
productivity, ease-of-use, cost-efficiency and profitability:  
Z-Max.Net delivers it all.

 
Network Generation

New communication protocols, such as NTRIP and GPRS, 
provide higher performance and lower cost access to  
differential data for RTK surveying. The number of  
correction service providers is rising and base station  
networks will expand over the coming years, transforming 
rover/base surveying to rover only. Z-Max.Net offers the 
advantage of the latest data communication standards so 
you are ready to adapt to tomorrow’s survey world.

Combined with a MobileMapper CE field terminal, Z-Max.
Net is the only survey system on the market to include an 
additional handheld GPS for multiple application needs 
(GIS, navigation and more).

Base / Rover Configuration

Z-Max.Net is the most flexible survey system on the market. 
Thanks to its wide data format compatibility (RTCM V.2.x, 
CMR/CMR+, DBEN, RTCM V3.0 and other standards).  
Z-Max.Net easily combines with your equipment and 
ensures seamless operation within any network. 

As a base, Z-Max.Net broadcasts simultaneously through 
UHF and GSM, providing 100% field coverage for the rover.

Post-Processed Surveys

Z-Max.Net performs all types of post-processed surveys 
- static, stop-&-go and kinematic - reaching unprecedented 
accuracy levels. 

Base data can come from a CORS station or any GPS 
receiver. Raw data from Z-Max.Net can also be used with 
the OPUS processing system. Whatever the source, unique 
Prism technology cuts survey data collection time by  
up to 50%1

Z-Max.Net: Flexibility in the Field



Survey Solutions Contact Information: 
In France  +33 2 28 09 38 00  n  Fax +33 2 28 09 39 39
In Germany  +49 81 6564 7930  n  Fax +49 81 6564 7950
In Russia  +7 495 956 5400  n  Fax +7 495 956 5360
In the Netherlands  +31 78 61 57 988  n  Fax +31 78 61 52 027 
Email  surveysalesemea@magellangps.com

In Singapore  +65 6235 3678 n Fax +65 6235 4869
In China  +86 10 6566 9866 n Fax +86 10 6566 0246
Email  surveysalesapac@magellangps.com
www.pro.magellanGPS.com

GNSS Characteristics 
n	24 parallel channels all-in-view
n	L1 C/A code and carrier
n	L1/L2 P-code, full wavelength carrier
n	Z-Tracking
n	Multipath mitigation
n	Integrated real-time WAAS/EGNOS
n	Update rate: 10 Hz
n	Protocol: NMEA0183

Accuracy Specifications
1-2

Static Rapid Static
n Horizontal 0.005 m + 0.5 ppm  

(0.016 ft + 0.5 ppm)
n Vertical 0.010 m + 0.5 ppm  

(0.033 ft + 0.5 ppm)

Post-Processed Kinematic
n Horizontal 0.010 m + 1.0 ppm  

(0.033 ft +1.0 ppm)
n Vertical 0.020 m + 1.0 ppm  

(0.065 ft +1.0 ppm)

Real-Time Performance
1-2

SBAS (WAAS/EGNOS) (rms)
n Horizontal: <3 m (10 ft) 
Real-Time DGPS position
n < 0.8 m (2.62 ft)
Real-Time Kinematic Position (fine mode)
n Horizontal 0.010 m + 1.0 ppm  

(0.033 ft + 1.0 ppm)
n Vertical 0.020 m + 1.0 ppm  

(0.065 ft + 1.0 ppm)
Real-Time Kinematic Position (fine mode)
n 99.9% reliability
n Typical 2 second initialization for baselines  

< 20 km

Datalogging Characteristics
Recording Interval
n 0.1 - 999 seconds

Physical Characteristics
Size
n Unit: 26.9 x 12.5 x 14 cm  

(10.6x4.9x5.5 inch)
n Antenna: 19 cm dia x 10.1 cm h  

(7.5 x 4.0 inch)

Weight
n Receiver Module: 1.371 kg (3.02 lb)
n Antenna Module: 0.64 kg (1.17 lb)
n Power Module: 0.52 kg (0.96 lb)

Front Panel
n Eight-character alphanumeric  

LED display
n 4 tri-color LEDs
n 5-key keyboard

Memory
n 48 hours of 1 sec. raw GPS data with 64 MB 

Secure digital 
n 128 MB SD card available

I/O Interface
n RS232, RS232/422, USB, Bluetooth

Environmental Characteristics
Receiver
n Operating temperature: -30° to +55°C 
  (-22° to +131°F)
n Storage temperature: -40° to +85°C 
  (-40° to +185°F)
n Meets IP54 for moisture
n Shock: 1.5 m (4.92 ft) pole drop
n Vibration: MIL-STD-810F Method 514.4  

(I-3.1.1, I-3.4.8, I-3.4.9) 

Power Characteristics
n Max-Run battery life > 14 hrs.
n 10-28 VDC input
n Regulated 12 VDC output on serial ports

Controller Language Support
n English, French, German, Spanish 

System Components
Standard
n	Z-Max.Net GNSS receiver
n	GNSS antenna
n	Power module, charger included
n	System bag
n	Hard-shell shipping case

Communication Module3

n	Magellan UHF
n	Pacific Crest
n	GSM/GPRS Tri-band
n	GSM/GPRS Dual-band (US)
n	GSM/GPRS EU + Magellan UHF
n	GSM/GPRS EU + PacCrest UHF
n	GSM/GPRS US + Magellan UHF
n	GSM/GPRS US + PacCrest UHF

Field Terminal kit with FAST Survey3

n	MobileMapper CE 
n	Allegro CX from Juniper

Other3

n	Magellan UHF transmitter kit
n	Pacific Crest transmitter kit
n	RTK rover backpack kit
n	Rechargeable battery kit

1  Performance values assume minimum of five satellites, 
  following the procedures recommended in the product 
  manual. High-multipath areas, high PDOP values and 
  periods of severe atmospheric conditions may degrade 
  performance.

2 Accuracy and TTFF specifications based on tests  
conducted in Nantes, France, and Moscow. Tests in  
different locations under different conditions may  
produce different results.

3	System composition varies depending on the  
chosen configuration

Magellan follows a policy of continuous product improvement; specifications and descriptions are thus subject to change without notice. Please contact Magellan for the latest product information.
© 2006 Magellan Navigation, Inc. All rights reserved. Z-Max, Instant-RTK, LRK, Z-Tracking, Prism, FAST Survey, GNSS Solutions and MobileMapper are trademarks of Magellan Navigation, Inc. 
All other product and brand names are trademarks of their respective holders. September 06 P/N XC20062E

Z-Max.Net Technical Specifications

Office Software Suite -  
GNSS Solutions
Key software functions include:
n	Integrated transformation and grid system 
   computations allow for processing, adjusting, 

reporting and exporting point positions in 
   user-selected or user-defined systems
n	Pre-defined datums along with user-defined 

capabilities using the 7-parameter method of 
computing and applying datum  
transformation parameters

n	Survey mission planning
n	Automatic vector processing
n	Least-squares network adjustment
n	Data analysis and quality control tools
n	Coordinate transformations
n	Reporting
n	Exporting

n	Geoid 03 
n English, Spanish, French, German language 

support

System Requirement
n	Windows 2000 / XP
n	Pentium® 133 or higher
n	32 MB RAM
n	90 MB disk space required for installation

Field Software Suite – FAST Survey
Key software functions include:
n	Map view
n	Geodetic geometry: intersection,  

azimuth/distance, offsetting,  
poly-line, curve, area

n	Z-Max.Net GPS support :  
configuration, monitoring and control

n	Coordinate system support:  
predefined grid systems, predefined datums,  
projections, Geoids, local grid

n	Data import/export: DXF, SHP, RW5,  
LandXML, …

n	Survey utilities: calculator, RW5 file viewing
n	Compatibility with optical  

surveying instruments
n	Road construction

Supported Hardware
n	MobileMapper CE
n	Juniper Allegro CX

www.ctsystems.eu   info@ctsystems.eu  +31 (0)227 - 591295
De Wieken 6     1777 HT  Hippolytushoef     The Netherlands















������ SET5F
Version 01-00

TOTAL STATION

SURVEYING INSTRUMENTS

Enhanced software with 3,000-point data memory.



Flexible, Friendly and Featherweight
The SET5F's powerful EDM, dependable dual-axis compensator and 3,000-point data memory
are conveniently packaged in a compact, lightweight body. Software [Version 01-00) has
been enhanced for more effective survey work, and "softkey" assignments can be freely
customized to suit all user needs.

Dependable
Hardware

Proven Dual-axis Compensator
•Since its introduction with the Series C
total station in 1989, Sokkia's dual-axis
compensator has proven its reliability and
accuracy at survey sites all over the world.
•The dual-axis tilt sensor monitors
deviations of both the X and Y axes and the
correct horizontal and vertical angle
readings are automatically computed and
applied. The result is easier and faster
instrument leveling.

Spacious 3,000-point Internal
Memory
•The SET5F's internal memory is large—
holding a full 3,000 data points—and
secure. For optimum convenience,
measurements can be performed and
recorded at the touch of a key.
•Up to five (5) job files can be created to
efficiently organize multiple survey tasks.
•Forty (40) feature codes (max.13 charac-
ters each) can be kept in the memory for
easy recall as needed.

The High-performing EDM
•1,500m/4,900ft range with a single prism
under good ambient conditions (40km/
25miles visibility, with no haze, overcast,
no scintillation).
•Outstanding precision;
±(3+2ppmxD)mm. This corresponds to a

deviation of a mere ±3.2mm at a distance
of 100m and ±5mm at 1,000m.
•Supreme speed; only 1.7 seconds initial
measuring time in the rapid measurement
mode.

Average Conditions Good Conditions
CP01 Compact Prism 700 m/2,300 ft.
One AP01 Prism 1,200 m/3,900 ft. 1,500 m 4,900 ft.
Three AP01 Prisms 1,600 m/5,200 ft. 2,000 m 6,500 ft.

Powerful Telescope
•Highest magnification in its class: 30x
•Easy, accurate sighting of prisms or
targets

Outstanding Mobility
•Total carrying weight (including instrument,
tribrach, battery and hard case) is a mere 8
kg/18 lbs. The secret lies in the lightest and
most compact carrying case of its kind

(W390 x D255 x
H220mm / W15.3 x
D10.0 x H8.6in.), making
the SET5F supremely

portable.
•A convenient
shoulder strap is
provided as
standard. An
optional back
pack (SC94) is
ideal for longer
day treks.

Enhanced
Software

The SET5F can be easily customized
to your preferred key assignments.
•The SET5F offers optimum keyboard
flexibility. Any keyboard layout can be
configured. For example, functions can be
assigned to any key position on any page,
and unused functions can be temporarily
deleted.
•A powerful "softkey" feature facilitates
input of coordinate values,
feature codes, etc.

Sophisticated Application Software
Missing Line Measurement (MLM)
•The SET5F measures horizontal distance,
slope distance, height difference, and slope
in percent (%) between two prisms, all at the
touch of a key.

EDM

THEO

S-O

Key assignment mode



The SET5F brings full freedom to survey work.

Remote Elevation Measurement
(REM)
•The SET5F can be used to easily
determine the height of a point where a
prism cannot be placed. The system
sights a prism directly above or below the
target point, and then sights the point
desired.

Angle Repetition
•For enhanced accuracy in the horizontal
angle measurement, the SET5F can
measure in repetition. It then calculates
and displays the average of the multiple
angle measurements.

Azimuth Angle Setting
•Using the coordinates of the instrument
station and a backlight point, the SET5F
can automatically set the horizontal angle
to the azimuth of the backlight.

Resection
•With 2 to 5 known points, the SET5F can
be used to determine the azimuth and
coordinates of the unknown instrument
station.
•When using 2 known points, both angles
and distances are measured. When
using 3 or more points, the distance does
not always have to be measured.

3-D Coordinate Measurement
•The SET5F calculates 3-D coordinate
values of measuring points.
•The operator may choose display settings
either of "N, E, Z" or "E, N, Z."

3-D Setting-out
•The SET5F can be used to perform
3-dimensional setting-out with N, E and/or
Z coordinates.

Offset Measurements
Two basic offset measurement methods
are provided to measure the hidden
points. One calls for input of the offset
distance and the direction between the
measuring point and the prism. The other
uses a prism set on the left or right side of
the measuring point at the same distance
from the SET5F; the angles and distance
to the prism are measured, and the
measuring point is sighted. In both cases,
the SET5F calculates the horizontal and
vertical angles and distance, or the N, E,
Z coordinates.



Standard Configuration
The SET5F comes with two (2) BDC25
rechargeable batteries EDC19 battery
charging adapter CDC27, CDC31 or
CDC31A quick charger, CP7 tubular
compass, sunshade, lens cap, plumb bob,
vinyl cover, tool kit, operator's manual,
carrying case and shoulder strap.

Electronic Field Books
(SDR33/SDR31)
Thanks to its advanced two-way commu-
nications port, the SET5F's functions can
all be accessed by external controller. For
example, by connecting one of the
Sokkia's acclaimed Electronic Field Books
(SDR33 or SDR31), complex field
operations such as traverse adjustment,
intersection, area calculations and roading
can be carried out with remarkable ease.

Optional Accessories
DE17A Diagonal Eyepiece
OF1/OF1A Solar Filters
SC94 Back Pack

Designs and specifications are subject to change without notice.

SOKKIA CO.,LTD.
1-1, TOMIGAYA l-CHOME, SHIBUYA-KU, TOKYO, 151 JAPAN
PHONE +81-3-3465 5211 FAX +81-3-346-5203
INTERNATIONAL DEPT. PHONE +81-3-346-5201 FAX +81-3-3465-5202

SET5F Specifications
Telescope Fully transiting, coaxial EDM
Length 165mm (6.5in)
Objective aperture 45mm (1.8in)
Magnification, image 30x, Erect
Resolving power 3.0"
Field of view 1°30'(26m/1,000m)
Minimum focus 1.3m (4.3ft.)
Reticle illumination Bright or Dim, selectable
Angle measurement Incremental encoder, diametrical detection
Display resolution H&V 1"/ 0.2 mgon/ 0.005 mil, 5"/1 mgon/ 0.02 mil
Angle unit H&V Degree/Gon/Mil
Accuracy H&V 5" (1.5 mgon/ 0.02 mil) according to DIN18723
Dual-axis compensator Liquid dual-axis tilt sensor, range: ±3' (±55 mgon)
Display mode H Clockwise/ Counterclockwise, Repetition, Oset, Hold available

V Zenith 0°/ Horizontal 0°/ Horizontal 0°±90°/ Slope%
Distance measurement Electro-optical with modulated infrared LED.
Measuring range (slope distance) A: Average conditions; slight haze, visibility about 20km(12 miles),

  sunny periods, weak scintillation.
G: Good conditions; no haze, visibility about 40km (25 miles),
  overcast, no scintillation.
Maximum ranges are achieved with Sokkia CP/AP prisms.

With CP01 compact prism A: 1.3m (4.3ft.) to 700m (2,300ft.)
With one AP01 prism A: 1.3m (4.3ft.) to 1,200m (3,900ft.), G: 1,500m (4,900ft.)
With three AP01 prism A: 1.3m (4.3ft.) to 1,600m (5,200ft.), G: 2,000m (6,500ft.)
Distance unit Meters or feet, selectable
Accuracy (Fine measurement) ±(3+2ppmxD)mm D=measuring range, unit=mm
Measuring unit and time Fine 0.001 m Every 3.2 seconds (initial 4.7 seconds)
(slope distance) Rapid 0.001 m 1.7 seconds

Tracking 0.01 m Every 0.3 seconds (initial 1.4 seconds)
Average 0.0001 m (average of 2 to 9 times measurement)

Atmospheric correction Key-in the temperature and pressure, or -499 to +499ppm.
Prism constant -99 to 0mm (1 mm steps)
Refraction & Earth-curvature On/off selectable (K=0.142)
  correction
General
Display LCD dot matrix display (20 characters x 4 lines) on both faces with

  back light.
Keyboard 5 keys on both faces, free assignment of functions.
Resume function On/off selectable
Sensitivity of levels Plate level: 40"/2mm, Circular level: 10'/2mm (in tribrach)
Optical plummet Image: erect, Magnification: 3x, Minimum focus: 0.5m (1.6ft.)
Interface Asynchronous serial, RS-232C compatible, baud rate 1200/

  9600bps
2-way communication Provided
Data storage 3,000-point data memory
Operating temperature -20°C to +50°C (-4°F to +122°F)
Tilting/Trunnion axis height 236mm (9.3in) from tribrach bottom, 193mm (7.6in) from

  tribrach dish.
Size with handle and battery W150 x D165 x H353mm, W5.9 x D6.5 x H13.9in.
Weight with handle and battery 5.4kg (11.9lbs)
Weight of parts BDC25 battery: 240g (8.5oz.), Handle: 100g (3.5oz.),

  Tribrach: 740g (1.6 lbs), Case:2.4kg (5.3lbs)
Power supplies
Battery level display 4 steps with warning message.
Automatic power cut-off On/off selectable (30 minutes after the last operation)
Power source BDC25 rechargeable battery, Ni-Cd 6V, 2 supplied as standard.
Working duration at 25°C (77°F) Distance & angle measurement: about 5 hours, about 600 points
    w/one BDC25 battery (Fine & single measurement with 30 seconds intervals).

Angle measurement only: about 9 hours.
Charging time CDC27/31: about 80 minutes, CDC31A: about 90 minutes



Appendix III 
 
 
Vessel Reports, Offsets, and Diagrams 
 
 
Launch 1010  
 

1. Offsets 
2. Patch Test 
3. DDSSM and Settlement & Squat 
4. POS Gams Calibration 
5. Wire Diagram 

 
Launch 1018 
 

1. Offsets 
2. Patch Test 
3. DDSSM and Settlement & Squat 
4. POS Gams Calibration 
5. Wire Diagram 

 
S220 
 

1. Offsets 
2. Patch Test 
3. DDSSM and Settlement & Squat 
4. POS Gams Calibration 
5. Wire Diagram 
6. Correspondence 

 



Measuring Party: Gonsalves, Glazewski, N. Morgan (2007 value used for 2008)

Date: 3/16/2007
Fuel Level: ~ 1/3 Full

Measure 1 Draft Tube: 15.2 cm

Measure 2

Measure 3 Port-to-Stbd Z-difference

Avg (cm) Theoretical Actual Error

Avg (m) 0.0327 0.0487 0.0160

Stdev

BM Z-value (m) BM C to WL Average (m)
BM C to WL (m) -0.957

1010

Waterline Measurements - 2007

-97.3

Benchmark B to Waterline

-90.4

Benchmark A to Waterline

-94.50

-0.9450 -0.8963

-89.63

-94.1 -90.0

-92.1 -88.5

0.010020.02623

-0.965 -0.949
-0.02017 -0.05283



All offsets are in the Theodolite Coordinate System
BM E x 1.665536 Port Ant x 2.316862

y -0.892424 y -0.886431
z 1.612667 z Unknown

BM F x 1.668082 Stbd Ant x 2.324270
y -0.001217 y 0.952574
z 1.649000 z Unknown

BM G x 1.668115
y 0.957794
z 1.578000

Measuring Party (fill in yellow spaces only): Date:
Breen 4/15/2008

z-Values
Distances Ant. Base Phase Center
Port Ant to BM 'E' 0.691 0.691 0.693 0.70443 1.880922 1.926922
Port Ant to BM 'F' 1.111 1.108 1.11 1.12243 1.884225 1.930225
Port Ant to BM 'G' 1.97 1.963 1.968 1.979764 1.890128 1.936128

1.882574 1.928574 AVERAGE
0.0047 STDEV

Stbd Ant to BM 'E' 1.961 1.962 1.963 1.974764 1.861152 1.907152
Stbd Ant to BM 'F' 1.156 1.166 1.163 1.17443 1.846452 1.892452
Stbd Ant to BM 'G' 0.702 0.705 0.702 0.715764 1.863920 1.909920

1.855186 1.901186 AVERAGE
Antenna Post Diameter Radius 0.0094 STDEV

0.025527 0.012764

This spreadsheet is designed to compute the z-values of the phase centers 
of the new POS M/V antenna.

The distances from the antenna post to each benchmark was measured 
three times and averaged. The post offset to phase center (radius) was 
then added.

The distance is 0.046m (4.60cm) from the bottom of 
the antenna to the Phase center, obtained from the 
POSM/V v4 guide, see image above. 
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Date DN

Offset Measurements (positive cm): Average Angle Bias (deg):
Bow-Stern 10.1 10.2 10.4 10.2 Bow Up -1.4
Port-Stbd 15.1 15.2 15.7 15.3 Port Up -1.8
Up-Down 36.0 36.4 36.5 36.3 The measuring crew should

 insure there will be no yaw bias.
BM H to Phase Center IMU to Phase Center

(Theodolite Coordinate System) (CARIS Coordinate System)

x 11.105 cm x 0.250 m

y -16.466 cm y -0.133 m

z -35.540 cm z 0.549 m

Breen
Personnel

Offsets from Aft Benchmark to Phase Center of Transducer

4/15/2008 1010
Vessel

Instructions:  The purpose of this measurement is to check for 
gross movement of the tranducer.  

While the boat is in the cradle, gently lower the transducer and 
lock it in place.  Using a metric tape measure, plumb bob and 
carpenter's level, measure the horizontal and vertical offsets from 
the aft benchmark (BM H) to the phase center of the transducer.  
The phase center is measured at the forward edge of the black 
insulating layer, as shown in the photos.  If you have trouble 
locating the center, borrow a compass from the navigation 
department.

Notwithstanding a major accident, BM H will be outboard, aft and 
higher than the phase center; as such, enter all offsets as positive
numbers (in cm) and the proper signs will be applied.  

Once offsets have been measured, apply a digital level to the 
IMU to determine any pitch or roll bias in the orientation of the 
launch.  For the purposes of this spreadsheet, a positive angle 
(measured in degrees) will imply the bow is higher than the stern 
and the port side is higher than the starboard side.

All measurements should be done in triplicate to aid in the 
calculation of the uncertainty (needed in the HVF).  The IMU to 
Phase Center  values will be calculated automatically.

BM 



BM 'H' to Phase Center (POS M/V Coordinate system)
Rotation about x-axis Original vector Rotation angles

1 0 0 10.2 x-axis 1.8 Note:  A positive angle will raise the port-side.
0 Cos(x-angle) -Sin(x-angle) -15.3 y-axis 1.4 Note:  A positive angle will raise the bow.
0 Sin(x-angle) Cos(x-angle) 36.3 z-axis 0 Note:  The measuring crew should insure there will be no yaw bias.

Rotation about y-axis Rotated about x-axis BM 'H' to Phase Center (POS M/V Coordinate system)
Cos(y-angle) 0 Sin(y-angle) 10.233 Newly rotated vector

0 1 0 -16.466 11.10
-Sin(y-angle) 0 Cos(y-angle) 35.800 -16.47

35.54
Rotation about z-axis Rotated about y-axis
Cos(z-angle) -Sin(z-angle) 0 11.105
Sin(z-angle) Cos(z-angle) 0 -16.466

0 0 1 35.540

Rotated about z-axis
11.105

-16.466
35.540

* - Valid for a right-handed (i.e. POS M/V) coordinate system
Angles are rotated clockwise when looking from the origin along the positive axis.

Note:  The traditional rotation matrices require a 
right-handed coordinate system.  Thus, behind-the-
scenes, all numbers have been converted to the 
POS M/V Coordinate system.



1010
IMU BM H IMU to BM H

x 3.515566 3.271447 -0.244119
y 0.010709 0.425598 0.41489
z -1.183 -1.376667 -0.193667

IMU to PC = (IMU to BM H) + (BM H to PC/100)

Using the XYZ positions of the IMU and BM H from the launch Offsets & Measurements  form located in the 
DAPR appendix, the offset from the IMU to BM H could be calculated, as shown above.  The measured offsets 
from BM H to the phase center of the transducer are divided by 100 to convert to meters, then added to the offset 
from the IMU to BM H.  The result is the offset from the IMU to the phase center of the transducer.  The values in 
the X and Y fields are transposed and the inverse of the Z value is used to give the offsets in CARIS coordinates.



 1010 Offsets and Measurements - Summary

Measurement IMU to RP* 8101 to RP*
aka
Coord. Sys. Caris Caris Caris Caris Caris
x 0.000 0.250 0.250 1.147 n/a
y 0.000 -0.133 -0.133 1.066 n/a
z 0.000 0.549 0.549 3.661 -0.243

*IMU is RP (Reference Pt)

Vessel Offsets for 1010_8101 are derived from the Horizontal, Vertical & XYZ worksheets in this spreadsheet. 2008 Measured Values

Coord. Sys.
Theodolite IMU (m) x 3.516 IMU (m) x 3.516 IMU (m) x 3.516

y 0.011 y 0.011 y 0.011
z -1.183 z -1.183 z -1.183

BM H x 3.271447 Port Antenna x 2.317 BM C x 0.000
y 0.425598 y -0.886 y 0.000
z -1.37667 z 1.929 z 0.000

IMU x -0.244 IMU to x -1.199 BM C to IMU
to BM H y 0.415 Port Antenna y -0.897 x n/a

z -0.194 z 3.112 y n/a
z -1.183

BM H to x 11.10496 IMU to x -0.133
Phase Ctr (cm)   y -16.466 Phase Ctr y 0.250 BM C to Waterline
measured z -35.540 z -0.549 measured x n/a

y n/a
BM H to x 0.11105 z -0.940
Phase Ctr (m)     y -0.16466

z -0.3554
see 

Coord. Sys.
Theodolite IMU to x -0.133 x 1.066 x n/a

Phase Ctr y 0.250 y 1.147 y n/a
z -0.549 z -3.661 z 0.243

Coord. Sys. CARIS Coord. Sys. CARIS Coord. Sys. CARIS
x 0.250 x 1.147 x n/a
y -0.133 y 1.066 y n/a
z 0.549 z 3.661 z -0.243

Port Ant to 8101

Port Ant to 8101

IMU to 8101

8101 to RP* IMU to 8101
Calculations

Nav to Trans x,y,zSWATH1 x,y,z  & MRU to Trans
RP* to Waterline

RP to Waterline

RP to WaterlineIMU to 8101 IMU to 8101 Port Ant to 8101



 1010 Offsets and Measurements - Summary

Caris Pos/Mv Caris Pos/Mv
Scalar Distance 1.839 -0.897 -1.199 -0.011 -1.176

-1.199 -0.897 -1.176 -0.011
-3.112 -3.112 -0.243 -0.243

2007 Measured Values

Port Ant (m) x 2.317 IMU (m) x 3.516 IMU (m) y 0.011
y -0.886 y 0.011 x is n/a z -1.183
z 1.929 z -1.183

Heave Pt (m)
Stbd Ant (m) x 2.324 Port Ant (m) x 2.317 (centerline) y 0.000

y 0.953 y -0.886
z 1.901 z 1.929 BM C to Waterline (m) -0.940

measured scalar dist 

BM C
x&y are n/a z 0.000

BM C to Waterline (m)
(Heave Pt) z -0.940

IMU to LCG x -1.176
See IMU to Heave tab

x -1.199 x -1.176
Scalar Distance 1.839 y -0.897 y -0.011

z 3.112 z 0.243

Coord. Sys. Pos/Mv Coord. Sys. Pos/Mv
x -1.199 x -1.176
y -0.897 y -0.011
z -3.112 z -0.243

See IMU to Heave tab

IMU to Heave

IMU to Port Antenna IMU to Heave

Port Ant to Stbd Ant

Port Ant to Stbd Ant

IMU to Port Antenna

Port Ant to Stbd Ant IMU to Port Antenna IMU to Heave



Description of Offsets for Launch 1010
All Values Shown are in CARIS Coordinates

The Ship Reference Frame (SRF) for Launch 1010 was based from benchmark (BM) C as the 0 point.  Physical locations were measured with x,y,z offsets 
from this point.  These locations were used to calculate offsets of items with respect to each other, as described for each offset.

x=0.250

z=0.549

z=3.667

x=1.144

z=-3.112

x=-0.897
1.839

z=-0.243
x=-0.011

z=0.549

y=-0.133

z=3.661

y=1.066

z=-0.243

z=-3.112

y=-1.199

z=-0.243
y=-1.176



x y z x y z x y z x y z x y z
0.250 -0.133 0.549 1.147 1.066 3.661 N/A N/A -0.243 -0.897 -1.199 -3.112 -0.011 -1.176 -0.243

IMU to 8101 Port Ant to 8101 RP to Waterline Port Ant to Stbd Ant IMU to Port Antenna IMU to Heave
Scalar Distance

1.839

The physical positions of the 
IMU and the phase center of the 
8101 with respect to the Ship 
Reference Frame were 
measured by NOAA personnel.  
These physical measurements 
were used to calculate the xyz 
offsets from the IMU to BM H. 
Measurements from BM H to the 
Phase Center of the 8101 were 
collected by NOAA personnel 
while the boat was secured on 
the pier and thought to be as 
level as possible.  The measured 
offsets from BM H to the phase 
center were then added to the 
offset from the IMU to BM H.  
The result is the offset from the 
IMU to the phase center of the 
transducer.  The values in the X 
and Y fields are transposed and 
the inverse of the Z value is used 
to give the offsets in CARIS 
coordinates.

NOAA personnel calculated the 
distance between the port 
antenna and the phase center of 
the port antenna subtracting  the 
IMU to Port Antenna value from 
the IMU to Phase Center value.   

The average vertical distance 
from BM A and B to the waterline 
was measured by 
FAIRWEATHER personnel using 
a steel tape and bubble level.  
These values were used to 
calculate the BM C to the 
waterline value.  With the 
knowledge of the BM C height 
above the IMU, the waterline 
height above the IMU could be 
calculated.  On launch 1010, the 
IMU is used as the reference 
point.  

The location of the IMU and the 
location of the port antenna were 
measured by NOAA personnel 
with respect to the Ship 
Reference Frame (SRF).  The 
xyz offsets from the IMU to the 
port antenna could be calculated 
from these physical locations. 

The heave point was positioned 
differently on each of the axes.  
The distance for the 
longitundinal axis was 
determined as described in the 
"IMU to Heave" tab in this 
workbook.  The athwart ships 
axis was the vessel centerline.  
Lastly, the waterline was used as 
the height of the heave point, 
which was calculated earlier in 
'RP to Waterline'.  

The location of the phase center 
of the port and starboard 
POS/MV antennas were 
measured by NOAA personnel 
with respect to the SRF.  The 
scalar distance between the 
phase centers was then 
calculated. 



1010 Vessel Diagram
All Values Shown are in Theodolite Coordinates

Note:   Both antenna have been replaced for the POS 
V4.  While their x-y values are not thought to have 
changed, the z-value has been remeasured.





 1010 Offsets and Measurements - Horizontal

BM CT BS BM A m S DD dA Hd Vd BM A
X 5.123977 HA 11 2 35 191.0431 5.22883 -1.793911 X -0.0080
Y -0.000827 VA 108 56 10 108.9361 -18.93611 Y -1.0024
Z 0.845 SDx 5.528 Z -0.0229

HI 1.031
HT 0.105

BM CT BS BM A m S DD dA Hd Vd BM A
X 5.123977 HA 11 2 50 191.0472 5.223191 0.091931 X -0.0024
Y -0.000827 VA 88 59 30 88.99167 1.008333 Y -1.0017
Z 0.845 SDx 5.224 Z -0.0351

HI 1.028
HT 2

BM CT BS BM B m S DD dA Hd Vd BM B
X 5.123977 HA 348 57 40 168.9611 5.227332 -1.825751 X -0.0066
Y -0.000827 VA 109 15 10 109.2528 -19.25278 Y 1.0001
Z 0.845 SDx 5.537 Z -0.0548

HI 1.031
HT 0.105

BM CT BS BM B m S DD dA Hd Vd BM B
X 5.123977 HA 348 57 20 168.9556 5.22166 0.05962 X -0.0010
Y -0.000827 VA 89 20 45 89.34583 0.654167 Y 0.9995
Z 0.845 SDx 5.222 Z -0.0674

HI 1.028
HT 2

BM CT BS BM C m S DD dA Hd Vd BM C
X 5.12892 HA 180 0 0 180 5.128883 -1.773947 X 0.0000
Y 0 VA 109 4 45 109.0792 -19.07917 Y 0.0000
Z 0.847926 SDx 5.427 Z 0.0000

HI 1.031
HT 0.105

BM CT BS BM C m S DD dA Hd Vd BM C
X 5.1257 HA 0 0 0 180 5.125747 0.113336 X 0.0000
Y 0 VA 88 44 0 88.73333 1.266667 Y 0.0000
Z 0.8586 SDx 5.127 Z -0.0001

HI 1.028
HT 2

BM F BS BM D m S DD dA Hd Vd BM D
X 1.668082 HA 0 0 0 0 5.249724 -1.383634 X 6.9178
Y -0.001217 VA 104 45 55 104.7653 -14.76528 Y -0.0012
Z 1.649 SDx 5.429 Z 0.3394

HI 1.234
HT 1.16

BM C BS BM D m S DD dA Hd Vd BM D
X 0 HA 0 0 0 0 6.906514 0.342484 X 6.9065
Y 0 VA 87 9 40 87.16111 2.838889 Y 0.0000
Z 0 SDx 6.915 Z 0.3805

HI 1.225
HT 1.187

BM CT BS BM D m S DD dA Hd Vd BM D
X 5.123977 HA 180 1 25 0.023611 1.782119 -1.402809 X 6.9061
Y -0.000827 VA 128 12 30 128.2083 -38.20833 Y -0.0001
Z 0.845 SDx 2.268 Z 0.3932

HI 1.031
HT 0.08

BM CT BS BM D m S DD dA Hd Vd BM D
X 5.123977 HA 180 1 35 0.026389 1.800322 0.049414 X 6.9243
Y -0.000827 VA 88 25 40 88.42778 1.572222 Y 0.0000
Z 0.845 SDx 1.801 Z 0.3724

HI 1.028
HT 1.55

TBM 2 BS BM D m S DD dA Hd Vd BM D
X 18.8276 HA 2 4 10 182.0694 11.91991 2.88893 X 6.9154
Y 0.4290 VA 76 22 35 76.37639 13.62361 Y -0.0014
Z -2.1960 SDx 12.265 Z 0.3759

HI 1.233
HT 1.55

All offsets are in Theodolite Coordinate System



 1010 Offsets and Measurements - Horizontal
BM CT BS BM E m S DD dA Hd Vd BM E

X 5.123977 HA 14 27 40 194.4611 3.568662 -0.176011 X 1.6684
Y -0.000827 VA 92 49 25 92.82361 -2.823611 Y -0.8920
Z 0.845 SDx 3.573 Z 1.6200

HI 1.031
HT 0.08

BM CT BS BM E m S DD dA Hd Vd BM E
X 5.123977 HA 14 27 5 194.4514 3.57438 1.278054 X 1.6627
Y -0.000827 VA 70 19 30 70.325 19.675 Y -0.8928
Z 0.845 SDx 3.796 Z 1.6011

HI 1.028
HT 1.55

TBM CT BS BM F m S DD dA Hd Vd BM F
X 5.123977 HA 180 0 0 180 3.456432 -0.062679 X 1.6675
Y -0.000827 VA 91 2 20 91.03889 -1.038889 Y -0.0008
Z 0.845 SDx 3.457 Z 1.6433

HI 0.941
HT 0.08

BM CT BS BM F m S DD dA Hd Vd BM F
X 5.123977 HA 0 1 10 180.0194 3.448108 -0.141253 X 1.6759
Y -0.000827 VA 92 20 45 92.34583 -2.345833 Y -0.0020
Z 0.845 SDx 3.451 Z 1.6547

HI 1.031
HT 0.08

BM CT BS BM F m S DD dA Hd Vd BM F
X 5.123977 HA 0 0 0 180 3.463146 1.316679 X 1.6608
Y -0.000827 VA 69 11 0 69.18333 20.81667 Y -0.0008
Z 0.845 SDx 3.705 Z 1.6397

HI 1.028
HT 1.55

BM CT BS BM G m S DD dA Hd Vd BM G
X 5.123977 HA 344 29 55 164.4986 3.578828 -0.210271 X 1.6753
Y -0.000827 VA 93 21 45 93.3625 -3.3625 Y 0.9557
Z 0.845 SDx 3.585 Z 1.5857

HI 1.031
HT 0.08

BM CT BS BM G m S DD dA Hd Vd BM G
X 5.123977 HA 344 29 40 164.4944 3.593882 1.243713 X 1.6609
Y -0.000827 VA 70 54 40 70.91111 19.08889 Y 0.9599
Z 0.845 SDx 3.803 Z 1.5667

HI 1.028
HT 1.55

TBM2 BS BM H m S DD dA Hd Vd BM H
X 18.8276 HA 180 0 0 180 15.55637 -0.418679 X 3.2712
Y 0.4290 VA 91 32 30 91.54167 -1.541667 Y 0.4290
Z -2.1960 SDx 15.562 Z -1.3537

HI 1.171
HT -0.09

TBM 2 BS BM H m S DD dA Hd Vd BM H
X 18.8276 HA 0 0 50 180.0139 15.55449 -0.449948 X 3.2731
Y 0.4290 VA 91 39 25 91.65694 -1.656944 Y 0.4252
Z -2.1960 SDx 15.561 Z -1.3639

HI 1.232
HT -0.05

TBM 2 BS BM H m S DD dA Hd Vd BM H
X 18.8276 HA 0 1 25 180.0236 15.5575 -0.449658 X 3.2701
Y 0.4290 VA 91 39 20 91.65556 -1.655556 Y 0.4226
Z -2.1960 SDx 15.564 Z -1.3627

HI 1.233
HT -0.05

TBM 2 BS BM I m S DD dA Hd Vd BM I
X 18.8276 HA 359 59 35 179.9931 15.06194 -0.390392 X 3.7656
Y 0.4290 VA 91 29 5 91.48472 -1.484722 Y 0.4308
Z -2.1960 SDx 15.067 Z -1.3504

HI 1.171
HT -0.065

TBM 2 BS BM I m S DD dA Hd Vd BM I
X 18.8276 HA 0 0 55 180.0153 15.06239 -0.44631 X 3.7652



 1010 Offsets and Measurements - Horizontal
Y 0.4290 VA 91 41 50 91.69722 -1.697222 Y 0.4250
Z -2.1960 SDx 15.069 Z -1.3593

HI 1.233
HT -0.05

TBM 2 BS BM I m S DD dA Hd Vd BM I
X 18.8276 HA 359 59 50 179.9972 15.06336 -0.447435 X 3.7642
Y 0.4290 VA 91 42 5 91.70139 -1.701389 Y 0.4297
Z -2.1960 SDx 15.07 Z -1.3614

HI 1.232
HT -0.05

TBM CT BS Stbd Ant m S DD dA Hd Vd Stbd Ant
X 5.123977 HA 161 13 25 161.2236 2.958503 0.249444 X 2.3229
Y -0.000827 VA 85 10 50 85.18056 4.819444 Y 0.9514
Z 0.845 SDx 2.969 Z 1.9344

HI 0.92
HT 0.08

BM CT BS Stbd Ant m S DD dA Hd Vd Stbd Ant
X 5.123977 HA 341 9 55 161.1653 2.956677 0.140223 X 2.3256
Y -0.000827 VA 87 17 5 87.28472 2.715278 Y 0.9537
Z 0.845 SDx 2.96 Z 1.9362

HI 1.031
HT 0.08

TBM CT BS Port Ant m S DD dA Hd Vd Port Ant
X 5.123977 HA 197 31 25 197.5236 2.943877 0.278278 X 2.3167
Y -0.000827 VA 84 36 0 84.6 5.4 Y -0.8872
Z 0.845 SDx 2.957 Z 1.9633

HI 0.92
HT 0.08

BM CT BS Port Ant m S DD dA Hd Vd Port Ant
X 5.123977 HA 17 29 45 197.4958 2.943124 0.169485 X 2.3170
Y -0.000827 VA 86 42 15 86.70417 3.295833 Y -0.8856
Z 0.845 SDx 2.948 Z 1.9655

HI 1.031
HT 0.08

BM C BS IMU m S DD dA Hd Vd IMU
X 0.0000 HA 359 35 35 359.5931 3.519377 -0.713627 X 3.5193
Y 0.0000 VA 101 27 45 101.4625 -11.4625 Y -0.0250
Z 0.0000 SDx 3.591 Z -1.1936

HI 1.07
HT 1.55

BM C BS IMU m S DD dA Hd Vd IMU
X 0.0000 HA 359 37 30 359.625 3.519208 -0.709419 X 3.5191
Y 0.0000 VA 101 23 50 101.3972 -11.39722 Y -0.0230
Z 0.0000 SDx 3.59 Z -1.1944

HI 1.065
HT 1.55

BM C BS IMU m S DD dA Hd Vd IMU
X 0.0000 HA 359 44 25 359.7403 3.508314 -0.722813 X 3.5083
Y 0.0000 VA 101 38 30 101.6417 -11.64167 Y -0.0159
Z 0.0000 SDx 3.582 Z -1.1748

HI 1.147
HT 1.599

BM CT BS TBM 1 m S DD dA Hd Vd TBM 1
X 5.123977 HA 180 0 10 0.002778 13.70743 -2.535711 X 18.8314
Y -0.000827 VA 100 28 50 100.4806 -10.48056 Y -0.0002
Z 0.845 SDx 13.94 Z -2.2127

HI 1.028
HT 1.55

BM CT BS TBM 1 m S DD dA Hd Vd TBM 1
X 5.123977 HA 179 59 45 359.9958 13.70731 -2.536376 X 18.8313
Y -0.000827 VA 100 29 0 100.4833 -10.48333 Y -0.0018
Z 0.845 SDx 13.94 Z -2.2104

HI 1.031
HT 1.55

BM D BS TBM 1 m S DD dA Hd Vd TBM 1
X 6.9065 HA 0 0 0 0 11.91516 -2.662444 X 18.8217
Y 0.0000 VA 257 24 15 257.4042 -12.59583 Y 0.0000
Z 0.3805 SDx 12.209 Z -2.2020



 1010 Offsets and Measurements - Horizontal
HI 1.165
HT 1.085

BM CT BS TBM 2 m S DD dA Hd Vd TBM 2
X 5.123977 HA 181 47 50 1.797222 13.70934 -2.541907 X 18.8266
Y -0.000827 VA 100 30 15 100.5042 -10.50417 Y 0.4291
Z 0.845 SDx 13.943 Z -2.2159

HI 1.031
HT 1.55

TBM1 Pier BS TBM 2 m S DD dA Hd Vd TBM 2
X 18.8281 HA 90 0 0 90 0.43 0 X 18.8281
Y -0.0007 VA 0 0 0 0 0 Y 0.4293
Z -2.1960 SDx 0.43 Z -2.1960

HI 0
HT 0

BM CT BS TBM 2 m S DD dA Hd Vd TBM 2
X 5.123977 HA 181 47 40 1.794444 13.71075 -2.539763 X 18.8280
Y -0.000827 VA 100 29 40 100.4944 -10.49444 Y 0.4285
Z 0.845 SDx 13.944 Z -2.2168

HI 1.028
HT 1.55

BM C BS TBM CT m S DD dA Hd Vd TBM CT
X 0 HA 359 58 20 359.9722 5.117313 0.241326 X 5.1173
Y 0 VA 87 18 0 87.3 2.7 Y -0.0025
Z 0 SDx 5.123 Z 0.8483

HI 1.225
HT 0.618



 1010 Offsets and Measurements - Vertical

FR
SETUP 1
BS BM C FS BM A

TI Ave (HI) TI Ave BM El
Top 1.992 1.967333 Top 2.014 1.988333333
Mid 1.967 0.025 Mid 1.988 0.026
Bot 1.943 0.024 Bot 1.963 0.025

DTI DTI
1 1

BM C HI Rod BM A
0 1.967333333 1.988333 -0.021

SETUP 5
BS BM C FS BM A

TI Ave (HI) TI Ave BM El
Top 1.908 1.883 Top 1.928 1.902333333
Mid 1.883 0.025 Mid 1.902 0.026
Bot 1.858 0.025 Bot 1.877 0.025

DTI DTI
0 1

BM C HI Rod BM A BM A Ave -0.02016667
0 1.883 1.902333 -0.019333 mm DIFF -1.66666667

SETUP 1
BS BM C FS BM B

TI Ave (HI) TI Ave BM El
Top 1.992 1.967333 Top 2.046 2.021
Mid 1.967 0.025 Mid 2.021 0.025
Bot 1.943 0.024 Bot 1.996 0.025

DTI DTI
1 0

BM C HI Rod BM B
0 1.967333333 2.021 -0.053667

SETUP 5
BS BM C FS BM B

TI Ave (HI) TI Ave BM El
Top 1.908 1.883 Top 1.961 1.935
Mid 1.883 0.025 Mid 1.935 0.026
Bot 1.858 0.025 Bot 1.909 0.026

DTI DTI
0 0

BM C HI Rod BM B BM B Ave -0.05283333
0 1.883 1.935 -0.052 mm DIFF -1.66666667

BM C 0 BY DEFINITION

SETUP 1
BS BM C FS BM D

TI Ave (HI) TI Ave BM El
Top 1.992 1.967333 Top 1.59 1.580666667
Mid 1.967 0.025 Mid 1.581 0.009
Bot 1.943 0.024 Bot 1.571 0.01

DTI DTI
1 1

BM C HI Rod BM D
0 1.967333333 1.580667 0.386667

SETUP 5
BS BM C FS BM D

TI Ave (HI) TI Ave BM El
Top 1.908 1.883 Top 1.502 1.494333333
Mid 1.883 0.025 Mid 1.495 0.007
Bot 1.858 0.025 Bot 1.486 0.009

DTI DTI
0 2

BM C HI Rod BM D BM D Ave 0.387666667
0 1.883 1.494333 0.388667 mm DIFF -2

SETUP 1
BS BM C FS BM E

TI Ave (HI) TI Ave BM El
Top 1.992 1.967333 Top 0.372 0.354666667
Mid 1.967 0.025 Mid 0.354 0.018
Bot 1.943 0.024 Bot 0.338 0.016

DTI DTI
1 2

BM C HI Rod BM E
0 1.967333333 0.354667 1.612667

SETUP 6
BS BM D FS BM E

All offsets are in Theodolite Coordinate System



 1010 Offsets and Measurements - Vertical
TI Ave (HI) TI Ave BM El

Top 1.697 1.689 Top 0.481 0.463
Mid 1.689 0.008 Mid 0.463 0.018
Bot 1.681 0.008 Bot 0.445 0.018

DTI DTI
0 5.55E-14

BM D HI Rod BM E BM E Ave 1.612666833
0.386667 1.689 0.463 1.612667 mm DIFF -0.00033333

SETUP 1
BS BM C FS BM F

TI Ave (HI) TI Ave BM El
Top 1.992 1.967333 Top 0.336 0.319666667
Mid 1.967 0.025 Mid 0.319 0.017
Bot 1.943 0.024 Bot 0.304 0.015

DTI DTI
1 2

BM C HI Rod BM F
0 1.967333333 0.319667 1.647667

SETUP 5
BS BM C FS BM F

TI Ave (HI) TI Ave BM El
Top 1.908 1.883 Top 0.249 0.232666667
Mid 1.883 0.025 Mid 0.233 0.016
Bot 1.858 0.025 Bot 0.216 0.017

DTI DTI
0 1

BM C HI Rod BM F BM F Ave 1.649
0 1.883 0.232667 1.650333 mm DIFF -2.66666667

SETUP 1
BS BM C FS BM G

TI Ave (HI) TI Ave BM El
Top 1.992 1.967333 Top 0.406 0.389333333
Mid 1.967 0.025 Mid 0.389 0.017
Bot 1.943 0.024 Bot 0.373 0.016

DTI DTI
1 1

BM C HI Rod BM G
0 1.967333333 0.389333 1.578

SETUP 6
BS BM D FS BM G

TI Ave (HI) TI Ave BM El
Top 1.697 1.689 Top 0.515 0.497666667
Mid 1.689 0.008 Mid 0.497 0.018
Bot 1.681 0.008 Bot 0.481 0.016

DTI DTI
0 2

BM D HI Rod BM G BM G Ave 1.578000167
0.386667 1.689 0.497667 1.578 mm DIFF -0.00033333

SETUP 10
BS BM C FS BM J

TI Ave (HI) TI Ave BM El
Top 0.667 0.657 Top 1.764 1.755
Mid 0.657 0.01 Mid 1.755 0.009
Bot 0.647 0.01 Bot 1.746 0.009

DTI DTI
0 2.22E-13

BM C HI Rod BM J
0 0.657 1.755 -1.098

SETUP 11
BS BM C FS BM J

TI Ave (HI) TI Ave BM El
Top 0.658 0.648333 Top 1.761 1.752
Mid 0.649 0.009 Mid 1.752 0.009
Bot 0.638 0.011 Bot 1.743 0.009

DTI DTI
2 0

BM C HI Rod BM J BM J Ave -1.10083333
0 0.648333333 1.752 -1.103667 mm DIFF 5.666666667

SETUP 2
BS BM C FS TBM 2

TI Ave (HI) TI Ave BM El
Top 1.381 1.347333 Top 3.609 3.549666667
Mid 1.348 0.033 Mid 3.55 0.059
Bot 1.313 0.035 Bot 3.49 0.06

DTI DTI



 1010 Offsets and Measurements - Vertical
2 1

BM C HI Rod TBM 2
0 1.347333333 3.549667 -2.202333

BS BM C FS TBM 2 NOTE
TI Ave (HI) TI Ave BM El

Top - 1.188 Top - 3.395
Mid 1.188 n/a Mid 3.395 n/a
Bot - n/a Bot -

DTI DTI
n/a n/a

BM C HI Rod TBM 2 TBM 2 Ave -2.20466667
0 1.188 3.395 -2.207 mm DIFF 4.666666667

SETUP 2
BS BM C FS BM CT

TI Ave (HI) TI Ave BM El
Top 1.381 1.347333 Top 0.51 0.502
Mid 1.348 0.033 Mid 0.502 0.008
Bot 1.313 0.035 Bot 0.494 0.008

DTI DTI
2 0

BM C HI Rod BM CT
0 1.347333333 0.502 0.845333

SETUP 7
BS BM C FS BM CT

TI Ave (HI) TI Ave BM El
Top 1.563 1.528 Top 0.693 0.683333333
Mid 1.528 0.035 Mid 0.684 0.009
Bot 1.493 0.035 Bot 0.673 0.011

DTI DTI
0 2

BM C HI Rod BM CT BM CT Ave 0.845
0 1.528 0.683333 0.844667 mm DIFF 0.666666667

SETUP 3
BS BM C FS Stbd Ant

TI Ave (HI) TI Ave BM El
Top 2.068 2.044333 Top 0.128 0.116
Mid 2.045 0.023 Mid 0.116 0.012
Bot 2.02 0.025 Bot 0.104 0.012

DTI DTI
2 1.39E-14

BM C HI Rod Stbd Ant
0 2.044333333 0.116 1.928333

SETUP 4
BS BM C FS Stbd Ant

TI Ave (HI) TI Ave BM El
Top 2.067 2.043333 Top 0.126 0.114333333
Mid 2.044 0.023 Mid 0.114 0.012
Bot 2.019 0.025 Bot 0.103 0.011

DTI DTI
2 1

BM C HI Rod Stbd Ant Stbd Ant Ave 1.928666667
0 2.043333333 0.114333 1.929 mm DIFF -0.66666667

SETUP 3
BS BM C FS Port Ant

TI Ave (HI) TI Ave BM El
Top 2.068 2.044333 Top 0.102 0.086666667
Mid 2.045 0.023 Mid 0.086 0.016
Bot 2.02 0.025 Bot 0.072 0.014

DTI DTI
2 2

BM C HI Rod Port Ant
0 2.044333333 0.086667 1.957667

SETUP 4
BS BM C FS Port Ant

TI Ave (HI) TI Ave BM El
Top 2.067 2.043333 Top 0.101 0.085333333
Mid 2.044 0.023 Mid 0.085 0.016
Bot 2.019 0.025 Bot 0.07 0.015

DTI DTI
2 1

BM C HI Rod Port Ant Port Ant Ave 1.957833333
0 2.043333333 0.085333 1.958 mm DIFF -0.33333333

SETUP 10
BS BM C FS IMU



 1010 Offsets and Measurements - Vertical
TI Ave (HI) TI Ave BM El

Top 0.667 0.657 Top 1.849 1.841
Mid 0.657 0.01 Mid 1.841 0.008
Bot 0.647 0.01 Bot 1.833 0.008

DTI DTI
0 0

BM C HI Rod IMU
0 0.657 1.841 -1.184

SETUP 11
BS BM C FS IMU

TI Ave (HI) TI Ave BM El
Top 0.658 0.648333 Top 1.839 1.830333333
Mid 0.649 0.009 Mid 1.83 0.009
Bot 0.638 0.011 Bot 1.822 0.008

DTI DTI
2 1

BM C HI Rod IMU IMU Ave -1.183
0 0.648333333 1.830333 -1.182 mm DIFF -2

SETUP 8
BS TBM 2 FS BM H NOTE

TI Ave (HI) TI Ave BM El
Top 0.792 0.755667 Top -0.032 -0.072
Mid 0.755 0.037 Mid -0.072 0.04
Bot 0.72 0.035 Bot -0.112 0.04

DTI DTI
2 1.39E-14

TBM 2 HI Rod BM H
-2.204667 0.755666667 -0.072 -1.377

SETUP 9
BS TBM 2 FS BM H NOTE

TI Ave (HI) TI Ave BM El
Top 0.783 0.746333 Top -0.041 -0.082
Mid 0.746 0.037 Mid -0.082 0.041
Bot 0.71 0.036 Bot -0.123 0.041

DTI DTI
1 6.94E-15

TBM 2 HI Rod BM H BM H Ave -1.37666667
-2.204667 0.746333333 -0.082 -1.376333 mm DIFF -0.66666667

SETUP 8
BS TBM 2 FS BM I NOTE

TI Ave (HI) TI Ave BM El
Top 0.792 0.755667 Top -0.036 -0.075
Mid 0.755 0.037 Mid -0.075 0.039
Bot 0.72 0.035 Bot -0.114 0.039

DTI DTI
2 6.94E-15

TBM 2 HI Rod BM I
-2.204667 0.755666667 -0.075 -1.374

SETUP 9
BS TBM 2 FS BM I NOTE

TI Ave (HI) TI Ave BM El
Top 0.783 0.746333 Top -0.047 -0.085666667
Mid 0.746 0.037 Mid -0.086 0.039
Bot 0.71 0.036 Bot -0.124 0.038

DTI DTI
1 1

TBM 2 HI Rod BM I BM I Ave -1.37333333
-2.204667 0.746333333 -0.085667 -1.372667 mm DIFF -1.33333333
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The Z plane means were taken using only the vertical level measurements.
BM A 88 165 133
X -0.0080 -0.0024 Mean -0.00523
Y -1.0024 -1.0017 -1.002038
Z -0.0229 -0.0351 -0.021 -0.019333333 -0.020167

BM B 95 172 13 143
X -0.006636 -0.000971 Mean -0.003804
Y 1.000078 0.999488 0.999783
Z -0.054751 -0.06738 -0.053666667 -0.052 -0.052833

BM C
X 0 By Definition
Y 0
Z 0

BM D 3 39 137 200 235
X 6.906514 6.917806 6.90609668 6.924299204 6.908486 Mean 6.912961 0.008066 ⇐ X Std Dev
Y 0 -0.001217 -9.25846E-05 2.19861E-06 -0.003272 -0.001121 0.001414 ⇐ Y Std Dev
Z 0.380484 0.339366 0.393190546 0.372414056 0.358922 0.386667 0.3886667 0.387667

BM E 102 179 174 33
X 1.66838 1.662692 Mean 1.665536
Y -0.892003 -0.892844 -0.892424
Z 1.619989 1.601054 1.612667 1.612666667 1.612667

BM F 18 109 186 43 163
X 1.667546 1.67587 1.660831138 Mean 1.668082 0.007534 ⇐ X Std Dev
Y -0.000827 -0.001997 -0.000826981 -0.001217 0.000676 ⇐ Y Std Dev
Z 1.643321 1.654747 1.63967874 1.647666667 1.650333 1.649

BM G 116 193 53 184
X 1.675333 1.660896 Mean 1.668115
Y 0.955657 0.959932 0.957794
Z 1.585729 1.566713 1.578 1.578000333 1.578

BM H 60 221 242
X 3.271201 3.270066 3.273074882 Mean 3.271447 0.001519 ⇐ X Std Dev
Y 0.428992 0.422581 0.425221731 0.425598 0.003222 ⇐ Y Std Dev
Z -1.353679 -1.362658 -1.363947954 -1.377 -1.376333 -1.376667

BM I 67 228 249 234 254
X 3.7656 3.7652 3.764211686 Mean 3.765006 0.000723 ⇐ X Std Dev
Y 0.4308 0.4250 0.429722538 0.428505 0.003105 ⇐ Y Std Dev
Z -1.3504 -1.3593 -1.361435445 -1.374 -1.372667 -1.373333

1010 Launch Offsets Measurements

All offsets are in Theodolite Coordinate System



BM J 67 228 249 274 294
X n/a n/a n/a n/a n/a Mean
Y n/a n/a n/a n/a n/a
Z -1.3504 -1.3593 -1.361435445 -1.098 -1.103667 -1.100833

BM CT 11 81 158
X 5.117312 5.12892 5.1257 Mean 5.123977 0.005993 ⇐ X Std Dev
Y -0.002481 0 0 -0.000827 0.001432 ⇐ Y Std Dev
Z 0.848326 0.847926 0.8586 0.845333333 0.844667 0.845

TBM 1 46 144 207
X 18.82167 18.83129 18.83141214 Mean 18.82813 0.005587 ⇐ X Std Dev
Y 0 -0.001824 -0.000162426 -0.000662 0.001009 ⇐ Y Std Dev
Z -2.20196 -2.210376 -2.212711485 -2.196 -2.197 -2.1965

TBM 2 53 151 214 63
X 18.82813 18.82657 18.82800643 Mean 18.82757 0.000865 ⇐ X Std Dev
Y 0.429338 0.429129 0.428509392 0.428992 0.000431 ⇐ Y Std Dev
Z -2.196 -2.215907 -2.216762747 -2.202333333 -2.207 -2.204667

IMU 74 256 263
X 3.5083 3.519289 3.519132539 Mean 3.515566 0.006313 ⇐ X Std Dev
Y -0.0159 0.024996 0.023032997 0.010709 0.023067 ⇐ Y Std Dev
Z -1.1748 -1.193627 -1.194419237 -1.184 -1.182 -1.183

Port Ant 25 130 103 123
X 2.316717 2.3170 Mean 2.316862
Y -0.887225 -0.8856 -0.886431
Z 1.963278 1.9655 1.957666667 1.958 1.957833

Stbd Ant 32 123 93 113
X 2.32292 2.32562 Mean 2.32427
Y 0.951443 0.953705 0.952574
Z 1.934444 1.936223 1.928333333 1.929 1.928667

Phase Center of Ducer
270 277 284

X 3.360447 3.364447 3.370447321 Mean 3.365114 0.005033 ⇐ X Std Dev
Y 0.272598 0.271598 0.275598369 0.273265 0.002082 ⇐ Y Std Dev
Z -1.719 -1.719 -1.722 -1.729166667 -1.729167



 1010 Offsets and Measurements
IMU to Heave

Measurement Explanation Notes

BM C to BM D
6.913 From Offsets & Measurements XYZ.

BM D  to Center of Pick Point
-0.275 Measured with steel tape 11/16/05.

Center of Pick Point to Frame 0
0.5207 From JMC drawing.  Converted to meters.

BM C to Frame 0
7.1587 Calculated from cells 4, 7 and 10.

Frame 0 to LCG
-4.818888 From JMC Stability Test.  Converted to meters.

BM C to LCG
2.339812 Calculated from cells 13 and 16.

BM C to IMU
3.516 From Offsets & Measurements XYZ.

IMU to LCG
-1.176188 Calculated from cells 19 and 22.

JMC refers to the Jensen Marine Consultants, Inc. report 
titled, "28' NOAA Survey Launch Stability Information 
Booklet," dated February 23, 2005*.  There were several 
different values for the LCG in the JMC report, but the value 
used for these calculations was believed to be the most 
reasonable.

* There was some confusion as to which boat had the 
stability testing done to it.  This was due to the report listing it 
as 1010, but the CO (CAPT John Lowell at the time) and 
Steve Currie both assert that the testing was done to 1018.

IMU to Heave

Stability values are not available for Launch 1010 at this 
time.  Values used are from Launch 1018*.

LCG stands for logitudinal center of gravity, which was 
assumed to be the location of the heave point for the launch. 









FAIRWEATHER
Multibeam Echosounder Calibration

Vessel

6/10/2008
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

Launch 1010

FA Personnel

4/10/2006Launch 1010

162

8101

344972701011

6/9/2008

Blank Inlet / Tongass Narrows

4/15/2008Swing Arm Mount

POSMV v4.0



Acquisition Log

6/10/2008
Date Dn Local Area Wx

Bottom Type Approximate Water Depth

Personnel on board

Comments

TrueHeave filename

21:31 30m
SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

23:44 35.4
SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #3 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #4 filename UTC Time Lat Lon Depth Ext. Depth

08162131

081622344

162

55 16 55.85 131 39 14.43

TH_1010_163.000

55 19 48 131 37 38

Evans, Morgan, Argento, Bucher

Sunny, northern wind, small wavesBlank Inlet / Tongass Narrows



ROLL
SV Cast # Heading Speed (kts) Remarks

8162131 100 8.0
280 8.0

PITCH
SV Cast # Heading Speed (kts) Remarks

8162131 311 8.0
131 8.0

HEADING/YAW
SV Cast # Heading Speed (kts) Remarks

81622344 309 8.0
130 8.0
309 8.0
130 8.0

NAV TIME LATENCY
SV Cast # Heading Speed (kts) Remarks

81622344 035 5.0
035 9.0

XTF Line Filename

XTF Line Filename

XTF Line Filename

XTF Line Filename
PITCH1
PITCH2

ROLL1.xtf
ROLL2.xtf

brief depth filter cutout at beginning (ncm)

HEAD1
HEAD2
HEAD3
HEAD4

LAT1.xtf
LAT2.xtf



Processing Log

6/10/2008
Date Dn Personnel

TrueHeave applied

SVP applied

Tide applied

Zone file

Lines merged

Data cleaned to remove gross fliers

TH_1010_163.000

9450460_1010_PatchTest.tid

1010_Patch_Dn162.svp

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

Data converted --> HDCS_Data in CARIS

Argento162

Do not enter/apply correctors until all evaluations are complete and analyzed.

Compute correctors in this order



Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
0.00 0.10 1.45 0.54
0.00 0.10
0.00 1.42 0.82
0.00 0.10 1.44 0.49
0.00 0.15 1.43 0.77

0.00 0.11 1.44 0.66
0.00 0.02 0.01 0.16

Resulting HVF File Name

MRU Align StdDev gyro 0.16 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.02 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 6/14/2008Bonnie Johnston

PATCH TEST RESULTS/CORRECTORS

Argento
Andrews

Final Values based on

Averages
Standard Deviation

FINAL VALUES

Campbell
Johnston
Renoud

FA_1010_Reson_8101  (2008-162)

Did not use Andrews roll value, it was an outlier of -0.33.  Did not use Campbell's Pitch value; it was an outlier at -0.1.

Argento, Andrews (minus roll and yaw), Campbell (except pitch), Johnston, Renoud



                         LAUNCH DDSSM DATA ACQUISITION FORM

Date 10-Jun-08 DN 163 Wind Northern
Vessel # 1010 Location Blank Inlet/Tongass Narrows Seas small waves

Average Depth 26 m Personnel Evans, Morgan, Aregnto, Bucher

RPM Speed Az Isis Line Name                       Acquisition Comments
0 5 255 DSSM1 Didn't use.  Too far from other nadir beams and Idle line.

0 5.2 75 DSSM2
0 7 255 DSSM3

7.4 75 DSSM4

8.8 255 DSSM5

8.8 255 DSSM6

9.1 75 DSSM7

11 255 DSSM8

11.5 75 DSSM9

IDLE IDLE DSSM10 NOT A GOOD LINE.  DOES NOT INTERSECT WITH OTHER LINES.

IDLE IDLE DSSM11 NOT A GOOD LINE.  DOES NOT INTERSECT WITH OTHER LINES.

IDLE IDLE DSSM12 NOT A GOOD LINE.  DOES NOT INTERSECT WITH OTHER LINES.

IDLE IDLE DSSM13 NOT A GOOD LINE.  DOES NOT INTERSECT WITH OTHER LINES.

IDLE IDLE DSSM14 NOT A GOOD LINE.  DOES NOT INTERSECT WITH OTHER LINES.



                   DDSSM DATA PROCESSING AND RESULTS FORM

Date 6/10/2008 DN 163 Wind
Vessel # 1010 Location Blank Inlet/Tongass Narrows Seas

  Average Depth 26 m Personnel Argento, Johnston (DDSSM Values)

SVP file loaded 1010_Patch_Dn162.svp

Tide file loaded 9450460_1010_PatchTest.tid

Speed-Rest, values obtained by following FPM May 2008, incorrect

Speed Isis Line Name CARIS Line Name Depth Loc 1 Diff Loc 1 Depth Loc 2 Diff Loc 2 Depth Loc 3 Diff Loc 3 Average

0 DSSM10, 11, 12 DSSM10, 11, 12 28.624125 0 31.6041875 0 21.2503333 0 0
5.2 DSSM2 DSSM2 28.46575 -0.158375 31.300625 -0.3035625 21.461 0.21066667 -0.0837569
7.4 DSSM4 DSSM4 28.411 -0.213125 31.3404 -0.2637875 21.3841818 0.13384848 -0.1143547
9.1 DSSM7 DSSM7 28.3187143 -0.305410714 31.29375 -0.3104375 21.3679231 0.11758974 -0.1660862
11.5 DSSM9 DSSM9 28.435 -0.189125 31.385875 -0.2183125 21.4088889 0.15855556 -0.0829606

Rest-Speed - Values used

Speed Isis Line Name CARIS Line Name Depth Loc 1 Diff Loc 1 Depth Loc 2 Diff Loc 2 Depth Loc 3 Diff Loc 3 Average
0 DSSM10, 11, 12 DSSM10, 11, 12 28.624125 0 31.6041875 0 21.2503333 0 0

5.2 DSSM2 DSSM2 28.46575 0.158375 31.300625 0.3035625 21.461 -0.2106667 0.08375694
7.4 DSSM4 DSSM4 28.411 0.213125 31.3404 0.2637875 21.3841818 -0.1338485 0.11435467
9.1 DSSM7 DSSM7 28.3187143 0.305410714 31.29375 0.3104375 21.3679231 -0.1175897 0.16608616
11.5 DSSM9 DSSM9 28.435 0.189125 31.385875 0.2183125 21.4088889 -0.1585556 0.08296065



2008 1010 DDSSM  Values used (Rest-Speed) 

Speed (m/s) Speed (knots) Stop 1 Stop 2 Stop 3 Std. Dev. Average
0.00 0 0 0 0 0 0.00
2.68 5.2 0.158 0.304 -0.211 0.265 0.08
3.81 7.4 0.213 0.264 -0.134 0.216 0.11
4.68 9.1 0.305 0.310 -0.118 0.246 0.17
5.92 11.5 0.189 0.218 -0.159 0.210 0.08

1010 DDSSM 2008 Values
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Ship: FAIRWEATHER Vessel: 1010
Date: 6/9/2008 Dn: 162
Personnel: Argento, Evans, Bucher, Morgan

PCS Serial # IMU Serial # 294

IP Address:

POS controller Version (Use Menu Help > About) 3.4.0.0

POS Version (Use Menu View > Statistics) 320 V4
GPS Receivers

Primary Receiver S/N 60162863

Secondary Receiver S/N 60145247

Calibration area
Location:
Approximate Position: Lat

Lon
DGPS Beacon Station: Anette Island
Frequency: 323

Satellite Constellation (Use View> GPS Data)

Primary GPS

PDOP (Use View> GAMS Solution)

NOAA POS/MV Calibration Report

Tongass Narrows

Secondary GPS

2564

129.100.1.231



POS/MV Configuration
Settings

Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

Configuration Notes:

POS/MV Calibration

Calibration Procedure: (Refer to POS MV V3 Installation and Operation Guide, 4-25)
Start time: 9:12 AM
End time: 9:16 AM
Heading accuracy achieved for calibration: 0.295

Calibration Results:
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

Calibration Notes:

Save POS Settings on PC (Use File > Store POS Settings on PC)
File Name:



General Notes:
The POS/MV uses a Right-Hand Orthogonal Reference System
The right-hand orthogonal system defines the following:
• The x-axis is in the fore-aft direction in the appropriate reference frame.
• The y-axis is perpendicular to the x-axis and points towards the

right (starboard) side in the appropriate reference frame.
• The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence
Apply the rotation in the following order to bring the two frames of reference 

into complete alignment:
a) Heading rotation - apply a right-hand screw rotation θz about the

z-axis to align one frame with the other.
b) Pitch rotation - apply a right-hand screw rotation θy about the

once-rotated y-axis to align one frame with the other.
c) Roll rotation - apply a right-hand screw rotation θx about the

twice-rotated x-axis to align one frame with the other.



SETTINGS
Input/Output Ports (Use Settings > Input/Output Ports)

COM1

COM2

COM3



SETTINGS Continued
Heave Filter (Use Settings > Heave)

Events Use Settings > Events)

INSTALLATION (Use Settings > Installation)

Lever Arms and Mounting Angles (Use Settings > Installation > Lever Arms and Offsets)



Tags, Multipath and Auto Start (Use Settings > Installation > Tags, Multipath and Auto Start)

Sensor Mounting (Use Settings > Installation > Sensor Mounting)

User Parameter Accuracy (Use Settings > Installation > User Accuracy)



GPS  Receiver Configuration (Use Settings> Installation> GPS Receiver Configuration)

Primary GPS  Receiver

Secondary GPS Receiver
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- 2008
Measuring Party: Andrews, Argento, Wozumi

Date: 4/28/2008
Fuel Level: FULL

Measure 1 Draft Tube: N/A

Measure 2

Measure 3 Port-to-Stbd Z-difference

Avg (cm) Theoretical Actual Error

Avg (m) 0.0237 0.0007 -0.0230

Stdev

BM Z-value (m) BM C to WL Average (m)
BM C to WL (m) -0.563 (Add this value to 1018_Offsets & Measurements_2008)

Individual -0.55567 -0.57433
measurement -0.54867 -0.57033
StDev for TPU xls 0.013116 -0.55067 -0.57933 utilized in Offsets and Measurements and TPU spreadsheet
(of 6 #'s)

-85.5

-85.03

0.29933

0.00361 0.00451

-85.5 -85.0

1018
Benchmark A to Waterline Benchmark B to Waterline

0.27567
-0.552 -0.575

Waterline Measurements

-84.8 -84.6

-0.8503

-85.0

-85.10

-0.8510



All offsets are in the Theodolite Coordinate System
BM E x 1.825761 Port Ant x 2.445325

y -0.861405 y -0.913449
z 2.018667 z Unknown

BM F x 1.826865 Stbd Ant x 2.444676
y -0.002043 y 0.920569
z 2.054333 z Unknown

BM G x 1.828354
y 0.918931
z 1.998333

Measuring Party (fill in yellow spaces only): Date:
Andrews, Breen, Rice 4/20/2008

z-Values
Distances Ant. Base Phase Center
Port Ant to BM 'E' 0.651 0.651 0.653 0.664417 2.252934 2.298934
Port Ant to BM 'F' 1.109 1.106 1.108 1.120417 2.259711 2.305711
Port Ant to BM 'G' 1.946 1.941 1.941 1.955417 2.290537 2.336537

2.256322 2.302322 AVERAGE
0.020 STDEV

Stbd Ant to BM 'E' 1.883 1.882 1.885 1.896083 2.210097 2.256097
Stbd Ant to BM 'F' 1.108 1.111 1.108 1.12175 2.213769 2.259769
Stbd Ant to BM 'G' 0.64 0.644 0.648 0.65675 2.225193 2.271193

2.219481 2.265481 AVERAGE
Antenna Post Diameter Radius 0.008 STDEV

0.0255 0.01275

This spreadsheet is designed to compute the z-values of the phase 
centers of the new POS M/V antenna.

The distances from the antenna post to each benchmark was measured 
three times and averaged. The post offset to phase center (radius) was 
then added.

The distance is 0.046m (4.60cm) from the bottom of 
the antenna to the Phase center, obtained from the 
POSM/V v4 guide, see image above. 



92
Date DN

Offset Measurements (positive cm): Average Angle Bias (deg):
Bow-Stern 9.6 10.0 10.0 9.9 Bow Up 0.0
Port-Stbd 14.3 14.6 14.9 14.6 Port Up -2.8
Up-Down 37.0 36.5 36.4 36.6 The measuring crew should

 insure there will be no yaw bias.

BM H to Phase Center IMU to Phase Center (8101)
(Theodolite Coordinate System) (CARIS Coordinate System)

x 9.867 cm x 0.282 m

y -16.372 cm y -0.145 m

z -35.876 cm z 0.548 m

Offsets from Aft Benchmark to Phase Center of Transducer

4/1/2008 1018
Vessel

Andrews, Breen, Campbell, Rice
Personnel

Instructions:  The purpose of this measurement is to check for 
gross movement of the tranducer.  

While the boat is in the cradle, gently lower the transducer and 
lock it in place.  Using a metric tape measure, plumb bob and 
carpenter's level, measure the horizontal and vertical offsets from 
the aft benchmark (BM H) to the phase center of the transducer.  
The phase center is measured at the forward edge of the black 
insulating layer, as shown in the photos.  If you have trouble 
locating the center, borrow a compass from the navigation 
department.

Notwithstanding a major accident, BM H will be outboard, aft and 
higher than the phase center; as such, enter all offsets as positive 
numbers (in cm) and the proper signs will be applied.  

Once offsets have been measured, apply a digital level to the IMU 
to determine any pitch or roll bias in the orientation of the launch.  
For the purposes of this spreadsheet, a positive angle (measured 
in degrees) will imply the bow is higher than the stern and the port 
side is higher than the starboard side.

All measurements should be done in triplicate to aid in the 
calculation of the uncertainty (needed in the HVF).  The IMU to 
Phase Center  values will be calculated automatically.

BM H



BM 'H' to Phase Center (POS M/V Coordinate system)
Rotation about x-axis Original vector Rotation angles

1 0 0 9.9 x-axis 2.8 Note:  A positive angle will raise the port-side.
0 Cos(x-angle) -Sin(x-angle) -14.6 y-axis 0 Note:  A positive angle will raise the bow.
0 Sin(x-angle) Cos(x-angle) 36.6 z-axis 0 Note:  The measuring crew should insure there will be no yaw bias.

Rotation about y-axis Rotated about x-axis BM 'H' to Phase Center (POS M/V Coordinate system)
Cos(y-angle) 0 Sin(y-angle) 9.867 Newly rotated vector

0 1 0 -16.372 9.87
-Sin(y-angle) 0 Cos(y-angle) 35.876 -16.37

35.88
Rotation about z-axis Rotated about y-axis
Cos(z-angle) -Sin(z-angle) 0 9.867
Sin(z-angle) Cos(z-angle) 0 -16.372

0 0 1 35.876

Rotated about z-axis
9.867

-16.372
35.876

* - Valid for a right-handed (i.e. POS M/V) coordinate system
Angles are rotated clockwise when looking from the origin along the positive axis.

Note:  The traditional rotation matrices require a 
right-handed coordinate system.  Thus, behind-the-
scenes, all numbers have been converted to the 
POS M/V Coordinate system.



1018
IMU BM H IMU to BM H

x 3.545867 3.302044 -0.243823
y -0.01516 0.430807 0.445967
z -0.85883 -1.0485 -0.18967

IMU to PC = (IMU to BM H) + (BM H to PC/100)

Using the XYZ positions of the IMU and BM H from the launch Offsets & Measurements  form located in the 
DAPR appendix, the offset from the IMU to BM H could be calculated, as shown above.  The measured offsets 
from BM H to the phase center of the transducer are divided by 100 to convert to meters, then added to the offset 
from the IMU to BM H.  The result is the offset from the IMU to the phase center of the transducer.  The values in 
the X and Y fields are transposed and the inverse of the Z value is used to give the offsets in CARIS coordinates.



1018 Offsets and Measurements
Summary

Measurement IMU to RP* 8101 to RP*
aka SWATH1 x,y,z  & MRU to Trans Nav to Trans x,y,z
Coord. Sys. Caris Caris Caris Caris Caris
x 0.000 0.282 0.282 1.181 n/a
y 0.000 -0.145 -0.145 0.955 n/a
z 0.000 0.548 0.548 3.710 -0.296

ghhg
*IMU is Reference Point

Vessel Offsets for 1018_8101 are derived from the Horizontal,  Vertical & XYZ worksheets in this spreadsheet. 2008 Measured Value

Calculations
Coord. Sys.
Theodolite IMU (m) x 3.54587 IMU (m) x 3.545867 IMU (m) x 3.546

y -0.01516 y -0.01516 y -0.015
z -0.85883 z -0.85883 z -0.859

BM H x 3.30204 Port Ant (m) x 2.445 BM C x 0.000
y 0.43081 y -0.913 y 0.000
z -1.0485 z 2.302 z 0.000

IMU x -0.244 IMU to x -1.101 BM C to IMU
to BM H y 0.446 Port Antenna y -0.898 x n/a

z -0.190 z 3.161 y n/a
z -0.859

BM H to x 9.867 IMU to x -0.145
Phase Ctr (cm)   y -16.372 Phase Ctr y 0.282 BM C to Waterline (m)
measured z -35.876 z -0.548 z -0.563

BM H to x 0.099
Phase Ctr (m)     y -0.164

z -0.359
see 

Coord. Sys.
Theodolite IMU to x -0.145 x 0.955 x n/a

Phase Ctr y 0.282 y 1.181 y n/a
z -0.548 z -3.710 z 0.296

Coord. Sys. CARIS Coord. Sys. CARIS Coord. Sys. CARIS
x 0.282 x 1.181 x n/a
y -0.145 y 0.955 y n/a
z 0.548 z 3.710 z -0.296

8101 to RP*

IMU to 8101 RP to Waterline  IMU to 8101 Port Ant to 8101

IMU to 8101

IMU to 8101

RP* to Waterline  

RP to Waterline  

Port Ant to 8101

Port Ant to 8101



1018 Offsets and Measurements
Summary

Caris Pos/Mv Caris Pos/Mv
Scaler Distance 1.834 -0.898 -1.101 0.015 -1.114

-1.101 -0.898 -1.114 0.015
-3.161 -3.161 -0.296 -0.296

Port Ant (m) x 2.445 IMU (m) x 3.546 IMU (m) y -0.015
y -0.913 y -0.015 x is n/a z -0.859
z 2.302 z -0.859

Heave Pt (m)
Stbd Ant (m) x 2.445 Port Ant(m) x 2.445 (centerline) y 0.000

y 0.921 y -0.913
z 2.265 z 2.302 BM C to Waterline (m) -0.563

measured scalar dist 

BM C
x&y are n/a z 0.000

BM C to Waterline (m)
(Heave Pt) z -0.563

IMU to Hv x -1.114

x -1.101 x -1.114
Scalar Distance 1.8344 y -0.898 y 0.015

z 3.161 z 0.296

Coord. Sys. Pos/Mv Coord. Sys. Pos/Mv
x -1.101 x -1.114
y -0.898 y 0.015
z -3.161 z -0.296

See IMU to Heave tab.

IMU to Port Ant

IMU to Heave

Port Ant to Stbd Ant IMU to Heave

See IMU to Heave tab.

Port Ant to Stbd Ant

IMU to HeavePort Ant to Stbd Ant IMU to Port Ant

IMU to Port Ant



Description of Offsets for Launch 1018
All Values Shown are in CARIS Coordinates

The Ship Reference Frame (SRF) for Launch 1018 was based from benchmark (BM) C as the 0 point.  Physical locations were measured with x,y,z offsets from this point.  These locations 
were used to calculate offsets of items with respect to each other, as described for each offset.

x=0.282

z=0.548

z=3.710

x=1.181

z=-3.161

x=-0.898
1.834

z=-0.296
x=0.015

z=0.548

y=-0.145

z=3.710

z=-0.276

y=0.955

z=-3.161

y=-1.101

z=-0.296
y=-1.114



x y z x y z x y z x y z x y z
0.282 -0.145 0.548 1.181 0.955 3.710 N/A N/A -0.296 -0.898 -1.101 -3.161 0.015 -1.114 -0.296

IMU to Heave
Scalar Distance

1.834

IMU to 8101 Port Ant to 8101 RP to Waterline Port Ant to Stbd Ant IMU to Port Antenna

The physical positions of the IMU 
and the phase center of the 8101 
with respect to the Ship 
Reference Frame were 
measured by NOAA personnel.  
These physical measurements 
were used to calculate the xyz 
offsets from the IMU to BM H. 
Measurements from BM H to the 
Phase Center of the 8101 were 
collected by NOAA personnel 
while the boat was secured on 
the pier and thought to be as 
level as possible.  The measured 
offsets from BM H to the phase 
center were then added to the 
offset from the IMU to BM H.  
The result is the offset from the 
IMU to the phase center of the 
transducer.  The values in the X 
and Y fields are transposed and 
the inverse of the Z value is used 
to give the offsets in CARIS 
coordinates.

NOAA personnel calculated the 
distance between the port 
antenna and the phase center of 
the port antenna subtracting  the 
IMU to Port Antenna value from 
the IMU to Phase Center value.   

The average vertical distance 
from BM A and B to the waterline 
was measured by 
FAIRWEATHER personnel using 
a steel tape and bubble level.  
These values were used to 
calculate the BM C to the 
waterline value.  With the 
knowledge of the BM C height 
above the IMU, the waterline 
height above the IMU could be 
calculated.  On launch 1018, the 
IMU is used as the reference 
point. 

The location of the IMU and the 
location of the port antenna were 
measured by NOAA personnel 
with respect to the Ship 
Reference Frame (SRF).  The 
xyz offsets from the IMU to the 
port antenna could be calculated 
from these physical locations. 

The heave point was positioned 
differently on each of the axes.  
The distance for the longitundinal 
axis was determined as 
described in the "IMU to Heave" 
tab in this workbook.  The 
athwart ships axis was the vessel 
centerline.  Lastly, the waterline 
was used as the height of the 
heave point, which was 
calculated earlier in 'RP to 
Waterline'.  

The location of the phase center 
of the port and starboard 
POS/MV antennas were 
measured by NOAA personnel 
with respect to the SRF.  The 
scalar distance between the 
phase centers was then 
calculated. 



All Values Shown are in Theodolite Coordinates
1018 Vessel Diagram

Note:   Both antenna have been replaced for the POS 
V4.  While their x-y values are not thought to have 
changed, the z-value has been remeasured.





BM C BS BM A D m S DD dA Hd Vd BM A
X 0 HA 269 55 40 269.9278 1.412249 -1.000956 X -0.0018
Y 0 VA 125 19 40 125.3278 -35.32778 Y -1.4122
Z 0 SDx 1.731 Z 0.2940

HI 1.385
HT 0.09

BM L BS BM A D m S DD dA Hd Vd BM A
X 4.8802 HA 196 5 30 196.0917 5.084436 -0.720982 X -0.0050
Y -0.00318 VA 98 4 15 98.07083 -8.070833 Y -1.4125
Z 1.192667 SDx 5.1353 Z 0.3037

HI 1.431
HT 1.599

BM F BS BM A D m S DD dA Hd Vd BM A
X 1.8269 HA 217 38 5 217.6347 2.310529 -1.824927 X -0.0029
Y -0.0020 VA 128 18 10 128.3028 -38.30278 Y -1.4129
Z 2.0543 SDx 2.9443 Z 0.3004

HI 1.673
HT 1.602

BM C BS BM B D m S DD dA Hd Vd BM B
X 0 HA 90 6 50 90.11389 1.408507 -1.02162 X -0.0028
Y 0 VA 125 57 15 125.9542 -35.95417 Y 1.4085
Z 0 SDx 1.74 Z 0.2734

HI 1.385
HT 0.09

BM F BS BM B D m S DD dA Hd Vd BM B
X 1.8269 HA 142 17 30 142.2917 2.30385 -1.847291 X 0.0042
Y -0.0020 VA 128 43 25 128.7236 -38.72361 Y 1.4071
Z 2.0543 SDx 2.953 Z 0.2780

HI 1.673
HT 1.602

BM L BS BM B D m S DD dA Hd Vd BM B
X 4.8802 HA 163 48 50 163.8139 5.07525 -0.745425 X 0.0061
Y -0.00318 VA 98 21 20 98.35556 -8.355556 Y 1.4116
Z 1.192667 SDx 5.1297 Z 0.2792

HI 1.431
HT 1.599

All offsets are in Theodolite Coordinate System



BM D BS BM C D m S DD dA Hd Vd BM C
X 6.970125 HA 180 0 0 180 6.971795 -0.940903 X -0.0017 Modified D so C is 0
Y -0.002655 VA 97 41 10 97.68611 -7.686111 Y -0.0027
Z 0.695667 SDx 7.035 Z 0.0108

HI 1.451
HT 1.195

BM F BS BM C D m S DD dA Hd Vd BM C
X 1.8244 HA 180 4 0 180.0667 1.824376 -2.121032 X 0.0000 Modified F so C is 0
Y 0.0021 VA 139 18 0 139.3 -49.3 Y 0.0000
Z 2.0500 SDx 2.7977 Z 0.0000

HI 1.673
HT 1.602

 BS BM C D m S DD dA Hd Vd BM C
X 0 HA 0 0 0 0 0 0 X 0.0000
Y 0 VA 0 0 0 0 90 Y 0.0000
Z 0 SDx 0 Z 0.0000

HI 0
J HT 0

BM C BS BM D D m S DD dA Hd Vd BM D
X 0 HA 0 0 0 0 6.971868 0.503147 X 6.9719
Y 0 VA 85 52 20 85.87222 4.127778 Y 0.0000
Z 0 SDx 6.99 Z 0.6901

HI 1.385
HT 1.198

 BS BM D D m S DD dA Hd Vd BM D
X 0 HA 0 0 0 0 0 0 X 6.9718
Y 0 VA 0 0 0 0 90 Y 0.0000 IN BM D BS BM C
Z 0 SDx 0 Z 0.6849

HI 0
HT 0

BM F BS BM D D m S DD dA Hd Vd BM D
X 1.8269 HA 359 58 20 359.9722 5.142666 -1.428201 X 6.9695
Y -0.0020 VA 105 31 15 105.5208 -15.52083 Y -0.0045
Z 2.0543 SDx 5.3373 Z 0.6971

HI 1.673
HT 1.602



BM L BS BM D D m S DD dA Hd Vd BM D
X 4.8802 HA 359 59 50 359.9972 2.085613 -1.839614 X 6.9658
Y -0.00318 VA 131 24 50 131.4139 -41.41389 Y -0.0033
Z 1.192667 SDx 2.781 Z 0.7021

HI 1.431
HT 0.082

BM C BS BM E D m S DD dA Hd Vd BM E
X 0 HA 334 42 5 334.7014 2.016759 1.426038 X 1.8233
Y 0 VA 54 44 10 54.73611 35.26389 Y -0.8618
Z 0 SDx 2.47 Z 2.0160

HI 1.385
HT 0.795

BM D BS BM E D m S DD dA Hd Vd BM E
X 6.970125 HA 189 28 15 189.4708 5.214703 0.66789 X 1.8265
Y -0.002655 VA 82 42 5 82.70139 7.298611 Y -0.8607
Z 0.695667 SDx 5.2573 Z 2.0166

HI 1.451
HT 0.798

BM L BS BM E D m S DD dA Hd Vd BM E
X 4.8802 HA 195 42 25 195.7069 3.171173 0.192337 X 1.8274
Y -0.00318 VA 86 31 45 86.52917 3.470833 Y -0.8617
Z 1.192667 SDx 3.177 Z 2.0220

HI 1.431
HT 0.794

BM C BS BM F D m S DD dA Hd Vd BM F
X 0 HA 359 48 40 359.8111 1.823512 1.461634 X 1.8235
Y 0 VA 51 17 10 51.28611 38.71389 Y -0.0060
Z 0 SDx 2.337 Z 2.0516

HI 1.385
HT 0.795

BM D BS BM F D m S DD dA Hd Vd BM F
X 6.970125 HA 180 1 10 180.0194 5.139289 0.704122 X 1.8308
Y -0.002655 VA 82 11 55 82.19861 7.801389 Y -0.0044
Z 0.695667 SDx 5.1873 Z 2.0528

HI 1.451
HT 0.798

BM L BS BM F D m S DD dA Hd Vd BM F



X 4.8802 HA 179 56 15 179.9375 3.051481 0.228177 X 1.8287
Y -0.00318 VA 85 43 25 85.72361 4.276389 Y 0.0001
Z 1.192667 SDx 3.06 Z 2.0578

HI 1.431
HT 0.794

BM C BS BM G D m S DD dA Hd Vd BM G
X 0 HA 26 44 30 26.74167 2.041987 1.405606 X 1.8236
Y 0 VA 55 27 30 55.45833 34.54167 Y 0.9188
Z 0 SDx 2.479 Z 1.9956

HI 1.385
HT 0.795

BM D BS BM G D m S DD dA Hd Vd BM G
X 6.970125 HA 169 49 30 169.825 5.221683 0.647696 X 1.8306
Y -0.002655 VA 82 55 45 82.92917 7.070833 Y 0.9198
Z 0.695667 SDx 5.2617 Z 1.9964

HI 1.451
HT 0.798

BM L BS BM G D m S DD dA Hd Vd BM G
X 4.8802 HA 163 11 15 163.1875 3.185444 0.170427 X 1.8309
Y -0.00318 VA 86 56 15 86.9375 3.0625 Y 0.9182
Z 1.192667 SDx 3.19 Z 2.0001

HI 1.431
HT 0.794

TBM BS BM H D m S DD dA Hd Vd BM H
X 10.0263 HA 179 55 15 179.9208 6.721906 0.035522 X 3.3044
Y 0.4245 VA 89 41 50 89.69722 0.302778 Y 0.4337
Z -1.8654 SDx 6.722 Z -1.0239

HI 0.756
HT -0.05

TBM BS BM H D m S DD dA Hd Vd BM H
X 10.0263 HA 179 57 40 179.9611 6.726626 -0.031633 X 3.2996
Y 0.4245 VA 90 16 10 90.26944 -0.269444 Y 0.4290
Z -1.8654 SDx 6.7267 Z -1.0231

HI 0.824
HT -0.05

TBM BS BM H D m S DD dA Hd Vd BM H
X 10.0263 HA 179 57 20 179.9556 6.724154 -0.044336 X 3.3021



Y 0.4245 VA 90 22 40 90.37778 -0.377778 Y 0.4297
Z -1.8654 SDx 6.7243 Z -1.0098

HI 0.85
HT -0.05

TBM BS BM I D m S DD dA Hd Vd BM I
X 10.0263 HA 179 57 50 179.9639 6.189202 0.034807 X 3.8371
Y 0.4245 VA 89 40 40 89.67778 0.322222 Y 0.4284
Z -1.8654 SDx 6.1893 Z -1.0246

HI 0.756
HT -0.05

TBM BS BM I D m S DD dA Hd Vd BM I
X 10.0263 HA 180 1 50 180.0306 6.186227 -0.030142 X 3.8400
Y 0.4245 VA 90 16 45 90.27917 -0.279167 Y 0.4212
Z -1.8654 SDx 6.1863 Z -1.0216

HI 0.824
HT -0.05

TBM BS BM I D m S DD dA Hd Vd BM I
X 10.0263 HA 180 0 0 180 6.187145 -0.043795 X 3.8391
Y 0.4245 VA 90 24 20 90.40556 -0.405556 Y 0.4245
Z -1.8654 SDx 6.1873 Z -1.0092

HI 0.85
HT -0.05

BM C BS BM J D m S DD dA Hd Vd BM J
X 0 HA 0 5 40 0.094444 3.28806 -0.990463 X 3.2881
Y 0 VA 106 45 50 106.7639 -16.76389 Y 0.0054
Z 0 SDx 3.434 Z -0.8005

HI 1.385
HT 1.195

BM C BS BM J D m S DD dA Hd Vd BM J
X 0 HA 0 3 45 0.0625 3.291776 -0.936134 X 3.2918
Y 0 VA 105 52 30 105.875 -15.875 Y 0.0036
Z 0 SDx 3.4223 Z -0.7991

HI 1.372
HT 1.235

BM C BS BM J D m S DD dA Hd Vd BM J
X 0 HA 0 2 15 0.0375 3.291552 -0.928486 X 3.2916
Y 0 VA 105 45 10 105.7528 -15.75278 Y 0.0022



Z 0 SDx 3.42 Z -0.8065
HI 1.36
HT 1.238

BM C BS BM K D m S DD dA Hd Vd BM K
X 0 HA 2 19 25 2.323611 3.293853 -0.992034 X 3.2911
Y 0 VA 106 45 40 106.7611 -16.76111 Y 0.1335
Z 0 SDx 3.44 Z -0.8020

HI 1.385
HT 1.195

BM C BS BM K D m S DD dA Hd Vd BM K
X 0 HA 2 19 55 2.331944 3.294948 -0.938504 X 3.2922
Y 0 VA 105 53 55 105.8986 -15.89861 Y 0.1341
Z 0 SDx 3.426 Z -0.8015

HI 1.372
HT 1.235

BM C BS BM K D m S DD dA Hd Vd BM K
X 0 HA 2 21 0 2.35 3.293653 -0.92951 X 3.2909
Y 0 VA 105 45 35 105.7597 -15.75972 Y 0.1351
Z 0 SDx 3.4223 Z -0.8075

HI 1.36
HT 1.238

BM C BS BM L D m S DD dA Hd Vd BM L
X 0 HA 359 58 35 359.9764 4.884186 -0.13311 X 4.8842
Y 0 VA 91 33 40 91.56111 -1.561111 Y -0.0020
Z 0 SDx 4.886 Z 1.1899

HI 1.385
HT 0.062

BM D BS BM L D m S DD dA Hd Vd BM L
X 6.970125 HA 180 2 45 180.0458 2.089829 0.115163 X 4.8803
Y -0.002655 VA 86 50 45 86.84583 3.154167 Y -0.0043
Z 0.695667 SDx 2.093 Z 1.1938

HI 1.451
HT 1.068

BM F BS BM L D m S DD dA Hd Vd BM L
X 1.8269 HA 0 3 10 0.052778 3.052617 -0.926082 X 4.8795
Y -0.0020 VA 106 52 35 106.8764 -16.87639 Y 0.0008
Z 2.0543 SDx 3.19 Z 1.1993



HI 1.673
HT 1.602

BM D BS PORT ANT D m S DD dA Hd Vd PORT ANT
X 0 HA 339 28 10 339.4694 2.610523 1.726867 X 2.4447
Y 0 VA 56 30 55 56.51528 33.48472 Y -0.9155
Z 0 SDx 3.13 Z 2.3219

HI 1.385
HT 0.79

BM D BS PORT ANT D m S DD dA Hd Vd PORT ANT
X 6.970125 HA 191 21 30 191.3583 4.613315 0.970543 X 2.4472
Y -0.002655 VA 78 7 10 78.11944 11.88056 Y -0.9112
Z 0.695667 SDx 4.7143 Z 2.3222

HI 1.451
HT 0.795

BM L BS PORT ANT D m S DD dA Hd Vd PORT ANT
X 4.8802 HA 200 29 30 200.4917 2.600669 -0.216924 X 2.4441
Y -0.00318 VA 94 46 5 94.76806 -4.768056 Y -0.9136
Z 1.192667 SDx 2.6097 Z 2.3247

HI 1.431
HT 0.082

BM C BS STBD ANT D m S DD dA Hd Vd STBD ANT
X 0 HA 20 41 20 20.68889 2.60875 1.709557 X 2.4405
Y 0 VA 56 45 45 56.7625 33.2375 Y 0.9217
Z 0 SDx 3.119 Z 2.3046

HI 1.385
HT 0.79

BM D BS STBD ANT D m S DD dA Hd Vd STBD ANT
X 6.970125 HA 168 29 0 168.4833 4.617073 0.951015 X 2.4460
Y -0.002655 VA 78 21 40 78.36111 11.63889 Y 0.9192
Z 0.695667 SDx 4.714 Z 2.3027

HI 1.451
HT 0.795

BM L BS STBD ANT D m S DD dA Hd Vd STBD ANT
X 4.884186 HA 159 15 20 159.2556 2.605607 -0.236301 X 2.4475
Y -0.002013 VA 95 10 55 95.18194 -5.181944 Y 0.9209
Z 1.18989 SDx 2.6163 Z 2.3026

HI 1.431



HT 0.082

BM H BS PHASE CENT D m S DIRECT MEASUREMENT PHASE CENT
X 3.302044 HA N/A N/A N/A 0.08 X 3.3820
Y 0.430807 VA N/A N/A N/A -0.143 Y 0.2878
Z -1.0485 SDx N/A -0.36 Z -1.4085

HI N/A
HT N/A

BM H BS PHASE CENT D m S DIRECT MEASUREMENT PHASE CENT
X 3.302044 HA N/A N/A N/A 0.08 X 3.3820
Y 0.430807 VA N/A N/A N/A -0.145 Y 0.2858
Z -1.0485 SDx N/A -0.36 Z -1.4085

HI N/A
HT N/A

BM H BS PHASE CENT D m S DIRECT MEASUREMENT PHASE CENT
X 3.302044 HA N/A N/A N/A 0.08 X 3.3820
Y 0.430807 VA N/A N/A N/A -0.143 Y 0.2878
Z -1.0485 SDx N/A -0.36 Z -1.4085

HI N/A
HT N/A

BM C BS IMU D m S DD dA Hd Vd IMU
X 0 HA 359 45 30 359.7583 3.545118 -1.038158 X 3.5451
Y 0 VA 106 19 20 106.3222 -16.32222 Y -0.0150
Z 0 SDx 3.694 Z -0.8482

HI 1.385
HT 1.195

BM C BS IMU D m S DD dA Hd Vd IMU
X 0 HA 359 45 55 359.7653 3.5471 -0.98379 X 3.5471
Y 0 VA 105 30 5 105.5014 -15.50139 Y -0.0145
Z 0 SDx 3.681 Z -0.8468

HI 1.372
HT 1.235

BM C BS IMU D m S DD dA Hd Vd IMU
X 0 HA 359 44 30 359.7417 3.545481 -0.975756 X 3.5454
Y 0 VA 105 23 15 105.3875 -15.3875 Y -0.0160
Z 0 SDx 3.6773 Z -0.8538

HI 1.36
HT 1.238



BM D BS TBM D m S DD dA Hd Vd TBM
X 6.970125 HA 7 55 30 7.925 3.082642 -2.405777 X 10.0233
Y -0.002655 VA 127 58 10 127.9694 -37.96944 Y 0.4224
Z 0.695667 SDx 3.9103 Z -1.8641

HI 1.451
HT 1.605

BM L BS TBM D m S DD dA Hd Vd TBM
X 4.8802 HA 4 45 40 4.761111 5.161378 -2.88509 X 10.0238
Y -0.00318 VA 119 12 15 119.2042 -29.20417 Y 0.4252
Z 1.192667 SDx 5.913 Z -1.8664

HI 1.431
HT 1.605

BM F BS TBM D m S DD dA Hd Vd TBM
X 1.8269 HA 2 59 5 2.984722 8.215994 -4.000061 X 10.0317
Y -0.0020 VA 115 57 35 115.9597 -25.95972 Y 0.4258
Z 2.0543 SDx 9.138 Z -1.8657

HI 1.673
HT 1.593



FR
SETUP 1
BS BM C FS BM A

TI Ave (HI) TI Ave BM El
Top 2.704 2.680667 Top 2.409 2.383
Mid 2.681 0.023 Mid 2.383 0.026
Bot 2.657 0.024 Bot 2.357 0.026

DTI DTI
1 0

BM C HI Rod BM A
0 2.680667 2.383 0.297667

SETUP 2
BS BM C FS BM A

TI Ave (HI) TI Ave BM El
Top 2.708 2.684667 Top 2.409 2.383667
Mid 2.685 0.023 Mid 2.384 0.025
Bot 2.661 0.024 Bot 2.358 0.026

DTI DTI
1 1

BM C HI Rod BM A BM A AVE 0.299333
0 2.684667 2.383667 0.301 mm DIFF -3.33333

SETUP 1
BS BM C FS BM B

TI Ave (HI) TI Ave BM El
Top 2.704 2.680667 Top 2.431 2.406333
Mid 2.681 0.023 Mid 2.406 0.025
Bot 2.657 0.024 Bot 2.382 0.024

DTI DTI
1 1

BM C HI Rod BM B
0 2.680667 2.406333 0.274333

SETUP 2
BS BM C FS BM B

TI Ave (HI) TI Ave BM El
Top 2.708 2.684667 Top 2.432 2.407667
Mid 2.685 0.023 Mid 2.408 0.024
Bot 2.661 0.024 Bot 2.383 0.025

DTI DTI
1 1

BM C HI Rod BM B BM B AVE 0.275667
0 2.684667 2.407667 0.277 mm DIFF -2.66667

SETUP 1
BS BM C FS BM C

TI Ave (HI) TI Ave BM El
Top 2.704 2.680667 Top 2.409 2.383
Mid 2.681 0.023 Mid 2.383 0.026
Bot 2.657 0.024 Bot 2.357 0.026

DTI DTI
1 0

BM C HI Rod BM C
0 2.680667 2.383 0.297667

SETUP 2
BS BM C FS BM C 0 BY DEFINITION

TI Ave (HI) TI Ave BM El
Top 2.708 2.684667 Top 2.409 2.383667

All offsets are in Theodolite Coordinate System



Mid 2.685 0.023 Mid 2.384 0.025
Bot 2.661 0.024 Bot 2.358 0.026

DTI DTI
1 1

BM C HI Rod BM C
0 2.684667 2.383667 0.301 mm DIFF -0.00333

SETUP 1
BS BM C FS BM D

TI Ave (HI) TI Ave BM El
Top 2.704 2.680667 Top 1.997 1.986667
Mid 2.681 0.023 Mid 1.986 0.011
Bot 2.657 0.024 Bot 1.977 0.009

DTI DTI
1 2 ??

BM C HI Rod BM D
0 2.680667 1.986667 0.694

SETUP 2
BS BM C FS BM D

TI Ave (HI) TI Ave BM El
Top 2.708 2.684667 Top 1.997 1.987333
Mid 2.685 0.023 Mid 1.987 0.01
Bot 2.661 0.024 Bot 1.978 0.009

DTI DTI
1 1

BM C HI Rod BM D BM D AVE 0.695667
0 2.684667 1.987333 0.697333 mm DIFF -3.33333

SETUP 1
BS BM C FS BM E

TI Ave (HI) TI Ave BM El
Top 2.704 2.680667 Top 0.68 0.664333
Mid 2.681 0.023 Mid 0.664 0.016
Bot 2.657 0.024 Bot 0.649 0.015

DTI DTI
1 1

BM C HI Rod BM E
0 2.680667 0.664333 2.016333

SETUP 2
BS BM C FS BM E

TI Ave (HI) TI Ave BM El
Top 2.708 2.684667 Top 0.679 0.663667
Mid 2.685 0.023 Mid 0.663 0.016
Bot 2.661 0.024 Bot 0.649 0.014

DTI DTI
1 2

BM C HI Rod BM E BM E AVE 2.018667
0 2.684667 0.663667 2.021 mm DIFF -4.66667

SETUP 1
BS BM C FS BM F

TI Ave (HI) TI Ave BM El
Top 2.704 2.680667 Top 0.643 0.628
Mid 2.681 0.023 Mid 0.628 0.015
Bot 2.657 0.024 Bot 0.613 0.015

DTI DTI
1 0

BM C HI Rod BM F



0 2.680667 0.628 2.052667
SETUP 2
BS BM C FS BM F

TI Ave (HI) TI Ave BM El
Top 2.708 2.684667 Top 0.643 0.628667
Mid 2.685 0.023 Mid 0.629 0.014
Bot 2.661 0.024 Bot 0.614 0.015

DTI DTI
1 1

BM C HI Rod BM F BM F AVE 2.054333
0 2.684667 0.628667 2.056 mm DIFF -3.33333

SETUP 1
BS BM C FS BM G

TI Ave (HI) TI Ave BM El
Top 2.704 2.680667 Top 0.699 0.684
Mid 2.681 0.023 Mid 0.684 0.015
Bot 2.657 0.024 Bot 0.669 0.015

DTI DTI
1 1.11E-13

BM C HI Rod BM G
0 2.680667 0.684 1.996667

SETUP 2
BS BM C FS BM G

TI Ave (HI) TI Ave BM El
Top 2.708 2.684667 Top 0.699 0.684667
Mid 2.685 0.023 Mid 0.685 0.014
Bot 2.661 0.024 Bot 0.67 0.015

DTI DTI
1 1

BM C HI Rod BM G BM G AVE 1.998333
0 2.684667 0.684667 2 mm DIFF -3.33333

SETUP 5
BS TBM FS BM H

TI Ave (HI) TI Ave BM El
Top 0.506 0.492 Top -0.058 -0.07233
Mid 0.492 0.014 Mid -0.072 0.014
Bot 0.478 0.014 Bot -0.087 0.015

DTI DTI
0 1

TBM HI Rod BM H
-1.61267 0.492 -0.07233 -1.04833

SETUP 6
BS TBM FS BM H

TI Ave (HI) TI Ave BM El
Top 0.403 0.418 Top -0.131 -0.146
Mid 0.418 -0.015 Mid -0.146 0.015
Bot 0.433 -0.015 Bot -0.161 0.015

DTI DTI
5.55E-14 2.78E-14

TBM HI Rod BM H BM H AVE -1.0485
-1.61267 0.418 -0.146 -1.04867 mm DIFF 0.333333

SETUP 5
BS TBM FS BM I

TI Ave (HI) TI Ave BM El
Top 0.506 0.492 Top -0.06 -0.07367



Mid 0.492 0.014 Mid -0.074 0.014
Bot 0.478 0.014 Bot -0.087 0.013

DTI DTI
0 1

TBM HI Rod BM I
-1.61267 0.492 -0.07367 -1.047

SETUP 6
BS TBM FS BM I

TI Ave (HI) TI Ave BM El
Top 0.403 0.418 Top -0.134 -0.14733
Mid 0.418 -0.015 Mid -0.147 0.013
Bot 0.433 -0.015 Bot -0.161 0.014

DTI DTI
5.55E-14 1

TBM HI Rod BM I BM I AVE -1.04717
-1.61267 0.418 -0.14733 -1.04733 mm DIFF 0.333333

SETUP 7
BS BM C FS BM J

TI Ave (HI) TI Ave BM El
Top 1.068 1.06 Top 1.88 1.871
Mid 1.06 0.008 Mid 1.871 0.009
Bot 1.052 0.008 Bot 1.862 0.009

DTI DTI
0 0

BM C HI Rod BM J
0 1.06 1.871 -0.811

SETUP 8
BS BM C FS BM J

TI Ave (HI) TI Ave BM El
Top 1.058 1.049 Top 1.865 1.857333
Mid 1.049 0.009 Mid 1.857 0.008
Bot 1.04 0.009 Bot 1.85 0.007

DTI DTI
2.22E-13 1

BM C HI Rod BM J BM J AVE -0.80967
0 1.049 1.857333 -0.80833 mm DIFF -2.66667

SETUP 7
BS BM C FS BM K

TI Ave (HI) TI Ave BM El
Top 1.068 1.06 Top 1.88 1.871
Mid 1.06 0.008 Mid 1.871 0.009
Bot 1.052 0.008 Bot 1.862 0.009

DTI DTI
0 0

BM C HI Rod BM K
0 1.06 1.871 -0.811

SETUP 8
BS BM C FS BM K

TI Ave (HI) TI Ave BM El
Top 1.058 1.049 Top 1.868 1.859667
Mid 1.049 0.009 Mid 1.86 0.008
Bot 1.04 0.009 Bot 1.851 0.009

DTI DTI
2.22E-13 1

BM C HI Rod BM K BM K AVE -0.81083
0 1.049 1.859667 -0.81067 mm DIFF -0.33333



SETUP 3
BS BM C FS BM L

TI Ave (HI) TI Ave BM El
Top 1.852 1.817333 Top 0.633 0.623667
Mid 1.818 0.034 Mid 0.624 0.009
Bot 1.782 0.036 Bot 0.614 0.01

DTI DTI
2 1

BM C HI Rod BM L
0 1.817333 0.623667 1.193667

SETUP 4
BS BM C FS BM L

TI Ave (HI) TI Ave BM El
Top 1.851 1.817 Top 0.635 0.625333
Mid 1.817 0.034 Mid 0.625 0.01
Bot 1.783 0.034 Bot 0.616 0.009

DTI DTI
0 1

BM C HI Rod BM L BM L AVE 1.192667
0 1.817 0.625333 1.191667 mm DIFF 2

SETUP 1
BS BM C FS P ANT

TI Ave (HI) TI Ave BM El
Top 2.704 2.680667 Top 0.377 0.364
Mid 2.681 0.023 Mid 0.364 0.013
Bot 2.657 0.024 Bot 0.351 0.013

DTI DTI
1 0

BM C HI Rod P ANT
0 2.680667 0.364 2.316667

SETUP 2
BS BM C FS P ANT

TI Ave (HI) TI Ave BM El
Top 2.708 2.684667 Top 0.394 0.382
Mid 2.685 0.023 Mid 0.382 0.012
Bot 2.661 0.024 Bot 0.37 0.012

DTI DTI
1 0

BM C HI Rod P ANT P ANT AVE 2.309667
0 2.684667 0.382 2.302667 mm DIFF 14

SETUP 1
BS BM C FS S ANT

TI Ave (HI) TI Ave BM El
Top 2.704 2.680667 Top 0.394 0.381667
Mid 2.681 0.023 Mid 0.382 0.012
Bot 2.657 0.024 Bot 0.369 0.013

DTI DTI
1 1

BM C HI Rod S ANT
0 2.680667 0.381667 2.299

SETUP 2
BS BM C FS S ANT

TI Ave (HI) TI Ave BM El
Top 2.708 2.684667 Top 0.376 0.363333
Mid 2.685 0.023 Mid 0.363 0.013



Bot 2.661 0.024 Bot 0.351 0.012
DTI DTI

1 1
BM C HI Rod S ANT S ANT AVE 2.310167

0 2.684667 0.363333 2.321333 mm DIFF -22.3333

SETUP 7
BS BM C FS IMU

TI Ave (HI) TI Ave BM El
Top 1.068 1.06 Top 1.928 1.918
Mid 1.06 0.008 Mid 1.918 0.01
Bot 1.052 0.008 Bot 1.908 0.01

DTI DTI
0 0

BM C HI Rod IMU
0 1.06 1.918 -0.858

SETUP 8
BS BM C FS IMU

TI Ave (HI) TI Ave BM El
Top 1.058 1.049 Top 1.918 1.908667
Mid 1.049 0.009 Mid 1.909 0.009
Bot 1.04 0.009 Bot 1.899 0.01

DTI DTI
2.22E-13 1

BM C HI Rod IMU IMU AVE -0.85883
0 1.049 1.908667 -0.85967 mm DIFF 1.666667

SETUP 1
BS BM C FS PC

TI Ave (HI) TI Ave BM El
Top 2.704 2.680667 Top 2.409 2.383
Mid 2.681 0.023 Mid 2.383 0.026
Bot 2.657 0.024 Bot 2.357 0.026

DTI DTI
1 0

BM C HI Rod PC
0 2.680667 2.383 0.297667 MEASURED

SETUP 2
BS BM C FS PC

TI Ave (HI) TI Ave BM El
Top 2.708 2.684667 Top 2.409 2.383667
Mid 2.685 0.023 Mid 2.384 0.025
Bot 2.661 0.024 Bot 2.358 0.026

DTI DTI
1 1

BM C HI Rod PC PC AVE 0.299333
0 2.684667 2.383667 0.301 mm DIFF -3.33333

SETUP 3
BS BM C FS TEMP BM

TI Ave (HI) TI Ave BM El
Top 1.852 1.817333 Top 3.448 3.429667
Mid 1.818 0.034 Mid 3.429 0.019
Bot 1.782 0.036 Bot 3.412 0.017

DTI DTI
2 2

BM C HI Rod TEMP BM
0 1.817333 3.429667 -1.61233



SETUP 4
BS BM C FS TEMP BM

TI Ave (HI) TI Ave BM El
Top 1.851 1.817 Top 3.449 3.43
Mid 1.817 0.034 Mid 3.43 0.019
Bot 1.783 0.034 Bot 3.411 0.019

DTI DTI
0 4.44E-13

BM C HI Rod TEMP BM TEMP BM -1.61267
0 1.817 3.43 -1.613 mm DIFF 0.666667



Jul-04

The Z plane means were taken using only the vertical level measurements.
BM A      
X -0.00178 -0.00503 -0.00289 Mean -0.00323 0.001649 ⇐ X Std Dev
Y -1.41225 -1.41246 -1.41291 -1.41254 0.000338 ⇐ Y Std Dev
Z 0.294044 0.303685 0.300406 0.299333 0.299333

BM B      
X -0.0028 0.00421 0.006127 Mean 0.002512 0.004699 ⇐ X Std Dev
Y 1.408504 1.407088 1.411589 1.40906 0.002301 ⇐ Y Std Dev
Z 0.27338 0.278042 0.279241 0.275667  0.275667

BM C      
X 0 By Definition
Y 0
Z 0  

BM D      
X 6.971868 6.971768 6.9671 6.9698 Mean 6.970125 0.002251 ⇐ X Std Dev
Y 0 0 -0.0085 -0.0021 -0.00265 0.004025 ⇐ Y Std Dev
Z 0.690147 0.684947 0.6944 0.6993 0.695667 0.695667

BM E      
X 1.823338 1.826502 1.827443 Mean 1.825761 0.002151 ⇐ X Std Dev
Y -0.86183 -0.86071 -0.86167 -0.8614 0.000607 ⇐ Y Std Dev
Z 2.016038 2.016557 2.022004 2.018667  2.018667

BM F      
X 1.823502 1.830837 1.828721 1.824402 Mean 1.826865 0.003493 ⇐ X Std Dev
Y -0.00601 -0.0044 0.000149 0.002088 -0.00204 0.003794 ⇐ Y Std Dev
Z 2.051634 2.052789 2.057844 2.050034 2.054333 2.054333

BM G      
X 1.823585 1.830565 1.830913 Mean 1.828354 0.004134 ⇐ X Std Dev
Y 0.91883 0.919783 0.91818 0.918931 0.000806 ⇐ Y Std Dev
Z 1.995606 1.996363 2.000093 1.998333  1.998333

BM H      
X 3.30437 3.299646 3.302118 Mean 3.302044 0.002363 ⇐ X Std Dev
Y 0.433739 0.429017 0.429667 0.430807 0.002559 ⇐ Y Std Dev
Z -1.0239 -1.02305 -1.00976 -1.0485 -1.0485

BM I      
X 3.8371 3.840044 3.839125 Mean 3.838746 0.001523 ⇐ X Std Dev
Y 0.4284 0.421152 0.424451 0.424652 0.003604 ⇐ Y Std Dev
Z -1.0246 -1.02156 -1.00922 -1.04717  -1.04717

BM J      
X 3.288056 3.291774 3.291551 Mean 3.29046 0.002086 ⇐ X Std Dev
Y 0.00542 0.003591 0.002154 0.003722 0.001637 ⇐ Y Std Dev
Z -0.80046 -0.79913 -0.80649 -0.80967  -0.80967

BM K      
X 3.291145 3.29222 3.290883 Mean 3.291416 0.000708 ⇐ X Std Dev
Y 0.133544 0.134068 0.135052 0.134221 0.000765 ⇐ Y Std Dev
Z -0.80203 -0.8015 -0.80751 -0.81083  -0.81083

BM L      
X 4.884186 4.880297 4.876118 Mean 4.8802 0.004035 ⇐ X Std Dev

1018 Launch Offset Measurements

All offsets are in Theodolite Coordinate System



Y -0.00201 -0.00433 -0.0032 -0.00318 0.001157 ⇐ Y Std Dev
Z 1.18989 1.193829 1.196552 1.192667 1.192667

S ANT      
X 2.440518 2.446009 2.447502 Mean 2.444676 0.003678 ⇐ X Std Dev
Y 0.921654 0.919158 0.920894 0.920569 0.00128 ⇐ Y Std Dev
Z 2.304557 2.302682 2.302589 2.310167  2.310167

P ANT      
X 2.444717 2.447164 2.444094 Mean 2.445325 0.001623 ⇐ X Std Dev
Y -0.91553 -0.91122 -0.9136 -0.91345 0.002157 ⇐ Y Std Dev
Z 2.321867 2.322209 2.324743 2.309667  2.309667

IMU      
X 3.545087 3.54707 3.545445 Mean 3.545867 0.001057 ⇐ X Std Dev
Y -0.01495 -0.01453 -0.01599 -0.01516 0.000748 ⇐ Y Std Dev
Z -0.84816 -0.84679 -0.85376 -0.85883  -0.85883

TBM Theo     
X 10.02333 10.02377 10.03171 Mean 10.02627 0.00472 ⇐ X Std Dev
Y 0.42237 0.425222 0.425761 0.424451 0.001822 ⇐ Y Std Dev
Z -1.86411 -1.86642 -1.86573 -1.86542  -1.86542

Phase Center     
X 3.382044 3.382044 3.382044 Mean 3.382044 0 ⇐ X Std Dev
Y 0.287807 0.285807 0.287807 0.287141 0.001155 ⇐ Y Std Dev
Z -1.4085 -1.4085 -1.4085 -1.4085  -1.4085



Measurement Explanation Notes

BM C to BM D
6.97 From Offsets & Measurements XYZ.

BM D  to Center of Pick Point
-0.27 Measured with steel tape 11/16/05.

Center of Pick Point to Frame 0
0.5207 From JMC drawing of 1010.  Converted to meters.

BM C to Frame 0
7.2207 Calculated from cells 4, 7 and 10.

Frame 0 to LCG
-4.818888 From JMC Stability Test for 1010.  Converted to meters.

BM C to LCG
2.401812 Calculated from cells 13 and 16.

BM C to IMU
3.516 From Offsets & Measurements XYZ.

IMU to LCG
-1.114188 Calculated from cells 19 and 22.

All calculations are for the X offset from the IMU to the 
Heave Point in the theodolite coordinate system.  
Measurements are in meters.  

All calculations are for the X offset from the IMU to the 
Heave Point in the theodolite coordinate system.  
Measurements are in meters.  

LCG stands for longitudinal center of gravity, which was 
assumed to be the location of the heave point for the launch. 

JMC refers to the Jensen Marine Consultants, Inc. report 
titled, 28' NOAA Survey Launch Stability Information Booklet 
(1018), dated February 23, 2005.  There were several 
different values for the LCG in the JMC report, but the value 
used for these calculations was believed to be the most 
reasonable.









FAIRWEATHER
Multibeam Echosounder Calibration

Vessel

6/9/2008
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

POSMV 320 v.4 8/13/2008, re done after configuration switch, earlier date unavailable
Description of Positioning System Date of most recent positioning system calibration

Launch 1018

Breen, Campbell, Johnston, Argento, Faulkes, Renoud

not availableDrop down hull mount on 1018

161

8101

Ketchikan Tongass Narrows

357373102026

4/1/2008Swing Arm Mount



Acquisition Log

6/9/2008 161
Date Dn Local Area Wx

Bottom Type Approximate Water Depth

Personnel on board

Comments

TrueHeave filename

11:02 42.1 54.4
SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

11:19 42.4 55.2
SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

12:00 37.3 48.6
SV Cast #3 filename UTC Time Lat Lon Depth Ext. Depth

13:34 45.3 59.9
SV Cast #3 filename UTC Time Lat Lon Depth Ext. Depth

0:00 41.1 53.4
SV Cast #3 filename UTC Time Lat Lon Depth Ext. Depth

131/37/07.2

081611334 55/19/58.8 131/37/58.3

081611459 55/16/57.5

TH_1018_161.000

55/19/58.4 131/37/46.9

081611200 55/19/35.6

081611102 55/19/58.8 131/37/47

081611119

Ketchikan Tongass Narrows Clear

Breen, Campbell, Walker, Faulkes

131/39/54.1



ROLL
SV Cast # XTF Line Filename Heading Speed (kts) Remarks

81611200 143 5.5
316 5.2
146 5.3
316 5.4
146 5.8
316 5.4

PITCH
SV Cast # XTF Line Filename Heading Speed (kts) Remarks

81611119 108 7.5
295 7.5
110 7.6+

292 7.2
111 7.5

HEADING/YAW
SV Cast # XTF Line Filename Heading Speed (kts) Remarks

81611334
298 6.6
117 6.8
298 6.6
116 6.6

NAV TIME LATENCY
SV Cast # XTF Line Filename Heading Speed (knotsRemarks

81611102 6.0
8.0

10.0
12.0

Heading1
Heading2 good, 2 and 3 same side

Timing3 Good line

Heading3 good
Heading4

Good line

Pitch5
Pitch6

abort

Transducer was raised and lowered between each roll linRoll6

Roll1 Good line

Pitch1

Roll5

Roll2
Roll3
Roll4

Pitch2
Pitch3
Pitch4 abort

Timing4 Good line

good,4 and 5 same side
Heading5 good

Timing1 Good line
Timing2



Processing Log

Date Dn Personnel

TrueHeave applied

SVP applied

Tide applied

Zone file

Lines merged

Data cleaned to remove gross fliers

TH_1018_161.000, TH_1018_161A.000

9450460_1010_PatchTest.tid

Patch_10181_161_GMT.svp

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

Data converted --> HDCS_Data in CARIS

Do not enter/apply correctors until all evaluations are complete and analyzed.

Compute correctors in this order



Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)

0.00 0.37 2.57 1.52
0.00 2.63 1.62

0.00 0.32 2.50 2.10
0.00 0.25 2.58 1.42

0.00 0.31 2.57 1.67
0.00 0.06 0.05 0.30

Resulting HVF File Name

MRU Align StdDev gyro 0.30 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.06 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 6/14/2008Bonnie Johnston

PATCH TEST RESULTS/CORRECTORS

Breen

Did not use Breen and Argento values because their Latency was large.  Timing latency should be almost indetectable.  An incorrect 
latency would falsely impact the rest of the values, so those were not used.

Final Values based on

Averages
Standard Deviation

FINAL VALUES

Johnston

FA_1018_Reson8101 (2006-161)

Johnston, Campbell (except pitch), Faulkes, Renoud

Renoud
Faulkes

Campbell
Argento



FAIRWEATHER
Multibeam Echosounder Calibration

Vessel

6/23/2008 Kodiak, AK
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

POSMV v4 8/13/2008, re done after configuration switch, earlier date unavailable
Description of Positioning System Date of most recent positioning system calibration

Launch 1018

Argento, Bucher, Renoud

N/A1018 swing mount

175

Reson 8101

357373102026

4/1/2008Swing Arm Mount



Acquisition Log

6/23/2008
Date Dn Local Area Wx

Bottom Type Approximate Water Depth

Personnel on board

Comments

TrueHeave filename

19:05 37.1
SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth
081751905

175

57/44/08.5 152/24/26.7

TH_1018_Dn175

clear, sunny, breezyNE Cliff Point

Evans, Bucher, Argento, Renoud

90 ftSandy



ROLL
SV Cast # Heading Speed (kts) Remarks

1 175 8.0
1 355 8.0
1 175 8.0
1 359 8.0
1 175 8.0
1 353 8.0
1 175 8.0
1 355 8.0
1 170 8.0
1 355 8.0
1 170 8.0
1 355 4.0
1 170 4.0
1 355 10.0
1 170 10.0
1 355 8.0
1 170 8.0

okay, messy data, usable10_kts_B
8_kts_A

Bucher_B_8kts small sonar blowout, otherwise good line

8_kts_B data blowout, messy data, still usable

4kts
4kts_B

good
good

10_kts good

Argento_B_8kts good
Bucher_A_8kts good

XTF Line Filename

Renoud_A_8kts
Renoud_B_8kts
Argento_A_8kts

Evans_A_8kts
Evans_B_8kts
Evans_B_8kts1
Evans_C_8kts

good
good
good
small sonar blowout, otherwise good line

wavy,don'tuse
good
short sonar blowout but usable line
good

Evans_D_8kts



Processing Log

6/23/2008
Date Dn Personnel

TrueHeave applied

SVP applied

Tide applied

Zone file

Lines merged

Data cleaned to remove gross fliers

TH_1018_175

9457292

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

Data converted --> HDCS_Data in CARIS

Faulkes175

Do not enter/apply correctors until all evaluations are complete and analyzed.

Compute correctors in this order



See the following Roll Comparsion section for detailed listing of evaluator values.

Roll (deg)
3.065
See Roll Comparison section
3.065

Resulting HVF File Name

MRU Align StdDev Roll/Pitch Value was not adjusted, Dn 161 value was retained.

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 6/23/2008FA Personnel

PATCH TEST RESULTS/CORRECTORS

FA_1018_Reson8101.hvf

Final Values based on

Averages
Standard Deviation

FINAL VALUES

average of Johnston, Campbell, Argento, Bucher values



FAIRWEATHER
Multibeam Echosounder Calibration

Vessel

8/16/2008
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration
POSMV v4

4/1/2008Swing Arm Mount

Kodiak, AK

Launch 1018

Forney, Argento, Evans

N/A1018 swing mount

229

Reson 8101

357373102026

8/13/2008



Acquisition Log

8/16/2008
Date Dn Local Area Wx

Bottom Type Approximate Water Depth

Personnel on board

Comments

TrueHeave filename

1718 60.5
SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

Cloudy & calmKodiak, AK

Forney, Argento, Evans

08229171.8ex

229

57/47/50.53 152/21/03.33

TH_1018_229_2008



ROLL
SV Cast # Heading Speed (kts) Remarks

1 066
1 066 8.0
1 294 8.0
1 066 8.0
1 294 8.0

PITCH
SV Cast # Heading Speed (kts) Remarks

1 133 8.0
1 317 8.0
1 133 8.0
1 317 8.0

HEADING/YAW
SV Cast # Heading Speed (kts) Remarks

1 133 8.0
1 317 8.0
1 133 8.0
1 317 8.0

NAV TIME LATENCY
SV Cast # Heading Speed (kts) Remarks

SUCCESSFUL
SUCCESSFUL
SUCCESSFUL

HEADING_S1
HEADING_S2
HEADING_N2

SUCCESSFUL
SUCCESSFUL
SUCCESSFUL
SUCCESSFUL

HEADING_N1 SUCCESSFUL

SUCCESSFUL

ABORTED
SUCCESSFUL
SUCCESSFUL
SUCCESSFUL

ROLL5

ROLL1
ROLL2
ROLL3
ROLL4

XTF Line Filename

XTF Line Filename

XTF Line Filename
PITCH1
PITCH2
PITCH3
PITCH4

XTF Line Filename



Processing Log

Date Dn Personnel

TrueHeave applied

SVP applied

Tide applied

Zone file

Lines merged

Data cleaned to remove gross fliers

Do not enter/apply correctors until all evaluations are complete and analyzed.

Compute correctors in this order

Data converted --> HDCS_Data in CARIS

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias



Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
0.00 -0.96 2.99 0.28
0.00 -0.38 2.88 0.18
0.00 -0.50 3.03 0.05

3.06
-0.80 3.00 0.15

0.00 -0.66 2.99 0.17
0.00 0.27 0.07 0.09

-0.66 2.99 0.17

Resulting HVF File Name

MRU Align StdDev gyro 0.09 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.17 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 17 August 200

Values for MRU Align StdDev gyro and Roll/Pitch were not adjusted in the hvf, the values obtained on Dn 161 were retained in the 
hvf. 

FA_1018_Reson8101.hvf

Averages, after outliers were removed.Final Values based on

Averages
Standard Deviation

FINAL VALUES

Renoud
ST Bucher
FOO

Matthew Ringel, FOO Fairweather

PATCH TEST RESULTS/CORRECTORS

Argento
PS Raymond

Patch Test conducted after it was discovered that the POSMV antenna cables were plugged in backwards (i.e. primary was 
plugged into secondary and vice versa).  Gams calibration performed as well.  Patch test values are a fair amount different than 
previous values.  New values supercede old values as old values were based on an incorrect navigation solution.



                          LAUNCH DDSSM DATA ACQUISITION FORM

Date 6/9/2008 DN 161 Wind NW 20
Vessel # 1018 Location Blank Inlet Seas 1-2 ft

Average Depth 25m Personnel Breen, Campbell, Faulkes

RPM Speed Az Isis Line Name                       Acquisition Comments
0 6kts 65 DDSSM1 Good Line

0 8kts 65 DDSSM2 Good Line

0 10kts 65 DDSSM3 Good Line
12kts 65 DDSSM4 Good Line

0 Stop1 Don't Use. Did not cross other lines.
0 Stop2 Wind blowing launch to south over lines. 
0 Stop3 Wind blowing launch to south over lines
0 Stop4 Wind blowing launch to south over lines



Date 6/10/2008 DN 162 Wind
Vessel # 1018 Location Seas

  Average Depth 25 m Personnel

SVP file loaded Patch_10181_161_GMT.svp

Tide file loaded  9450460_1010_PatchTest.tid

Speed-Rest, values obtained by following FPM May 2008, incorrect erroneous formulas/values

Speed Isis Line Name CARIS Line Name Depth Stop2 Diff Stop 2 Depth Stop 3 Diff Stop 3 Depth Stop 4 Diff Stop 4 Average

0 kts STOP 2, 3, 4 STOP 2, 3, 4 26.9886933 0 32.2156629 0 22.3035753 0 0
6 kts DDSSM1 DDSSM1 26.83904 -0.149653333 32.05825 -0.1574129 22.343125 0.03954966 -0.0891722
8 kts DDSSM2 DDSSM2 26.7426667 -0.246026667 31.950875 -0.2647879 22.2724545 -0.0311208 -0.1806451
10 kts DDSSM3 DDSSM3 26.7879286 -0.051111429 32.0003333 -0.2153296 22.1465 -0.1570753 -0.1411721
12 kts DDSSM4 DDSSM4 26.6840909 -0.058575758 32.0708 0.01255 22.1312 -0.211925 -0.0859836

Rest-Speed - Values used

Speed Isis Line Name CARIS Line Name Depth Stop2 Diff Stop 2 Depth Stop 3 Diff Stop 3 Depth Stop 4 Diff Stop 4 Average

0 kts STOP 2, 3, 4 STOP 2, 3, 4 26.9886933 0 32.2156629 0 22.3035753 0 0
6 kts DDSSM1 DDSSM1 26.83904 0.149653333 32.05825 0.15741292 22.343125 -0.0395497 0.0891722
8 kts DDSSM2 DDSSM2 26.7426667 0.246026667 31.950875 0.26478792 22.2724545 0.0311208 0.18064513
10 kts DDSSM3 DDSSM3 26.7879286 0.200764762 32.0003333 0.21532959 22.1465 0.15707534 0.19105656
12 kts DDSSM4 DDSSM4 26.6840909 0.304602424 32.0708 0.14486292 22.1312 0.17237534 0.20728023

Breen, Johnston (values)
Blank Islet



2008 1018 DDSSM  Values used (Rest-Speed) 

Speed (m/s) Speed (knots) Stop 2 Stop 3 Stop 4 Std. Dev. Average
0.00 0 0 0 0 0 0.00
3.09 6 0.149653333 0.157412921 -0.039549658 0.111543893 0.09
4.12 8 0.246026667 0.264787921 0.031120797 0.1298312 0.18
5.14 10 0.200764762 0.215329588 0.157075342 0.030316268 0.19
6.17 12 0.304602424 0.144862921 0.172375342 0.085398715 0.21

1018 DDSSM 2008 Values
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Ship: FAIRWEATHER Vessel: 1018
Date: 8/13/2008 Dn: 226
Personnel: Ringel

PCS Serial # IMU Serial # 007

IP Address:

POS controller Version (Use Menu Help > About) 3.4.0.0

POS Version (Use Menu View > Statistics) 320 v.4
GPS Receivers

Primary Receiver S/N 60145158

Secondary Receiver S/N 60130644

Calibration area
Location:
Approximate Position: Lat 55 5 40.5

Lon 159 54 39.6
DGPS Beacon Station: Cold bay
Frequency: 289

Satellite Constellation (Use View> GPS Data)

Primary GPS
Sketch general SV configuration or insert screen grabs Note any differences from Primary GPS Receiver

N
HDOP HDOP

1.5 1.4

VDOP VDOP
2.3 2.4

Sattelites in use: 10 Sattelites in use: 10
L1 SNR > 30 35 40 L1 SNR > 30 35 40

PDOP 1.8 (Use View> GAMS Solution)

POS/MV Configuration
Settings

Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)
User Entries, Pre-Calibration Baseline Vector

0 Two Antenna Separation (m) 0.052 X Component (m)
0.4 Heading Calibration Threshold -1.831 YComponent (m)

0 Heading Correction -0.005 Z Component (m)

Configuration Notes:

NOAA POS/MV Calibration Report

Shumagin Islands, AK

Secondary GPS

N

2560



POS/MV Calibration

Calibration Procedure: (Refer to POS MV V3 Installation and Operation Guide, 4-25)

Start time: 2130
End time: 2145
Heading accuracy achieved for calibration: 0.2

Calibration Results:
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

POS/MV Post-Calibration Values Baseline Vector
1.834 Two Antenna Separation (m) 0.011 X Component (m)

n/a Heading Calibration Threshold 1.834 YComponent (m)
0 Heading Correction 0.035 Z Component (m)

GAMS Status Online online
Save Settings MRR

Calibration Notes:

Save POS Settings on PC (Use File > Store POS Settings on PC)
File Name:

General Notes:
The POS/MV uses a Right-Hand Orthogonal Reference System
The right-hand orthogonal system defines the following:
• The x-axis is in the fore-aft direction in the appropriate reference frame.
• The y-axis is perpendicular to the x-axis and points towards the

right (starboard) side in the appropriate reference frame.
• The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence
Apply the rotation in the following order to bring the two frames of reference 

into complete alignment:
a) Heading rotation - apply a right-hand screw rotation θz about the

z-axis to align one frame with the other.
b) Pitch rotation - apply a right-hand screw rotation θy about the

once-rotated y-axis to align one frame with the other.
c) Roll rotation - apply a right-hand screw rotation θx about the

twice-rotated x-axis to align one frame with the other.

See configuration extractor file for POS Settings.



SETTINGS
Input/Output Ports (Use Settings > Input/Output Ports)

COM1

COM2

COM3



SETTINGS Continued

Heave Filter (Use Settings > Heave)

Events Use Settings > Events)

INSTALLATION (Use Settings > Installation)

Lever Arms and Mounting Angles (Use Settings > Installation > Lever Arms and Offsets)

Tags, Multipath and Auto Start (Use Settings > Installation > Tags, Multipath and Auto Start)



Sensor Mounting (Use Settings > Installation > Sensor Mounting)

User Parameter Accuracy (Use Settings > Installation > User Accuracy)

GPS  Receiver Configuration (Use Settings> Installation> GPS Receiver Configuration)

Primary GPS  Receiver

Secondary GPS Receiver
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Measurement
Coord. Sys. Caris Caris Caris
x 2.868 1.691 n/a Scaler Distance 1.995
y 8.252 20.172 n/a
z 4.752 17.756 -0.002

*Top of IMU is RP (Reference Pt)

2007 Measured Values used for 2008

Calculations

Coord. Sys. Westlake NGS IMU Base to baseline at Keel NGS
IMU easting 0.000 Port easting -11.920 (ft) elevation 12.856 Port easting -11.920
Base northing 0.000 Ant northing 1.177 IMU Base to baseline at Keel Ant northing 1.177

(ft/m) elevation 0.000 (m) elevation -13.004 (m) elevation 3.919 (m) elevation -13.004
Westlake NGS
8111 easting 27.072 Waterline to Keel Stbd easting -11.917

(ft) northing 9.410 (ft) elevation 13.40 Ant northing 3.171
elevation 15.042 Waterline to Keel (m) elevation -12.956

Westlake (m) elevation 4.084
8111 easting 8.252 (m) easting 8.252 See Ship's Draft Tab

(m) northing 2.868 Top of IMU northing 2.868
elevation 4.585  to 8111 elevation 4.752 Top of IMU to Base of IMU

(m) elevation 0.168
Base of IMU to Top of IMU Top of IMU to Keel

(m) elevation -0.168 (m) 4.086

(m) easting 8.252 (m) easting 20.172 (m) easting N/A
Top of IMU northing 2.868 northing 1.691 Waterline northing N/A Scalar Distance (m) 1.995
 to 8111 elevation 4.752 elevation 17.756  to IMU elevation -0.002

Coord Sys. CARIS Coord Sys. CARIS Coord. Sys.CARIS
x 2.868 x 1.691 x N/A
y 8.252 y 20.172 y N/A
z 4.752 z 17.756 z -0.002

See Description Tab

IMU to 8111 Port Ant to Stbd AntPort Ant to 8111 Waterline to RP*

IMU to 8111

Port Ant to 8111 (Nav to Trans)

Port Ant to 8111 Waterline to RP*

Waterline to RP* Port Ant to Stbd Ant

Port Ant to Stbd Ant

Vessel Offsets for S220_8111 are derived from Westlake-Survey-Report-NOAA-Fairweather-09-23-03.pdf
and Fairweather_NGS_Report_Feb_2007.doc

IMU to 8111 (MRU to Trans)



Caris Pos/Mv Caris Pos/Mv
1.177 -11.920 1.866 -7.028

-11.920 1.177 -7.028 1.866
-13.004 -13.004 -2.086 -2.086

NGS IMU to Bulkhd (Frame) 52 IMU Base to baseline at Keel
IMU Top (m) easting 0.000 (ft) easting -11.638 (ft) elevation 12.856

northing 0.000 (m) easting -3.547 (m) elevation 3.919
elevation 0.000

NGS Frame 0 (FP) to Frame 52 Top of IMU to Base of IMU
Port easting -11.920 (m) easting -27.737 (m) elevation 0.168
Ant northing 1.177 Top of IMU to Keel

(m) elevation -13.004 IMU to Frame 0 (FP) (m) elevation 4.086
(m) easting 24.190

Center of Gravity above baseline
Heave Pt* to Frame 0 (FP) (ft) elevation 16.37

(ft) easting 102.42 Mean Metacentric height
(m) easting 31.218 (ft) elevation 3.88

IMU to Centerline Heave Pt* to baseline at Keel
(ft) northing 6.122 (ft) elevation 20.25

(m) northing 1.866 (m) elevation 6.172

Heave Pt* to Centerline (*Heave Pt is Metacenter)
(m) northing 0 (FP is Forward Perpendicular)

(m) easting -11.920 (m) easting -7.028
Top of IMU northing 1.177 Top of IMU northing 1.866
 to Port Ant elevation -13.004 to Heave Pt* elevation -2.086

Coord Sys. Pos/Mv Coord. Sys. Pos/Mv
x -11.920 x -7.028
y 1.177 y 1.866
z -13.004 z -2.086

see Description Tab

IMU to HeaveIMU to Port Ant

IMU to Heave

IMU to HeaveIMU to Port Ant

IMU to Port Ant



Measurement
Coord. Sys. Caris Caris Caris Caris Pos/Mv Caris Pos/Mv
x 0.493 -0.684 n/a Scaler Distance 1.995 1.177 -11.920 1.866 -7.028
y 7.665 19.585 n/a -11.920 1.177 -7.028 1.866
z 4.726 17.730 -0.002 -13.004 -13.004 -2.086 -2.086

*Top of IMU is RP (Reference Pt)

Derivations
Coord. Sys.

Westlake NGS
IMU easting 0.000 Port easting -11.920
Base northing 0.000 Ant northing 1.177

(ft/m) elevation 0.000 (m) elevation -13.004
Westlake
8160 easting 25.149

(ft) northing 1.619
elevation 14.956

Westlake
8160 easting 7.665

(m) northing 0.493 (m) easting 7.665
elevation 4.559 Top of IMU northing 0.493

 to 8160 elevation 4.726
Base of IMU to Top of IMU

(m) elevation -0.168

(m) easting 7.665 (m) easting 19.585
Top of IMU northing 0.493 northing -0.684
 to 8160 elevation 4.726 elevation 17.730

Coord Sys Caris Coord Sys Caris
x 0.493 x -0.684
y 7.665 y 19.585
z 4.726 z 17.730

Port Ant to 8160

IMU to Port Ant

IMU to 8160

IMU to 8160 (MRU to Trans)

IMU to 8160

Port Ant to 8160 (Nav to Trans)

Port Ant to 8160

IMU to HeavePort Ant to Stbd AntWaterline to RP*

Vessel Offsets for S220_8111 are derived from Westlake-Survey-Report-NOAA-Fairweather-09-23-03.pdf
and Fairweather_NGS_Report_Feb_2007.doc



Description of Offsets for FAIRWEATHER S-220
All Values Shown are in CARIS Coordinates

IMU to Port Antenna
x: 1.177
y: -11.920
z: -13.004

IMU to Heave Point
x: 1.866
y: -7.028
z: -2.085

IMU=Reference Point (RP)
x: 0.000
y: 0.000
z: 0.000

IMU to Seabat 8111
x: 2.868
y: 8.252
z: 4.752

IMU to Seabat 8160
x: 0.493
y: 7.665
z: 4.726

Port Antenna to 8160
x: -0.684
y: 19.585
z: 17.730

Port Antenna to 8111
x: 1.691
y: 20.172
z: 17.756



Scaler Distance 1.995

IMU to Port Antenna
x: 1.177

y: -11.920
z: -13.004

IMU to Heave Point
x: 1.866
y: -7.028
z: -2.086

Port Antenna to 8160
x: -0.684
y: 19.585
z: 17.730

Port Antenna to 8111
x: 1.691
y: 20.172
z: 17.756

IMU to Seabat 8160
x: 0.493
y: 7.665
z: 4.726

IMU to Seabat 8111
x: 2.868
y: 8.252
z: 4.752

IMU=Reference Point (RP)
x: 0.000
y: 0.000
z: 0.000



x y z x y z
2.868 8.252 4.752 0.493 7.665 4.726

x y z x y z
1.691 20.172 17.756 -0.684 19.585 17.730

IMU to 8111 (MRU to Trans)

Port Ant to 8111 (Nav to Trans)

IMU to 8160 (MRU to Trans)

The lever arms between the IMU 
and phase center of the 8111 
transducer are taken from the 
Westlake report with the addition 
of the 0.168 m offset included for 
the height of the IMU.

Port Ant to 8160 (Nav to Trans)

The lever arms between the IMU 
and phase center of the 8160 
transducer are taken from the 
Westlake report with the addition of 
the 0.168 m offset included for the 
height of the IMU.

This information comes from a 
combination of the Westlake and 
NGS surveys. Additions for spacing 
bolt between antenna base and top 
of pole mount were port antenna 
elevation adjusted 2.4 cm. Relative 
positions obtained from Port Ant to 
8111 via IMU.

This information comes from a 
combination of the Westlake and 
NGS surveys. Additions for 
spacing bolt between antenna 
base and top of pole mount were 
port antenna elevation adjusted 
2.4 cm. Relative positions 
obtained from Port Ant to 8160 via 
IMU.



x y z
Scaler Distance 1.995 1.177 -11.920 -13.004

x y z x y z From pg 3 of the Westlake Survey
n/a n/a -0.002 1.866 -7.028 -2.086

Waterline to RP*

IMU to Heave

The height of the IMU above the 
keel comes from the Westlake 
survey value of 3.919 m plus the 
measured value of the top of the 
IMU to the base plate, to get an 
IMU height above the keel.  The 
draft (waterline to keel) used for the 
FAIRWEATHER is based on initial 
observations.  Differencing the 
value of IMU to keel and waterline 
to keel gives the waterline to RP 
distance.  

Key points on the IMU, from the 
Westlake survey, are its location 
with respect to the ship’s 
reference frame.  It is 4.087 m 
(3.919 m to base line + 0.168 m 
for IMU height above base plate) 
above the keel, 1.866 m port of 
centerline and 3.547 m forward of 
frame 52.  This information is 
needed to reference the IMU to 
the ship’s Heave Measurement 
Location (Heave Point). *

IMU to Port Ant

IMU to Heave

Port Ant to Stbd Ant

From the NGS survey, it was 
determined that the vector for 
antenna separation was 1.995 m. 
Additions for spacing bolt between 
antenna base and top of pole 
mount were port antenna elevation 
adjusted 2.4 cm, stbd antenna 
elevation adjusted 2.0 cm.

This information comes directly 
from the NGS survey.

IMU to Heave



Referencing the metacenter (Heave Point, HP) to the IMU information requires information about the frame spacing of the vessel.  From the 
Westlake survey, the IMU is located 3.547 m forward of frame 52.  From Inclination document, the HP is 31.217 m aft of the forward 
perpendicular.  From engineering drawings of the ship frame spacing is approximately 21 inches.  The calculation for the longitudinal location
of the HP with respect to frame zero, the Forward Perpendicular (FP) is as follows:

52 (frame) * 21 (inches/frame)/12(inches/ft)*.3048(m/ft)-3.547 m = 24.190 m from frame 0.

31.217 m (HP aft of FP) – 24.190 m (IMU aft of FP) =  7.027 m (HP aft of IMU)

The calculation for the vertical separation between the IMU and the HP is based on the height of the metacenter being 6.172m and the 
height of the IMU being 4.087 m above the keel.  Differencing yields the metacenter being 2.085 m above the IMU.

The calculation for the athwartship separation is based upon the assumption that the HP is on the centerline and the knowledge that the IMU 
is 1.866 m to port of the centerline.

* From the Art Anderson inclination experiment the position of the metacenter was used as the position of the ship’s Heave Point. (There 
may be a better way to determine the Heave Point, but this decision was based upon available information).  The metacenter is defined by 
the center of buoyancy.  As a vessel inclines through small angles, the center of buoyancy moves through the arc of a circle whose center is 
at the metacenter.  

Important numbers and information determined from the Art Anderson report are the location of the metacenter and how it is positioned with 
respect to the vessel.  The longitudinal location of the metacenter is defined as 102.42 feet (31.217 m) aft of the forward perpendicular.  The 
height of the metacenter is 20.25 feet (6.172 m) above the keel.  There is an assumption of the metacenter being on the centerline of the 
vessel.  Similar values for the RAINIER’s metacenter are 32.52 m aft of the forward perpendicular and 5.2 m above the keel.  The difference 
in the height of the metacenter can be attributed to the difference between the FA’s and RA’s average draft which is 13.12 feet as opposed to
approximately 14.5 feet respectively.



Sources

On September 23, 2003 an offset survey of the NOAA Ship FAIRWEATHER was conducted by:
Westlake Consultants, Incorporated
15115 SW Sequoia Parkway, Suite 150
Tigard, Oregon 97224
Phone (503) 684-0652

…and the relocation of the POS M/V antenna forced a partial resurvey in Feb. 2007 by Steven Breidenbach of NGS.

On July 16, 2004 an inclination experiment was conducted at MOC-P by:

Art Anderson Associates
202 Pacific Avenue
Bremerton, WA  98337-1932

Offset values for the ship were derived from three sources.  Two static offset surveys, an inclination experiment, and values measured or 
approximated by ship’s personnel.

These values relate the physical positions of one sensor to the next with the base plate of the IMU being the point of origin.  All 
dimensions in the document are given in feet and decimal feet.  



Calculations

As a requirement for the TPE, the standard deviation for each position is 3 mm.  This value is based upon a conversation with 
Elaine McDonald of Westlake and is followed up by an Email documenting that fact.  The email is located at the end of this 
document.

The values for the required lever arms are listed in the S220_Offsets and Measurements spreadsheet.  The reference point and the 
IMU are identical.  Difference in documentation between Westlake and FA calculations are based off of measuring up from the 
IMU base (Westlake’s origin) and the top of the IMU.  The top center of the IMU for the POS/MV is the defined origin for the 
POS/MV and the origin that is being used on all FAIRWEATHER vessels.  The distance from the base plate to the top of the IMU
is 0.168 m, a value measured by ship’s complement.  Conversions factor from feet to meters is 0.3048 m/ft.



Fwd Aft slope IMU Depth IMU Depth (m)

2008 x1 y1 x2 y2
16-Apr before fueling 5.25 13.88 189 12.75 -0.00615 13.42 4.092
16-Apr after fueling 5.25 13.88 189 14.42 0.00294 14.10 4.297

Draft at IMU (ft) 13.76 4.194 AVE
The IMU x-value (ft): 79.36 No boats 0.476 0.145 STDEV

x-value (m): 24.19 Light Ship
Post Fuel
Transfer

Fwd Stbd Fwd Port Avg Aft Stbd Aft Port Avg

13.75 14.00 13.88 13.00 12.50 12.75
13.75 14.00 13.88 14.33 14.50 14.42

Draft measurements were taken once the engineers had transferred the fuel in a satisfactory manner.  The 
2007 measurement for draft was used due to the lack of sufficient draft measurements.

Notes:

Fuel level @ ~50%, in forward tanks.  Launch 1018 in #4 Davit, 1010 in #5, Ambar in #2, FRB deployed, THIS IS POTENTIALLY 
NOT A VALID MEASUREMENT AS ALL FUEL WAS LOADED FORWARD WITH THE INTENTION THAT AFT TANKS WERE 
ABOUT TO BE FILLED.

All Fuel tanks pressed up. Launch 1018 in #4 Davit, 1010 in #5, Ambar in #2, FRB in #1. 



2007 Fwd Aft slope IMU Depth IMU Depth (m)
2-Feb

26-Feb
27-Feb
28-Feb x1 y1 x2 y2
21-Mar (3/21) Fuel Transfer 5.25 13.17 189 13.92 0.00408 13.47 4.105
27-Mar various boats 5.25 13.04 189 13.75 0.00385 13.33 4.062
28-Mar various boats 5.25 13.13 189 13.88 0.00408 13.43 4.093
12-Apr (4/12) Morning - All boa 5.25 13.08 189 13.92 0.00454 13.42 4.090
12-Apr (4/12) Afternoon - No bo 5.25 13.15 189 13.63 0.00261 13.34 4.066

Draft at IMU (ft) 13.40 4.083 AVE
The IMU x-value (ft): 79.36 No boats 12.608 0.061 0.019 STDEV

x-value (m): 24.19 Light Ship 13.100
Post Fuel 13.258
Transfer 13.470

Immediately prior to the FA field season, the draft measurements were taken once the engineers had 
transferred the fuel in a satisfactory manner.  The waterline at the IMU was then calculated based on a 
linear interpolation.
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ENS Rice and CST Morgan 
10/23/08 
 
Depth Measurement of FAIRWEATHER’s Transducers and Keel with the DLDG 
and Leadline 
 
Vertical offsets have been observed during the 2008 season between ship collected 
soundings and launch collected soundings. To check vertical offsets in the Caris HVF 
depth measurements were taken on the ship’s transducers and keel under the IMU. These 
measurements were taken with the Diver’s Least Depth Gauge (DLDG).  
 
Since the DLDG has not been used this season, calibration measurements were also taken 
to check the accuracy of the DLDG. This was done by hanging a lead line from the ship 
and taking measurements at the leadline markings with the DLDG. Currents estimated at 
0.5 knots were present during these measurements. 
 
Table 1 shows the various measurements and their depth conversions. A comparison of 
the leadline to the DLDG measured depth shows offsets of approximately 0.16 meters. 
 
 

Table 1: Measurements from the DLDG 
Location Pressure (psi) Depth (meters) 
2 meters (leadline) 17.60 Not converted 
3 meters (leadline) 19.10 3.16 
4 meters (leadline) 20.59 Not converted 
5 meters (leadline) 22.04 5.18 
6 meters (leadline) 23.50 Not converted 
7 meters (leadline) 24.90 7.15 
8 meters (leadline) 26.41 Not converted 

Keel 20.63 4.19 
8111 21.48 4.79 
8160 21.12 4.55 

 
 
The leadline measurement for the waterline to keel was 4.1m with a difference from the 
DLDG measurement for the waterline to keel of 0.09m which is a difference that is 
within the level of accuracy of the measurements themselves. 
 
Based on theses measurements and there agreement with each other and the 2007 
waterline to keel measurement, the static draft offset was ruled out as the possible source 
for the discrepancy between the launches and the ship data. 
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NOAA SHIP FAIRWEATHER 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
 
PURPOSE 
 
The primary purpose of the survey was to accurately determine the spatial relationship of various 
components of a POS MV navigation system aboard the NOAA ship FAIRWEATHER.  
Reference points were also established to determine the spatial location of differential GPS 
antennas,   Additionally, various reference points (bench marks) were restablished onboard the 
vessel to aid in future spatial surveys aboard the boat. 
 
 
PROJECT DETAILS 
 
This survey was conducted while the ship was docked at the USCG in Seattle, WA .  The weather 
was cool with a steady breeze.   
 
 
INSTRUMENTATION 
 
The Topcon 3000LW total station was used to make all measurements. 

Technical Data: 
   Angle Measurement 
   Smallest unit in display 0.1 seconds 
 
  Standard Deviation 
   Horizontal angle  1.0 seconds 
   Vertical angle   1.0 seconds 
   Distance measurement 2mm + 2ppm 
 
A standard “peanut” prism was used as a sighting target.  This prism was configured to have a zero 
mm offset.   
 
 
PERSONNEL 
  
  
 Steve Breidenbach NOAA/NOS/NGS/GSD/I&M BRANCH 
    (540) 373-1243 
 
 Dennis Lokken           NOAA/NOS/NGS/GSD/I&M BRANCH 
    (540) 373-1243 
 
  
 



NOAA SHIP FAIRWEATHER 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 
 
 
ESTABLISHING THE REFERENCE FRAME 
 
To conduct this survey a local coordinate reference frame was established where the X axis runs 
along the centerline of the boat and is positive from IMU towards the bow of the boat.  The Y axis 
is perpendicular to the centerline of the boat (X axis) and is positive from IMU towards the right, 
when looking at the boat from the stern.  The Z axis is positive in an upward direction from the 
IMU.  In this reference frame the IMU has the following coordinates; 
X = 100.000(m) 
Y = 100.000(m) 
Z  = 100.000(m) 
 
At the end of the survey all the coordinates were rotated to a right-handed coordinate system.  The 
coordinates were translated to the IMU origin and the Granite Block origin. 
 
 
 
 
 
DISCUSSION 
 
I recommend conducting the survey again, once the ship is put into dry dock.  Conducting a survey 
such as this while the boat is in the water requires that the automatic compensators in the survey 
instrument be turned off.  The survey is therefore conducted with all survey instrumentation set up 
relative to the mean movement of the related level vials.  While every effort was made to make the 
most precise measurements possible, some additional error accumulation cannot be avoided under 
these type observing conditions.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



The positions given for the IMU GPS antenna are to the bottom of the bolt as depicted on the 
photo below. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Position of the C-NAV Antenna 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
Point Summary Report 

Name  Std Dev n (m)  Std Dev e (m)  Std Dev Hz (m)  Std Dev u (m)  

10FLOOR  0.003  0.003  0.004  0.002  

11FLOOR  0.003  0.004  0.005  0.002  

1CLEAT  0.004  0.018  0.019  0.002  

1DECK  0.004  0.018  0.018  0.002  

1FLOOR  0.000  0.000  0.000  0.000  

1LOCKER  0.004  0.004  0.005  0.003  

1RAIL  0.004  0.022  0.023  0.002  

1WALL  0.003  0.002  0.004  0.001  

1WALL3  0.003  0.003  0.004  0.002  

2CLEAT  0.003  0.021  0.021  0.002  

2CLEAT1  0.004  0.022  0.022  0.003  

2FLOOR  0.001  0.001  0.001  0.001  

2RAIL  0.004  0.022  0.022  0.002  

2WALL  0.002  0.003  0.004  0.002  

3ANT  0.003  0.006  0.007  0.003  

3FLOOR  0.002  0.002  0.003  0.002  

3WALL  0.003  0.003  0.005  0.002  

4FLOOR  0.001  0.001  0.002  0.003  

5FLOOR  0.002  0.004  0.005  0.001  

6FLOOR  0.002  0.002  0.003  0.003  

7FLOOR  0.005  0.003  0.006  0.002  

8FLOOR  0.004  0.004  0.005  0.002  

9FLOOR  0.002  0.013  0.013  0.003  

ABOLT  0.003  0.026  0.026  0.003  

ANT DECK  0.003  0.006  0.007  0.003  



Name  Std Dev n (m)  Std Dev e (m)  Std Dev Hz (m)  Std Dev u (m)  

ANT DECK BM  0.004  0.007  0.008  0.003  

ANT PORT  0.003  0.007  0.008  0.003  

ANT RAIL  0.004  0.006  0.007  0.003  

ANT RAIL BM  0.003  0.007  0.007  0.003  

ANT STAR  0.004  0.007  0.008  0.003  

BOW BM  0.004  0.023  0.024  0.003  

BOW BM2  0.004  0.023  0.023  0.003  

BRIDGEPORT  0.005  0.011  0.012  0.003  

BRIDGESTAR  0.005  0.011  0.012  0.003  

BRIDGESTAR2  0.005  0.011  0.012  0.003  

DOOR  0.001  0.001  0.002  0.001  

GRANITE BOW  0.002  0.001  0.002  0.001  

GRANITE CENTER  0.002  0.001  0.002  0.001  

GRANITE PORT  0.002  0.001  0.002  0.001  

GRANITE STAR  0.003  0.002  0.003  0.001  

GRANITE STERN  0.002  0.001  0.002  0.001  

IMU BM  0.003  0.001  0.003  0.003  

IMU BOW PORT  0.002  0.001  0.002  0.001  

IMU BOW STAR  0.002  0.001  0.002  0.001  

IMU CENTER  0.000  0.000  0.000  0.000  

IMU STERN PORT  0.002  0.001  0.002  0.001  

IMU STERN STAR  0.002  0.001  0.002  0.001  

LADDER  0.002  0.002  0.002  0.001  

MVP BM  0.004  0.023  0.023  0.003  

RAIL STAR  0.006  0.015  0.016  0.003  

RAIL STAR1  0.004  0.005  0.007  0.003  

RAILPORT  0.005  0.015  0.016  0.003  



Name  Std Dev n (m)  Std Dev e (m)  Std Dev Hz (m)  Std Dev u (m)  

RAILSTAR  0.005  0.015  0.016  0.003  

STEARN BM  0.004  0.024  0.024  0.003  

STERN BM  0.003  0.024  0.024  0.002  
 
 
 
 
COORDINATES 
 
 
                                                                                IMU Origin                                                                               
                                                               Right-handed Coordinate System                                                            
    
Name Easting (x) meters Northing (y) meters Elevation (z) meters 
IMU CENTER 0 0 0 
IMU BOW PORT CORNER 0.073 -0.084 -0.006 
IMU BOW STAR CORNER 0.071 0.088 -0.004 
IMU STERN STAR CORNER -0.068 0.089 -0.003 
IMU STERN PORT CORNER -0.065 -0.086 -0.006 
GRANITE BOW 0.147 0.48 0.108 
GRANITE STAR -0.002 0.574 0.111 
GRANITE STERN -0.148 0.478 0.109 
GRANITE PORT -0.003 0.382 0.106 
GRANITE CENTER -0.002 0.477 0.108 
IMU BM 0.034 -0.263 -0.496 
STERN BM -40.32 1.927 -2.184 
MVP BM -38.721 5.985 -2.018 
STEARN BM -40.313 1.921 -2.181 
POS GPS ANT STARBOARD -11.917 3.171 -12.936 
POS GPS ANT PORT -11.92 1.177 -12.98 
A FRAME BOLT -43.019 1.975 -7.142 
POS GPS ANT RAIL BM -12.037 2.101 -10.376 
POS IMU ANT DECK BM -11.823 2.07 -9.301 
C-NAV ANT -10.075 4.131 -11.377 
BOW BM 28.346 2.077 -7.853 
 
 



                                                                 Granite Block Origin 
                                                        Right-handed Coordinate System 
    
Name Easting (x) meters Northing (y) meters Elevation (z) meters 
IMU CENTER 0.002 -0.477 -0.108 
IMU BOW PORT CORNER 0.075 -0.561 -0.114 
IMU BOW STARBOARD CORNER 0.073 -0.39 -0.112 
IMU STERN STARBOARD CORNER -0.065 -0.388 -0.111 
IMU STERN PORT CORNER -0.063 -0.563 -0.114 
GRANITE BOW 0.149 0.003 0 
GRANITE STAR 0 0.097 0.003 
GRANITE STERN -0.145 0.001 0.001 
GRANITE PORT 0 -0.095 -0.002 
GRANITE CENTER 0 0 0 
IMU BM 0.036 -0.74 -0.604 
STERN BM -40.317 1.45 -2.292 
MVP BM -38.719 5.508 -2.126 
STEARN BM -40.31 1.444 -2.289 
POS GPS ANT STARBOARD -11.915 2.694 -13.044 
POS GPS ANT PORT -11.918 0.699 -13.088 
A FRAME BOLT -43.017 1.498 -7.25 
POS GPS ANT RAIL BM -12.034 1.623 -10.484 
POS IMU ANT DECK BM -11.821 1.593 -9.409 
C-NAV ANT -10.073 3.654 -11.485 
BOW BM 28.349 1.6 -7.961 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
POS GPS RAIL BM AND POS GPS DECK BM 



 
 
IMU BM 











 



Westlake Consultants, Inc.
9/23/2003

Definitions and Basis for Dimensions/Locations

Northings 

Northings (Port - Starboard) are with reference to the IMU Foundation Plate centerline scribe.
Positive values are starboard of the IMU.
Negative values are port of the IMU.
Calculated values are in italics.

Eastings 

Eastings (Stern to Bow ) are with reference to the IMU Foundation Plate centerline scribe.
Positive values are forward of the IMU. 
Negative values are aft of the IMU.
Calculated values are in italics.

Elevations  

Elevations are with reference to the IMU Foundation Plate centerline scribe = 0 elevation. 
Positive values are below the IMU (toward the keel).
Negative values are toward the topside.

Dimensions 

All dimensions are in feet and decimal feet. All dimensions provided are "offsets" to IMU centerline.

Ship's Centerline Data 

At project initiation, control was established to define the ship's centerline 
as a plane running from a point on the centerline of the keel at the stern through a 
point on the centerline of the keel near the bow, to a point on the bow splitting the bow chock. 

IMU Referenced Data - Procedure
All data was originally referenced to the ship's geometry. 
Following location of the IMU, data was transformed to the IMU as point of origin for 
Northings, Eastings, and Elevation. All dimensions provided with reference to the IMU are "offsets."
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Westlake Consultants, Inc.
9/23/2003

Ship's Centerline - Control Measurements 
(Prior to location of IMU and referencing of data to IMU as point of origin (0,0,0)

Defined by measurements at the keel centerline 
longitude transverse elevation

near the bow 1190.674 1000.000 135.8672
at the stern (point of origin) 1000.000 1000.000 100.0000
along the keel (approx 180' forward) 1180.121 1000.000 116.6810

Ship's Baseline

Defined by measurements on the keel 
longitude transverse elevation

at the stern (point of origin) 1000.000 1000.000 100.0000
and approx. 129' forward of stern 1129.120 999.985 100.0022
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Westlake Consultants, Inc.
9/23/2003

IMU Foundation Plate
EASTING NORTHING ELEVATION

Horizontal alignment per scribed lines 
on IMU foundation plate 0.001

0.000

Scribed lines - intersection/centerline of IMU plate
0.000 0.000 0.000

Elevation checks near four corners of IMU Foundation plate *
0.001

-0.001
0.000

-0.001

SUMMARY 
•  IMU foundation plate is level to within +/-0.001 feet.
•  IMU foundation plate is located 12.856 feet above baseline established at the keel.
•  IMU is parallel to ship's centerline to within +/- 0.001 feet.

Location of scribed centerline intersection is 6.122 feet port of ship's centerline.
•  IMU foundation plate centerline is located 11.638' feet forward of bulkhead 52. 

* elevation check adjusted for target 
that created 10 mm offset =.03281 

feet
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Westlake Consultants, Inc.
9/23/2003

Granite Block 
EASTING NORTHING ELEVATION

Horizontal alignment per scribed lines
1.584
1.583

Scribed lines - intersection/centerline of granite block 
-0.003 1.583

Deviation
Elevation checks near four corners of granite block from level

-0.217 -0.001
-0.217 -0.001
-0.216 0.001
-0.215 0.001

SUMMARY 
•  Granite block is level to within +/-0.001 foot 

of average elevation = -0.21632 feet
•  Granite block is parallel to ship's centerline to within  0.001 foot 

Location is  4.54 feet to port of ship's centerline and 1.583 feet starboard of IMU.
•  Granite block is aligned with IMU to within 0.003 feet longitudinally. 

* elevation check adjusted for target that created 10 
mm offset = 0.03281 feet
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Westlake Consultants, Inc.
9/23/2003

Array Acoustical Centers - Referenced to IMU 

EASTING NORTHING ELEVATION

PORT ARRAY (81-60) 25.149 1.619 14.956

Explanation of Calculations
Acoustic center is defined as the center of the transmitter array with the 
elevation = 83 mm below mounting face of array.

Easting
Center of array is defined by the foundation plate bolt centerlines (1/2 distance between bolts)

27.008 Forward edge of foundation as measured 
- 0.104 Forward edge of foundation to centerline of forward bolt hole
- 1.755 Distance from bolt hole centerline to center of array 
25.149 feet forward of IMU 

Northing
Center of array is defined as the mid-point between the bolt holes on the foundation. 

1.369 Port edge of foundation  as measured 
+ 0.078 Port edge of foundation to centerline of bolt hole - per Cascade General 
 + 0.172 Distance from bolt hole centerline to array center 

1.619 feet starboard of IMU

Elevation 
Per Reson drawing 2148M011_001  the elevation is 83 mm below array mounting surface

14.679 Array foundation elevation as measured. 
  0.005 Isolation "shim" added between foundation and array 
  0.272 83 mm below array mounting surface to acoustical center 
14.956 feet below IMU 
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Westlake Consultants, Inc.
9/23/2003

Array Acoustical Centers - Referenced to IMU 
EASTING NORTHING ELEVATION

STARBOARD ARRAY (81-11) 27.072 9.41 15.042

Explanation of Calculations
Acoustic center is defined as midpoint of the transmitter array in the longitudinal and transverse axes. 
The elevation is defined as the center of the receiving array. 

Easting
Center of array is defined as 0.235' aft of the forward bolt centerlines on transmitter array foundation

28.563 Forward edge of foundation fixture plate as measured (receiving plate forward edge)
27.349 Forward edge of transmitter array foundation as calculated 

 - 0.042 Forward edge of foundation to centerline of forward bolt hole - per design
 - 0.235 Distance from bolt hole centerline to center of array - per design
27.072 feet forward of IMU 

Northing
Center of array is defined as the mid-point between the bolt holes on the transmitter array foundation.

9.410 Centerline of array foundation as measured on scribe - aft section of fixture plate
9.410 feet starboard of IMU

Elevation 
Elevation is 0.401 feet above receiver array mounting surface

16.085 Mounting foundation fixture plate as measured. 
15.447 Receiver foundation elevation - as calculated 

 + 0.005 Isolation "shim" added between foundation and array 
 - 0.410 Design distance from mounting surface of array to acoustic center 
15.042 feet below IMU 
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Westlake Consultants, Inc.
9/23/2003

Longitudinal Array Foundation - Port Side 
EASTING NORTHING ELEVATION

Horizontal alignment measured  at port edge of array foundation
1.369
1.369

Forward edge of array foundation - measured
27.008

Horizontal alignment - calculated  to array centerline 
1.619
1.619

deviation from 
Elevation checks near four corners of array foundation level (average)

14.680 0.001
14.681 0.002
14.678 -0.001
14.677 -0.002

SUMMARY 
•  Port longitudinal array foundation average elevation is 14.679 feet.

Variation in elevation is +0.002 to -0.002 feet.
•  Port longitudinal array foundation is parallel to ship's centerline and 1.369 feet starboard of IMU.

Calculated array centerline is 1.619 feet starboard of IMU 

Foundation edge is 0.25 feet port of 
array centerline
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Longitudinal Array Foundation - Starboard Side 
EASTING NORTHING ELEVATION deviation from 

Horizontal alignment measured  on fixture plate scribe - parallel
9.410 0.002
9.406 -0.002

Forward edge of array foundation fixture plate - measured
28.563

deviation from
Elevation checks near four corners of array foundation "fixture plate" average

16.085 0.000
16.085 0.000
16.084 0.000
16.085 0.000

Calculated locations of longitudinal and transverse array foundations
Forward edge
Receiver (transverse) 28.563
Transmitter (longitudinal) 27.349

difference = 1.214

NOTE:   On Transmitter array foundation - from forward edge to center of forward holes = 0.042'
On Receiver array foundation distance from forward edge to center of forward holes = 0.076'

Calculated elevation of longitudinal and transverse array foundations
Receiver/Transverse Foundation 15.446
Transmitter/Longitudinal Foundation 15.709

difference = 0.263

SUMMARY 
•  Starboard longitudinal array foundation (measured at fixture plate) average elevation is 16.085 feet.

Deviation from level (average elevation) is less than 0.001 feet. 
•  Starboard longitudinal array foundation averages 9.408 feet starboard of IMU.

Variation from parallel is from -0.002  feet to +0.002 feet from average. 
•  Starboard longitudinal array foundation forward edge is 28.563 feet forward of IMU. 

Design location is 3.292 feet 
starboard of ship centerline 
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Westlake Consultants, Inc.
9/23/2003

Transverse Array Foundation - Port Side
EASTING NORTHING ELEVATION

Forward Edge - Transverse array foundation - measured
28.343
28.338

Port edge - Transverse array - measured
-0.181

Centerline of array - calculated  
28.093
28.088

Port edge of foundation plus 1.806 feet 1.624
to calculated array centerline 

deviation from 
Elevation checks near four corners of array foundation level

14.679 0.002
14.675 -0.001
14.675 -0.001
14.677 0.001

SUMMARY 
•  Transverse array foundation average measured elevation is 14.677 feet 

below IMU (0.006 feet above design location).
Deviation from level (average elevation) is 0.003 to -0.001 feet

•  Transverse array foundation centerline (calculated) averages 28.090 feet forward of IMU.
Variation from parallel to ship's centerline is from -0.003 to 0.003 feet (from average). 

•  Transverse array centerline is calculated to be 1.624 feet starboard of IMU. 

Foundation forward edge minus        
0.25 feet to array centerline

0.861 feet below baseline with 0.965 
foot offset = 98.180 feet average 
elevation

Page 9 of 11 Pages
Westlake-Survey-Report-NOAA-Fairweather-09-23-03.xls

Report of Sonar Array
Installation on

NOAA Fairweather



Westlake Consultants, Inc.
9/23/2003

Transverse Array Foundation - Starboard Side

NOTE: Direct Measurements were not taken to the transverse array because a single "fixture plate" covered bo
transmitter and receiver foundations. The data provided here is primarily "calculated".

EASTING NORTHING ELEVATION

Forward edge - as measured on fixture plate
Receiver - (transverse) 28.563

as measured 
Transmitter  (longitudinal) 27.349

difference = 1.214

NOTE:   On Transmitter array foundation - from forward edge to center of forward holes = 0.042'
On Receiver array foundation distance from forward edge to center of forward holes = 0.076'

Horizontal Alignment 9.406
centerline scribe on fixture plate 
as measured - forward portion of plate
(near receiver array)
Average of measurements on fixture plate 9.408

Elevation of longitudinal and transverse array foundations
Receiver/Transducer Transverse Foundation 15.446
Transmitter/Longitudinal Foundation 15.709

difference = 0.263
Based on measured elevations averaging 16.085 feet across fixture plate

SUMMARY
•  Transverse array foundation is calculated to be 15.446 feet below IMU - calculated from measured elevation 

of 16.085 feet.  Deviation in elevation measurements across the  array fixture plate is less than 0.001 fe
•  Transverse array foundation forward edge (measured) is 28.563 feet forward of IMU.
•  Transverse array centerline is measured to be 9.406 feet starboard of IMU. 

Variation from parallel of the fixture plate across entire starboard array is ± 0.002  feet (from average). 
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9/23/2003

Antennae
EASTING NORTHING ELEVATION

Stbd POS MV Antenna -Location -35.866 12.925 -38.209
Port POS MV Antenna - Location -35.739 -0.409 -38.283

Foundation Plate Stack Antenna Alignment 7.677
Foundation Plate Stack Antenna Alignment 7.677

Port GYRO Foundation Plate Alignment 2.411
Port GYRO Foundation Plate Alignment 2.411

Stbd GYRO Foundation Plate Alignment 3.866
Stbd GYRO Foundation Plate Alignment 3.867

SUMMARY
•  Foundation plate stack antenna alignment is parallel to ship's centerline.
•  Port GYRO Foundation Plate is aligned parallel to ship's centerline.
•  Starboard GYRO Foundation Plate is aligned parallel to ship's centerline.
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FAIRWEATHER
Multibeam Echosounder Calibration

Vessel

4\24\2008
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

35652N/A

4/24/2008

S220 8111

Ringel, Campbell, Morgan, Argento, Wozumi

N/AFairweather

115

Reson 8111

Moira Sound

Spring 2007Hull

POSMV 320 v.4



Acquisition Log

4/24/2008
Date Dn Local Area Wx

Bottom Type Approximate Water Depth

Personnel on board

Comments

TrueHeave filename

4:58 132.8 172.64
SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

15:47 84.1 109.3
SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

11:13 65.3 84.9
SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

Attempted cast after roll lines but unable to retrieve fish. Pulled by hand.

115.001

115.003

115

55/04/31 131/57/47

TH_S220_115, S220_115_TH(?)

55/04/47 131/58/54

Uozumi, Argento

rocky

Clear, cool, calmMoira Sound

115.004 55/04/58 131/58/12

RESON Error at about 5:45 local time, Reson Power LED dim, and readings went wonky.  HeadTemp value fluctuates between 



ROLL
SV Cast # Heading Speed (kts) Remarks

137 4Kt
317 4kt
137 4kt
317 4Kt

PITCH
SV Cast # Heading Speed (kts) Remarks

045 7.0
225
225
225

HEADING/YAW
SV Cast # Heading Speed (kts) Remarks

225 8.5

225 8.7
045

045
115.003 225

NAV TIME LATENCY
SV Cast # Heading Speed (kts) Remarks

115.003 045 3Kt
225 3Kt
045 12Kt
225 12Kt

XTF Line Filename

Pitch_NE_

HeadingA_NE_B
HeadingB_SW_A

XTF Line Filename
Pitch_NW_B
Pitch_SW_B
HeadingB_SW_C
HeadingB_SW_B

Roll_NW_A
Roll_SE_B
Roll_NW_B

good data, set 2
HeadingA_NE_A

HeadingB_SW_C

XTF Line Filename

Run as heading line
Run as heading line

Shoalest point not acquired
XTF Line Filename

good data, set 1HeadingC_SW_B

HeadingB_SW_B
HeadingC_NE_C

HeadingD_NE_A

Latency_SW_12kt

Latency_NE_3kt
Latency_SW_3kt
Latency_NE_12kt

good data, set 2
no good, ran over shoalest point, not pararell to other lin

no good, ran over shoalest point, good for pitch
good data, set 1

off line ~15 meters
off line ~15 meters
right on line
right on line

Roll_SE_A



Processing Log

4/25/2007
Date Dn Personnel

TrueHeave applied

SVP applied

Tide applied

Zone file

Lines merged

Data cleaned to remove gross fliers

bcc

Patch_Test.zdf

bcc

bcc

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

Data converted --> HDCS_Data in CARIS

Campbell116

Do not enter/apply correctors until all evaluations are complete and analyzed.

Compute correctors in this order



Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
0.00 -0.28 0.02 -0.20
-0.04 -0.20 0.03 -0.30
0.00 -0.60 0.02 -0.70
0.00 -0.34 0.04 -0.25
0.00 -0.62 0.03 -0.30

-0.01 -0.41 0.03 -0.35
0.02 0.19 0.01 0.20
0.00 -0.41 0.03 -0.35

Concensus Average Average Average

Resulting HVF File Name

MRU Align StdDev gyro 0.20 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.10 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 21 May 2008

Argento
Campbell

Patch test lines for the Reson 8111 were run on April 24th and 25th, 2008. Procedures for the test followed those outlined in the 
Patch Test Procedures SOP and the 2008 FPM. Lines for Pitch, Heading/Yaw, Roll and Nav Time Latency were run over 
appropriate features in the entrance to Moira Sound, along the SE portion of Prince of Wales Island, in SE Alaska. Following 
acquisition the data were converted in CARIS, True heave, Sound Velocity and Tides were applied, and the data was merged. 
Gross flyers were removed using Swath Editor. The data were then analyzed by 5 independant evaluators using the CARIS HIPS 
Calibration Utility. Based on the results of the evaluations the final values for use in updating the Hydrographic Vessel File were 
approved by the FOO, the Chief Survey Tech and Toshi Wozumi from PHB. 

Matthew Ringel LT/NOAA

PATCH TEST RESULTS/CORRECTORS

Final Values based on

Averages
Standard Deviation

FINAL VALUES

CST 
Wozumi
FOO

FA_S220_Reson8111.hvf



FAIRWEATHER
Multibeam Echosounder Calibration

Vessel

6/1/2008 and 6/13/2008
Date Dn Local Area

Calibrating Hydrographer(s)

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

Sonar Mounting Configuration Date of current offset measurement/verification

Description of Positioning System Date of most recent positioning system calibration

S220 8160

Johnston

N/AFairweather

153/165

Reson 8160

35385N/A

4/24/2008

Moira Sound, Clarence Strait

Spring 2007Hull

POSMV 320 v.4



Acquisition Log

6/1/2008
Date Dn Local Area Wx

Bottom Type Approximate Water Depth

Personnel on board

Comments

TrueHeave filename

SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

153_001

153_002

153

SV casts done with MVP.

TH_8160_Patch_154

Rocky

Moira Sound, Clarence Strait

Campbell, Johnston, Argento, Bucher

18 to 150 meters



ROLL
SV Cast # Heading Speed (kts) Remarks
153_001 292 6.0

150 4.9
294 6.0

148 5.1

8160_Roll_Patch_DN165

PITCH
SV Cast # Heading Speed (kts) Remarks
153_001 044 5.7
153_002 043 6.6

223 4.4
046 5.5
224 4.3

HEADING/YAW
SV Cast # Heading Speed (kts) Remarks
153_001

052 6.1

052
222
222 4.8
052 5.5
228 5.0

NAV TIME LATENCY
SV Cast # Heading Speed (kts) Remarks
153_002 040 4.0

220 4.0
040 11.0
220 11.0
040 11.0
220 11.0

XTF Line Filename
Roll1, roll2
roll3
Roll4
Roll5

XTF Line Filename

XTF Line Filename

XTF Line Filename
PITCH1
PITCH2
PITCH3
PITCH4

Roll6
Roll7

ROLL1
ROLL2

roll 1 is small. Roll 2 is most of line. DO NOT USE
do not use. Aborted line. DO NOT USE
good line, a little off on NW end. DO NOT USE
Good line.
do not use. Aborted line.
good but off about 20m to the NW end.

GOOD LINE, SOME SLOPING IN OUTERBEAMS
GOOD LINE, SOME SLOPING IN OUTERBEAMS

Line no good. Aborted.

Was supposed to be heading but can be used for pitch in
no good for pitch. May work as a heading line if needed
Good line
Should be good over the feature. Off on the ends.
Good line.

Heading6

PITCH5

Heading8

Heading2
Heading3
Heading4
Heading5

Heading7

Heading1
Probably not good. Do not use.
The feature was captured in the outerbeam, but the track
Looked good

good line

Run to starbord next time.  Appeared to be directly over 
Data looks good.  Some features detected.  Not sure abo
Good outer beam feature

good line
bad line

Pretty good outer beam feature as above.

LATENCY4.XTF
33m starbird of line over feature
good line
good line

LATENCY3.XTF

LATENCY5.XTF

LATENCY.XTF
LATENCY1.XTF
LATENCY2.XTF



Processing Log

6/3/2008
Date Dn Personnel

TrueHeave applied
H:\2008_Data\Testing_2008\S220_Patch_Test\DN 165_Roll_Lines\TH_220_165.000

SVP applied
I:\2008_Processed_Data\SVP\Testing_2008\8160_Patch_Test_153\8160_Roll_Patch_DN165.svp

Tide applied

Zone file

Lines merged

Data cleaned to remove gross fliers

H:\2008_Data\Testing_2008\S220_Patch_Test\Dn 153\TH_8160_Patch_154.000

O322FA2008_CORP.zdf (Dn 165 ROLL1 and ROLL2)

I:\2008_Processed_Data\Tide\Testing_2008\Predicted\9450460_8160.tid (Dn153)

I:\2008_Processed_Data\SVP\Testing_2008\8160_Patch_Test_153\8160_PATCH_Concat.svp

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

Data converted --> HDCS_Data in CARIS

Argento156

Do not enter/apply correctors until all evaluations are complete and analyzed.

Compute correctors in this order



Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
-0.01 -0.80 0.30

-0.50 0.30
0.00 -0.35 -0.37 0.14
-0.01 -0.27 0.08
0.00 -0.28 0.30
0.00 -0.50

-0.07

-0.03 0.00 1.00 -0.30

0.00 -0.49 -0.24 0.22
0.01 0.20 0.15 0.11

Resulting HVF File Name

MRU Align StdDev gyro 0.11 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.18 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date: 6/14/2008

Roll Values from the first patch test were way too high and were causing large offsets and artifacts in the data.  2 additional roll lines were run on the 8160 
near the Chatham Strait Project on DN 165.  Running the roll lines in deeper water yielded more accurate calibration numbers.  See the next tab for Roll 
values from DN 165.  Roll lines from DN153 were not used to calculate the roll bias.  Lines ROLL1 and ROLL2 from DN165 near Chatham Sound Project 
were used to calibrate roll.

Bonnie Johnston

PATCH TEST RESULTS/CORRECTORS

Argento
Bucher

FA_S220_Reson8160_5to750.hvf  (2008-153)

Renoud

Final Values based on

Averages
Standard Deviation

FINAL VALUES

Johnston
Campbell
Ringel
Rice

Argento (L/P/Y), Bucher (P), Johnston (L/P/R/Y), Campbell (L/R/Y), Ringel (L/P/Y), Rice (L/P), Reno

Outlier values removed:



Wind s 15knts
Date 4/14/2006 DN 104 Seas 1-2 ft

Vessel # S220 Location Bellingham, WA
Average Depth 25m Personnel Froelich, Castle, VanWaes

RPM Speed Az Isis Line Name                       Acquisiton Comments
0 0 0 STOP1/STOP2 Fat finger logged two lines

0 0 180 STOP5
0 0 180 STOP6

132 4.7 180 DDSSM1

135 6.1 180 DDSSM2

135 7.2 180 DDSSM3

135 8.1 180 DDSSM4

135 9.1 180 DDSSM5

135 10.3 180 DDSSM6 Corrupted file
155 11.6 180 DDSSM7
175 12.9 180 DDSSM13

FAIRWEATHER S220 Settlement & Squat (DDSSM method)

SHIP DDSSM DATA ACQUISITION FORM



DDSSM Processing Log
Vessel

4/14/2006 104
Date Dn

TrueHeave applied

SVP applied

Tide applied

Zoned

Filtered 40/40

S220-8111

Data converted --> HDCS_Data in CARIS

Lines merged

Data cleaned to remove gross fliers

06104212.svp

N161RA2005CORP.zdf

9449424.tid, 9449880.tid

TH_S220_104



2006 FAIRWEATHER S220 Settlement & Squat (DDSSM method)

RPM Speed (m/s) Speed (knots) MedianA MedianB MedianC Std. Dev. Squat Squat + Sigma Squat - Sigma
0.00 0 0 0 0 0 0.00

132 2.42 4.7 0.092 0.093 0.084 0.005 0.09 0.095 0.085
135 3.14 6.1 0.051 0.077 0.098 0.023 0.08 0.099 0.052
135 3.7 7.2 0.049 0.079 0.066 0.015 0.06 0.079 0.050
135 4.17 8.1 0.038 0.079 0.022 0.029 0.05 0.076 0.017
135 4.68 9.1 0.096 0.086 0.104 0.009 0.10 0.104 0.086
155 5.97 11.6 0.147 0.196 0.167 0.025 0.17 0.195 0.145
175 6.64 12.9 0.148 0.180 0.239 0.046 0.19 0.235 0.143

Values used for 20082006 S220 Dynamic Draft Offset
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                      SHIP DDSSM DATA ACQUISITION FORM

Date 4/24/2008 DN 115 Wind calm
Vessel # S220 Location Moira Seas flat

Average Depth 69F Personnel Campbell,FOO (8-12), CST, Bucher (12-4), Argento,Uozumi (4-8

RPM Speed Az Isis Line Name                       Acquisition Comments
120/10 2 NW DDSSM_NW_2kt_1 115-0605 (renamed), deleted small mistake line 115-0617
120/10 2 SE DDSSM_SE_2kt_2

180/100 13 NW DDSSM_NW_13kt_3
120/20 4 SE DDSSM_SE_4kt_4 mis-named NW, renamed
120/20 4 NW DDSSM_NW_4kt_5
160/80 10 SE DDSSM_SE_10kt_6 re-run, offline at southern end
140/50 6 NW DDSSM_NW_6kt_7
140/50 6 SE DDSSM_SE_6kt_8
160/80 10 NW DDSSM_NW_10kt_9

180/100 13 SE DDSSM_SE_13kt_10  2 lines created by mistake (SE_13KT_11,12), delete
150/60 8 NW DDSSM_NW_8kt_11
150/60 8 SE DDSSM_SE_8kt_12

STOP1 DDSSM_STOP1_A NE, initially NW logged perpendicular to main scheme
STOP2 DDSSM_STOP2_A Midpoint
STOP3 DDSSM_STOP3_A SE Point

160/80 10 SE DDSSM_SE_10kt_13 rerun of line 6
STOP4 DDSSM_STOP3_B



DDSSM Processing Log
Vessel

Date:5/1/2008 DN:122 Processors: Campbell
  

TrueHeave applied

SVP applied

Tide applied

Zoned

Filtered 40/40

9450460 (preliminary)

Patch_Test.zdf

Lines merged

Data cleaned to remove gross fliers

S220-8111

Data converted --> HDCS_Data in CARIS

TH_S220_115; S220_115_TH

Patch_S220_115_SV



Graph of Final Results (A,C) (*Note* B included in chart and table to right) Final Results S220 2008 Dn 115 testing
(average of A andC combined medians)

Speed (knots)
Speed 
(m/s)

Depth 
Difference Std. Dev.

1.30 0.67 0.00 0
2.52 1.30 0.33 0.095

Graph of numbers to left 3.43 1.76 0.54 0.128
y-axis offset (depth difference) 6.92 3.56 0.56 0.103
x-axis speed (m/s) 8.96 4.61 0.54 0.101

10.93 5.62 0.62 0.091
13.81 7.10 0.66 0.129

Avg: 0.1104
`

Final Results
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                       SHIP DDSSM DATA ACQUISITION FORM

Date 10/25/2008 DN 299 Wind 12kts
Vessel # S220 Location NW Union Bay, Ernest Sd Seas c, 1ft

Average Depth Personnel Argento, Beduhn, Bucher, Campbell

RPM Speed Az Isis Line Name                       Acquisition Comments
120/10 1.5 SE 2kts_SE.xtf
120/10 2 NW 2kts_NW.xtf
120/30 3.3 SE 4kts_SE.xtf
120/30 3.67 NW 4kts_NW.xtf
140/50 6 SE 6kts_SE.xtf
140/50 6 NW 6kts_NW.xtf
150/60 8 SE 8kts_SE.xtf
150/60 8 NW 8kts_NW.xtf
160/80 10 SE 10kts_SE.xtf
160/80 10.8 NW 10kts_NW.xtf
180/94 13.6 SE 14kts_SE.xtf
180/94 14 NW 14kts_NW.xtf

STOP1
STOP2
STOP3
STOP4

Good Run
Good run
Good Run

A little to port ~10m, wide at NW end. okay
Good run

wide at SE start. okay
A little to port and starboard  ~10m, wide each way at NW end

A little to port at NW corner of line, ~8m
Good Run
Good Run



DDSSM Processing Log
Vessel

Date:10/25/08 DN: 299 Processors: Argento
  

TrueHeave applied

SVP applied

Tide applied

Zoned

S220-8111

Data converted --> HDCS_Data in CARIS

POS_TH_S220_2008_299.000

DDSSM_S220_Dn299.svp

Filtered 40/40

Preliminary

O119FA2008CORP.zdf

Lines merged

Data cleaned to remove gross fliers



Graph of Final Results (A,2A,B,C) Final Results S220 2008 Dn 299 testing
(average of A,2A,B, and C combined medians)

Speed 
(m/s)

Depth 
Difference Std. Dev.

0.9880 0.0000 0.0000
Graph of numbers to left 1.8212 0.0619 0.0320
y-axis offset (depth difference) 3.0297 0.1593 0.0290
x-axis speed (m/s) 3.7733 0.0423 0.0300

5.3779 0.1044 0.0410
6.7578 0.1708 0.0460

Avg: 0.0356
`

Final Results
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Ship: FAIRWEATHER Vessel: S220
Date: 4/24/2008 Dn: 115
Personnel: Campbell

PCS Serial # IMU Serial # 292

IP Address: 129.100.1.231

POS controller Version (Use Menu Help > About) 3.3.2.2

POS Version (Use Menu View > Statistics) Version 4
GPS Receivers

Primary Receiver BD950 SN:4611A66708 v.00211

Secondary Receiver BD950 SN:4602A62806 v.00211

Calibration area
Location:
Approximate Position: Lat 55 4 50

Lon 131 58 34.2
DGPS Beacon Station: Annette
Frequency: 323

Satellite Constellation (Use View> GPS Data)

Primary GPS
Sketch general SV configuration or insert screen grabs Note any differences from Primary GPS Receiver

N
HDOP HDOP

0.926 0.928

VDOP VDOP
1.113 1.117

Sattelites in use: 12 Sattelites in use: 12
L1 SNR > 30 35 40 L1 SNR > 30 35 40

PDOP (Use View> GAMS Solution)

POS/MV Configuration
Settings Gams Parameter Setup (Use Settings>Installation>GAMS Installation)

  
    

   
   

  

Configuration Notes: Antenna separation based on 2007 survey.

NOAA POS/MV Calibration Report

 Moria Sound, SE Alaska

Secondary GPS

N

2411



POS/MV Calibration

Calibration Procedure: (Refer to POS MV V3 Installation and Operation Guide, 4-25)

Start time: 2:16
End time: 2:41
Heading accuracy achieved for calibration: 0.398

Calibration Results:
 Gams Parame (Use Settings>Installation>GAMS Installation)

   

   
  
  

GAMS Status Online Yes
Save Settings Yes

Calibration Notes:

Save POS Settings on PC (Use File > Store POS Settings on PC)
File Name:

General Notes:
The POS/MV uses a Right-Hand Orthogonal Reference System
The right-hand orthogonal system defines the following:
• The x-axis is in the fore-aft direction in the appropriate reference frame.
• The y-axis is perpendicular to the x-axis and points towards the

right (starboard) side in the appropriate reference frame.
• The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence
Apply the rotation in the following order to bring the two frames of reference 

into complete alignment:
a) Heading rotation - apply a right-hand screw rotation θz about the

z-axis to align one frame with the other.
b) Pitch rotation - apply a right-hand screw rotation θy about the

once-rotated y-axis to align one frame with the other.
c) Roll rotation - apply a right-hand screw rotation θx about the

twice-rotated x-axis to align one frame with the other.



SETTINGS
Input/Output Ports (Use Settings > Input/Output Ports)

COM1

COM2

COM3

COM4



SETTINGS Continued COM5

Heave Filter (Use Settings > Heave)

Events (Use Settings > Events)

INSTALLATION (Use Settings > Installation)

Lever Arms and Mounting Angles (Use Settings > Installation > Lever Arms and Offsets)



INSTALLATION Continued
Tags, Multipath and Auto Start (Use Settings > Installation > Tags, Multipath and Auto Start)

Sensor Mounting (Use Settings > Installation > Sensor Mounting)

User Parameter Accuracy (Use Settings > Installation > User Accuracy)



Frame Control (Use Tools > Config)

(Use Settings> Installation> GPS Receiver Configuration)
GPS  Receiver Configuration 

Primary GPS  Receiver

Secondary GPS Receiver
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SeaBat 8160 Noise Analysis 

1.0 Overview 
 
For mid and deep water sonar systems, noise emanating from the vessel on which the sonar is 
mounted is a major determinant in the performance of the sonar.   In addition to sources such as 
echosounders and other acoustic devices, such as doppler logs, mechanical noise from the 
engines and drive trains, and flow noise will also affect performance, with the magnitude of the 
noise varying with vessel speed. 
 
This document describes the noise analysis test done on the RESON SeaBat 8160 installed on 
the NOAA S/V Fairweather, on 10 October 2004. 

2.0 Test Conduct 
 
The following is a description of the system setup and test protocol used to test the SeaBat 8160 
multibeam sonar. 

2.1 Sonar Setup 
 
To determine the amount of in-band noise seen by the sonar, the system was configured as 
follows: 

 
Setting Value 
Power Off 
Gain Manual Fixed 20 
Range  100 meters 

 
Data collection was done using a RESON engineering utility, which collects the full amplitude 
and phase time series data from the sonar.  Figure 1 shows a sample screen capture, in this case 
one of the data sets taken at six knots, with a shaft speed of 140 RPM.  At least ten (10) 
collections were done for each test case, and the results for first 10 measurements each test case 
were averaged for the report. 

2.2 Vessel Operation 
 
Normal survey speed for the vessel is approximately 10 knots.  To bracket this range, and to 
check at possible lower survey speeds, the test was defined to cover the range of 2 to 12 knots, in 
2 knot steps.  The initial tests were at a shaft speed of 130 RPM, with the speed adjusted by 
changing the pitch on the propellers.  Additional tests were run at shaft speeds of 140 and 150 
RPM, with the pitch adjusted to achieve speeds of 6, 8 and 10 knots.  A log of data collections 
for the tests is provided in Appendix A. 
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All the underway data collections were done in water depths of 200 to 300 meters.  The zero 
speed data collections were done at anchor, in water depths of about 30 meters. 
 

 
Figure 1 - Snapshot Utility Screen Capture 

2.3 Data Analysis 
 
The data from each of the test cases were collated in an Excel spreadsheet, shown in Appendix 
B.  A graph of the measured noise levels, as a function of vessel speed and shaft RPM is shown 
in Figure 2.  The noise level is a unitless value that represents the average of all the amplitude 
samples, from all the beams for the sampled sonar ping.  This value represents a combination of 
the electrical noise in the sonar, and the response to all acoustic energy, within the bandwidth of 
the sonar, impinging on the receive array.   
 
For each the 130, 140 and 150 RPM tests, the plot shows the noise level as a function of vessel 
speed.  Only one sample was taken at 160 RPM, since to achieve the 12 knot speed, it was 
necessary to run at that RPM, with the pitch set to maximum test value of 10 feet. 
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8160 Noise vs. Speed
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Figure 2 - Noise Plot 

3.0 Conclusions 
 

a. It appears that the best survey speed, from a noise perspective, is at approximately 10 
knots.  Both lower and higher speeds correlate with higher noise levels. 

b. For lower survey speeds, it would be desirable to use a lower shaft RPM, combined with 
a higher pitch setting, to minimize the noise level seen by the sonar. 

c. The reason for the higher noise levels seen in the zero speed, at anchor collections is 
undetermined, by may be a result of the much shallower operating depth, and increased 
reverberation of vessel mechanical noise reflected off the bottom. 
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Appendix A – Test Log 
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Appendix B – Noise Analysis Spreadsheet 
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SeaBat 8111 Noise Analysis 

1.0 Overview 
 
For mid and deep water sonar systems, noise emanating from the vessel on which the sonar is 
mounted is a major determinant in the performance of the sonar.   In addition to sources such as 
echosounders and other acoustic devices, such as doppler logs, mechanical noise from the 
engines and drive trains, and flow noise will also affect performance, with the magnitude of the 
noise varying with vessel speed. 
 
This document describes the noise analysis test done on the RESON SeaBat 8111 installed on 
the NOAA S/V Fairweather, on 11 October 2004. 

2.0 Test Conduct 
 
The following is a description of the system setup and test protocol used to test the SeaBat 8111 
multibeam sonar. 

2.1 Sonar Setup 
 
To determine the amount of in-band noise seen by the sonar, the system was configured as 
follows: 

 
Setting Value 
Power Off 
Gain Manual Fixed 20 
Range  100 meters 

 
Data collection was done using a RESON engineering utility, which collects the full amplitude 
and phase time series data from the sonar.  Figure 1 shows a sample screen capture, in this case 
one of the data sets taken at six knots, with a shaft speed of 140 RPM.  At least ten (10) 
collections were done for each test case, and the results for first 10 measurements each test case 
were averaged for the report. 

2.2 Vessel Operation 
 
Normal survey speed for the vessel is approximately 10 knots.  To bracket this range, and to 
check at possible lower survey speeds, the test protocol was defined to cover the range of 2 to 12 
knots, in 2 knot steps.  The tests were conducted at shaft speeds of 120 to 170 RPM, in 10 RPM 
steps, with the speed adjusted by changing the pitch on the propellers.  For each RPM value, the 
speeds that could be achieved at that shaft speed were tested.  A log of data collections for the 
tests is provided in Appendix A. 
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All the underway data collections were done in water depths of 120 to 160 fathoms.  The zero 
speed data collections, with the engines on, were done at anchor in about 30 meters of water, and 
out in the bay, at water depths of about 130 fathoms. 
 

 
Figure 1 - Snapshot Utility Screen Capture 

2.3 Data Analysis 
 
The data from each of the test cases were collated in an Excel spreadsheet, shown in Appendix 
B.  A graph of the measured noise levels, as a function of vessel speed and shaft RPM is shown 
in Figure 2.  The noise level is a unitless value that represents the average of all the amplitude 
samples, from all the beams for the sampled sonar ping.  This value represents a combination of 
the electrical noise in the sonar, and the response to all acoustic energy, within the bandwidth of 
the sonar, impinging on the receive array.   
 
For each the tests, the plot shows the noise level as a function of vessel speed.  Again, the tests 
were run at the speeds that could be achieved at the selected shaft RPM. 
 
In an effort to resolve the cause of the high noise levels at anchor seen in the 8160 tests, noise 
tests with the engines at idle (110 shaft RPM, 0 pitch) in both shallow and deep water.  In deeper 
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water, much lower noise levels were observed, apparently due to the greater attenuation of the 
noise from the various acoustic sources on the ship over the greater range. 
 

8111 Noise Analysis
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Figure 2 - Noise Plot 

3.0 Conclusions 
 

a. It appears that the best survey speed for the 8111, from a noise perspective, is in the 
range of 8 to 10 knots.  Both lower and higher speeds correlate with higher noise levels. 

b. It would be desirable to use shaft speeds of 140 RPM, or lower, to minimize the noise 
level seen by the sonar. 

c. Significantly increased levels of reverberation from acoustic sources on the vessel are 
seen in shallower water.  If this causes any degradation in the quality of the soundings in 
the 8111, increased power levels, higher than those recommended in the sonar settings 
guide, should be used to compensate. 



 

 

  
 

 
Fairweather 8111 Noise Analysis Report Page 4 of 6
 

Appendix A – Test Logs 
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Appendix B – Noise Analysis Spreadsheet 
 

 
 



Appendix IV 
 
 
Total Propagated Error (TPE) 
 
 

• Fairweather TPE Values 
• Tide TPE Values 

 



Vessel FAIRWEATHER-S220 FAIRWEATHER-S220 1010 1018
Sonar System Reson 8111 Reson 8160 Reson 8101 Reson 8101

MRU to Trans X 2.868 0.493 0.250 0.282
MRU to Trans Y 8.252 7.665 -0.133 -0.145
MRU to Trans  Z 4.752 4.726 0.549 0.548
Nav to Trans X 1.691 -0.684 1.147 1.181
Nav to Trans Y 20.172 19.585 1.066 0.955
Nav to Trans Z 17.756 17.730 3.661 3.71
Trans Roll 0.00 0.00 0.000 0.00

Vessel FAIRWEATHER-S220 FAIRWEATHER-S220 1010 1018
Sonar System Reson 8111 Reson 8160 Reson 8101 Reson 8101

Status
Motion Gyro (deg) 0.02 0.02 0.02 0.02 Finalized
Heave% Amp 5 5 5 5 Finalized
Heave (m) 0.05 0.05 0.05 0.05 Finalized
Roll (deg) 0.02 0.02 0.02 0.02 Finalized
Pitch (deg) 0.02 0.02 0.02 0.02 Finalized
Position Nav (m) 0.5* 0.5 0.5 0.5 Finalized
Vessel Speed (m/s) 0.03 0.03 0.03 0.03 Finalized
Timing Trans (s) 0.005 0.005 0.005 0.005 Finalized
Nav Timing (s) 0.005 0.005 0.005 0.005 Finalized
Gyro Timing (s) 0.005 0.005 0.005 0.005 Finalized
Heave Timing (s) 0.005 0.005 0.005 0.005 Finalized
Pitch Timing (s) 0.005 0.005 0.005 0.005 Finalized
Roll Timing (s) 0.005 0.005 0.005 0.005 Finalized
Offset X (m) 0.007 0.007 0.007 0.007 Finalized
Offset Y (m) 0.007 0.007 0.007 0.007 Finalized
Offset Z (m) 0.008 0.008 0.007 0.007 Finalized
Loading 0.02 0.02 0.000 0.010 Finalized
Draft (m) 0.022 0.022 0.050 0.016 Finalized
DeltaDraft (m) 0.110 0.110 0.020 0.05 Finalized
MRU alignStdev gyro 0.2 0.11 0.16 0.3 Finalized
MRU align roll/pitch 0.1 0.18 0.02 0.06 Finalized
Tide Meas (m) 0.02 0.02 0.02 0.02 Project Dependent**
Tide Zoning (m) 0.1 0.1 0.1 0.1 Project Dependent**
SV Meas (m/s) 0.5 0.5 1.0 1.0 Finalized
Surface SV (m/s) 0.5 0.5 1.0 1.0 Finalized

*Position Nav adjusted in HVF to 5m when acquiring in Coarse Acquisition mode, additional information will be submitted in the DAPR and/or the DR.
**Default values listed, descriptive report will list actual values applied if supplied with Project Instructions.

FAIRWEATHER SURVEY

Documents Title                        
FA_TPE_Values_2008

C
om

pu
te

 
TP

E 
D

ia
lo

g 
B

ox

Ve
ss

el
 C

on
fig

ur
at

io
n 

Fi
le

Version          
2008.2

Standard Deviation

POS/MV        
Model 320

Positioning System POS/MV          
Model 320

Positioning System POS/MV          
Model 320 V4

POS/MV          
Model 320 V4

Motion 
Sensor

Offsets

Sound 
Velocity

Tides

Vessel 
Offsets

Waterline

MRU 
Alignment

Offsets

Latency

Last update        
October 27, 2008

Process Owner   
Survey

Approval Date    
October 27, 2008  

POS/MV         
Model 320 V3

POS/MV        
Model 320 V3

POS/MV         
Model 320

                
Appendix IV

POS/MV          
Model 320



Tide Zoning 95% Tide Zoning 1-sigma
Tide Measurement (Provided by CO-OPS) (Use in Caris)

OPR-O322-FA-08
Chatham Strait 0.02 0.26 0.13

OPR-P183-FA-08
Shumagin Islands 0.02 0.19 0.095

and Vicinity

OPR-P357-FA-08
Kachemak bay 0 0 0

(TCARI is a special case, see FOO for more info)

OPR-P132-FA-08
PWS 0.02 0.31 0.155

OPR-O309-FA-08
Icy Bay, AK 0.02 0.17 0.085

OPR-O168-FA-08
Endicott Arm 0.02 0.1 0.05

OPR-O119-FA-08
Ernest Sound 0.02 0.14 0.07



Appendix V 
 
 
Additional Calibration Reports 
 
 

• Control 
• Diver Least Depth Gauge 
• Laser Level 
• Leadlines 
• Sound Velocity 
• Total Stations 

 



2008 DGPS Beacon Quality Test 
 
Date: 
May 2-3, 2008 
 
People involved: 
Llian Breen, ENS 
Brenna Campbell, SST 
Matt Ringel, LT 
 
Location: 
USCG ISC Ketchikan BM No. 37 (see appendix A) 
 

 
 
Weather: 
~46 deg. Fahrenheit, light-moderate rain, gusty winds, 100% cloud cover 
 
 Equipment Used: 
Trimble DSM 232 Firmware v3.57 (DGPS beacon) 
Trimble Zephyr Geodetic Model 2 (DGPS beacon atenna) 
Trimble DSM 232 Firmware v3.57 (DGPS receiver) 
Trimble Combined receiver  
Pacific Crest Position Data Link Base (in low power operation) 



Pacific Crest Broadcast antenna 
Pacific Crest Position Data Link Rover 
Panasonic CF-18 Toughbook 
Ashtech Evaluate Software (for data acquisition) 
4 12v Marine batteries 
 
Method: 
Followed the Fly_Away_SOP.doc as edited by Llian Breen 
 
Results: 
95% of all horizontal positions were within 0.8496 meters, which meets the horizontal 
control standards as defined in the HSSD for the use of a DGPS flyaway station. 
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FAIRWEATHER Horizontal Positioning Equipment Check FAIRWEATHER Horizontal Positioning Equipment Check FAIRWEATHER Horizontal Positioning Equipment Check FAIRWEATHER Horizontal Positioning Equipment Check FAIRWEATHER Horizontal Positioning Equipment Check FAIRWEATHER Horizontal Positioning Equipment Check FAIRWEATHER Horizontal Positioning Equipment Check FAIRWEATHER Horizontal Positioning Equipment Check FAIRWEATHER Horizontal Positioning Equipment Check 
3/14/20073/14/20073/14/20073/14/20073/14/20073/14/20073/14/20073/14/20073/14/2007

USCG ISC Ketchikan BM NO 37USCG ISC Ketchikan BM NO 37USCG ISC Ketchikan BM NO 37USCG ISC Ketchikan BM NO 37USCG ISC Ketchikan BM NO 37USCG ISC Ketchikan BM NO 37USCG ISC Ketchikan BM NO 37USCG ISC Ketchikan BM NO 37USCG ISC Ketchikan BM NO 37
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BM NO 37BM NO 37BM NO 37BM NO 37BM NO 37BM NO 37BM NO 37BM NO 37BM NO 37BM NO 37



Subject: 
OPUS solution : USCG0732.07O 000106232 
From: 
opus@ngs.noaa.gov 
Date: 
Mon, 02 Apr 2007 12:07:31 -0400 (EDT) 
To: 
horcon.fairweather@noaa.gov 
 
 FILE: USCG0732.07O 000106232 
 
                              NGS OPUS SOLUTION REPORT 
                              ======================== 
 
      USER: horcon.fairweather@noaa.gov             DATE: April 02, 2007 
RINEX FILE: uscg073s.07o                            TIME: 16:07:30 UTC 
 
 
  SOFTWARE: page5  0612.06 master29.pl             START: 2007/03/14  18:06:00 
 EPHEMERIS: igs14183.eph [precise]                  STOP: 2007/03/14  20:36:00 
  NAV FILE: brdc0730.07n                        OBS USED:  6385 /  6511   :  98% 
  ANT NAME: ASH701975.01AGP NONE             # FIXED AMB:    30 /    32   :  94% 
ARP HEIGHT: 2.0                              OVERALL RMS: 0.018(m) 
 
 
 REF FRAME: NAD_83(CORS96)(EPOCH:2003.0000)            ITRF00 (EPOCH:2007.1995) 
       
         X:     -2415358.884(m)   0.013(m)          -2415359.692(m)   0.013(m) 
         Y:     -2718046.175(m)   0.012(m)          -2718045.070(m)   0.012(m) 
         Z:      5222559.312(m)   0.016(m)           5222559.510(m)   0.016(m) 
 
       LAT:   55 19 58.66133      0.010(m)        55 19 58.67266      0.010(m) 
     E LON:  228 22 28.18023      0.007(m)       228 22 28.10433      0.007(m) 
     W LON:  131 37 31.81977      0.007(m)       131 37 31.89567      0.007(m) 
    EL HGT:            3.781(m)   0.023(m)                 3.780(m)   0.023(m) 
 ORTHO HGT:            9.656(m)   0.034(m) [Geoid06 NAVD88] 
 
                        UTM COORDINATES    STATE PLANE COORDINATES 
                         UTM (Zone 09)         SPC (5001 AK 1) 
Northing (Y) [meters]     6134983.221                0.000 
Easting (X)  [meters]      333464.469                0.000 
Convergence  [degrees]    -2.15989540           0.00000000 
Point Scale                0.99994023           0.00000000 
Combined Factor            0.99993963           0.00000000 
 
US NATIONAL GRID DESIGNATOR:  9UUB3346434983(NAD 83) 
 
 
 
                              BASE STATIONS USED 
PID       DESIGNATION                        LATITUDE    LONGITUDE DISTANCE(m) 
AI5022 BIS1 BIORKA ISLAND 1 CORS ARP       N565116.162 W1353221.387  296620.8 
AJ4430 LEV1 LEVEL ISLAND 1 CORS ARP        N562756.438 W1330533.935  155968.5 
AF9530 AIS1 ANNETTE ISLAND 1 CORS ARP      N550408.647 W1313558.255   29425.1 
 
                 NEAREST NGS PUBLISHED CONTROL POINT 
AI4914      BM NO 37                       N551958.659 W1313731.820       0.0 



 
 
                                                    
                                                    
                          BASE STATION INFORMATION  
                                                    
 STATION NAME: bis1  a    5 (BIORKA ISLAND 1; Biorka Island, Alaska, U.S.A.) 
  ANTENNA: ASH700829.3     SNOW                             S/N=xxxx             
 XYZ  -2494921.0213  -2448390.9324   5317113.5289  MON @ 1997.0000 (M) 
 XYZ        -0.0164         0.0037         0.0005  VEL (M/YR) 
 NEU         0.0000         0.0000         0.0000  MON TO ARP (M) 
 NEU        -0.0000         0.0000         0.0877  ARP TO L1 PHASE CENTER (M) 
 NEU        -0.0000         0.0000         0.0598  ARP TO L2 PHASE CENTER (M) 
 XYZ        -0.1673         0.0377         0.0051  VEL TIMES 10.1982 YRS 
 XYZ         0.0000         0.0000         0.0000  MON TO ARP 
 XYZ        -0.0342        -0.0336         0.0734  ARP TO L1 PHASE CENTER 
 XYZ  -2494921.2228  -2448390.9283   5317113.6074  L1 PHS CEN @ 2007.1995 
 XYZ        -0.0001         0.0014         0.0005  + XYZ ADJUSTMENTS 
 XYZ  -2494921.2228  -2448390.9269   5317113.6080  NEW L1 PHS CEN @ 2007.1995 
 XYZ  -2494921.1886  -2448390.8933   5317113.5345  NEW ARP @ 2007.1995 
 XYZ  -2494921.1886  -2448390.8933   5317113.5345  NEW MON @ 2007.1995 
 LLH  56 51 16.17228  224 27 38.53267     66.6787  NEW L1 PHS CEN @ 2007.1995 
 LLH  56 51 16.17228  224 27 38.53267     66.5910  NEW ARP @ 2007.1995 
 LLH  56 51 16.17228  224 27 38.53267     66.5910  NEW MON @ 2007.1995 
 
 STATION NAME: lev1  a    8 (Level Island 1; Level Island, Alaska  USA) 
  ANTENNA: ASH700829.3     SNOW                             S/N=CG11936          
 XYZ  -2412828.4670  -2579056.1235   5293283.3535  MON @ 1997.0000 (M) 
 XYZ        -0.0190         0.0003        -0.0044  VEL (M/YR) 
 NEU         0.0000         0.0000         0.0000  MON TO ARP (M) 
 NEU        -0.0000         0.0000         0.0877  ARP TO L1 PHASE CENTER (M) 
 NEU        -0.0000         0.0000         0.0598  ARP TO L2 PHASE CENTER (M) 
 XYZ        -0.1938         0.0031        -0.0449  VEL TIMES 10.1982 YRS 
 XYZ         0.0000         0.0000         0.0000  MON TO ARP 
 XYZ        -0.0331        -0.0354         0.0731  ARP TO L1 PHASE CENTER 
 XYZ  -2412828.6939  -2579056.1558   5293283.3817  L1 PHS CEN @ 2007.1995 
 XYZ        -0.0002         0.0006         0.0002  + XYZ ADJUSTMENTS 
 XYZ  -2412828.6941  -2579056.1552   5293283.3819  NEW L1 PHS CEN @ 2007.1995 
 XYZ  -2412828.6610  -2579056.1198   5293283.3088  NEW ARP @ 2007.1995 
 XYZ  -2412828.6610  -2579056.1198   5293283.3088  NEW MON @ 2007.1995 
 LLH  56 27 56.44916  226 54 25.98578     25.2831  NEW L1 PHS CEN @ 2007.1995 
 LLH  56 27 56.44916  226 54 25.98578     25.1954  NEW ARP @ 2007.1995 
 LLH  56 27 56.44916  226 54 25.98578     25.1954  NEW MON @ 2007.1995 
 
 STATION NAME: ais1  a    7 (ANNETTE ISLAND 1; Annette Island, Alaska, U.S.A.) 
  ANTENNA: ASH700829.3     SNOW                             S/N=11276            
 XYZ  -2430153.7846  -2737192.8996   5205816.6147  MON @ 1997.0000 (M) 
 XYZ        -0.0151         0.0008        -0.0082  VEL (M/YR) 
 NEU         0.0000         0.0000         0.0000  MON TO ARP (M) 
 NEU        -0.0000         0.0000         0.0877  ARP TO L1 PHASE CENTER (M) 
 NEU        -0.0000         0.0000         0.0598  ARP TO L2 PHASE CENTER (M) 
 XYZ        -0.1540         0.0082        -0.0836  VEL TIMES 10.1982 YRS 
 XYZ         0.0000         0.0000         0.0000  MON TO ARP 
 XYZ        -0.0333        -0.0376         0.0719  ARP TO L1 PHASE CENTER 
 XYZ  -2430153.9719  -2737192.9290   5205816.6030  L1 PHS CEN @ 2007.1995 
 XYZ         0.0001        -0.0001        -0.0000  + XYZ ADJUSTMENTS 
 XYZ  -2430153.9718  -2737192.9291   5205816.6030  NEW L1 PHS CEN @ 2007.1995 



 XYZ  -2430153.9385  -2737192.8915   5205816.5311  NEW ARP @ 2007.1995 
 XYZ  -2430153.9385  -2737192.8915   5205816.5311  NEW MON @ 2007.1995 
 LLH  55  4  8.65871  228 24  1.66998     32.2471  NEW L1 PHS CEN @ 2007.1995 
 LLH  55  4  8.65871  228 24  1.66998     32.1594  NEW ARP @ 2007.1995 
 LLH  55  4  8.65871  228 24  1.66998     32.1594  NEW MON @ 2007.1995 
 
                         REMOTE STATION INFORMATION 
                                                    
 STATION NAME: uscg       1 
  ANTENNA: ASH701975.01AGP NONE                             S/N=UNKNOWN          
 XYZ  -2415360.3793  -2718045.5588   5222561.1762  MON @ 2007.1993 (M) 
 NEU         0.0000        -0.0000         2.0000  MON TO ARP (M) 
 NEU        -0.0000         0.0000         0.0637  ARP TO L1 PHASE CENTER (M) 
 NEU        -0.0000         0.0000         0.0440  ARP TO L2 PHASE CENTER (M) 
 XYZ        -0.7557        -0.8504         1.6449  MON TO ARP 
 XYZ        -0.0241        -0.0271         0.0524  ARP TO L1 PHASE CENTER 
 XYZ  -2415361.1590  -2718046.4363   5222562.8735  L1 PHS CEN @ 2007.1995 
 
 BASELINE NAME:   bis1  uscg 
 XYZ         0.6817         0.4813        -1.6607  + XYZ ADJUSTMENTS 
 XYZ  -2415360.4774  -2718045.9549   5222561.2128  NEW L1 PHS CEN @ 2007.1995 
 XYZ  -2415360.4533  -2718045.9278   5222561.1604  NEW ARP @ 2007.1995 
 XYZ  -2415359.6976  -2718045.0775   5222559.5155  NEW MON @ 2007.1995 
 LLH  55 19 58.67251  228 22 28.10438      5.8533  NEW L1 PHS CEN @ 2007.1995 
 LLH  55 19 58.67251  228 22 28.10438      5.7896  NEW ARP @ 2007.1995 
 LLH  55 19 58.67251  228 22 28.10438      3.7896  NEW MON @ 2007.1995 
 
 BASELINE NAME:   lev1  uscg 
 XYZ         0.6864         0.4936        -1.6609  + XYZ ADJUSTMENTS 
 XYZ  -2415360.4727  -2718045.9427   5222561.2127  NEW L1 PHS CEN @ 2007.1995 
 XYZ  -2415360.4486  -2718045.9156   5222561.1603  NEW ARP @ 2007.1995 
 XYZ  -2415359.6929  -2718045.0652   5222559.5153  NEW MON @ 2007.1995 
 LLH  55 19 58.67284  228 22 28.10412      5.8462  NEW L1 PHS CEN @ 2007.1995 
 LLH  55 19 58.67284  228 22 28.10412      5.7825  NEW ARP @ 2007.1995 
 LLH  55 19 58.67284  228 22 28.10412      3.7825  NEW MON @ 2007.1995 
 
 BASELINE NAME:   ais1  uscg 
 XYZ         0.6951         0.4928        -1.6769  + XYZ ADJUSTMENTS 
 XYZ  -2415360.4639  -2718045.9435   5222561.1967  NEW L1 PHS CEN @ 2007.1995 
 XYZ  -2415360.4398  -2718045.9164   5222561.1443  NEW ARP @ 2007.1995 
 XYZ  -2415359.6842  -2718045.0660   5222559.4993  NEW MON @ 2007.1995 
 LLH  55 19 58.67268  228 22 28.10452      5.8300  NEW L1 PHS CEN @ 2007.1995 
 LLH  55 19 58.67268  228 22 28.10452      5.7663  NEW ARP @ 2007.1995 
 LLH  55 19 58.67268  228 22 28.10452      3.7663  NEW MON @ 2007.1995 
 
                                   G-FILES  
                                            
Axx2007 314   7 314 
B2007 31418 5   7 3142035 1 page5 v0612.06IGS     222 1 2 27NGS   2007 4 2IFDDFX 
Iant_info.003        NGS   20070320 
C00090001 -795614910   19 2696541842   21  945540190   39 X0737AUSCGX0737ABIS1 
D  1  2  7550588  1  3 -9307589  2  3 -7806480 
  
Axx2007 314   7 314 
B2007 31418 5   7 3142035 1 page5 v0612.06IGS     222 1 2 27NGS   2007 4 2IFDDFX 
Iant_info.003        NGS   20070320 
C00090002   25310319   17 1389889454   20  707237935   38 X0737AUSCGX0737ALEV1 



D  1  2  8189618  1  3 -9202066  2  3 -7448116 
  
Axx2007 314   7 314 
B2007 31418 5   7 3142035 1 page5 v0612.06IGS     222 1 2 27NGS   2007 4 2IFDDFX 
Iant_info.003        NGS   20070320 
C00090003 -147942543   19 -191478255   22 -167429683   36 X0737AUSCGX0737AAIS1 
D  1  2  9369495  1  3 -7883557  2  3 -7554607 
  
                   POST-FIT RMS BY SATELLITE VS. BASELINE 
                                                          
            OVERALL     03     06     07     10     16     18     19     21 
 bis1-uscg|  0.017  0.018  0.016  0.018  0.014  0.019  0.013  0.015    ... 
                22     24     25     26     29     30 
 bis1-uscg|  0.018  0.015    ...  0.022  0.019    ...                      
 
            OVERALL     03     06     07     10     16     18     19     21 
 lev1-uscg|  0.018  0.017  0.018  0.019  0.017  0.022  0.017  0.015    ... 
                22     24     26     29     30 
 lev1-uscg|  0.018  0.013  0.018  0.021    ...                             
 
            OVERALL     03     06     07     10     16     18     19     21 
 ais1-uscg|  0.018  0.020  0.018  0.018  0.012  0.022  0.016    ...    ... 
                22     24     26     29     30 
 ais1-uscg|  0.015  0.017  0.015  0.016    ...                             
 
                        OBS BY SATELLITE VS. BASELINE 
                                                      
            OVERALL     03     06     07     10     16     18     19     21 
 bis1-uscg|   2148    155    203    279    102    296    245     28    ... 
                22     24     25     26     29     30 
 bis1-uscg|    118    284    ...    200    238    ...                      
            OVERALL     03     06     07     10     16     18     19     21 
 lev1-uscg|   2087    155    182    225    106    296    247     28    ... 
                22     24     26     29     30 
 lev1-uscg|    117    284    200    247    ...                             
            OVERALL     03     06     07     10     16     18     19     21 
 ais1-uscg|   2150    152    207    284    105    295    239    ...    ... 
                22     24     26     29     30 
 ais1-uscg|    119    283    213    253    ...                             
                                            
 
 Covariance Matrix for the xyz OPUS Position (meters2). 
    0.0000022467     0.0000002159    -0.0000004052 
    0.0000002159     0.0000029444    -0.0000004008 
   -0.0000004052    -0.0000004008     0.0000094689 
 
 Covariance Matrix for the enu OPUS Position (meters2). 
    0.0000023402    -0.0000002845     0.0000001534 
   -0.0000002845     0.0000044782     0.0000029060 
    0.0000001534     0.0000029060     0.0000078416 
 
 Horizontal network accuracy =    0.00458 meters. 
 Vertical network accuracy   =    0.00549 meters. 
 
 
                       Derivation of NAD 83 vector components 
 



  
  Position of reference station ARP in NAD_83(CORS96)(EPOCH:2003.0000). 
                  Xa(m)           Ya(m)           Za(m) 
       BIS1  -2494920.37852  -2448391.99956   5317113.26406    2003.00 
       LEV1  -2412827.84636  -2579057.21856   5293283.07789    2003.00 
       AIS1  -2430153.14737  -2737194.00189   5205816.33593    2003.00 
  
  Position of reference station monument in NAD_83(CORS96)(EPOCH:2003.0000). 
                  Xr(m)           Yr(m)           Zr(m) 
       BIS1  -2494920.37852  -2448391.99956   5317113.26406    2003.00 
       LEV1  -2412827.84636  -2579057.21856   5293283.07789    2003.00 
       AIS1  -2430153.14737  -2737194.00189   5205816.33593    2003.00 
  
  Velocity of reference station monument in NAD_83(CORS96)(EPOCH:2003.0000). 
                  Vx (m/yr)       Vy (m/yr)       Vz (m/yr) 
       BIS1         0.00490         0.00450         0.00990 
       LEV1         0.00220         0.00120         0.00480 
       AIS1         0.00580         0.00170         0.00110 
  
  Vectors from unknown station monument to reference station monument 
  in NAD_83(CORS96)(EPOCH:2003.0000). 
                Xr-X= DX(m)     Yr-Y= DY(m)     Zr-Z= DZ(m) 
       BIS1    -79561.49452    269654.17544     94553.95206    2003.00 
       LEV1      2531.03764    138988.95644     70723.76589    2003.00 
       AIS1    -14794.26337    -19147.82689    -16742.97607    2003.00 
 
This position and the above vector components were computed without any  
knowledge by the National Geodetic Survey regarding the equipment or  
field operating procedures used. 



FILE: 99991892.08O 000401738 
 
                             NGS OPUS SOLUTION REPORT 
                             ======================== 
 
All computed coordinate accuracies are listed as peak-to-peak values. 
For additional information: www.ngs.noaa.gov/OPUS/Using_OPUS.html#accuracy 
 
     USER: weston.renoud@noaa.gov                  DATE: July 25, 2008 
RINEX FILE: 9999189t.08o                            TIME: 20:44:53 UTC 
 
 
 SOFTWARE: page5  0612.06 master.pl               START: 2008/07/07  19:50:00 
 EPHEMERIS: igs14871.eph [precise]                  STOP: 2008/07/07  23:22:00 
 NAV FILE: brdc1890.08n                        OBS USED:  6124 /  7170   :  85% 
 ANT NAME: ASH701975.01AGP NONE             # FIXED AMB:    37 /    41   :  90% 
ARP HEIGHT: 1.8                              OVERALL RMS: 0.017(m) 
 
 
 REF FRAME: NAD_83(CORS96)(EPOCH:2003.0000)            ITRF00 (EPOCH:2008.5161) 
 
        X:     -2856077.871(m)   0.018(m)          -2856078.763(m)   0.018(m) 
        Y:     -1547384.126(m)   0.007(m)          -1547383.076(m)   0.007(m) 
        Z:      5470609.931(m)   0.029(m)           5470610.261(m)   0.029(m) 
 
      LAT:   59 28  4.19773      0.005(m)        59 28  4.19524      0.005(m) 
    E LON:  208 26 53.63529      0.009(m)       208 26 53.54968      0.009(m) 
    W LON:  151 33  6.36471      0.009(m)       151 33  6.45032      0.009(m) 
   EL HGT:           16.941(m)   0.034(m)                17.370(m)   0.034(m) 
 ORTHO HGT:            7.387(m)   0.125(m) [NAVD88 (Computed using GEOID06)] 
 
                       UTM COORDINATES    STATE PLANE COORDINATES 
                        UTM (Zone 05)         SPC (5004 AK 4) 
Northing (Y) [meters]     6593040.803           609834.429 
Easting (X)  [meters]      582068.589           412038.502 
Convergence  [degrees]     1.24749500          -1.33669094 
Point Scale                0.99968255           0.99999480 
Combined Factor            0.99967990           0.99999215 
 
US NATIONAL GRID DESIGNATOR:  5VNF8206993041(NAD 83) 
 
 
 
                             BASE STATIONS USED 
PID       DESIGNATION                        LATITUDE    LONGITUDE DISTANCE(m) 
DI9676 KOD5 KODIAK 5 CORS ARP              N573703.690 W1521136.263  209430.6 
DJ3029 KEN5 KENAI 5 CORS ARP               N604030.284 W1512100.570  134969.2 
AI0952 TSEA ANCHORAGE CORS ARP             N611114.374 W1495341.819  212301.1 
 
                NEAREST NGS PUBLISHED CONTROL POINT 
UW5593      GRASS ISLAND 1975 AZ MK        N592918.836 W1512918.639    4256.3 
 
 
 
 
 



                         BASE STATION INFORMATION 
 
 STATION NAME: kod5  a    2 (Kodiak 5; Kodiak, Alaska  USA) 
 ANTENNA: TRM41249USCG    SCIT                             S/N=60100858 
 XYZ  -3028720.7822  -1597307.4139   5363076.7078  MON @ 1997.0000 (M) 
 XYZ        -0.0145         0.0111         0.0097  VEL (M/YR) 
 NEU         0.0000         0.0000         0.0000  MON TO ARP (M) 
 NEU        -0.0000         0.0000         0.0813  ARP TO L1 PHASE CENTER (M) 
 NEU        -0.0000         0.0000         0.0689  ARP TO L2 PHASE CENTER (M) 
 XYZ        -0.1670         0.1278         0.1117  VEL TIMES 11.5153 YRS 
 XYZ         0.0000         0.0000         0.0000  MON TO ARP 
 XYZ        -0.0385        -0.0203         0.0687  ARP TO L1 PHASE CENTER 
 XYZ  -3028720.9877  -1597307.3064   5363076.8882  L1 PHS CEN @ 2008.5161 
 XYZ         0.0001         0.0001         0.0001  + XYZ ADJUSTMENTS 
 XYZ  -3028720.9876  -1597307.3063   5363076.8883  NEW L1 PHS CEN @ 2008.5161 
 XYZ  -3028720.9491  -1597307.2860   5363076.8196  NEW ARP @ 2008.5161 
 XYZ  -3028720.9491  -1597307.2860   5363076.8196  NEW MON @ 2008.5161 
 LLH  57 37  3.69097  207 48 23.65274     27.2919  NEW L1 PHS CEN @ 2008.5161 
 LLH  57 37  3.69097  207 48 23.65274     27.2106  NEW ARP @ 2008.5161 
 LLH  57 37  3.69097  207 48 23.65274     27.2106  NEW MON @ 2008.5161 
 
 STATION NAME: ken5  a    2 (Kenai 5; Kenai, Alaska  USA) 
 ANTENNA: TRM41249USCG    SCIT                             S/N=60051882 
 XYZ  -2748338.8009  -1501544.4452   5537749.5705  MON @ 1997.0000 (M) 
 XYZ        -0.0279        -0.0114        -0.0038  VEL (M/YR) 
 NEU         0.0000         0.0000         0.0000  MON TO ARP (M) 
 NEU        -0.0000         0.0000         0.0813  ARP TO L1 PHASE CENTER (M) 
 NEU        -0.0000         0.0000         0.0689  ARP TO L2 PHASE CENTER (M) 
 XYZ        -0.3213        -0.1313        -0.0438  VEL TIMES 11.5153 YRS 
 XYZ         0.0000         0.0000         0.0000  MON TO ARP 
 XYZ        -0.0349        -0.0191         0.0709  ARP TO L1 PHASE CENTER 
 XYZ  -2748339.1571  -1501544.5956   5537749.5976  L1 PHS CEN @ 2008.5161 
 XYZ        -0.0000         0.0000        -0.0000  + XYZ ADJUSTMENTS 
 XYZ  -2748339.1571  -1501544.5956   5537749.5976  NEW L1 PHS CEN @ 2008.5161 
 XYZ  -2748339.1222  -1501544.5765   5537749.5267  NEW ARP @ 2008.5161 
 XYZ  -2748339.1222  -1501544.5765   5537749.5267  NEW MON @ 2008.5161 
 LLH  60 40 30.28022  208 38 59.34315     56.3955  NEW L1 PHS CEN @ 2008.5161 
 LLH  60 40 30.28022  208 38 59.34315     56.3142  NEW ARP @ 2008.5161 
 LLH  60 40 30.28022  208 38 59.34315     56.3142  NEW MON @ 2008.5161 
 
 STATION NAME: tsea  a    8 (The Surveyors Exchange A; Anchorage, Alaska  USA) 
 ANTENNA: LEIAT504GG      LEIS                             S/N=319 
 XYZ  -2666155.0438  -1545828.5805   5565470.2836  MON @ 1997.0000 (M) 
 XYZ        -0.0182         0.0041        -0.0051  VEL (M/YR) 
 NEU         0.0000         0.0000         0.0000  MON TO ARP (M) 
 NEU        -0.0000         0.0000         0.1042  ARP TO L1 PHASE CENTER (M) 
 NEU        -0.0000         0.0000         0.1238  ARP TO L2 PHASE CENTER (M) 
 XYZ        -0.2096         0.0472        -0.0587  VEL TIMES 11.5153 YRS 
 XYZ         0.0000         0.0000         0.0000  MON TO ARP 
 XYZ        -0.0434        -0.0252         0.0913  ARP TO L1 PHASE CENTER 
 XYZ  -2666155.2968  -1545828.5585   5565470.3162  L1 PHS CEN @ 2008.5161 
 XYZ         0.0000         0.0000        -0.0001  + XYZ ADJUSTMENTS 
 XYZ  -2666155.2968  -1545828.5585   5565470.3161  NEW L1 PHS CEN @ 2008.5161 
 XYZ  -2666155.2534  -1545828.5333   5565470.2248  NEW ARP @ 2008.5161 
 XYZ  -2666155.2534  -1545828.5333   5565470.2248  NEW MON @ 2008.5161 
 LLH  61 11 14.37401  210  6 18.08838     43.0456  NEW L1 PHS CEN @ 2008.5161 
 LLH  61 11 14.37401  210  6 18.08838     42.9414  NEW ARP @ 2008.5161 
 LLH  61 11 14.37401  210  6 18.08838     42.9414  NEW MON @ 2008.5161 



 
                        REMOTE STATION INFORMATION 
 
 STATION NAME: 9999       1 
 ANTENNA: ASH701975.01AGP NONE                             S/N=UNKNOWN 
 XYZ  -2856080.1160  -1547383.5351   5470612.2588  MON @ 2008.5159 (M) 
 NEU        -0.0000        -0.0000         1.8000  MON TO ARP (M) 
 NEU        -0.0000         0.0000         0.0637  ARP TO L1 PHASE CENTER (M) 
 NEU        -0.0000         0.0000         0.0440  ARP TO L2 PHASE CENTER (M) 
 XYZ        -0.8040        -0.4356         1.5504  MON TO ARP 
 XYZ        -0.0285        -0.0154         0.0549  ARP TO L1 PHASE CENTER 
 XYZ  -2856080.9485  -1547383.9861   5470613.8641  L1 PHS CEN @ 2008.5161 
 
 BASELINE NAME:   kod5  9999 
 XYZ         1.3621         0.4617        -2.0109  + XYZ ADJUSTMENTS 
 XYZ  -2856079.5864  -1547383.5244   5470611.8532  NEW L1 PHS CEN @ 2008.5161 
 XYZ  -2856079.5579  -1547383.5090   5470611.7983  NEW ARP @ 2008.5161 
 XYZ  -2856078.7539  -1547383.0734   5470610.2479  NEW MON @ 2008.5161 
 LLH  59 28  4.19528  208 26 53.54982     19.2176  NEW L1 PHS CEN @ 2008.5161 
 LLH  59 28  4.19528  208 26 53.54982     19.1539  NEW ARP @ 2008.5161 
 LLH  59 28  4.19528  208 26 53.54982     17.3539  NEW MON @ 2008.5161 
 
 BASELINE NAME:   ken5  9999 
 XYZ         1.3441         0.4599        -1.9817  + XYZ ADJUSTMENTS 
 XYZ  -2856079.6044  -1547383.5262   5470611.8824  NEW L1 PHS CEN @ 2008.5161 
 XYZ  -2856079.5760  -1547383.5108   5470611.8275  NEW ARP @ 2008.5161 
 XYZ  -2856078.7719  -1547383.0752   5470610.2771  NEW MON @ 2008.5161 
 LLH  59 28  4.19530  208 26 53.54937     19.2512  NEW L1 PHS CEN @ 2008.5161 
 LLH  59 28  4.19530  208 26 53.54937     19.1875  NEW ARP @ 2008.5161 
 LLH  59 28  4.19530  208 26 53.54937     17.3875  NEW MON @ 2008.5161 
 
 BASELINE NAME:   tsea  9999 
 XYZ         1.3526         0.4543        -1.9998  + XYZ ADJUSTMENTS 
 XYZ  -2856079.5959  -1547383.5318   5470611.8642  NEW L1 PHS CEN @ 2008.5161 
 XYZ  -2856079.5674  -1547383.5164   5470611.8094  NEW ARP @ 2008.5161 
 XYZ  -2856078.7634  -1547383.0808   5470610.2590  NEW MON @ 2008.5161 
 LLH  59 28  4.19513  208 26 53.54994     19.2331  NEW L1 PHS CEN @ 2008.5161 
 LLH  59 28  4.19513  208 26 53.54994     19.1694  NEW ARP @ 2008.5161 
 LLH  59 28  4.19513  208 26 53.54994     17.3694  NEW MON @ 2008.5161 
 
 



                                  G-FILES 
 
Axx2008 7 7   8 7 7 
B2008 7 71949   8 7 72321 1 page5 v0612.06IGS     222 1 2 27NGS   2008 
725IFDDFX 
Iant_info.003        NGS   20080718 
C00090001-1726421952   34 -499242126   18-1075334283   51 X1898A9999X1898AKOD5 
D  1  2  9140339  1  3 -7463733  2  3 -7562317 
 
Axx2008 7 7   8 7 7 
B2008 7 71949   8 7 72321 1 page5 v0612.06IGS     222 1 2 27NGS   2008 
725IFDDFX 
Iant_info.003        NGS   20080718 
C00090002 1077396498   38  458384987   21  671392496   57 X1898A9999X1898AKEN5 
D  1  2  9334424  1  3 -7597895  2  3 -7532433 
 
Axx2008 7 7   8 7 7 
B2008 7 71949   8 7 72321 1 page5 v0612.06IGS     222 1 2 27NGS   2008 
725IFDDFX 
Iant_info.003        NGS   20080718 
C00090003 1899235100   39   15545475   17  948599659   54 X1898A9999X1898ATSEA 
D  1  2  8316036  1  3 -8052712  2  3 -8652821 
 
                  POST-FIT RMS BY SATELLITE VS. BASELINE 
 
           OVERALL     02     03     04     06     07     08     10     13 
 kod5-9999|  0.017  0.016    ...  0.017    ...    ...  0.018  0.013  0.021 
               15     16     19     20     23     24     25     26     27 
 kod5-9999|    ...  0.019    ...    ...  0.021    ...  0.014  0.025  0.014 
 
           OVERALL     02     03     04     06     07     08     10     13 
 ken5-9999|  0.016  0.014    ...  0.018    ...    ...  0.018  0.014  0.019 
               15     16     19     20     23     24     25     26     27 
 ken5-9999|    ...  0.020    ...    ...  0.020    ...  0.016    ...  0.014 
               28     29 
 ken5-9999|    ...    ... 
 
           OVERALL     02     03     04     06     07     08     10     13 
 tsea-9999|  0.017  0.014    ...  0.015    ...    ...  0.018  0.014  0.021 
               15     16     19     20     21     23     24     25     26 
 tsea-9999|    ...  0.019    ...    ...    ...  0.021    ...  0.015  0.019 
               27     28     29 
 tsea-9999|  0.014    ...    ... 
 
 



                       OBS BY SATELLITE VS. BASELINE 
 
           OVERALL     02     03     04     06     07     08     10     13 
 kod5-9999|   2044    190    ...    111    ...    ...    260    290    263 
               15     16     19     20     23     24     25     26     27 
 kod5-9999|    ...     20    ...    ...    183    ...    298     52    377 
           OVERALL     02     03     04     06     07     08     10     13 
 ken5-9999|   2009    190    ...    111    ...    ...    264    290    257 
               15     16     19     20     23     24     25     26     27 
 ken5-9999|    ...     25    ...    ...    183    ...    315    ...    374 
               28     29 
 ken5-9999|    ...    ... 
           OVERALL     02     03     04     06     07     08     10     13 
 tsea-9999|   2071    190    ...    111    ...    ...    264    290    278 
               15     16     19     20     21     23     24     25     26 
 tsea-9999|    ...     25    ...    ...    ...    184    ...    299     50 
               27     28     29 
 tsea-9999|    380    ...    ... 
 
 
 Covariance Matrix for the xyz OPUS Position (meters^2). 
   0.0000091578     0.0000004124    -0.0000010302 
   0.0000004124     0.0000023422    -0.0000005312 
  -0.0000010302    -0.0000005312     0.0000194800 
 
 Covariance Matrix for the enu OPUS Position (meters^2). 
   0.0000035434     0.0000022488    -0.0000013629 
   0.0000022488     0.0000099429     0.0000045041 
  -0.0000013629     0.0000045041     0.0000174937 
 
 Horizontal network accuracy =    0.00667 meters. 
 Vertical network accuracy   =    0.00820 meters. 
 
 
 



                      Derivation of NAD 83 vector components 
 
 
 Position of reference station ARP in NAD_83(CORS96)(EPOCH:2003.0000). 
                 Xa(m)           Ya(m)           Za(m) 
      KOD5  -3028720.08248  -1597308.40205   5363076.37683    2003.00 
      KEN5  -2748338.18060  -1501545.56153   5537749.15284    2003.00 
      TSEA  -2666154.36828  -1545829.60462   5565469.86580    2003.00 
 
 Position of reference station monument in NAD_83(CORS96)(EPOCH:2003.0000). 
                 Xr(m)           Yr(m)           Zr(m) 
      KOD5  -3028720.08248  -1597308.40205   5363076.37683    2003.00 
      KEN5  -2748338.18060  -1501545.56153   5537749.15284    2003.00 
      TSEA  -2666154.36828  -1545829.60462   5565469.86580    2003.00 
 
 Velocity of reference station monument in NAD_83(CORS96)(EPOCH:2003.0000). 
                 Vx (m/yr)       Vy (m/yr)       Vz (m/yr) 
      KOD5         0.00680         0.01170         0.02080 
      KEN5        -0.00600        -0.01070         0.00620 
      TSEA         0.00380         0.00480         0.00460 
 
 Vectors from unknown station monument to reference station monument 
 in NAD_83(CORS96)(EPOCH:2003.0000). 
               Xr-X= DX(m)     Yr-Y= DY(m)     Zr-Z= DZ(m) 
      KOD5   -172642.21148    -49924.27605   -107533.55417    2003.00 
      KEN5    107739.69040     45838.56447     67139.22184    2003.00 
      TSEA    189923.50272      1554.52138     94859.93480    2003.00 
 
This position and the above vector components were computed without any 
knowledge by the National Geodetic Survey regarding the equipment or 
field operating procedures used. 



FILE: KLAB2321.08O 000474805 
 
                              NGS OPUS SOLUTION REPORT 
                              ======================== 
 
All computed coordinate accuracies are listed as peak-to-peak values. 
For additional information: www.ngs.noaa.gov/OPUS/Using_OPUS.html#accuracy 
 
      USER: weston.renoud@noaa.gov                  DATE: November 19, 2008 
RINEX FILE: klab232t.08o                            TIME: 22:59:33 UTC 
 
 
  SOFTWARE: page5  0810.20 master23.pl 081023      START: 2008/08/19  19:39:00 
 EPHEMERIS: igs14932.eph [precise]                  STOP: 2008/08/20  16:26:00 
  NAV FILE: brdc2320.08n                        OBS USED: 29751 / 38895   :  
76% 
  ANT NAME: THA800961+REC   NONE             # FIXED AMB:   272 /   368   :  
74% 
ARP HEIGHT: 2                                OVERALL RMS: 0.019(m) 
 
 
 REF FRAME: NAD_83(CORS96)(EPOCH:2002.0000)            ITRF00 (EPOCH:2008.6346) 
       
         X:     -2856077.860(m)   0.088(m)          -2856078.755(m)   0.088(m) 
         Y:     -1547384.156(m)   0.034(m)          -1547383.099(m)   0.034(m) 
         Z:      5470609.946(m)   0.048(m)           5470610.272(m)   0.048(m) 
 
       LAT:   59 28  4.19785      0.056(m)        59 28  4.19531      0.056(m) 
     E LON:  208 26 53.63730      0.045(m)       208 26 53.55121      0.045(m) 
     W LON:  151 33  6.36270      0.045(m)       151 33  6.44879      0.045(m) 
    EL HGT:           16.957(m)   0.084(m)                17.381(m)   0.084(m) 
 ORTHO HGT:            7.403(m)   0.146(m) [NAVD88 (Computed using GEOID06)] 
 
                        UTM COORDINATES    STATE PLANE COORDINATES 
                         UTM (Zone 05)         SPC (5004 AK 4) 
Northing (Y) [meters]     6593040.807           609834.432 
Easting (X)  [meters]      582068.621           412038.534 
Convergence  [degrees]     1.24749548          -1.33669046 
Point Scale                0.99968255           0.99999480 
Combined Factor            0.99967989           0.99999215 
 
US NATIONAL GRID DESIGNATOR:  5VNF8206993041(NAD 83) 
 
 
 
                              BASE STATIONS USED 
PID       DESIGNATION                        LATITUDE    LONGITUDE DISTANCE(m) 
DI9676 KOD5 KODIAK 5 CORS ARP              N573703.690 W1521136.263  209430.6 
DK4055 TBON ANCHORAGE AK DOT CORS ARP      N611046.980 W1494706.414  214235.2 
DJ3661 CHI5 CP HINCHINBROOK 5 CORS ARP     N601415.040 W1463847.551  287888.7 
 
                 NEAREST NGS PUBLISHED CONTROL POINT 
UW5593      GRASS ISLAND 1975 AZ MK        N592918.836 W1512918.639    4256.3 
 
 
                                                    
                                                    
 



                          BASE STATION INFORMATION  
                                                    
 STATION NAME: kod5  a    2 (Kodiak 5; Kodiak, Alaska  USA) 
  MONUMENT: NO DOMES NUMBER  
 XYZ  -3028720.7822  -1597307.4139   5363076.7078  MON @ 1997.0000 (M) 
 XYZ        -0.0145         0.0111         0.0097  VEL (M/YR) 
 NEU         0.0000         0.0000         0.0000  MON TO ARP (M) 
 NEU        -0.0034        -0.0019         0.0813  ARP TO L1 PHASE CENTER (M) 
 NEU        -0.0037        -0.0015         0.0689  ARP TO L2 PHASE CENTER (M) 
 XYZ        -0.1687         0.1291         0.1129  VEL TIMES 11.6341 YRS 
 XYZ         0.0000         0.0000         0.0000  MON TO ARP 
 XYZ        -0.0419        -0.0200         0.0668  ARP TO L1 PHASE CENTER 
 XYZ  -3028720.9928  -1597307.3047   5363076.8875  L1 PHS CEN @ 2008.6346 
 XYZ         0.0002         0.0000         0.0001  + XYZ ADJUSTMENTS 
 XYZ  -3028720.9927  -1597307.3047   5363076.8876  NEW L1 PHS CEN @ 2008.6346 
 XYZ  -3028720.9507  -1597307.2848   5363076.8208  NEW ARP @ 2008.6346 
 XYZ  -3028720.9507  -1597307.2848   5363076.8208  NEW MON @ 2008.6346 
 LLH  57 37  3.69086  207 48 23.65251     27.2933  NEW L1 PHS CEN @ 2008.6346 
 LLH  57 37  3.69097  207 48 23.65263     27.2120  NEW ARP @ 2008.6346 
 LLH  57 37  3.69097  207 48 23.65263     27.2120  NEW MON @ 2008.6346 
 
 STATION NAME: tbon  a    2 (Anchorage AK DOT; Anchorage, Alaska  USA) 
  MONUMENT: NO DOMES NUMBER  
 XYZ  -2663849.7606  -1551322.7408   5565105.5749  MON @ 1997.0000 (M) 
 XYZ        -0.0194        -0.0002        -0.0105  VEL (M/YR) 
 NEU         0.0000         0.0000         0.0000  MON TO ARP (M) 
 NEU         0.0025         0.0013         0.1065  ARP TO L1 PHASE CENTER (M) 
 NEU        -0.0007         0.0013         0.1254  ARP TO L2 PHASE CENTER (M) 
 XYZ        -0.2257        -0.0023        -0.1222  VEL TIMES 11.6341 YRS 
 XYZ         0.0000         0.0000         0.0000  MON TO ARP 
 XYZ        -0.0418        -0.0259         0.0945  ARP TO L1 PHASE CENTER 
 XYZ  -2663850.0281  -1551322.7690   5565105.5473  L1 PHS CEN @ 2008.6346 
 XYZ        -0.0000         0.0000        -0.0001  + XYZ ADJUSTMENTS 
 XYZ  -2663850.0282  -1551322.7689   5565105.5472  NEW L1 PHS CEN @ 2008.6346 
 XYZ  -2663849.9863  -1551322.7431   5565105.4527  NEW ARP @ 2008.6346 
 XYZ  -2663849.9863  -1551322.7431   5565105.4527  NEW MON @ 2008.6346 
 LLH  61 10 46.97824  210 12 53.49451     93.2325  NEW L1 PHS CEN @ 2008.6346 
 LLH  61 10 46.97816  210 12 53.49442     93.1260  NEW ARP @ 2008.6346 
 LLH  61 10 46.97816  210 12 53.49442     93.1260  NEW MON @ 2008.6346 
 
 STATION NAME: chi5  a    2 (CP Hinchinbrook 5; Cape Hinchinbrook, Alaska  USA) 
  MONUMENT: NO DOMES NUMBER  
 XYZ  -2651399.3405  -1745185.8197   5513742.9228  MON @ 1997.0000 (M) 
 XYZ        -0.0053         0.0225         0.0079  VEL (M/YR) 
 NEU         0.0000         0.0000         0.0000  MON TO ARP (M) 
 NEU        -0.0034        -0.0019         0.0813  ARP TO L1 PHASE CENTER (M) 
 NEU        -0.0037        -0.0015         0.0689  ARP TO L2 PHASE CENTER (M) 
 XYZ        -0.0617         0.2618         0.0919  VEL TIMES 11.6341 YRS 
 XYZ         0.0000         0.0000         0.0000  MON TO ARP 
 XYZ        -0.0372        -0.0222         0.0689  ARP TO L1 PHASE CENTER 
 XYZ  -2651399.4394  -1745185.5802   5513743.0836  L1 PHS CEN @ 2008.6346 
 XYZ         0.0001        -0.0001        -0.0001  + XYZ ADJUSTMENTS 
 XYZ  -2651399.4393  -1745185.5803   5513743.0835  NEW L1 PHS CEN @ 2008.6346 
 XYZ  -2651399.4021  -1745185.5580   5513743.0147  NEW ARP @ 2008.6346 
 XYZ  -2651399.4021  -1745185.5580   5513743.0147  NEW MON @ 2008.6346 
 LLH  60 14 15.04627  213 21 12.35592     94.8327  NEW L1 PHS CEN @ 2008.6346 
 LLH  60 14 15.04638  213 21 12.35605     94.7514  NEW ARP @ 2008.6346 
 LLH  60 14 15.04638  213 21 12.35605     94.7514  NEW MON @ 2008.6346 



 
                         REMOTE STATION INFORMATION 
                                                    
 STATION NAME: klab       1 
  MONUMENT: NO DOMES NUMBER  
 XYZ  -2856078.9790  -1547383.1462   5470612.3161  MON @ 2008.6334 (M) 
 NEU         0.0017         0.0031         2.0000  MON TO ARP (M) 
 NEU        -0.0017        -0.0031         0.3622  ARP TO L1 PHASE CENTER (M) 
 NEU        -0.0003        -0.0015         0.3594  ARP TO L2 PHASE CENTER (M) 
 XYZ        -0.8906        -0.4860         1.7236  MON TO ARP 
 XYZ        -0.1646        -0.0856         0.3111  ARP TO L1 PHASE CENTER 
 XYZ  -2856080.0341  -1547383.7179   5470614.3508  L1 PHS CEN @ 2008.6346 
 
 BASELINE NAME:   kod5  klab 
 XYZ         0.1920         0.0600        -2.0474  + XYZ ADJUSTMENTS 
 XYZ  -2856079.8421  -1547383.6579   5470612.3033  NEW L1 PHS CEN @ 2008.6346 
 XYZ  -2856079.6776  -1547383.5723   5470611.9922  NEW ARP @ 2008.6346 
 XYZ  -2856078.7870  -1547383.0862   5470610.2687  NEW MON @ 2008.6346 
 LLH  59 28  4.19464  208 26 53.54953     19.7519  NEW L1 PHS CEN @ 2008.6346 
 LLH  59 28  4.19470  208 26 53.54973     19.3897  NEW ARP @ 2008.6346 
 LLH  59 28  4.19464  208 26 53.54953     17.3897  NEW MON @ 2008.6346 
 
 BASELINE NAME:   tbon  klab 
 XYZ         0.2796         0.0561        -2.0657  + XYZ ADJUSTMENTS 
 XYZ  -2856079.7546  -1547383.6617   5470612.2851  NEW L1 PHS CEN @ 2008.6346 
 XYZ  -2856079.5900  -1547383.5761   5470611.9740  NEW ARP @ 2008.6346 
 XYZ  -2856078.6994  -1547383.0901   5470610.2504  NEW MON @ 2008.6346 
 LLH  59 28  4.19644  208 26 53.55239     19.6980  NEW L1 PHS CEN @ 2008.6346 
 LLH  59 28  4.19649  208 26 53.55259     19.3358  NEW ARP @ 2008.6346 
 LLH  59 28  4.19644  208 26 53.55239     17.3358  NEW MON @ 2008.6346 
 
 BASELINE NAME:   chi5  klab 
 XYZ         0.2002         0.0256        -2.0178  + XYZ ADJUSTMENTS 
 XYZ  -2856079.8340  -1547383.6923   5470612.3330  NEW L1 PHS CEN @ 2008.6346 
 XYZ  -2856079.6694  -1547383.6067   5470612.0219  NEW ARP @ 2008.6346 
 XYZ  -2856078.7788  -1547383.1206   5470610.2983  NEW MON @ 2008.6346 
 LLH  59 28  4.19487  208 26 53.55170     19.7821  NEW L1 PHS CEN @ 2008.6346 
 LLH  59 28  4.19493  208 26 53.55189     19.4199  NEW ARP @ 2008.6346 
 LLH  59 28  4.19487  208 26 53.55170     17.4199  NEW MON @ 2008.6346 
 
 



                                   G-FILES  
                                            
Axx2008 819   8 820 
B2008 8191938   8 8201626 1 page5 v0810.20IGS     222 1 2 27NGS   
20081119IFDDFX 
Iant_info.003        NGS   20081104 
C00090001-1726421637   35 -499241985   12-1075334479   49 X2328AKLABX2328AKOD5 
D  1  2  8824158  1  3  1127043  2  3   959933 
  
Axx2008 819   8 820 
B2008 8191938   8 8201626 1 page5 v0810.20IGS     222 1 2 27NGS   
20081119IFDDFX 
Iant_info.003        NGS   20081104 
C00090002 1922287131   33  -39396530   11  944952022   57 X2328AKLABX2328ATBON 
D  1  2  1460405  1  3   141929  2  3 -7917980 
  
Axx2008 819   8 820 
B2008 8191938   8 8201626 1 page5 v0810.20IGS     222 1 2 27NGS   
20081119IFDDFX 
Iant_info.003        NGS   20081104 
C00090003 2046793768   22-1978024374   26  431327163   39 X2328AKLABX2328ACHI5 
D  1  2 -3860857  1  3 -3616611  2  3 -6103363 
  
                   POST-FIT RMS BY SATELLITE VS. BASELINE 
                                                          
            OVERALL     02     03     04     05     06     07     08     09 
 kod5-klab|  0.017  0.022  0.025  0.019    ...  0.013  0.020  0.020  0.015 
                10     11     12     13     14     15     16     17     18 
 kod5-klab|  0.016    ...  0.029  0.015  0.020  0.017  0.015  0.018  0.020 
                19     20     21     22     23     24     25     26     27 
 kod5-klab|  0.013  0.013  0.018  0.017  0.018  0.014  0.013  0.015  0.017 
                28     29     30     31     32 
 kod5-klab|  0.017  0.019  0.016  0.023  0.018                             
 
            OVERALL     02     03     04     05     06     07     08     09 
 tbon-klab|  0.021  0.027  0.054  0.018    ...  0.015  0.022  0.019  0.018 
                10     11     12     13     14     15     16     17     18 
 tbon-klab|  0.020  0.024  0.024  0.018  0.021  0.018  0.016  0.023  0.020 
                19     20     21     22     23     24     25     26     27 
 tbon-klab|  0.029  0.018  0.018  0.022  0.020  0.015  0.022  0.016  0.018 
                28     29     30     31     32 
 tbon-klab|  0.022  0.031  0.018  0.022  0.025                             
 
            OVERALL     02     03     04     05     06     07     08     09 
 chi5-klab|  0.020  0.022  0.017  0.028  0.016  0.017  0.020  0.018  0.021 
                10     11     12     13     14     15     16     17     18 
 chi5-klab|  0.018  0.015  0.021  0.028  0.025  0.017  0.015  0.021  0.023 
                19     20     21     22     23     24     25     26     27 
 chi5-klab|  0.022  0.019  0.025  0.021  0.021  0.019  0.019  0.017  0.016 
                28     29     30     31     32 
 chi5-klab|  0.018  0.018  0.023  0.019  0.024                             
 
 



                        OBS BY SATELLITE VS. BASELINE 
                                                      
            OVERALL     02     03     04     05     06     07     08     09 
 kod5-klab|   9737    158     14    318    ...    507    208    100    621 
                10     11     12     13     14     15     16     17     18 
 kod5-klab|    207    ...     24    217    543    317    383    508    614 
                19     20     21     22     23     24     25     26     27 
 kod5-klab|    486    432    418    408    155    319     64    219    184 
                28     29     30     31     32 
 kod5-klab|    605     80    618    518    492                             
            OVERALL     02     03     04     05     06     07     08     09 
 tbon-klab|   9757    157     47    322    ...    534    209     46    615 
                10     11     12     13     14     15     16     17     18 
 tbon-klab|    223     77     78    288    558    144    374    508    573 
                19     20     21     22     23     24     25     26     27 
 tbon-klab|    405    460    423    450    204    311     63    217    177 
                28     29     30     31     32 
 tbon-klab|    494     80    618    498    604                             
            OVERALL     02     03     04     05     06     07     08     09 
 chi5-klab|  10257    164    527    258    326    576    255     81    295 
                10     11     12     13     14     15     16     17     18 
 chi5-klab|    251    533    517    184    544    218    455    467    625 
                19     20     21     22     23     24     25     26     27 
 chi5-klab|    181    418     27    426    362    380     47    243    162 
                28     29     30     31     32 
 chi5-klab|    445    467    235    400    188                             
                                            
 
 Covariance Matrix for the xyz OPUS Position (meters2). 
    0.0000062178     0.0000000451    -0.0000000201 
    0.0000000451     0.0000020911    -0.0000002353 
   -0.0000000201    -0.0000002353     0.0000159356 
 
 Covariance Matrix for the enu OPUS Position (meters2). 
    0.0000029898     0.0000015658    -0.0000007002 
    0.0000015658     0.0000079725     0.0000045985 
   -0.0000007002     0.0000045985     0.0000132821 
 
 Horizontal network accuracy =    0.00598 meters. 
 Vertical network accuracy   =    0.00715 meters. 
 
 
 



                       Derivation of NAD 83 vector components 
 
  
  Position of reference station ARP in NAD_83(CORS96)(EPOCH:2002.0000). 
                  Xa(m)           Ya(m)           Za(m) 
       KOD5  -3028720.08248  -1597308.40205   5363076.37683    2003.00 
       TBON  -2663849.09248  -1551323.79098   5565105.12546    2003.00 
       CHI5  -2651398.59721  -1745186.74080   5513742.60884    2003.00 
  
  Position of reference station monument in NAD_83(CORS96)(EPOCH:2002.0000). 
                  Xr(m)           Yr(m)           Zr(m) 
       KOD5  -3028720.08248  -1597308.40205   5363076.37683    2003.00 
       TBON  -2663849.09248  -1551323.79098   5565105.12546    2003.00 
       CHI5  -2651398.59721  -1745186.74080   5513742.60884    2003.00 
  
  Velocity of reference station monument in NAD_83(CORS96)(EPOCH:2002.0000). 
                  Vx (m/yr)       Vy (m/yr)       Vz (m/yr) 
       KOD5         0.00680         0.01170         0.02080 
       TBON         0.00260         0.00050        -0.00080 
       CHI5         0.01660         0.02320         0.01770 
  
  Vectors from unknown station monument to reference station monument 
  in NAD_83(CORS96)(EPOCH:2002.0000). 
                Xr-X= DX(m)     Yr-Y= DY(m)     Zr-Z= DZ(m) 
       KOD5   -172642.22248    -49924.24605   -107533.56917    2003.00 
       TBON    192228.76752     -3939.63498     94495.17946    2003.00 
       CHI5    204679.26279   -197802.58480     43132.66284    2003.00 
 
This position and the above vector components were computed without any  
knowledge by the National Geodetic Survey regarding the equipment or  
field operating procedures used. 
 



Kukkamaki April 1, 2008 (Dn 092) 
 
On April 1, 2008 (Dn092) ENS Morgan, ENS Andrews and ST Campbell performed a 
Kukkamaki on both Carl Zeiss NI2 (stadia: 333) levels (S/N 103267 and S/N 100056). 
 
The Kukkamaki course was set up on the pier at ISC Seattle in the early afternoon. The 
weather was sunny and cool with light wind. A 40 meter straight line was set up on level 
ground and divided into 10 meter intervals. The level was then set up on the 30 meter 
mark and a backsight and foresight were shot to the 20 and 40 meter marks 
respectively. Next, the level was set up at the 0 meter mark, and a backsight and 
foresight were shot to the 20 and 40 meter marks, respectively. (See fig. 1)  
 
The Carl Zeiss level S/N 103267 had a collimation error of -0.01, which is within the 
allowed +/- 0.05 tolerance required by the Field Procedures Manual, May 2008.  The 
Carl Zeiss level S/N 100056 was also within tolerance with the same collimation error of 
-0.01.  

 
Fig 1. Diagram of Kukkamaki setup. 
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Setup
THREAD 
READING MEAN THREAD 

INTERVAL
SUM OF 

INTERVALS
ROD 

TEMP
THREAD 
READING MEAN THREAD 

INTERVAL
SUM OF 

INTERVALS

1415 BS1 1415 FS1
1 1400 1400 1400 1400

1385 1385
4200 4200

1398 20mS 1428 40mS Δh1-         0.00
2 1368 1368 1368 1368 Δh2          0

1338 1308 Δh1-Δh2 = 0.00
4104 4104 - 0.2 (CR)    -0.20

÷20m        -0.01
C =     -0.01

"C" must be < + 0.05mm/m

Instrument SN:  100056
Rod SN: B

C = (Δh1 - Δ2) - 0.2mm
20 m

                      where    BS1 - FS1 = Δh1
                                  BS2 - FS2 = Δh2

100056 SHEET OFU.S. DEPARTMENT OF COMMERCE

NATIONAL OCEANIC AND 
ATMOSPHERIC 

ADMINISTRATION

BACKSIGHTS

FORWARD RUN (See reverse for BACKWARD RUN)

FORESIGHTS

HSRR

FROM B.M.

THREE-WIRE

PRECISE LEVELING

NOAA FORM 75-29

REMARKS

___3____ ORDER, CLASS ___1____

WEATHER Sunny, cool

TO B.M.

Kukkamaki 12:45 DATE: DN 092, 1 April 2008

Fill in YELLOW shaded cells.

Party Chief: Baird
Observer:  Campbell
Recorder: Morgan
Rod Person: Andrews
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Setup
THREAD 
READING MEAN THREAD 

INTERVAL
SUM OF 

INTERVALS
ROD 

TEMP
THREAD 
READING MEAN THREAD 

INTERVAL
SUM OF 

INTERVALS

1344 BS1 1344 FS1
1 1330 1329.33 1330 1329.33

1314 1314
3988 3988

1365 20mS 1395 40mS Δh1-         0.00
2 1335 1335 1335 1335 Δh2          0

1305 1275 Δh1-Δh2 = 0.00
4005 4005 - 0.2 (CR)    -0.20

÷20m        -0.01
C =     -0.01

Fill in YELLOW shaded cells.

Party Chief: Baird
Observer:  Andrews
Recorder: Campbell
Rod Person: Morgan

REMARKS

___3____ ORDER, CLASS ___1____

WEATHER Sunny, cool

TO B.M.

Kukkamaki 12:45 DATE: DN 092, 1 April 2008

BACKSIGHTS

FORWARD RUN (See reverse for BACKWARD RUN)

FORESIGHTS

HSRR

FROM B.M.

THREE-WIRE

PRECISE LEVELING

NOAA FORM 75-29 103267 SHEET OFU.S. DEPARTMENT OF COMMERCE

NATIONAL OCEANIC AND 
ATMOSPHERIC 

ADMINISTRATION

C = (Δh1 - Δ2) - 0.2mm
20 m

                      where    BS1 - FS1 = Δh1
                                  BS2 - FS2 = Δh2

"C" must be < + 0.05mm/m

Instrument SN:  103267
Rod SN: B



                                                                                                     
Vertical Control Equipment Test 

March 2008 
 
The 2008 test of the FAIRWEATHER’s vertical control equipment included testing five 8210 
Sutron “bubbler” Tide Gauges that were provided by the Center for Operational Oceanographic 
Products and Services (CO-OPS).  The gauges are equipped with Paros Scientific Sensors (SDI-
12) for measuring pressure.  Each year, the gauges are checked by the CO-OPS Field Operations 
Center to ensure their accuracy. 
 
CO-OPS does not provide calibration or quality assurance documentation to the 
FAIRWEATHER.  FAIRWEATHER personnel are responsible for installation and removal of 
the water level gauges.  CO-OPS is responsible for delivering final approved vertical correctors 
to the FAIRWEATHER for application to the hydrographic data set.  As FAIRWEATHER 
receives new gauges, data quality assurance checks will be conducted in a similar manner as the 
procedures listed below to ensure full functionality prior to deployment. 

Five tide gauges: #16 (33452648), #12 (3344B1D0), #08 (33445222), #17 (3351E1F2) and #4 
(334211E6) were set up and tested by ship personnel at Federal Center South in Seattle, WA 
from March 12th through March 28th.  Each gauge was tested for at least 48 hours to insure 
proper data collection.  The orifice was placed just off the pier by the gauge in approximately 12 
meters of water. The GPS antenna was facing open sky to the South (Figure 1). The set-up was 
periodically checked to insure proper transmission and to check for any leaks in the system. 
 
CO-OPS was able to verify that all the above gauges had strong transmissions to the GOES 
satellite, and were collecting accurate tide curves. Gauge #4 produced an unusual tidal curve 
when checked with the Tuffbook although CO-OPS verified this information as well. It would 
probably be wise to use the other 4 gauges before opting to use gauge #4. 
 

 
Figure 1: Tide gauge testing at Federal Center South: March 11-28, 2008 





NOAA Ship FAIRWEATHER
LASER LEVEL Accuracy test
3.8 sn# 000676
Laser Technology, Inc. Impulse 200 laser ranging instrument

Testing date: 02/27/2006

Trial
Actual 

Distance
LL 

Distance
Actual 
Height

LL 
Height

1 10 10.0 2.0 2.0
2 10 10.0 2.0 2.0
3 10 10.0 2.0 2.0
4 20 20.0 2.0 1.9
5 20 19.9 2.0 2.0
6 20 20.0 2.0 2.0
7 50 50.1 2.0 2.0
8 50 50.1 2.0 2.1
9 50 50.1 2.0 2.1
10 100 100.1 2.0 2.1
11 100 100.1 2.0 1.9
12 100 100.1 2.0 1.8

LL = Laser Level
all distances are measured in meters

Comparison Testing Lasers 000676 and i0929 and Trimble

Testing date: 03/03/2006

Trial Trimble 
Distance

000676 
Distance

i0929 
Distance

000676 
Height

i0929 
Height

Actual 
Height

1.0 30.0 32.8 33.0 2.1 2.4 2.0 2.8
2.0 23.5 27.3 27.8 2.0 1.9 2.0 3.8
3.0 20.2 24.0 24.2 2.2 2.0 2.0 3.8
4.0 34.0 31.9 32.4 2.6 2.3 2.0 2.1
5.0 26.8 26.2 25.8 2.1 2.0 2.0 0.6
7.0 30.6 28.5 28.5 2.0 2.4 2.0 2.1
6.0 51.9 38.7 38.5 2.0 2.3 2.0 13.2

sum 217.0 209.4 210.2 15.0 15.3 14.0 28.4 15.2

mean 31.0 29.9 30.0 2.1 2.2 2.0 4.1 2.5

standard deviation 10.3 5.0 4.9 0.2 0.2 0.0



Checked by: 

Lead Line Corrector
(c = b - a)

-0.004

-0.008
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-0.016
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-0.01285

0.016819631
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8 7.961
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9
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7 6.966

Lead Line / Sounding Pole Identification Number: Leadline 10_01_04
(Unique Identifier, with equipment type, date made, etc. )

4 3.984

5 4.98

Location: Ketchikan, Alaska

2.989

Field unit: FA

1 0.996

Measured by: Tyanne 
Faulkes & Weston Renoud

Recorded by: Weston 
Renoud

Graduated Marking
(a)

Chief of Party: CDR Baird

Lead Line / Sounding Pole Unit of Measure:  Meters

Method of Calibration:                   X� Steel tape          � Permanent graduation marks          �  
Other

Calibration Measurement
(b)

Lead Line & Sounding Pole Calibration Report

Average Correction

Standard Deviation

Date of Calibration: 6/11/2008

8.955

2 1.992

3



Correction Values Lead Line 10_01_04
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Checked by: 

Lead Line Corrector
(c = b - a)

-0.008

-0.012

-0.015

-0.021

-0.029

-0.038

-0.045
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-0.056

-0.066

-0.017

0.020044395
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6 5.962

9
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Lead Line / Sounding Pole Identification Number: Leadline 10_01_05
(Unique Identifier, with equipment type, date made, etc. )

4 3.979

5 4.971

Location: Ketchikan, Alaska

2.985

Field unit: FA

1 0.992

Measured by: Tyanne 
Faulkes & Weston Renoud

Recorded by: Weston 
Renoud

Graduated Marking
(a)

Chief of Party: CDR Baird

Lead Line / Sounding Pole Unit of Measure:  Meters

Method of Calibration:                   X� Steel tape          � Permanent graduation marks          �  
Other

Calibration Measurement
(b)

Lead Line & Sounding Pole Calibration Report

Average Correction

Standard Deviation

Date of Calibration: 6/11/2008

8.944

2 1.988

3



Correction Values Lead Line 10_01_05
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Checked by: 

Lead Line Corrector
(c = b - a)

0

-0.01

-0.018

-0.028

-0.038

-0.049

-0.06

-0.07

-0.081

-0.091

-0.02225

0.03089858

Lead Line & Sounding Pole Calibration Report

Average Correction

Standard Deviation

Date of Calibration: 6/11/2008

8.919

2 1.99

3

Field unit: FA

1 1

Measured by: Tyanne 
Faulkes & Weston Renoud

Recorded by: Tyanne 
Faulkes

Graduated Marking
(a)

Chief of Party: CDR Baird

Lead Line / Sounding Pole Unit of Measure:  Meters

Method of Calibration:                   X� Steel tape          � Permanent graduation marks          �  
Other

Calibration Measurement
(b)

Lead Line / Sounding Pole Identification Number: Leadline 10_02_05
(Unique Identifier, with equipment type, date made, etc. )

4 3.972

5 4.962

Location: Ketchikan, Alaska

2.982

9.909

8 7.93

6 5.951

9

10

7 6.94



Correction Values Lead Line 10_02_05
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Checked by: 

Lead Line Corrector
(c = b - a)

0.013

-0.006

-0.012

-0.015

-0.018

-0.014

-0.015

-0.015

-0.017

-0.016

-0.014

-0.015

-0.016

-0.017

8 7.985

6 5.986

4 3.985

5 4.982

Field unit: FA

1 1.013

Measured by: Tyanne 
Faulkes & Weston Renoud

Recorded by: Tyanne 
Faulkes

Graduated Marking
(a)

Chief of Party: CDR Baird

Lead Line / Sounding Pole Unit of Measure:  Meters

Method of Calibration:                   X� Steel tape          � Permanent graduation marks          �  
Other

Lead Line / Sounding Pole Identification Number: Leadline 20_01_05
(Unique Identifier, with equipment type, date made, etc. )

Date of Calibration: 6/11/2008

8.983

2 1.994

3 2.988

7 6.985

Calibration Measurement
(b)

Location: Ketchikan, Alaska

10.986

9

10

11

Lead Line & Sounding Pole Calibration Report

14

12 11.985

13.983

13 12.984

9.984



Lead Line Corrector
(c = b - a)

Graduated Marking
(a)

Calibration Measurement
(b)

-0.014

-0.01

-0.012

-0.004

-0.004

-0.002

-0.01115

0.007414602

15 14.986

16 15.99

17 16.988

18 17.996

19 18.996

20 19.998

Average Correction

Standard Deviation



Correction Values Lead Line 20_01_05

-0.02
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Checked by: 

Lead Line Corrector
(c = b - a)

-0.008

-0.009

-0.009

-0.009

0

0

-0.001

0

-0.002

-0.003

-0.005

-0.008

-0.01

-0.004

8 8

6 6

4 3.991

5 5

Field unit: FA

1 0.992

Measured by: Megan 
Bucher, Tyanne Faulkes, 
Brenna Campbell

Recorded by: Megan 
Bucher

Graduated Marking
(a)

Chief of Party: CDR Baird

Lead Line / Sounding Pole Unit of Measure:  Meters

Method of Calibration:                   X� Steel tape          � Permanent graduation marks          �  
Other

Lead Line / Sounding Pole Identification Number: Leadline 20_02_05
(Unique Identifier, with equipment type, date made, etc. )

Date of Calibration: 5/30/2008

8.998

2 1.991

3 2.991

7 6.999

Calibration Measurement
(b)

Location: Ketchikan, Alaska

10.995

9

10

11

Lead Line & Sounding Pole Calibration Report

14

12 11.992

13.996

13 12.99

9.997



Lead Line Corrector
(c = b - a)

Graduated Marking
(a)

Calibration Measurement
(b)

-0.005

-0.014

-0.015

-0.016

-0.018

-0.02

-0.0078

0.006220509

15 14.995

16 15.986

17 16.985

18 17.984

19 18.982

20 19.98

Average Correction

Standard Deviation



Correction Values Lead Line 20_02_05
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Checked by: BC

Lead Line Corrector
(c = b - a)

0.015

0.022

0.027

0.031

0.034

0.039

0.038

0.038

0.044

0.048

0.054

0.051

0.049

0.05

0.054

0.058

0.059

0.062

0.061

0.066

0.045

0.014

8 7.962

10.946

9

10

11

16 15.942

6 5.961

4 3.969

5 4.966

Field unit: FA

1 0.985

Measured by: BC/DJ Recorded by: BC

Graduated Marking
(a)

Chief of Party: Cdr. Andrew Beaver/NOAA Ship Fairweather

Lead Line / Sounding Pole Unit of Measure:  Meters

Method of Calibration:                   X� Steel tape          � Permanent graduation marks          �  
Other

Lead Line / Sounding Pole Identification Number: Leadline 20_03_05
(Unique Identifier, with equipment type, date made, etc. )

Date of Calibration: 3/26/2007

8.956

2 1.978

3 2.973

7 6.962

Calibration Measurement
(b)

Location: Ketchikan, Alaska

Lead Line & Sounding Pole Calibration Report

14

15 14.946

12 11.949

13.95

13 12.951

9.952

17 16.941

18 17.938

19 18.939

20 19.934

Average Correction

Standard Deviation



Correction Values Leadline 20_03_05

0

0.01

0.02
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0.07
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Checked by: BC

Lead Line Corrector
(c = b - a)

0.015

0.008

0.009

0.021

0.026

0.035

0.037

0.051

0.058

0.063

0.063

0.077

0.079

0.093

8 7.949

10.937

9

10

11

6 5.965

4 3.979

5 4.974

Field unit: FA

1 1.015

Measured by: BC/ACA Recorded by: BC

Graduated Marking
(a)

Chief of Party: CO Andrew Beaver/NOAA Ship Fairweather

Lead Line / Sounding Pole Unit of Measure:  Meters

Method of Calibration:                   X� Steel tape          � Permanent graduation marks          �  
Other

Lead Line / Sounding Pole Identification Number: Leadline 30_01_05
(Unique Identifier, with equipment type, date made, etc. )

Date of Calibration: 

8.942

2 1.992

3 2.991

7 6.963

Calibration Measurement
(b)

Location: Ketchikan, Alaska

Lead Line & Sounding Pole Calibration Report

14

12 11.923

13.907

13 12.921

9.937



Lead Line Corrector
(c = b - a)

Graduated Marking
(a)

Calibration Measurement
(b)

0.095

0.097

0.102

0.102

0.092

0.09

0.088

0.118

0.121

0.126

0.128

0.132

0.138

0.138

0.145

0.143

0.083

0.043

 

29 28.855

16 15.903

15 14.905

17 16.898

18 17.898

19 18.908

20 19.91

21 20.912

22 21.882

28 27.862

23 22.879

24 23.874

 Average Correction

25 24.872

30 29.857

26 25.868

27 26.862

  

 Standard Deviation



Correction Values Leadline 30_01_05
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MVP cfg - no_con_needed.txt
Subject: [Fwd: Re: AML SV+P .cfg file]
Date: Tue, 18 Apr 2006 15:49:46 +0000
From: "grant froelich" <grant.froelich@noaa.gov>
To: chiefst fairweather <chiefst.fairweather@noaa.gov>,
     foo fairweather <foo.fairweather@noaa.gov>,
     mike castle <mike.castle@noaa.gov>

--
-----------------------------------
Grant Froelich
Senior Survey Technician
NOAA Ship FAIRWEATHER
(907)254-2842 Cell
(808)659-0054 At Sea
----------------------------------

    ---------------------------------------------------------------------

Subject: RE: AML SV+P .cfg file
Date: Tue, 18 Apr 2006 09:45:18 -0300
From: Murray Eisan <meisan@brooke-ocean.com>
To: "'grant froelich'" <grant.froelich@noaa.gov>
CC: "'Darrell Groom'" <dgroom@brooke-ocean.com>

Hi Grant,

The calibration coefficients have been applied to the sensor at AML. The MVP
software logs the corrected data being outputted from the sensor. The AML
configuration file does not need to be applied to the MVP software.

Regards,

Murray Eisan

  ------------------------------------------------------------------------

From: grant froelich [mailto:grant.froelich@noaa.gov]
Sent: Monday, April 17, 2006 2:02 PM
To: support@brooke-ocean.com
Subject: AML SV+P .cfg file

Hello,

We recently sent our AML SV+P sensor out for calibration and when it
returned we also received a .cfg file.  Is this something that the MVP
software needs to correct the sound velocity files produced? If so, how is
that done?

thanks
grant

--
-----------------------------------

Page 1



SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 4585
CALIBRATION DATE: 12-Dec-07 

SBE19plus TEMPERATURE CALIBRATION DATA
ITS-90 TEMPERATURE SCALE

 
ITS-90 COEFFICIENTS

a0 =  1.155809e-003

a1 =  2.760002e-004

a2 = -1.131690e-006

a3 =  1.883899e-007

 

 BATH TEMP                          INSTRUMENT                         INST TEMP                              RESIDUAL

       (ITS-90)                             OUTPUT(n)                                    (ITS-90)                                  (ITS-90)

   1.0000            686687.361             1.0001              0.0001

   4.4999            614004.754             4.4998             -0.0001

  15.0000            430460.754            15.0001              0.0001

  18.5000            380363.738            18.5000             -0.0000

  23.9998            311750.672            23.9999              0.0001

  29.0000            259033.738            28.9997             -0.0003

  32.5001            226967.357            32.5002              0.0001

 

MV = (n -  524288) / 1.6e+007

R = (MV * 2.900e+009 + 1.024e+008) / (2.048e+004 - MV * 2.0e+005)

Temperature ITS-90 = 1/{a0 + a1[ln(R)] + a2[ln
2
(R)] + a3[ln

3
(R)]} - 273.15 (°C)

Residual = instrument temperature - bath temperature

Date, Delta T (mdeg C)

-0.02

-0.01

0.00

0.01

0.02

-5 0 5 10 15 20 25 30 35

R
e

s
id

u
a

l,
 (

D
e

g
re

e
s
 C

)

Temperature, Degrees C

28-Nov-06    0.82
12-Dec-07    0.00



SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 4585
CALIBRATION DATE: 12-Dec-07 

SBE19plus CONDUCTIVITY CALIBRATION DATA
PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

 
COEFFICIENTS:

g = -1.029961e+000

h =  1.489672e-001

i = -1.464344e-004

j =  3.212420e-005

CPcor = -9.5700e-008

CTcor =  3.2500e-006

 

 BATH TEMP       BATH SAL    BATH COND     INST FREQ       INST COND         RESIDUAL

       (ITS-90)             (PSU)           (Siemens/m)            (Hz)               (Siemens/m)         (Siemens/m)

  22.0000     0.0000    0.00000    2630.89     0.0000      0.00000

   1.0000    34.8802    2.98091    5187.07     2.9809      0.00001

   4.4999    34.8601    3.28844    5381.59     3.2884     -0.00001

  15.0000    34.8163    4.27161    5960.38     4.2716     -0.00001

  18.5000    34.8066    4.61722    6150.68     4.6172      0.00000

  23.9998    34.7949    5.17577    6446.10     5.1758      0.00002

  29.0000    34.7874    5.69812    6710.31     5.6981     -0.00000

  32.5001    34.7815    6.07062    6892.38     6.0706     -0.00001

 

f = INST FREQ / 1000.0

Conductivity = (g + hf
2
 + if

3
 + jf

4
) / (1 + δt + εp) Siemens/meter

t = temperature[°C)]; p = pressure[decibars]; δ = CTcor; ε = CPcor;

Residual = instrument conductivity - bath conductivity

Date, Slope Correction
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SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 4585
CALIBRATION DATE: 10-Dec-07 

SBE19plus PRESSURE CALIBRATION DATA
 5076 psia S/N 5433

 
COEFFICIENTS:

PA0 =    2.922174e-001

PA1 =    1.545394e-002

PA2 =   -6.665107e-010

PTEMPA0 = -6.655343e+001

PTEMPA1 =  5.244972e+001

PTEMPA2 = -5.868691e-001

PTCA0 =  5.087658e+005

PTCA1 = -1.236026e+000

PTCA2 =  1.032771e-001

PTCB0 =  2.398063e+001

PTCB1 = -2.075000e-003

PTCB2 =  0.000000e+000

 

  PRESSURE SPAN CALIBRATION                                                               THERMAL CORRECTION

  PRESSURE      INST   THERMISTOR  COMPUTED  ERROR                    TEMP  THERMISTOR      INST

         PSIA      OUTPUT    OUTPUT        PRESSURE      %FSR                      ITS90       OUTPUT       OUTPUT

   14.79 509710.3   1.7       14.69  -0.00         32.50     1.93   509766.17

 1026.63 575259.9   1.7     1026.43  -0.00         29.00     1.86   509744.49

 2038.77 641202.0   1.7     2038.44  -0.01         24.00     1.76   509724.13

 3050.69 707532.0   1.7     3050.55  -0.00         18.50     1.65   509708.34

 4062.52 774241.1   1.7     4062.52  -0.00         15.00     1.58   509701.13

 5074.51 841338.6   1.7     5074.38  -0.00          4.50     1.38   509692.64

 4062.62 774260.8   1.7     4062.82   0.00          1.00     1.31   509693.49

 3050.70 707557.8   1.7     3050.94   0.00

 2038.71 641225.7   1.7     2038.81   0.00         TEMP(ITS90)   SPAN(mV)

 1026.59 575280.9   1.7     1026.75   0.00            -5.00       23.99

   14.79 509728.3   1.7       14.96   0.00            35.00       23.91

 

y = thermistor output; t = PTEMPA0 + PTEMPA1 * y + PTEMPA2 * y
2

x = pressure output - PTCA0 - PTCA1 * t - PTCA2 * t
2

n = x * PTCB0 / (PTCB0 + PTCB1 * t + PTCB2 * t
2
)

pressure (psia) = PA0 + PA1 * n + PA2 * n
2

Date, Avg Delta P %FS
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SEA-BIRD ELECTRONICS, INC.
1808 - 136th Place Northeast, Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Conductivity Calibration Report

Conductivity sensors are normally calibrated 'as received', without cleaning or adjustments, allowing a determination of 

sensor drift.  If the calibration identifies a  problem or indicates cell cleaning is necessary, then a second calibration is 

performed after work is completed.  The 'as received' calibration is not performed if the sensor is damaged or non-

functional, or by customer request.

Customer: Pacific Marine Center / NOAA

Job Number: 48749

Model Number SBE 19Plus

Date of Report: 12/12/2007

Serial Number: 19P36026-4585

An 'as received' calibration certificate is provided, listing the coefficients used to convert sensor frequency to 

conductivity. Users must choose whether the 'as received'  calibration or the previous calibration better  represents the 

sensor condition during  deployment.  In SEASOFT enter the chosen coefficients using the program SEACON.  The 

coefficient 'slope' allows small corrections for drift between calibrations (consult the SEASOFT manual).  Calibration 

coefficients obtained after a repair or cleaning apply only to subsequent data.

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 12/12/2007 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: 0.0000 PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER CLEANING & REPLATINIZING' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

Cell cleaning and electrode replatinizing tend to 'reset' the conductivity sensor to its original condition.  Lack of drift in 

post-cleaning-calibration indicates geometric stability of the cell and electrical stability of the sensor circuit.

*Measured at 3.0 S/m

Last cal:Last cal:Last cal:Last cal:



Customer: Pacific Marine Center / NOAA

Job Number: 48749

Model Number SBE 19Plus

Date of Report: 12/12/2007

Serial Number: 19P36026-4585

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 12/12/2007 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: -0.00079 Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER REPAIR' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

Last cal:Last cal:Last cal:Last cal:

Temperature sensors are normally calibrated 'as received', without adjustments, allowing a determination sensor drift.  If 

the calibration identifies a problem, then a second calibration is performed after work is completed.  The 'as received' 

calibration is not performed if the sensor is damaged or non-functional, or by customer request.

An 'as received' calibration certificate is provided, listing coefficients to convert sensor frequency to temperature.  Users 

must choose whether the 'as received' calibration or the  previous calibration better represents the sensor condition 

during deployment.  In SEASOFT enter the  chosen coefficients using the program  SEACON.  The coefficient 'offset' 

allows a small correction for drift between calibrations (consult the SEASOFT manual).  Calibration coefficients 

obtained after a repair apply only to subsequent data.

SEA-BIRD ELECTRONICS, INC.
1808 - 136th Place Northeast, Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Temperature Calibration Report



SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 4616
CALIBRATION DATE: 13-Dec-07 

SBE19plus TEMPERATURE CALIBRATION DATA
ITS-90 TEMPERATURE SCALE

 
ITS-90 COEFFICIENTS

a0 =  1.245436e-003

a1 =  2.665741e-004

a2 = -5.451407e-007

a3 =  1.711935e-007

 

 BATH TEMP                          INSTRUMENT                         INST TEMP                              RESIDUAL

       (ITS-90)                             OUTPUT(n)                                    (ITS-90)                                  (ITS-90)

   1.0000            622352.492             0.9999             -0.0001

   4.4999            552562.262             4.5001              0.0002

  15.0000            379380.892            14.9998             -0.0002

  18.5000            332889.692            18.4999             -0.0001

  23.9999            269790.831            24.0000              0.0001

  29.0000            221777.615            29.0002              0.0002

  32.4938            192838.308            32.4937             -0.0001

 

MV = (n -  524288) / 1.6e+007

R = (MV * 2.900e+009 + 1.024e+008) / (2.048e+004 - MV * 2.0e+005)

Temperature ITS-90 = 1/{a0 + a1[ln(R)] + a2[ln
2
(R)] + a3[ln

3
(R)]} - 273.15 (°C)

Residual = instrument temperature - bath temperature

Date, Delta T (mdeg C)
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SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 4616
CALIBRATION DATE: 13-Dec-07 

SBE19plus CONDUCTIVITY CALIBRATION DATA
PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

 
COEFFICIENTS:

g = -1.045279e+000

h =  1.452251e-001

i = -2.415830e-004

j =  3.756860e-005

CPcor = -9.5700e-008

CTcor =  3.2500e-006

 

 BATH TEMP       BATH SAL    BATH COND     INST FREQ       INST COND         RESIDUAL

       (ITS-90)             (PSU)           (Siemens/m)            (Hz)               (Siemens/m)         (Siemens/m)

  22.0000     0.0000    0.00000    2686.34     0.0000      0.00000

   1.0000    34.9774    2.98842    5274.42     2.9884      0.00001

   4.4999    34.9578    3.29675    5471.69     3.2967     -0.00001

  15.0000    34.9141    4.28234    6058.72     4.2823     -0.00000

  18.5000    34.9046    4.62882    6251.74     4.6288      0.00000

  23.9999    34.8936    5.18884    6551.44     5.1889      0.00001

  29.0000    34.8864    5.71250    6819.45     5.7125     -0.00000

  32.4938    34.8808    6.08529    7003.83     6.0853     -0.00000

 

f = INST FREQ / 1000.0

Conductivity = (g + hf
2
 + if

3
 + jf

4
) / (1 + δt + εp) Siemens/meter

t = temperature[°C)]; p = pressure[decibars]; δ = CTcor; ε = CPcor;

Residual = instrument conductivity - bath conductivity

Date, Slope Correction
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SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 4616
CALIBRATION DATE: 10-Dec-07 

SBE19plus PRESSURE CALIBRATION DATA
 1450 psia S/N 5512

 
COEFFICIENTS:

PA0 =    8.124251e-001

PA1 =    4.422250e-003

PA2 =    1.768021e-012

PTEMPA0 = -7.642684e+001

PTEMPA1 =  4.928816e+001

PTEMPA2 = -2.749656e-001

PTCA0 =  5.204224e+005

PTCA1 =  1.484391e+001

PTCA2 = -2.799470e-001

PTCB0 =  2.473825e+001

PTCB1 =  5.000000e-005

PTCB2 =  0.000000e+000

 

  PRESSURE SPAN CALIBRATION                                                               THERMAL CORRECTION

  PRESSURE      INST   THERMISTOR  COMPUTED  ERROR                    TEMP  THERMISTOR      INST

         PSIA      OUTPUT    OUTPUT        PRESSURE      %FSR                      ITS90       OUTPUT       OUTPUT

   14.78 523770.2   2.0       14.80   0.00         32.49     2.24   523877.65

  301.38 588585.5   2.0      301.43   0.00         29.00     2.17   523876.71

  588.09 653389.3   2.0      588.02  -0.00         24.00     2.06   523874.45

  874.82 718238.8   2.0      874.82   0.00         18.50     1.95   523860.32

 1161.77 783121.3   2.0     1161.79   0.00         15.00     1.88   523848.83

 1448.57 847925.4   2.0     1448.42  -0.01          4.50     1.66   523759.51

 1161.59 783131.6   2.0     1161.83   0.02          1.00     1.59   523689.02

  874.88 718257.8   2.0      874.90   0.00

  588.18 653396.8   2.0      588.05  -0.01         TEMP(ITS90)   SPAN(mV)

  301.35 588564.1   2.0      301.33  -0.00            -5.00       24.74

   14.79 523775.1   2.0       14.82   0.00            35.00       24.74

 

y = thermistor output; t = PTEMPA0 + PTEMPA1 * y + PTEMPA2 * y
2

x = pressure output - PTCA0 - PTCA1 * t - PTCA2 * t
2

n = x * PTCB0 / (PTCB0 + PTCB1 * t + PTCB2 * t
2
)

pressure (psia) = PA0 + PA1 * n + PA2 * n
2

Date, Avg Delta P %FS
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Customer: Pacific Marine Center / NOAA

Job Number: 48749

Model Number SBE 19Plus

Date of Report: 12/13/2007

Serial Number: 19P36026-4616

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 12/13/2007 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: +0.00001 Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER REPAIR' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

Last cal:Last cal:Last cal:Last cal:

Temperature sensors are normally calibrated 'as received', without adjustments, allowing a determination sensor drift.  If 

the calibration identifies a problem, then a second calibration is performed after work is completed.  The 'as received' 

calibration is not performed if the sensor is damaged or non-functional, or by customer request.

An 'as received' calibration certificate is provided, listing coefficients to convert sensor frequency to temperature.  Users 

must choose whether the 'as received' calibration or the  previous calibration better represents the sensor condition 

during deployment.  In SEASOFT enter the  chosen coefficients using the program  SEACON.  The coefficient 'offset' 

allows a small correction for drift between calibrations (consult the SEASOFT manual).  Calibration coefficients 

obtained after a repair apply only to subsequent data.

SEA-BIRD ELECTRONICS, INC.
1808 - 136th Place Northeast, Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Temperature Calibration Report



SEA-BIRD ELECTRONICS, INC.
1808 - 136th Place Northeast, Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Conductivity Calibration Report

Conductivity sensors are normally calibrated 'as received', without cleaning or adjustments, allowing a determination of 

sensor drift.  If the calibration identifies a  problem or indicates cell cleaning is necessary, then a second calibration is 

performed after work is completed.  The 'as received' calibration is not performed if the sensor is damaged or non-

functional, or by customer request.

Customer: Pacific Marine Center / NOAA

Job Number: 48749

Model Number SBE 19Plus

Date of Report: 12/13/2007

Serial Number: 19P36026-4616

An 'as received' calibration certificate is provided, listing the coefficients used to convert sensor frequency to 

conductivity. Users must choose whether the 'as received'  calibration or the previous calibration better  represents the 

sensor condition during  deployment.  In SEASOFT enter the chosen coefficients using the program SEACON.  The 

coefficient 'slope' allows small corrections for drift between calibrations (consult the SEASOFT manual).  Calibration 

coefficients obtained after a repair or cleaning apply only to subsequent data.

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 12/13/2007 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: -0.00010 PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER CLEANING & REPLATINIZING' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

Cell cleaning and electrode replatinizing tend to 'reset' the conductivity sensor to its original condition.  Lack of drift in 

post-cleaning-calibration indicates geometric stability of the cell and electrical stability of the sensor circuit.

*Measured at 3.0 S/m

Last cal:Last cal:Last cal:Last cal:



SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 4617
CALIBRATION DATE: 13-Dec-07 

SBE19plus TEMPERATURE CALIBRATION DATA
ITS-90 TEMPERATURE SCALE

 
ITS-90 COEFFICIENTS

a0 =  1.249803e-003

a1 =  2.684771e-004

a2 = -5.378021e-007

a3 =  1.749472e-007

 

 BATH TEMP                          INSTRUMENT                         INST TEMP                              RESIDUAL

       (ITS-90)                             OUTPUT(n)                                    (ITS-90)                                  (ITS-90)

   1.0000            585637.556             0.9999             -0.0001

   4.4999            518796.730             4.5001              0.0002

  15.0000            354148.365            14.9999             -0.0001

  18.5000            310217.905            18.4999             -0.0001

  23.9999            250753.413            24.0000              0.0001

  29.0000            205617.349            29.0002              0.0002

  32.4938            178453.619            32.4936             -0.0002

 

MV = (n -  524288) / 1.6e+007

R = (MV * 2.900e+009 + 1.024e+008) / (2.048e+004 - MV * 2.0e+005)

Temperature ITS-90 = 1/{a0 + a1[ln(R)] + a2[ln
2
(R)] + a3[ln

3
(R)]} - 273.15 (°C)

Residual = instrument temperature - bath temperature

Date, Delta T (mdeg C)
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SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 4617
CALIBRATION DATE: 13-Dec-07 

SBE19plus CONDUCTIVITY CALIBRATION DATA
PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

 
COEFFICIENTS:

g = -9.990138e-001

h =  1.277431e-001

i = -2.519900e-004

j =  3.310361e-005

CPcor = -9.5700e-008

CTcor =  3.2500e-006

 

 BATH TEMP       BATH SAL    BATH COND     INST FREQ       INST COND         RESIDUAL

       (ITS-90)             (PSU)           (Siemens/m)            (Hz)               (Siemens/m)         (Siemens/m)

  22.0000     0.0000    0.00000    2801.41     0.0000      0.00000

   1.0000    34.9774    2.98842    5595.19     2.9884      0.00001

   4.4999    34.9578    3.29675    5806.90     3.2967     -0.00001

  15.0000    34.9141    4.28234    6436.33     4.2823     -0.00000

  18.5000    34.9046    4.62882    6643.17     4.6288      0.00000

  23.9999    34.8936    5.18884    6964.18     5.1888      0.00000

  29.0000    34.8864    5.71250    7251.14     5.7125      0.00000

  32.4938    34.8808    6.08529    7448.49     6.0853     -0.00000

 

f = INST FREQ / 1000.0

Conductivity = (g + hf
2
 + if

3
 + jf

4
) / (1 + δt + εp) Siemens/meter

t = temperature[°C)]; p = pressure[decibars]; δ = CTcor; ε = CPcor;

Residual = instrument conductivity - bath conductivity

Date, Slope Correction
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SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 4617
CALIBRATION DATE: 10-Dec-07 

SBE19plus PRESSURE CALIBRATION DATA
 1450 psia S/N 5513

 
COEFFICIENTS:

PA0 =   -5.664293e-001

PA1 =    4.439833e-003

PA2 =   -1.670012e-012

PTEMPA0 = -7.900853e+001

PTEMPA1 =  4.920630e+001

PTEMPA2 = -4.145551e-001

PTCA0 =  5.192344e+005

PTCA1 = -1.164606e+001

PTCA2 =  2.696057e-001

PTCB0 =  2.460838e+001

PTCB1 =  6.750000e-004

PTCB2 =  0.000000e+000

 

  PRESSURE SPAN CALIBRATION                                                               THERMAL CORRECTION

  PRESSURE      INST   THERMISTOR  COMPUTED  ERROR                    TEMP  THERMISTOR      INST

         PSIA      OUTPUT    OUTPUT        PRESSURE      %FSR                      ITS90       OUTPUT       OUTPUT

   14.78 522575.4   2.0       14.81   0.00         32.49     2.31   522683.38

  301.38 587178.0   2.0      301.47   0.01         29.00     2.24   522684.22

  588.09 651759.9   2.0      588.03  -0.00         24.00     2.13   522672.38

  874.82 716399.3   2.0      874.82   0.00         18.50     2.02   522665.05

 1161.77 781070.7   2.0     1161.75  -0.00         15.00     1.94   522665.13

 1448.57 845699.8   2.0     1448.46  -0.01          4.50     1.72   522730.73

 1161.59 781079.1   2.0     1161.78   0.01          1.00     1.65   522784.76

  874.88 716427.5   2.0      874.95   0.00

  588.18 651770.8   2.0      588.07  -0.01         TEMP(ITS90)   SPAN(mV)

  301.35 587126.9   2.0      301.25  -0.01            -5.00       24.61

   14.79 522574.3   2.1       14.81   0.00            35.00       24.63

 

y = thermistor output; t = PTEMPA0 + PTEMPA1 * y + PTEMPA2 * y
2

x = pressure output - PTCA0 - PTCA1 * t - PTCA2 * t
2

n = x * PTCB0 / (PTCB0 + PTCB1 * t + PTCB2 * t
2
)

pressure (psia) = PA0 + PA1 * n + PA2 * n
2

Date, Avg Delta P %FS

-0.50

-0.25

0.00

0.25

0.50

0 250 500 750 1000 1250 1500

R
e

s
id

u
a

l,
 (

%
 F

S
R

)

Pressure (PSIA)

10-Dec-07    -0.00



Customer: Pacific Marine Center / NOAA

Job Number: 48749

Model Number SBE 19Plus

Date of Report: 12/13/2007

Serial Number: 19P36026-4617

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 12/13/2007 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: -0.00085 Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER REPAIR' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

Last cal:Last cal:Last cal:Last cal:

Temperature sensors are normally calibrated 'as received', without adjustments, allowing a determination sensor drift.  If 

the calibration identifies a problem, then a second calibration is performed after work is completed.  The 'as received' 

calibration is not performed if the sensor is damaged or non-functional, or by customer request.

An 'as received' calibration certificate is provided, listing coefficients to convert sensor frequency to temperature.  Users 

must choose whether the 'as received' calibration or the  previous calibration better represents the sensor condition 

during deployment.  In SEASOFT enter the  chosen coefficients using the program  SEACON.  The coefficient 'offset' 

allows a small correction for drift between calibrations (consult the SEASOFT manual).  Calibration coefficients 

obtained after a repair apply only to subsequent data.

SEA-BIRD ELECTRONICS, INC.
1808 - 136th Place Northeast, Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Temperature Calibration Report



SEA-BIRD ELECTRONICS, INC.
1808 - 136th Place Northeast, Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Conductivity Calibration Report

Conductivity sensors are normally calibrated 'as received', without cleaning or adjustments, allowing a determination of 

sensor drift.  If the calibration identifies a  problem or indicates cell cleaning is necessary, then a second calibration is 

performed after work is completed.  The 'as received' calibration is not performed if the sensor is damaged or non-

functional, or by customer request.

Customer: Pacific Marine Center / NOAA

Job Number: 48749

Model Number SBE 19Plus

Date of Report: 12/13/2007

Serial Number: 19P36026-4617

An 'as received' calibration certificate is provided, listing the coefficients used to convert sensor frequency to 

conductivity. Users must choose whether the 'as received'  calibration or the previous calibration better  represents the 

sensor condition during  deployment.  In SEASOFT enter the chosen coefficients using the program SEACON.  The 

coefficient 'slope' allows small corrections for drift between calibrations (consult the SEASOFT manual).  Calibration 

coefficients obtained after a repair or cleaning apply only to subsequent data.

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 12/13/2007 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: -0.00020 PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER CLEANING & REPLATINIZING' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

Cell cleaning and electrode replatinizing tend to 'reset' the conductivity sensor to its original condition.  Lack of drift in 

post-cleaning-calibration indicates geometric stability of the cell and electrical stability of the sensor circuit.

*Measured at 3.0 S/m

Last cal:Last cal:Last cal:Last cal:



SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 0117
CALIBRATION DATE: 08-Jan-08 

SBE 45 CONDUCTIVITY CALIBRATION DATA
PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

 
COEFFICIENTS:

g = -1.031942e+000

h =  1.269033e-001

i = -2.218276e-004

j =  3.318496e-005

CPcor = -9.5700e-008

CTcor =  3.2500e-006

WBOTC = -3.1803e-006

 

 BATH TEMP       BATH SAL    BATH COND     INST FREQ       INST COND         RESIDUAL

       (ITS-90)             (PSU)           (Siemens/m)            (Hz)               (Siemens/m)         (Siemens/m)

  22.0000     0.0000    0.00000    2855.80    0.00000      0.00000

   1.0000    34.7807    2.97321    5622.31    2.97324      0.00003

   4.4999    34.7610    3.28001    5832.94    3.27999     -0.00003

  14.9999    34.7176    4.26078    6459.57    4.26076     -0.00001

  18.5000    34.7080    4.60555    6665.57    4.60555     -0.00000

  24.0000    34.6969    5.16282    6985.35    5.16285      0.00002

  29.0000    34.6902    5.68399    7271.30    5.68399      0.00001

  32.4999    34.6851    6.05568    7468.33    6.05567     -0.00001

 

f = INST FREQ * sqrt(1.0 + WBOTC * t) / 1000.0

Conductivity = (g + hf
2
 + if

3
 + jf

4
) / (1 + δt + εp) Siemens/meter

t = temperature[°C)]; p = pressure[decibars]; δ = CTcor; ε = CPcor;

Residual = instrument conductivity - bath conductivity

Date, Slope Correction
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SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 0117
CALIBRATION DATE: 11-Dec-07 

SBE 45 CONDUCTIVITY CALIBRATION DATA
PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

 
COEFFICIENTS:

g = -1.029836e+000

h =  1.264890e-001

i = -1.244736e-004

j =  2.698268e-005

CPcor = -9.5700e-008

CTcor =  3.2500e-006

WBOTC = -3.1803e-006

 

 BATH TEMP       BATH SAL    BATH COND     INST FREQ       INST COND         RESIDUAL

       (ITS-90)             (PSU)           (Siemens/m)            (Hz)               (Siemens/m)         (Siemens/m)

  22.0000     0.0000    0.00000    2854.99    0.00000      0.00000

   1.0000    35.7009    3.04425    5671.69    3.04426      0.00001

   4.5000    35.6792    3.35798    5885.14    3.35797     -0.00001

  15.0000    35.6327    4.36100    6519.96    4.36099     -0.00001

  18.5000    35.6226    4.71361    6728.60    4.71359     -0.00002

  23.9999    35.6111    5.28357    7052.48    5.28361      0.00003

  29.0000    35.6023    5.81635    7341.91    5.81634     -0.00001

  32.5001    35.5947    6.19615    7541.26    6.19615     -0.00000

 

f = INST FREQ * sqrt(1.0 + WBOTC * t) / 1000.0

Conductivity = (g + hf
2
 + if

3
 + jf

4
) / (1 + δt + εp) Siemens/meter

t = temperature[°C)]; p = pressure[decibars]; δ = CTcor; ε = CPcor;

Residual = instrument conductivity - bath conductivity

Date, Slope Correction
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SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 0117
CALIBRATION DATE: 08-Jan-08 

SBE 45 TEMPERATURE CALIBRATION DATA
ITS-90 TEMPERATURE SCALE

 
ITS-90 COEFFICIENTS

a0 = -2.444687e-004

a1 =  3.101067e-004

a2 = -4.608202e-006

a3 =  2.066460e-007

 

 BATH TEMP                          INSTRUMENT                         INST TEMP                              RESIDUAL

       (ITS-90)                                OUTPUT                                    (ITS-90)                                  (ITS-90)

   1.0000             825687.0             1.0001              0.0001

   4.4999             708009.0             4.4998             -0.0001

  14.9999             455003.1            15.0000              0.0001

  18.5000             395051.1            18.5000              0.0000

  24.0000             318250.6            23.9999             -0.0001

  29.0000             263033.5            29.0000             -0.0000

  32.4999             230938.9            32.4999              0.0000

 

Temperature ITS-90 = 1/{a0 + a1[ln(n)] + a2[ln
2
(n)] + a3[ln

3
(n)]} - 273.15 (°C)

Residual = instrument temperature - bath temperature

Date, Delta T (mdeg C)
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SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

 
SENSOR SERIAL NUMBER: 0117
CALIBRATION DATE: 11-Dec-07 

SBE 45 TEMPERATURE CALIBRATION DATA
ITS-90 TEMPERATURE SCALE

 
ITS-90 COEFFICIENTS

a0 = -1.865866e-004

a1 =  2.970047e-004

a2 = -3.621420e-006

a3 =  1.819198e-007

 

 BATH TEMP                          INSTRUMENT                         INST TEMP                              RESIDUAL

       (ITS-90)                                OUTPUT                                    (ITS-90)                                  (ITS-90)

   1.0000             825650.8             1.0001              0.0001

   4.5000             707981.6             4.4999             -0.0001

  15.0000             455000.0            15.0002              0.0002

  18.5000             395058.3            18.4998             -0.0002

  23.9999             318252.4            24.0001              0.0002

  29.0000             263036.0            28.9998             -0.0002

  32.5001             230933.8            32.5002              0.0001

 

Temperature ITS-90 = 1/{a0 + a1[ln(n)] + a2[ln
2
(n)] + a3[ln

3
(n)]} - 273.15 (°C)

Residual = instrument temperature - bath temperature

Date, Delta T (mdeg C)
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SEA-BIRD ELECTRONICS, INC.
1808 - 136th Place Northeast, Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Conductivity Calibration Report

Conductivity sensors are normally calibrated 'as received', without cleaning or adjustments, allowing a determination of 

sensor drift.  If the calibration identifies a  problem or indicates cell cleaning is necessary, then a second calibration is 

performed after work is completed.  The 'as received' calibration is not performed if the sensor is damaged or non-

functional, or by customer request.

Customer: Pacific Marine Center / NOAA

Job Number: 48749

Model Number SBE 45

Date of Report: 1/8/2008

Serial Number: 4536628-0117

An 'as received' calibration certificate is provided, listing the coefficients used to convert sensor frequency to 

conductivity. Users must choose whether the 'as received'  calibration or the previous calibration better  represents the 

sensor condition during  deployment.  In SEASOFT enter the chosen coefficients using the program SEACON.  The 

coefficient 'slope' allows small corrections for drift between calibrations (consult the SEASOFT manual).  Calibration 

coefficients obtained after a repair or cleaning apply only to subsequent data.

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 12/11/2007 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: +0.00150 PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER REPAIR' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 1/8/2008 Drift sinceDrift sinceDrift sinceDrift since N/A PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

Cell cleaning and electrode replatinizing tend to 'reset' the conductivity sensor to its original condition.  Lack of drift in 

post-cleaning-calibration indicates geometric stability of the cell and electrical stability of the sensor circuit.

*Measured at 3.0 S/m

Last cal:Last cal:Last cal:Last cal:



Customer: Pacific Marine Center / NOAA

Job Number: 48749

Model Number SBE 45

Date of Report: 1/8/2008

Serial Number: 4536628-0117

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 12/11/2007 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: +0.03490 Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER REPAIR' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 1/8/2008 Drift sinceDrift sinceDrift sinceDrift since N/A Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

Last cal:Last cal:Last cal:Last cal:

Temperature sensors are normally calibrated 'as received', without adjustments, allowing a determination sensor drift.  If 

the calibration identifies a problem, then a second calibration is performed after work is completed.  The 'as received' 

calibration is not performed if the sensor is damaged or non-functional, or by customer request.

An 'as received' calibration certificate is provided, listing coefficients to convert sensor frequency to temperature.  Users 

must choose whether the 'as received' calibration or the  previous calibration better represents the sensor condition 

during deployment.  In SEASOFT enter the  chosen coefficients using the program  SEACON.  The coefficient 'offset' 

allows a small correction for drift between calibrations (consult the SEASOFT manual).  Calibration coefficients 

obtained after a repair apply only to subsequent data.

SEA-BIRD ELECTRONICS, INC.
1808 - 136th Place Northeast, Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Temperature Calibration Report







Appendix VI 
 
 
Correspondence 
 
 

• System Check Correspondence 
• Data Representation 
• CUBE Results 

 



Subject: [Fwd: [Fwd: DGPS: P-checks & Nav DQA]] 
Date: Mon, 12 Sep 2005 18:22:20 -0800 
From: "foo fairweather" <foo.fairweather@noaa.gov> 
To: chiefst.fairweather@noaa.gov 
 
    --------------------------------------------------------------------- 
 
Subject: [Fwd: DGPS: P-checks & Nav DQA] 
Resent-Date: Mon, 12 Sep 2005 20:17:27 GMT 
Resent-From: FOO.Fairweather@noaa.gov 
Date: Mon, 12 Sep 2005 20:29:01 +0100 
From: "FOO Rainier" <foo.rainier@noaa.gov> 
To: _NMAO MOP FOO Fairweather <FOO.Fairweather@noaa.gov>, 
     abigail higgins <abigail.higgins@noaa.gov> 
 
Abigail, 
 
I assume you're checking FOO-FA now, so sorry if you get this twice. 
Anyway, here's the email from Gerd from the spring about P-checks.  Looks 
like it was a question from Lynn which prompted it in the first place. 
 
Ben 
 
-------- Original Message -------- 
     Subject: DGPS: P-checks & Nav DQA 
        Date: Wed, 25 May 2005 17:01:38 -0400 
        From: Gerd Glang <Gerd.Glang@noaa.gov> 
Organization: NOAA Hydro Systems & Technology Programs (301-713-2653, x152) 
          To: holly.dehart.atsea@noaa.gov 
          CC: Jack Riley <Jack.Riley@noaa.gov>, "Lynnette V. Morgan" 
              <Lynnette.V.Morgan@noaa.gov>, "Holly A. Dehart" 
              <Holly.A.Dehart@noaa.gov>, Benjamin K Evans 
              <Benjamin.K.Evans@noaa.gov>, Guy Noll <Guy.Noll@noaa.gov> 
  References: <793c68e7.68e7793c@fairweather.nmao.noaa.gov> 
 
Hi Holly (I hear my train leaving), 
 
Your "atsea" e-mail keeps getting bounced back...so I'm copying Lynn on 
this. 
 
Short answer - No. 
 
USCG Beacons are subject to their own rigorous integrity monitoring.  If the 
beacon signal is being received w/ good signal strength, it should be valid 
for correcting your position (simple answer).  The Specs and Deliverables 
requirements assume this. 
 
What we need to do is check that our receivers are working properly and no 
bogus antenna offsets were entered.  Probably adequate to do this once per 
season as part of the system cert, or when you suspect a problem.   Our MB 
data (and side scan data) are spatially dense enough that any problems would 
be apparent in the data right away.  Also, the several GPS failures we've 
experienced this year have all been pretty catastrophic, i.e., there was no 
doubt the POS GPS had failed.  Bottom line, it's not in the current draft 
FPM, its not in the Specs and Deliverables.  Should be a reqt for the System 
Cert process. 
 



So the two things I would require: 
 
1)   During data acquisition, conscientious monitoring of all sensor data 
(POS controller window, POS CPU lights, USCG Beacon Receiver display/lights, 
Isis display, etc). 
2)  During daily post-processing, a systematic and careful review of the 
data - treat as a directed editing problem. 
 
Of course, we often fiddle with acquisition system configurations, both 
hardware and software, for one reason or another (or some gremlin gets into 
the system).  It would be prudent to have a system cert-like checklist to 
run thru on Monday mornings after a long inport to prompt the 
briefly-befuddled or newly-trained OIC and chase Mr. Murphy away.  Sort of 
like a pre-flight checklist.  You may recall, we once had a case on the WH 
where an entire launch day (+4 hrs OT) of data was hosed because the Isis 
config was messed up the night before, and the JO's (who shall remain 
nameless but were nevertheless well qualified) didn't pay attention to #1. 
 
(The complacent hydrographer will soon go aground - GFG). 
 
BTW - RA has SonarPro for SSS (haven't used it much lately).   NRTs use 
SonarPro. 
 
G2 
 
Holly DeHart atsea wrote: 
 
> Hi Gerd, 
> 
> Lynn was asking me about comparing differential beacons, where you 
> take coincident positions w/ two systems on different beacons.  Sounds 
> like WH's old p-check system.  Do we still need to do these?  If so at 
> what frequency?  They've been doing it weekly all season w/ no errors, 
> is this still necessary? 
> 
> Holly 
> 
> 
 
-- 
LT Ben Evans, NOAA 
Field Operations Officer 
NOAA Ship RAINIER (s221) 
NOAA Marine Operations Center, Pacific 
1801 Fairview Ave. E 
Seattle, WA  98102 



Glen Rice 
4/30/08 
 
Thoughts on data representation 
 
The purpose of a Caris Base Surface is to accurately represent the soundings collected in 
a grid that best models the depth of the seafloor. Various statistical means are used to 
weight individual soundings and represent them at absolute locations (nodes) on the 
surface.  Basic settings exist to change how nodes represent data collected. Several of 
these settings affect the number of soundings contributing to the node and this is of 
primary concern here. 
 
Node spacing creates an expectation of data density. Higher grid resolution should be 
balanced with greater data density. Implementing a minimum number of soundings per 
node would clarify the amount of data any given node represents. While there may be 
robust statistical arguments to how much data should support each node, we can also 
define practical grid resolutions - given a min. number of sounding per node – based on 
past data captured with current survey methods. How many soundings support each node 
is dependent on survey detection criteria and is not discussed here. 
 
Which soundings are contributing to each node is also important. If contributing 
sounding data is being gathered over a distance greater than one nodal separation, the 
node does not solely represent the area associated with its grid resolution. To have nodes 
properly represent their spacing, only data that is near the node should be contributing to 
it.  
 
The foot print of each beam from a MBES should also be represented by the nodal 
spacing. If a beam has a larger foot print than the grid resolution used to represent that 
data, regardless of data density, the grid resolution should not be significantly smaller. 
 
A Look at Past Field Data 
 
Without an increase in survey time or a change in how data is collected, more data 
density cannot be obtained. Past data densities should be used to predict appropriate grid 
resolutions for future surveys. Past data density can be obtained as follows: 
 
Open a surface in CUBE and query the surface with depth and density layers checked. 
The density layer is all data presented to each node. To normalize to sounding/meter2 
values from the density layer must be divided by the capture area of each node (equation 
1). 
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where dm is density in sounding/meter2, dn is the soundings per node from the density 
layer, c is the capture distance, and z is the depth. It is important to normalize to 
sounding/meter2 so that surfaces can be compared for their data density regardless of the 
grid resolution and survey of origin.  
 
The data density in sounding/meter2 can be interesting when plotted vs depth, but does 
not show grid resolution directly. To decide what grid resolution is best the number of 
soundings per node should be established. By dividing sounding/node by the 
sounding/meter2 the grid resolution supported by the data density falls out (equation 2). 
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where rg is the resolution supported at that node, dd is the desired data density, and dm is 
the field data density in sounding/meter2 from equation 1. A plot of depth vs rg reveals 
the grid resolution supported at each depth with the desired supporting soundings. Figure 
1 shows the supported grid resolutions as a function of depth with 3 soundings per node. 
Further discussion is needed to define a specific of soundings per node for use in the 
field. 
 

 
Figure 1 

 
With supported grid resolution as a function of depth and soundings per node, grid 
resolutions at particular depths can be chosen. A line can be drawn across the plot 
designating a particular resolution (figure 2).  
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 2 
 

The red line drawn across figure 2 delineates a 3 meter grid resolution. In shallower areas 
the 3 meter grid resolution can be supported most of the time since most of the data is 
below the line. Between 40 meters and 80 meters this resolution is supported only some 
of the time. Beyond 80 meters and at this resolution, there would never be the three 
soundings per node as required. 
 
To support picking a particular resolution, an envelope around the data can be drawn that 
will ensure a certain percentage of the data will satisfy the density requirement. In the 
approach here the mean density plus some multiple of the standard deviation forms the 
upper bounds. (Figure 3) 



 
Figure 3 

 
Figure 3 shows what grid resolution would be supported by a subset of data from all 2007 
FAIRWEATHER surveys requiring 3 soundings per node 50% of the time (mean), 68% 
of the time (mean + 1 standard deviation), and 95% of the time (mean + 2 standard 
deviations). Using this guideline, more informed decisions can be made about what grid 
resolutions are used. The mean and standard deviation were calculated using a 5m bin 
size that overlapped 2.5m. 
 
Also important when deciding the grid resolution is the beam foot print. Approximate 
beam foot prints for the Reson 8101, 8111 and 8160 (calculated using a 1.5 degree foot 
print) can be found in Figure 4. 
 

 
Figure 4 



 
The foot print of each beam increases quickly when moving away from nadir. 
FAIRWEATHER roughly overlaps adjacent lines starting around 60 degrees from nadir. 
The beam at 60 degrees has a foot print of 0.105 times the water depth. This can be added 
to a plot of what grid resolutions would support. Figure 5 shows the data supported at 
several different soundings per node at the 95% confidence level as well as the 60 degree 
beam foot print. 
 

 
Figure 5 

 
Figure 5 demonstrates how both the beam foot print and the data density need to be taken 
into account depending on the data density desired and the depth range in question. In 
greater depth, which is not shown here, the data density becomes the dominant variable. 
 
Just as important as the actual data density, capture distance defines how localized the 
data contributing to each node is. Once a grid resolution is decided upon for a particular 
depth range there are two ways to set the capture distance when using CUBE. For a 
single resolution grid, with the capture distance set very small (1% of water depth), and 
the minimum capture distance set to the distance from the node to the corner of its grid 
resolution, or 0.707 times the grid resolution in use (figure 6). 



 
Figure 6 

 
By using a small capture distance the minimum capture distance will be in use over the 
depth range of the grid resolution. This ensures that only data being represented by the 
node is being used to compute the nodal depth and prevents oversized capture distances. 
A similar method can be used to determine an appropriate capture distance setting for use 
in multi resolution surfaces but is not explained here. 
 
Limiting the capture distance to the grid resolution prevents over smoothing the data. 
Surfaces would represent the data collected and pretty pictures can always be made later. 
This is particularly important when operating on steep slopes. Because CUBE 
approximates the bottom as flat, it is best to limit the capture distance, decreasing the 
influence of data outside of the grid resolution. 
 
Final Thoughts 
 
Implementing these steps provides a hind sight perspective on the data collected and the 
surfaces produced. Preliminary testing on FAIRWEATHER shows this method makes 
sense when used on 2007 data. Field testing is needed on new data once minimum 
sounding density parameters are established.  
 
Current methods using large capture distances with small grid resolutions are only 
averaging small amounts of data to make nicer looking surfaces. This also makes the data 
density look misleadingly high in the data density surface layer. To represent the data 
collected a quantitative approach to grid resolution and capture distance is needed. 



This document contains images derived from the 
methodology outlined in the previous posting by 
FAIRWEATHER’S HACK.  The purpose is to provide some 
calibration and insight to the methodology discussed. The 
supportable grid resolutions have been derived using 
previously explained methods in the document labeled 
Data Representation. These lines were picked from the 2 
standard deviation curve for 3 soundings per node.



For the purposes of this initial inquiry, these are the 
ranges used:

1m Resolution: 0 to 20 meters
2m Resolution: 0 to 20 meters
4m Resolution: 15 to 30 meters
8m Resolution: 25 to 45 meters
16m Resolution: 40 and higher

Each surface is filtered for nodes that have greater 
than 2.999 soundings per node.



In the course of calculating our CUBE Surfaces, we altered 
some parameters and maintained some from the CUBE 
Default profile.  For each grid resolution a separate profile 
was created within the cubeparams.xml file allowing the user 
to select a complete parameter profile when calculating each 
surface resolution.  The parameters defined within each 
profile were Estimate Offset (EO), Capture Distance Scale 
(CDS), Capture Distance Minimum (CDM), and Horizontal 
Error Scalar (HES).  The profiles were created as follows:

1metergrid: EO= 4.00, CDS = 1.00, CDM = 0.71, HES = 2.95
2metergrid: EO= 4.00, CDS = 1.00, CDM = 1.41 HES= 2.95
4metergrid: EO= 4.00, CDS = 1.00, CDM = 2.83, HES = 2.95
8metergrid: EO= 4.00, CDS = 1.00, CDM = 5.67, HES = 2.95
16metergrid: EO= 4.00, CDS = 10.00, CDM = 11.31, HES = 2.95



Capture Distance Scalar values were created very small to remove their 
influence on a node’s capture distance, and Capture Distance Minimum values 
were created to define the node’s ultimate capture distance, regardless of 
depth.  To achieve a node capable of capturing all soundings within it’s area, a 
capture distance equal to a circle encompassing nodal corners was created.  
Grid resolutions are ideally inviolable, allowing the creation of BASE Surface 
profiles that can then be applied to acquired data along defined depth ranges –
though the depth ranges may be flexible.

CDM = (√2)*Node Resolution / 2
CDM = Radius 
Total Capture Area = πr2

Afterwards, a selection of screen shots are created to make a comparison with 
identical BASE Surface creation using the recommended resolutions and 
recommended depth ranges.  We provide this comparison to establish whether 
a change in processing requirements is justified, and the degree to which it is.
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H11630

The smaller highlighted area represents the section of Survey 
H11630 used to test new Base Surface parameters for all grid 
resolution.  Along this fieldsheet, the depth ranges from roughly 9 
meters to 56 meters.  



1 meter grid resolution, CDM = .707

The data density acquired during this survey, and requiring a 
minimum of 3 soundings per node, does not support a one meter 
grid. 
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2 meter Grid Resolution, CDM = 1.41

Calculations based on past survey data densities indicate that we can 
support a full coverage 2 meter grid resolution from 0 to 20 meters. 
Current survey specifications of a 2 meter grid to 40 meters is 
unsupportable using current survey methods at 3 soundings per node.
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4 meter Resolution, CDM = 2.83 

Our calculations indicate that a 4 meter grid resolution, based on 

prediction made.

past data, can be used to create a full coverage surface from 20
to 35 meters in depth. Our usual specifications would have the 
depth range from about 25 meters to 60 meters at this resolution. 
Coverage appears to be complete to 50 meters, well above the 



The smaller highlighted area represents 
the section of Survey H11571 used to 
test new Base Surface parameters for all 
grid resolutions.  Along this fieldsheet, 
the depth ranges from roughly 6 meters 
to 540 meters. 



Our calculations indicate that a one meter grid is not often supportable at 3 
soundings per node. This survey supports this prediction.

Grid resolution  = 1 meter, CDM = .707



Grid resolution  = 2 meter, CDM = 1.41

In the case of this very steep and deep survey, we find evidence of a 2 meter 
grid resolution being supported for a depth range of 0-20 meters as 
predicted. Reasonable coverage extends down to 30 meters.



Our calculations indicate that a 4 meter grid resolution, based on 
past data, can be used to create a full coverage surface from 20
to 35 meters in depth. In fact, the data densities found in this
survey indicate that complete coverage can be produced to a 
depth of 80 meters.

Grid resolution  = 4 m, CDM = 2.83



In both surveys examined, as depth increased, the model over-predicted 
the resolution required to provide full coverage. We find that 8m and 16m 
resolution grids are usable to a much greater depth than anticipated. 
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Previously, areas of low data density were not always discovered
because of enlarged capture distances. The method used here assumes 
that previous coverage was adequate in previous surveys, an 
assumption that doesn’t hold.  Previously, in areas where “Deep”
settings were used, areas of inadequate data density were obscured. 



While the original approach was to define usable grid resolutions from past 
data, particularly low density data was skewing the mean values. To 
counteract the effects of these data sets only surveys with tight resolution 
distributions were used when picking a new set of grid resolutions.

Tight resolution (H11637) Loose resolution (H11572)



Using tighter data sets allow for higher grid resolutions, but also may bias the 
density goals for future surveys to a higher, less obtainable standard. 

An interesting result of using surveys with tighter density distribution is 
the beam foot print at 60 degrees becomes the limiting factor for the 

grid resolution that is usable for part of the depth range.

Surveys used in original method Surveys used that have only 
tight resolution distributions



If beam foot print becomes the limiting factor, higher data densities 
should be obtainable.

3 soundings per node 5 soundings per node



Based on 5 soundings per node and the limits of the 60 degree beam foot print the 
previous surveys were re-examined with grid resolutions at:
2m Resolution: 0 to 20 meters
4m Resolution: 15 to 40 meters
8m Resolution: 35 to 80 meters
16m Resolution: 70 and higher (with lower densities and enlarged beam footprints)



H11630
2 meter Grid Resolution, CDM = 1.41

Generally there is sufficient coverage at 5 soundings per node 
from 0 to 20 meters as predicted.

Insufficient coverage



H11630
4 meter Grid Resolution, CDM = 2.83

For this survey 5 soundings per node works down to 40m
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H11630
8 meter Grid Resolution, CDM = 5.67

The 8 meter grid was predicted to be useable between 
35 and 80 meters. There is adequate coverage for the 

rest of the sheet to support this resolution.



H11571
2 meter Grid Resolution, CDM = 1.41

A 2 meter grid resolution is not supported in this area. Because only 
the outer beams (1 though 20) are run along shore data is sparse. 
Being steep and deep, only one pass was made while collecting data 
for this resolution range. 3 soundings per node was supported in the 
previous section. This is an example of an area that would need to be 
rerun with a small change in required data density.



H11571
4 meter Grid Resolution, CDM = 2.83

Adequate coverage is shown down to 
60 meters for 5 soundings per node, 
except in the large holiday which did 

not have complete coverage at 3 
soundings per node. This is an area 
that would need to have more data 
collected over it. The methodology 

provided describes 50 meters of depth 
as supportable for this grid resolution. 
In this case the grid resolution is being 
limited to 4 meters by the 60 degree 

beam footprint.

Holiday



H11571
8 meter Grid Resolution, CDM = 5.67

Adequate coverage is shown at this 
resolution for this depth range.



H11571
16 meter Grid Resolution, CDM = 11.31

3 Soundings per Node

3 soundings per node is present down to 500 
meters. The 60 degree footprint limits the 

maximum depth range to 160 meters.



H11571
16 meter Grid Resolution, CDM = 11.31

1 Soundings per Node

At 1 sounding per node coverage is still 
complete even with the limited capture 

distance. The 60 degree footprint limits the 
maximum depth range to 160 meters.



The original objective was to look at past data and determine how well the 
methodology predicted the usable grid resolutions. Given the wide range of 
survey conditions and results no particular finding has become evident. 
The intention was to use a line of reasoning backed by a mathematical 
approach to define specific useable resolutions. As most things in the field, 
it is messy and a large amount of experience is needed to make best 
practices clear. Insufficient testing has been completed to define specific 
resolution, but the methodology has been tested and shows promise. 

The author believes that without large changes to current survey practices 
aboard FAIRWEATHER the best resolutions to be used are as follows:

Grid Resolution Depth Range

2 meters 0 to 20 meters

4 meters 15 to 40 meters

8 meters 35 to 80 meters

16 meters 70 meters and up 
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